Oracle® Applications Desktop Integrator

User's Guide

Release 7.1 for Windows

February, 2001
Part No. A88712-01
## Contents

**Preface** ........................................................................................................................................................... xiii

### 1 Introduction

- General Ledger .................................................................................................................................................. 1-1
- Oracle Assets ..................................................................................................................................................... 1-3
- Oracle Applications .......................................................................................................................................... 1-4

### 2 Frequently Asked Questions

- Installation Considerations .............................................................................................................................. 2-1
- Functional Issues .............................................................................................................................................. 2-6
- Technical Issues ............................................................................................................................................... 2-14

### 3 Getting Started

- Getting Started with ADI ................................................................................................................................. 3-1
- Security ............................................................................................................................................................ 3-1
- Validation and Segment Security .................................................................................................................. 3-3
  - ADI Toolbar .................................................................................................................................................. 3-3
- Signing On to ADI ............................................................................................................................................. 3-10
- Selecting an Applications Database ............................................................................................................... 3-12
- Choosing a Responsibility .............................................................................................................................. 3-15
- ADI Options ..................................................................................................................................................... 3-16
  - Toolbar Options ............................................................................................................................................. 3-16
  - General Options ............................................................................................................................................ 3-19
  - General Ledger Options ............................................................................................................................... 3-23
Request Center Options .................................................................................................................. 3-30
Language Options.......................................................................................................................... 3-32
Setting the Help System Location ................................................................................................. 3-33
Displaying Signon Information ........................................................................................................ 3-34
Displaying ADI Release Information ............................................................................................ 3-36
Choosing Values from Lists ........................................................................................................... 3-37
  Account Segment Values .............................................................................................................. 3-38
Choosing Account Segment Values ............................................................................................... 3-38
Submitting Processes .................................................................................................................... 3-42
  General Ledger ........................................................................................................................... 3-42
  Oracle Assets ............................................................................................................................. 3-46

4 Budget Wizard

Applications Desktop Integrator Budget Wizard .......................................................................... 4-1
Creating Budget Worksheets ......................................................................................................... 4-2
Options Available When a Budget Worksheet is Open ................................................................... 4-5
Budget Worksheet Parameters ...................................................................................................... 4-6
Changing the Budget Worksheet View .......................................................................................... 4-8
Updating Budget Balances Using ADI ......................................................................................... 4-13
Inserting a New Budget Account .................................................................................................. 4-15
Budget Rules .................................................................................................................................. 4-16
Adding Budget Notes to a Budget Worksheet .............................................................................. 4-16
Graphing Budgets Using ADI ....................................................................................................... 4-18
Uploading Budgets from ADI to General Ledger .......................................................................... 4-19
Budget Upload Options .................................................................................................................. 4-22

5 Journal Wizard

Applications Desktop Integrator Journal Wizard .......................................................................... 5-1
  Prerequisites: .............................................................................................................................. 5-1
  Profile Options ........................................................................................................................... 5-2
Creating Journal Worksheets ......................................................................................................... 5-2
Journal Worksheet Options ............................................................................................................ 5-4
  Choose Journal Type .................................................................................................................. 5-5
  Number of Journals ................................................................................................................... 5-5
  Create Worksheet in .................................................................................................................. 5-5
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing Journal Worksheets</td>
<td>5-6</td>
</tr>
<tr>
<td>Worksheet Tab</td>
<td>5-7</td>
</tr>
<tr>
<td>Header Tab</td>
<td>5-8</td>
</tr>
<tr>
<td>Lines Tab</td>
<td>5-10</td>
</tr>
<tr>
<td>Creating Journal Entries Using ADI</td>
<td>5-12</td>
</tr>
<tr>
<td>Notes</td>
<td>5-15</td>
</tr>
<tr>
<td>Uploading Journal Entries from ADI to General Ledger</td>
<td>5-17</td>
</tr>
<tr>
<td>Journal Upload Options</td>
<td>5-21</td>
</tr>
<tr>
<td>6 Report Wizard</td>
<td></td>
</tr>
<tr>
<td>Applications Desktop Integrator Report Wizard</td>
<td>6-1</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>6-2</td>
</tr>
<tr>
<td>Reports Toolbar</td>
<td>6-2</td>
</tr>
<tr>
<td>Report Wizard Interface</td>
<td>6-4</td>
</tr>
<tr>
<td>Report Wizard Tools</td>
<td>6-5</td>
</tr>
<tr>
<td>Collapsible/Expandable Regions</td>
<td>6-6</td>
</tr>
<tr>
<td>Excel-based Menu Options</td>
<td>6-7</td>
</tr>
<tr>
<td>Column Properties Window</td>
<td>6-11</td>
</tr>
<tr>
<td>Creating a Report Using Report Wizard</td>
<td>6-12</td>
</tr>
<tr>
<td>Report Width</td>
<td>6-13</td>
</tr>
<tr>
<td>Saving a Report Using Report Wizard</td>
<td>6-17</td>
</tr>
<tr>
<td>Adding and Deleting Rows Using Report Wizard</td>
<td>6-19</td>
</tr>
<tr>
<td>Adding and Deleting Columns Using Report Wizard</td>
<td>6-20</td>
</tr>
<tr>
<td>Changing Row Properties Using Report Wizard</td>
<td>6-21</td>
</tr>
<tr>
<td>Adding and Deleting Row Account Assignments Using Report Wizard</td>
<td>6-23</td>
</tr>
<tr>
<td>Changing Column Properties Using Report Wizard</td>
<td>6-25</td>
</tr>
<tr>
<td>Adding and Deleting Column Account Assignments Using Report Wizard</td>
<td>6-27</td>
</tr>
<tr>
<td>Generating Content Sets</td>
<td>6-28</td>
</tr>
<tr>
<td>Hierarchy Attributes</td>
<td>6-31</td>
</tr>
<tr>
<td>Hierarchy Filtering Options</td>
<td>6-34</td>
</tr>
<tr>
<td>7 Analysis Wizard</td>
<td></td>
</tr>
<tr>
<td>Applications Desktop Integrator Analysis Wizard</td>
<td>7-1</td>
</tr>
<tr>
<td>Analysis Wizard Features</td>
<td>7-2</td>
</tr>
<tr>
<td>Prerequisite:</td>
<td>7-2</td>
</tr>
</tbody>
</table>
8 Account Hierarchy Editor

The Account Hierarchy Editor ................................................................. 8-1
  Parent Levels in an Account Hierarchy .................................................. 8-2
The Account Hierarchy Editor Interface ............................................... 8-4
  Segment Values Window ........................................................................ 8-5
  Hierarchy Diagram Window .................................................................... 8-7
  Expanding and Collapsing Hierarchy Diagrams ...................................... 8-8
  Displaying Multiple Hierarchy Diagrams ................................................ 8-9
  Displaying Segment Value Details .......................................................... 8-9
The Account Hierarchy Editor Menu ....................................................... 8-10
  File Menu .................................................................................................. 8-10
  Edit Menu .................................................................................................. 8-11
  View Menu .................................................................................................. 8-12
  Window Menu .............................................................................................. 8-13
The Account Hierarchy Editor Toolbar ..................................................... 8-14
Finding Segment Values ........................................................................... 8-15
Adding or Changing Account Hierarchies with the Account Hierarchy Editor .................. 8-17
Adding or Changing Parent Values with the Account Hierarchy Editor ......................... 8-21
  Merging Ranges .......................................................................................... 8-23
Adding or Changing Child Values with the Account Hierarchy Editor ............................ 8-24
Duplicating Parent Hierarchies ................................................................. 8-26
Replacing Parent Segment Values ............................................................. 8-30
  Replacement Order List ............................................................................ 8-33
Modifying Segment Value Descriptions .................................................... 8-34
Adding and Changing Rollup Groups with the Account Hierarchy Editor ....................... 8-37
Closing the Account Hierarchy Editor ........................................................ 8-39
9 Asset Wizard
Create Assets Feature ................................................................. 9-1
Creating Asset Worksheets ......................................................... 9-2
Asset Worksheet Parameters ..................................................... 9-3
  Select Corporate Depreciation Book ....................................... 9-3
  Select Layout .......................................................................... 9-3
  Actions Button Options ......................................................... 9-5
  Editing Layout Templates ....................................................... 9-6
  Create Worksheet in .............................................................. 9-6
Entering Data in Your Asset Worksheet ....................................... 9-7
  Entering Data Manually ......................................................... 9-7
  Importing Data into Your Worksheet ....................................... 9-7
  Notes ..................................................................................... 9-7
Uploading Asset Data into Oracle Assets .................................... 9-8
Asset Upload Options ............................................................... 9-11

10 Record Physical Inventory
Record Physical Inventory Feature ............................................. 10-1
Creating Physical Inventory Worksheets .................................... 10-2
Physical Inventory Worksheet Parameters .................................. 10-3
  Select Physical Inventory ...................................................... 10-4
  Select Layout ...................................................................... 10-4
  Actions Button Options ...................................................... 10-6
  Editing Layout Templates .................................................... 10-6
  Create Worksheet in .......................................................... 10-7
Entering Data in Your Physical Inventory Worksheet .................. 10-7
  Entering Data Manually ....................................................... 10-7
  Importing Data into Your Worksheet ..................................... 10-8
  Notes .................................................................................. 10-8
Uploading Physical Inventory Data into Oracle Assets ................... 10-9
Physical Inventory Upload Options ........................................... 10-12

11 Import Text File
Import Text File Feature .......................................................... 11-1
12 Request Center

The Request Center ................................................................. 12-1
The Request Center Toolbar .................................................. 12-2
Setting Request Center Options ............................................ 12-5
Specifying a Sound File for Request Completion .................. 12-7
Submitting Reports ................................................................. 12-8
Ad Hoc Report Components ................................................ 12-13
Request Sets ............................................................................ 12-14
RXi Reports ............................................................................ 12-17
Setting Report Publishing Options ........................................ 12-18
  Attribute Sets ....................................................................... 12-21
  Local Web Page Options ..................................................... 12-23
  Spreadsheet Options ........................................................... 12-26
  Text Options ......................................................................... 12-29
Setting Report Submission Options ....................................... 12-30
Specifying Your Printer Settings .......................................... 12-31
Formatting Report Output .................................................... 12-33
Using Report Output Themes ............................................... 12-33
Customizing Themes for Standard (Fixed Format) Reports .... 12-35
Customizing Themes for Financial Reports ......................... 12-35
  Positioning Line Items ........................................................ 12-38
  Formatting with Tokens ....................................................... 12-38
  Formatting with Line Item Tokens ....................................... 12-40
  Formatting with Line Item Image Tokens ......................... 12-41
  Cell Level Formatting ......................................................... 12-42
  Heading Regions, Report Title, Report Heading, and Column .. 12-43
  Line Item and Amounts Regions ......................................... 12-44
Expanded Rows ........................................................................................................................ 12-46
Formatting Standard (Variable Format) Reports ...................................................................... 12-47
    Formatting with Tokens ........................................................................................................ 12-49
Custom Macro......................................................................................................................... 12-49
Viewing Report Output and Logs ............................................................................................ 12-50
Cancelling Requests ................................................................................................................ 12-50
Monitoring Requests ............................................................................................................. 12-51

Index
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us in the following ways:

- Electronic mail: appsdoc_us@oracle.com
- FAX: 650 506-7020  Attn: Oracle Applications Desktop Integrator
- Postal service:
  Oracle Corporation
  Oracle Applications Desktop Integrator
  500 Oracle Parkway
  Redwood Shores, CA  94065
  USA

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.

This preface explains how to use this manual and lists the typographical conventions used throughout. It includes the following topics:

- Overview and reference information
- Answers to Frequently Asked questions
- Specific tasks you can accomplish using ADI
- How to use ADI windows
- ADI functions and features
- Implementation suggestions
- Applications Desktop Integrator system setup

This preface explains how this user’s guide is organized and introduces other sources of information that can help you.

**Compatibility**

ADI is an integral part of Oracle Applications. ADI is a spreadsheet-based extension of Oracle General Ledger and Oracle Assets which offers full-cycle accounting and asset management within the comfort and familiarity of a spreadsheet.

ADI will work with any of the following Oracle databases:

- Oracle RDBMS version 7.1.6 or higher (7.1.5 for Open VMS)

ADI will work with any of the following Oracle Applications:
Release 10.7 or higher

About This Installation Guide
This guide is the primary source of information about Oracle Applications Desktop Integrator (ADI). It contains overview as well as task and reference information, organized to facilitate daily reference. It also includes a compilation of frequently asked questions. This guide includes the following chapters and appendices:

Chapter 1, Introduction: includes a brief introduction to each of ADI’s major features.

Chapter 2, Frequently Asked Questions (FAQ’s): includes a comprehensive list of question about ADI that are frequently asked by users.

Chapter 3, Getting Started: describes how to get started with the system, sign on to a database, and set ADI options.

Chapter 4, Budget Wizard: describes how to use the Budget Wizard to download budgets from General Ledger into a spreadsheet, edit the budget amounts, then upload the revised budget amounts to General Ledger. You can also analyze your budgets and create graphs.

Chapter 5, Journal Wizard: describes how to use the ADI Journal Wizard to create journal entries in a spreadsheet, then upload your journal entries to General Ledger.

Chapter 6, Report Wizard: describes how to use the ADI Report Wizard to define financial reports graphically in a spreadsheet, then upload the report definitions to General Ledger.

Chapter 7, Analysis Wizard: describes how to perform multidimensional analysis with report drilldown, completely within Excel. Use Analysis Wizard to quickly detect trends and exceptions in the financial data that supports your reported amounts.

Chapter 8, Account Hierarchy Editor: describes how to create, maintain, and manipulate your General Ledger account structure using an intuitive drag and drop graphical interface.

Chapter 9, Create Assets Feature: describes how to upload asset data from a spreadsheet into Oracle Assets. You can upload data from legacy systems or bridge Oracle Assets with a third party payables application.

Chapter 10, Record Physical Inventory Feature: describes how to upload physical inventory data into Oracle Assets then reconcile the data you loaded with information in the Oracle Assets production system.
Chapter 11, Import Text File: describes how to import data from legacy systems, third party payables applications, barcode scanned data, or other flat file sources, into your ADI asset or inventory worksheet.

Chapter 12, Request Center: describes the Application Desktop Integrator (ADI) Request Center. You can use the Request Center to submit report and monitor concurrent processes. You can also download, format, and publish report output.

This Book is Available Online

This user’s guide is available online, in HTML format. All other Oracle Applications user’s guides are available online, in both HTML and Adobe Acrobat format.

The paper and online version of this manual are identical; use whichever is most convenient.

The HTML version of this book is optimized for onscreen reading, and lets you follow hypertext links for easy access to books across our entries library; you can also search for words and phrases if your national language is supported by Oracle’s Information Navigator. The HTML documentation is available from the ADI toolbar, or from a URL provided by your system administrator. Note that the HTML documentation is translated into over twenty languages.

An Adobe Acrobat version of this manual is available on the ADI CD-ROM. For other Oracle Applications, you can order an Oracle Applications Documentation Library CD (Release 11) containing Adobe Acrobat versions of each manual in the Oracle Applications documentation set. Using this CD, you can search for information, read it on screen, and print individual pages, sections, or entire books. When you print from Adobe Acrobat, the resulting printouts look just like pages from an Oracle Applications hard copy manual.

Assumptions

This guide assumes you have a working knowledge of the principles and customary practices of your business area. This guide also assumes you are familiar with Oracle Applications and ADI. If you have never used these products, we suggest you attend one or more of the training classes available through Oracle Education. (See Other Information Sources for more information about ADI and Oracle training.)
Do Not Use Database Tools to Modify Oracle Applications Data

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. But if you use Oracle tools like SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications window can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications windows, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications windows to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our manuals.

Several special notes are provided to alert you to particular information within the body of the manual.

Other Information Sources

You can choose from many sources of information, including documentation, training, and support services, to increase your knowledge and understanding of ADI.

Related User’s Guides

Applications Desktop Integrator Tutorial
This tutorial is designed to help you quickly learn about all of ADI’s features. The tutorial is available for the Vision demonstration database.
Oracle Applications General Ledger User’s Guide
This guide is a complete source about General Ledger. It contains overviews as well as task and reference information about the General Ledger accounting cycle, journal entry, budgeting, consolidation, financial reporting, multi-currency, encumbrance accounting, standard reports and listings, and setting up General Ledger.

Oracle Assets User’s Guide
This guide provides information on using Oracle Assets to maintain your assets, including information on Mass Additions, the Mass Additions interface, Physical Inventory, and the Physical Inventory interface.

Oracle Application Flexfields Guide
This manual provides flexfields planning, setup, and reference information for the Applications Desktop Integrator and General Ledger implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This manual also provides information on creating custom reports on flexfields data.

Oracle Report Manager User Guide
This guide provides information on using the Report Manager to create and maintain reports you publish to the database. Report can be unrestricted and available to all users via their personal home pages, or a variety of security models can be applied that allow only authorized users to view entire reports or parts of reports. Reports published to the database are accessed via the Oracle Business Intelligence System and Oracle Self-Service Web Application.

Installation and System Administration

Oracle Applications Desktop Integrator Installation Guide
This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Public Sector Financials, Oracle Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.

Oracle Applications Installation Manual
This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Public Sector Financials, Oracle
Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.

**Oracle Applications Upgrade Manual**
This manual explains how to prepare your Oracle Applications products for an upgrade. It also contains information on finishing the upgrade procedure for each product. Refer to this manual and the Oracle Applications Installation Manual when you plan to upgrade your products.

**Oracle Applications System Administrator’s Guide**
This manual provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage concurrent processing.

**Oracle General Ledger Technical Reference Manual**
The Oracle General Ledger Technical Reference Manual contains database diagrams and a detailed description of General Ledger and related applications database tables, forms, reports, and programs. This information helps you convert data from your existing applications, integrate General Ledger with non-Oracle applications, and write custom reports for General Ledger.

**Oracle Assets Technical Reference Manual**
The Oracle Assets Technical Reference Manual contains database diagrams and a detailed description of Oracle Assets and related applications database tables, forms, reports, and programs. This information helps you convert data from your existing applications, integrate Oracle Assets with non-Oracle applications, and write custom reports for Oracle Assets.

**Oracle Applications Product Update Notes**
This book contains a summary of each new feature we added since Oracle Applications Release 10.7, as well as information about database changes and seed data changes that may affect your operations or any custom report you have written. If you are upgrading from Release 10.6 or earlier, you also need to read Oracle Applications Product Update Notes.
Other Information

Training
Oracle Education offers a complete set of training courses to help you and your staff master Oracle Applications and ADI. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. In addition, we can tailor standard courses or develop custom courses to meet your needs.

Support
From on-site support to central support, our team of experienced professionals provides the help and information you need to keep ADI working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.

About Oracle
Oracle Corporation develops and markets an integrated line of software products for database management, applications development, decision support, and office automation, as well as Oracle Applications, an integrated suite of more than 45 software modules for financial management, supply chain management, manufacturing, project systems, human resources, and sales and service management.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle is the world’s leading supplier of software for information management, and the world’s second largest software company. Oracle offers its database, tools, and applications products, along with related consulting, education, and support services, in over 140 countries around the world.
Thank You

Thank you for using Oracle Applications Desktop Integrator and this installation guide.

We value your comments and feedback. At the end of this guide is a Reader’s Comment Form you can use to explain what you like or dislike about Applications Desktop Integrator or this installation guide. Mail your comments to the following address or call us directly at (650) 506-7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.
Or, send electronic mail to appsdoc_us@oracle.com.
Applications Desktop Integrator (ADI) is a spreadsheet-based extension to select Oracle Applications that offers full cycle accounting and asset management within the comfort and familiarity of a spreadsheet. ADI combines a spreadsheet’s ease of use with the power of Oracle Applications, to provide true desktop integration during every phase of your accounting cycle. You can create budgets, record transactions, add assets, reconcile inventory, and run financial statements and inventory reports all without leaving your spreadsheet.

You can run ADI as a stand-alone application, without installing the full client version of Oracle General Ledger or Oracle Assets on your personal computer. This gives you the ability to confirm and reconcile inventory, revise budgets, create journal entries, and define financial and asset reports from any location, without being connected to your server. You only need to connect when you want to transfer data to or from Oracle Applications.

ADI includes the Budget Wizard, Journal Wizard, Report Wizard, and Analysis Wizard to simplify your work with General Ledger. To facilitate chart of account maintenance, use the Account Hierarchy Editor. ADI also includes the Create Assets, Record Physical Inventory, and Import Text File features to simplify your work with Oracle Assets. The Request Center enhances your reporting capabilities, using Excel to help you publish reports to a spreadsheet, printer, or the Web.

**General Ledger**

**Applications Desktop Integrator Budget Wizard** on page 4-1

The Budget Wizard provides a spreadsheet-based interface to simplify budget data entry and modeling in a disconnected environment. Use The Budget Wizard to automatically build a budget spreadsheet, based on the budgets and budget
organizations you have previously set up in General Ledger. You can download existing budget balances from General Ledger or create a new budget.

Enter your new budget balances manually, use budget rules, or use formulas and models. You can then automatically graph your budgets, and use a variety of graph styles to compare budget and actual balances. Afterward, you can save a budget spreadsheet on your PC and work on it at any time. When you are satisfied with your new budget balances, you can automatically upload them to General Ledger.

**Applications Desktop Integrator Journal Wizard on page 5-1**

Use the Journal Wizard to design and automatically generate spreadsheet-based journal entry worksheets. Enter your journal entries directly in this worksheet, where you can take advantage of the spreadsheet’s many data entry shortcuts, such as copying and pasting cells, dragging and dropping ranges of cells, or even using formulas to calculate journal line amounts.

ADI validates the data you enter against the accounts, security rules, and reference information you defined in General Ledger. Once you’ve created your journal entries and ADI has validated the data, you can automatically upload your journals to General Ledger. Before uploading, however, you can save and distribute your journal worksheets for approval.

**Applications Desktop Integrator Report Wizard on page 6-1**

The Report Wizard provides a spreadsheet-based interface to General Ledger’s financial reporting engine, the Financial Statement Generator (FSG). The Report Wizard seamlessly supports report definitions for all user levels. Novice users can define simple reports entirely within a spreadsheet, intermediate users can use a combination of spreadsheets and assistance windows, and advanced users can use configurable property sheets that allow faster data entry than working in the spreadsheet alone.

Most importantly, the spreadsheet interface allows users to manage the reporting process within the comfort and familiarity of a spreadsheet, while still taking advantage of the FSG’s reusable and interchangeable report objects, server-based processing for high performance, and report scheduling for efficient use of system resources.

**Applications Desktop Integrator Analysis Wizard on page 7-1**

The Analysis Wizard combines multidimensional analysis with report drilldown, completely within Excel. You can select amounts from spreadsheet reports and drill into the underlying financial information within Oracle Applications. The Analysis
Wizard presents the complete range of accounts that support a particular reported amount. You can select an individual account and drill into its summary balances, detail balances, journal lines, down to Payables and Receivables subledger details. During drilldown you can use drag-and-drop capabilities to pivot accounting dimensions, quickly reorganizing financial data to perform “what-if” and “what-happened” analysis of both summary and detail financial information. The versatility of the Analysis Wizard helps you quickly detect trends and exceptions in the financial data that supports your reported amounts.

**The Account Hierarchy Editor on page 8-1**

The Account Hierarchy Editor allows you to create, maintain, and manipulate General Ledger account structures from a single location, using an intuitive and easy to learn drag and drop interface.

Use the Account Hierarchy Editor to keep your account structure consistent with changes in your organization. You can create new parent and child values or modify dependencies in an existing hierarchy, copy your current hierarchy to make changes without affecting the original, or create a new independent hierarchy to model a pending reorganization.

Only those users with proper authorization can modify hierarchies. Validation rules insure correct relationships are maintained for a consistent chart of accounts.

**Oracle Assets**

**Create Assets Feature on page 9-1**

The Create Assets feature provides a spreadsheet-based interface to simplify asset creation. Use the Create Assets feature to automatically build personalized asset entry spreadsheets based on the information required by your organization’s specific implementation of Oracle Assets. You can enter your asset data manually, use the list of values, and take advantage of Excel’s data entry shortcuts. You can also map data files from legacy systems or third party payables applications into the asset worksheet. When you are satisfied with the worksheet, the Create Assets feature automatically uploads the data into Oracle Assets.

**Record Physical Inventory Feature on page 10-1**

The Record Physical Inventory feature provides a spreadsheet-based interface to simplify the physical inventory process. Use the Record Physical Inventory feature to automatically build personalized physical inventory spreadsheets based on the information required by your organization’s specific implementation of Oracle...
Oracle Applications

**Oracle Applications Desktop Integrator**

Assets. You can enter your physical inventory data manually, use the list of values, and take advantage of Excel’s data entry shortcuts. You can also map files created from scanned barcode data into the physical inventory worksheet. When you are satisfied with the worksheet, the Record Physical Inventory feature automatically uploads the data into Oracle Assets.

**Import Text File Feature on page 11-1**

The Import Text File feature allows you to import data from legacy systems, third party payables applications, barcode scanners, or any other flat data file sources, to your worksheet. Using the Import Text File feature, you can map fields in your source file to fields in your worksheet. Once you have created the map using the Import Text File feature, you can save it and apply it to future conversions.

**Oracle Applications**

**The Request Center on page 12-1**

Use the Applications Desktop Integrator (ADI) Request Center as a centralized tool for submitting, monitoring, and publishing your organization’s reports, report sets and request sets.

You can submit any Standard (Fixed Format), Standard (Variable Format) or Financial (FSG) report from the Request Center for processing on your server, as long as your responsibility permits you to do so. You can create and submit ad hoc FSG reports.

When your report completes processing, the Request Center can automatically publish the output to your spreadsheet, the Web, or directly into the database, while also applying custom formatting, such as colors, fonts, and a corporate logo.

Report formatting is accomplished with report themes that you create. For example, you could have a balance sheet theme, an income statement theme, or an asset theme saved on your hard disk, each with different formatting. When you run an income statement, you can choose to publish the report using the income statement theme. When you run a balance sheet, you can choose to publish the report using the balance sheet theme. When you run an asset report, you can choose to publish the report using the asset theme. With this unique feature, no additional preparation is needed before you distribute your reports to senior management.

You can also use the Request Center to monitor your concurrent requests. The Request Center automatically notifies you, by flashing a completion message on your screen, when your financial reports, journal uploads, budget uploads, or asset
uploads finish processing. The Request Center is particularly useful because you can use it to simultaneously monitor any concurrent program submitted by any Oracle Application against any database, not just the requests you submit from ADI. Once a request finishes processing, you can view the concurrent request log or the output report using any word processor or editor. You can even categorize your concurrent requests by adding specific requests to a 'Hot List' for immediate access in the future.

See Also:

Getting Started with ADI on page 3-1
ADI Toolbar on page 3-3
Frequently Asked Questions on page 2-1
This list of Frequently Asked Questions (FAQ) about Applications Desktop Integrator is organized into three major sections:

- **Installation Considerations** on page 2-1
- **Functional Issues** on page 2-6
- **Technical Issues** on page 2-14

The answers are presented in the sections that follow.

### Installation Considerations

**How can I install Applications Desktop Integrator for use with older versions of Oracle General Ledger?**

32-bit ADI works with all currently certified versions of Oracle General Ledger, including Release 10SC. You do not need to take any special action.

**Question:** What versions of ADI are compatible with Oracle General Ledger and Oracle Assets?

**Table 2–1**

<table>
<thead>
<tr>
<th>Oracle Applications Release</th>
<th>Applications Desktop Integrator Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL = Oracle General Ledger, A= Oracle Assets</td>
<td>3.0</td>
</tr>
<tr>
<td>11i</td>
<td>GL/A</td>
</tr>
<tr>
<td>11.0</td>
<td>GL</td>
</tr>
</tbody>
</table>
Installation Considerations

Table 2–1

<table>
<thead>
<tr>
<th>Oracle Applications Release</th>
<th>Applications Desktop Integrator Release</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL</td>
<td>GL/A GL/A GL/A GL/A GL/A GL/A GL/A GL/A</td>
</tr>
</tbody>
</table>

Question: Do I need a full client installation of Oracle General Ledger 10SC to use Applications Desktop Integrator?

No, you do not need a full client installation of Oracle General Ledger on your PC. Applications Desktop Integrator interacts with GL’s open interface tables GL_INTERFACE (using Journal Import) and GL_BUDGET_INTERFACE (using Budget Upload). These interface tables have remained constant since the initial character-mode version of Release 10. This means that you can run Applications Desktop Integrator even if you are not running 10SC.

Question: What Releases of Oracle General Ledger can I use with ADI?

General Ledger Release 10.7 - If you use Oracle General Ledger Release 10.7 NCA, you can continue to use Applications Desktop Integrator in its client/server configuration. Note, however, that Applications Desktop Integrator is not a web-enabled product like General Ledger NCA. Rather, each product provides its own separate user interface to a web-enabled Oracle Applications database. The middle application server tier introduced by the General Ledger NCA Java client has no effect on Applications Desktop Integrator’s ability to access the Oracle Applications database.

General Ledger Release 11.0 - ADI Release 3.2 was the first release to provide support for Oracle General Ledger Release 11.

General Ledger Release 11i - ADI Release 7.0 is the first release to provide support for Oracle General Ledger Release 11i.

Question: What Releases of Oracle Assets can I use with ADI?

Oracle Assets Release 10.7 - ADI Release 4.1 was the first release to provide support for Oracle Assets, Release 10.7.

Oracle Assets Release 11.0 - ADI Release 4.0 was the first release to provide support for Oracle Assets, Release 11.0.
Oracle Assets Release 11i - ADI 7.0 is the first release to provide support for Oracle Assets, Release 11i.

**Question: What are the technical requirements for Applications Desktop Integrator?** You need an Intel-based, or 100% compatible, personal computer (PC) with the following:

- Pentium processor or better
- Clock speed of 90 MHz or greater
- Network card
- SVGA color monitor with a resolution of at least 1024 x 768 pixels, configured to use the small fonts option if available
- 32MB RAM minimum.
- 96MB disk space. ADI requires 26MB. The remaining 70MB is for technology components that may already be installed on the PC.

---

**Note:** For Windows NT you must install the latest Service Packs:

- Service Pack 5 for Windows NT 3.51
- Service Pack 3 for Windows NT 4.0 or later
- Microsoft Excel 7.0 (32-bit), Microsoft Excel 97 (32-bit), or Microsoft Excel 2000.

---

- Microsoft Excel 7.0 (32-bit), or Microsoft Excel 97 (32-bit), Excel 2000.

**Note:** Earlier versions of Excel are no longer supported.

---

- Oracle General Ledger Release 10.7 (character mode, 10SC Production 16.1, or 10.7 NCA) or later.
- Oracle Assets Release 10.7 (character mode, 10SC Production 16.1, or 10.7 NCA) or later.

**Question: Does Applications Desktop Integrator support network installations?**
Yes, you can install Applications Desktop Integrator, Release 6.0 or earlier, on a network drive using the Oracle Client Software Manager. ADI Release 7.0 does not support this functionality.

**Question:** What does it mean if I get a message that a file was replaced with an older version during installation of Applications Desktop Integrator?

The Applications Desktop Integrator installation process may install different versions of some files that are currently on your system. This is common, and the installation process will handle this situation. Simply reboot your system after installing Applications Desktop Integrator and you will not see the message again.

**Question:** What does it mean if I get the message "Object variable or with block variable not set Error Number:91" while signing on to Applications Desktop Integrator?

This is an indication that Applications Desktop Integrator is not installed correctly. This is probably because Oracle Objects is not registered correctly, or your version of Required Support Files (RSF) is incorrect. Run the Diagnostic Wizard and follow its recommendations.

**Question:** What does it mean if I get a message containing "ERROR: ORA-12154: TNS: could not resolve service name" when using Applications Desktop Integrator for Excel 7/97/2000?

Applications Desktop Integrator for Excel 7/97/2000 is a 32-bit application that resides in a 32-bit Oracle home that is separate from the 16-bit Oracle home. You must ensure that the SQL*Net and Net8 configuration files (SQLNET.ORA and TNSNAMES.ORA) in the 32-bit Oracle home include entries for your databases.

**Question:** Can I install ADI on an Apple Macintosh computer?

There is no native version of ADI for the Macintosh, but you can install ADI on a Citrix WinFrame server or Windows Terminal Server with Citrix Metaframe. Then the Macintosh can access ADI via the server.

**Question:** Can I use ADI with Citrix WinFrame or Windows Terminal Server?

Yes, ADI will work with WinFrame and Windows Terminal Server.

**Question:** How are my SQLNET.ORA and TNSNAMES.ORA files related?

When SQL*Net or Net8 looks for your connect string in the TNSNAMES.ORA file, the NAMES.DEFAULT_DOMAIN value in your SQLNET.ORA file is automatically appended to the connect string specified (unless you have already appended a domain to the string).
For example, your SQLNET.ORA file has the following entry:

NAMES.DEFAULT_DOMAIN=us.oracle.com

And your TNSNAMES.ORA file has the connect string entered as

he040f.world

If you enter the connect string in ADI's database definition window as he040f, then SQL*Net or Net8 will look in the TNSNAMES.ORA file for

he040f.us.oracle.com

This entry does not exist in your TNSNAMES.ORA file. SQL Net or Net8 is unable to connect to the database.

To avoid this kind of situation, Oracle recommends that you use Oracle Network Manager to administer your SQL*Net or Net8 configuration files. If the configuration files must be manually edited, the following information provides some guidelines:

To correct the relationship between SQLNET.ORA and TNSNAMES.ORA:

Enter your connect string in ADI’s database definition window as he040f.world. SQL*Net or Net8 is able to connect to the database because this entry exists in your TNSNAMES.ORA file.

You can also correct the relationship between SQLNET.ORA and TNSNAMES.ORA as follows:

Enter your connect string in ADI’s database definition window as: he040f

Change the entry in the TNSNAMES.ORA file from: he040f.world to

he040f.us.oracle.com

SQL Net or Net8 is able to connect to the database because he040f.us.oracle.com exists in your TNSNAMES.ORA file.

**Question:** Can I have multiple installations of ADI on the same client PC?

No, ADI can only be installed once on a client PC, and the installation must be performed in the default Oracle home.

**Question:** How is ADI Online Help installed in Release 11i?

In Release 11i, Oracle Applications Help files are in HTML format and stored in the database. To load these files into the database, a utility called FNDGFU is used. To run the utility, see: Oracle Applications System Administrator’s Guide.
ADI Online Help for Release 11i will be provided as a documentation patch. Contact Oracle Support Services and refer to bug #1348841 for more information.

See Also:

Oracle Applications Desktop Integrator Installation Guide

Functional Issues

Question: Where can I find documentation for Applications Desktop Integrator?
Applications Desktop Integrator documentation is available from the following sources:

- On-line help (Choose the Help button from anywhere within Applications Desktop Integrator)
- The publications Oracle Applications Desktop Integrator Tutorial and Oracle Applications Desktop Integrator User’s Guide. These documents can be downloaded at http://docs.oracle.com. They may also be ordered through Oracle Documentation Sales.
- The publication Oracle Applications Desktop Integrator Installation Guide explains how to install ADI. This document can be downloaded at http://docs.oracle.com.

Question: What Releases of Excel does ADI support?
Support for Excel 7 (Office 95) became available with ADI Release 1.0.
Support for Excel 97 (Office 97) became available with ADI Release 2.1.
Support for Excel 2000 became available with ADI Release 6.0.

Question: How does Applications Desktop Integrator relate to Oracle Financial Analyzer?
The Applications Desktop Integrator Budget Wizard provides a spreadsheet-based budget entry screen that facilitates simple data entry and modeling in a disconnected environment. Oracle Financial Analyzer provides complex budget modeling in a distributed environment.

The Applications Desktop Integrator Report Wizard provides a spreadsheet-based reporting tool for quickly creating and running financial reports. Oracle Financial Analyzer provides online analytical processing (OLAP) and reporting with balance drill down, as well as report pivoting, within a distributed environment.

Question: Can Applications Desktop Integrator be used with Lotus 1-2-3?
No, there are no current plans to provide a Lotus port. Applications Desktop Integrator runs against Excel only.

**Question:** What languages are available for Applications Desktop Integrator?

ADI supports the following languages:

<table>
<thead>
<tr>
<th>Table 2–2  ADI Supported Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
</tr>
<tr>
<td>Japanese</td>
</tr>
<tr>
<td>German</td>
</tr>
<tr>
<td>Spanish</td>
</tr>
<tr>
<td>Latin American Spanish</td>
</tr>
<tr>
<td>French</td>
</tr>
<tr>
<td>Italian</td>
</tr>
<tr>
<td>Canadian French</td>
</tr>
<tr>
<td>Danish</td>
</tr>
<tr>
<td>Dutch</td>
</tr>
<tr>
<td>Korean</td>
</tr>
</tbody>
</table>

**Question:** What security is available for Applications Desktop Integrator?

Applications Desktop Integrator enforces the same username, password, and responsibility security as Oracle Applications. Also, you may choose to use function security or profile options, both defined in Oracle Applications.

See the Appendix in Oracle Applications Desktop Integrator Installation Guide for specific security information.

---

**Note:** Segment value security became available with ADI Release 2.0.

**Question:** How can I change the budget name, organization, currency, or period range of an existing budget worksheet?
Choose General Ledger from the ADI toolbar, then select the Budget Wizard and choose Edit Budget Criteria.

**Question:** How can I use a single Applications Desktop Integrator worksheet with several databases?

You can create a worksheet for each database in a single workbook, then copy and paste or create cell references from one worksheet to the other.

**Question:** Are there plans to support table-validated value sets within Applications Desktop Integrator?

This feature became available with ADI Release 2.0.

**Question:** What does it mean when I receive the messages: This action cannot be completed because the Microsoft Excel - Sheet1 application [EXCEL] is busy. Excel is not running, or is unavailable.

This message appears if you are in cell "EDIT" mode when you try to perform another action. If you first exit edit mode by leaving the active cell, you will not get this message.

**Question:** How can a character-mode Oracle General Ledger customer obtain and use Applications Desktop Integrator?

Order the Applications Desktop Integrator software, which is free for supported customers. Character-mode users can then communicate with their database through Applications Desktop Integrator, which interacts with General Ledger's open interfaces Applications_INTERFACE (using Journal Import) and Applications_BUDGET_INTERFACE (using Budget Upload).

**Question:** Can I download actuals and use them as a basis for a budget?

Yes – The Budget Wizard lets you download budgets and actuals into separate worksheets in the same workbook. You can then copy and paste your actual amounts into your budget worksheet, or create cell references from your actuals worksheet to your budget worksheet. You can also create a budget model that references your actual amounts.

**Question:** Now that I can use Reports to get my FSG output into Excel, what happens if my report exceeds the Excel 16,000 line limitation?

Report output is not bound by the Excel line limitation. The Request Center automatically splits report output into 16,000 line blocks for Excel 7, and 65,000 line blocks for Excel X.
blocks for Excel 97, with each block going into a separate worksheet within the workbook. If you fill a workbook, Request Center automatically opens another workbook and continues adding worksheets.

**Question:** Does Applications Desktop Integrator support cross-validation rules?
Applications Desktop Integrator enforces cross-validation rules if you set the General Ledger profile option Flexfields: Validate on Server to Yes. This feature became available with ADI Release 2.0.

**Question:** What does it mean when I try to view an FSG report and I get a Reports window to format my report?
In Production 15, we modified the FSG engine to add a method for Request Center to determine how to segment the output, since the different output regions (Report Heading, Column Headings, Line Items, and Amounts) can have different formats.
When running against Production 14, this feature is not available. Therefore, before the output is automatically loaded into Excel, a Request Center window pops-up with a sample of the actual output and prompts you to position a few pointers to mark the region boundaries. This window is similar to Excel’s Text Import feature but significantly easier to use (one step with drag and drop). Also, Request Center uses default positioning that will work with most reports.

**Question:** If I require Budget Journals, can I use Applications Desktop Integrator?
Yes, you can use the Journal Wizard which performs uploads through the journal API and creates journals. You cannot use the Budget Wizard since it uploads through the budget API which does not create journals. So, create budgets in a standard budget worksheet, then cut and paste the amounts into a journal worksheet for uploading.

**Question:** After downloading a budget, can I insert rows with new code combinations for upload?
Yes. ADI includes a Budget Wizard feature you can use to insert new budget accounts. Choose General Ledger from the ADI toolbar then select Insert Budget Account. Note that the added accounts must fall into the budget organization that was originally downloaded.

**Question:** Can I create and upload a new budget worksheet without first doing a budget download?
No. You must create the budget worksheet in Excel first, even if that means you must download a single account. If you want to upload data from another source,
create the budget worksheet, then use Excel’s cell referencing or cut & paste functions to transfer amounts into the worksheet.

**Question:** Is it possible to permit users to download without giving them upload privileges (without defining a password for the budget organization)?

Yes. The ADI security profile options that are available in General Ledger provide this level of control.

**Additional Information:**


**Question:** Why do my period names appear as numbers after retrieving report output into Excel using Reports?

Excel converts any value that looks like a date into its numeric equivalent. To ensure that Excel treats your period names as labels, put at least one space before the &POI token in the report definition column headings.

**Question:** Are Standard (Variable Format) reports available for all Oracle Applications?

Release 11i supports Standard (Variable Format) reports for General Ledger, Oracle Assets and Accounts Receivable.

**Question:** Can I submit report sets through the Request Center?

Report set submission is not yet supported, but you can publish report sets through the Request Center.

**Question:** Can I perform cell level formatting with report themes?

Yes, you can format financial reports at the cell level using report themes. For additional information, See: Cell Level Formatting, Oracle Applications Desktop Integrator User’s Guide.

**Question:** Is ADI a web enabled product?

No, ADI is a client/server application. However, ADI can be implemented in a three tier architecture using environments such as Citrix WinFrame and Windows Terminal Server.

**Question:** Can I run a financial statement between different sets of books?
Yes, if the sets of books contain the same chart of accounts and if the set of books for the report is determined based upon the user's responsibility. If the set of books for the report is defined within the report itself, you must first make a copy of the report using Report Wizard and change the set of books in the definition of the report copy.

**Question:** Can I drill down on a financial report amount produced by a row or column calculation using the Analysis Wizard?

No, you can only drill down on financial report amounts associated with account segments.

**Question:** Why aren't custom filters working on account segment values in budget worksheets?

You may notice unpredictable results when you apply a custom filter to an account segment value column of your budget worksheet. This is because Excel treats the values in these columns as text, rather than numeric. We recommend that you check your results carefully. Also, you may find that you need to precede your specified filter value with a single or double quote character. For example, >= "3750.

**Question:** Why do I receive the message "Select an amount on a Financial Report worksheet..." when I attempt to use the Analysis Wizard?

If multiple copies of Excel are running on your PC, ADI is unable to correctly determine which copy to use with the Analysis Wizard. You can resolve this one of two ways:

- Close all copies of Excel except the one from which you want to drill down.
- Enable the environment option. Double Click Drill Enabled on the Default Drill Options window in the Analysis Wizard, then select the amount on which you want to drill down and double-click the left mouse button.

**Question:** Why does the Analysis Wizard display an amount that is different from the original financial report amount I drilled down upon?

There are several reasons why the drill down results of the Analysis Wizard can differ from the amount on the financial report. This may occur when:

- Your report format is different from the original entry. For example, your report format may be set to 000,000 compared to your original entry which contained two decimal places 000,000.00.
You change the drill down period or amount type in the Analysis Wizard context window.

The amount in the financial report is an expanded row of a line item. In this case, the drill down will show the total of all expanded rows for the current line item.

If a column from the original column set fails to be included, then drill down may incorrectly calculate the period for the drill. Change the period using the context window.

Flexfield Segment Security Rules may prevent the responsibility using the drill down feature from viewing original journal entries created under a different responsibility.

Journals may have been posted after the report was run.

**Question:** When I upload my asset worksheet, I receive an error message stating that certain fields in my worksheet must have a value. When I check the worksheet, the fields do contain values. Why do I receive this error message?

The following fields in the Asset worksheet are dependent on other fields for complete validation:

<table>
<thead>
<tr>
<th>This field is dependent on...</th>
<th>This independent field</th>
</tr>
</thead>
<tbody>
<tr>
<td>YTD Depreciation</td>
<td>Cost</td>
</tr>
<tr>
<td>Salvage Value</td>
<td>Cost</td>
</tr>
<tr>
<td>Depreciation Reserve</td>
<td>Cost</td>
</tr>
<tr>
<td>Date Placed in Service</td>
<td>Category</td>
</tr>
<tr>
<td>Original Depr Start Date</td>
<td>Conversion Date</td>
</tr>
</tbody>
</table>

ADI cannot validate Oracle Assets business rules if the dependent field is placed in the Header Region of the asset worksheet and the independent field is placed in the Lines Region of the worksheet.

For example, if the field YTD Depreciation (dependent field) is placed in the Header Region and the field Cost (independent field) is placed in the Lines Region, the following error is displayed in the worksheet Message column upon upload:

YTD Depreciation must have a value
To correct or avoid this error, you can:

- Place both the dependent and independent fields in the Header Region.
- Place both the dependent and independent fields in the Lines Region.
- Place the independent field in the Header Region and the dependent field in the Lines Region.

**Question:** Can I access the General Ledger Account Hierarchy Editor through ADI?

The General Ledger Account Hierarchy Editor is available through ADI 3.2 and higher and supports the following releases:

- Character Mode: 10.6, 10.7
- Smart Client: 10.6 Prod 15, 10.7 Prod 16
- NCA: 10.7, 11.0.0+
- Applications: 11

The Account Hierarchy Editor is available in English language only.

**Question:** Why can’t I access the Switch Themes feature from the Request Center?

The Switch Themes feature is available for use only with spreadsheet output with ADI Releases 3.2 and earlier. You cannot use this feature to switch themes for web or text output. You also cannot apply cell level formatting with Switch Themes.

For ADI Releases 4.0 and higher, republish your worksheet using a different theme. Republishing lets you apply themes for any output type; spreadsheet, web, or text. ADI Releases 4.0 and higher also support cell level formatting.

**Question:** When I specify a BMP file as the company logo in my Theme, why does the resulting spreadsheet output display an icon with a GIF filename?

To insert bitmap image files into Themes, choose Insert > Picture from the Excel toolbar. Do not insert your images by choosing Insert > Object from the Excel toolbar.

**Question:** How can I enter both numbers and letters into an accounting flexfield without having it converted into an exponential number during upload?

Choose the Options button from the ADI toolbar and select General Options. Select the Settings tab. Clear the Zero Pad Account Values check box.

**Question:** Are there naming conventions to use with my ADI worksheets?
Use any name you like. Be sure to eliminate any spaces in your worksheet name. Excel macros do not function correctly if there are spaces in the worksheet name. See the following example:

- Test1.xls - correct
- Test 1. xls - incorrect

**Question:** What do I do when the data columns in my standard report are not split in the right places?

You can create a new theme or modify an existing theme to match the widths of the columns in your theme with those in the report output. Use the Import Wizard to easily match theme columns with report output columns. To align columns:

1. Publish your report to Text using the Request Center.
2. Open the text file in Excel using the Import Wizard.
3. Set the boundaries for each column within the Import Wizard in Excel.
4. Use these column widths in your theme.
5. Save your theme and use it to publish the report.

**Question:** Does ADI provide Descriptive Flexfield validation?

No, ADI does not offer Descriptive Flexfield validation.

### Technical Issues

**Question:** What Versions of Excel can I use with Applications Desktop Integrator?

You can use Excel 2000 with version 6.0 or later. Previous versions can be used with Excel 7.0 or Excel 97. All three are 32-Bit applications. Earlier 16-bit versions of Excel are no longer supported.

**Question:** What if I have problems signing on to Applications Desktop Integrator?

You need to define at least one Applications database. This tells Applications Desktop Integrator how to connect to your database. For information on defining a database, choose the Help button in the Oracle Applications Signon window within Applications Desktop Integrator.

**Question:** What if I get a runtime error when I signon?
This problem can occur with older versions of Applications Desktop Integrator when you do not have a budget or budget organization defined for your set of books. To fix this problem, define a budget or budget organization, or obtain a more recent version of Applications Desktop Integrator.

**Question: What versions of Oracle Applications are supported?**

Oracle General Ledger Release 10.7 (character mode, 10SC, NCA) or later.
Oracle Assets Release 10.7 or later.

**Question: What can I do if I get a runtime error 1005 when Applications Desktop Integrator builds a new journal or budget worksheet?**

This error occurs when Excel tries to set printed page settings, but no printer is installed. Make sure you have installed at least one printer in Windows. Also, you must select one of your installed printers as the default printer.

**Note:** This will not occur in Applications Desktop Integrator Production 15 or later.

**Question: What can I do if I get a runtime error and only a partially built journal or budget worksheet?**

Check your AUTOEXEC.BAT file to ensure that the %ORACLE_HOME%IN directory is present. Usually, it will appear as follows:

```
PATH=C:RAWININ;C:OS;C:INDOWS
```

**Question: What causes "Null Segment Value in Account" messages or "Invalid <field_name>" (when the field value is valid) errors?**

Account segment "above prompts" (list of values prompts) must be unique, and cannot be the same as any field names used in your journal worksheet. Ensure that your "above prompts" are unique using the Define Key Flexfield Segments window in Oracle General Ledger.

**Question: Where are my Applications Desktop Integrator preferences stored?**

ADI 3.0 (or later) – Stores preferences in the Windows Registry under the keys named HKEY_CURRENT_USER Software ORACLE ADI and GLDI. If you upgrade from an earlier version of ADI, your custom preferences and values will be transferred automatically to the Windows Registry.
Question: Now that I can view my log and output files using the Request Center, can I change the report viewer?

Yes, use the Request Center options window to define your report viewer.

Question: What should I do if I get General Protection Faults (GPF) and other errors?

We have created the Applications Desktop Integrator Diagnostic Wizard to help solve these sorts of problems. This interactive tool guides you through a step-by-step process that eliminates many known problems inherent to Windows. You can run the Diagnostic Wizard by choosing its program icon from the Oracle for Windows (or Windows NT) program group.

Question: Do I need to apply the 10SC patch to use Applications Desktop Integrator security?

No. You can manually set the profile options using the Application Developer responsibility. See: Enabling Security with ADI, Applications Desktop Integrator Installation Guide.

Question: What should I do if I get a SQL error when trying to submit an FSG report through Reports?

This happens because Reports is unable to locate your printer. If you do not want to print reports, set the Concurrent: Report Copies profile option to 0. If you want to print reports, set the Printer profile option and ensure that the Concurrent: Report Copies profile option is set to 1 or greater.

Question: What should I do if I get the message "Data source name not found and no default driver specified" when Applications Desktop Integrator is building a budget worksheet?

You should make sure that the database names you have defined in Applications Desktop Integrator do not include special characters, such as commas, dollar signs, pound signs, etc. We recommend that you restrict the characters used in your database names to spaces, the characters A through Z, and the numbers 0 through 9.

Question: Why doesn't ADI's context-sensitive online help work properly with Internet Explorer?

If ADI's web-based online help has been installed locally on your PC, context-sensitive online help will not work with Internet Explorer. This is caused by a problem in Internet Explorer that prevents it from recognizing properly formatted URL references when those references are to web pages stored on a local drive.

You can resolve this problem by installing your ADI help files on a central web server within your organization and accessing online help from there. Note that this...
solution will also save a lot of disk space on the individual PCs within your organization since ADI’s online help files do not have to be installed on each PC.

**Question: When I’m using ADI with Excel 97, why does Excel continually ask if I want to disable macros?**

Excel 97 includes a feature to help prevent Excel macro viruses from infecting your PC. This feature assumes that any macro that runs automatically when a worksheet is opened (including the Applications Desktop Integrator Excel add-in) may be a virus. If you use up-to-date virus software to protect your PC, it is probably safe to disable Excel 97’s macro virus detection feature.

You can disable macro virus detection in Excel 97 on the popup window that appears when Excel 97 detects an automatically run macro. Simply uncheck the Always Ask Before Opening Workbooks with Macros check box, then choose Enable Macros to continue.

**Question: Why do I receive a “Cannot find macro {filename}!{macroname}” error after opening a saved workbook?**

Excel 97 includes a macro virus protection feature that disables all of the macros within a workbook to prevent them from running. While this successfully prevents a macro virus from attacking your PC, it also prevents any application written in Excel, such as ApplicationsDI, from working.

We recommend that you install on your PC, and keep current, one of the many commercially available anti-virus software products. This will protect your PC from all viruses, not just Excel macro viruses.

Once you’ve installed an anti-virus product, disable the Excel macro virus protection feature as follows:

1. From the Excel menu, choose Tools > Options.
2. Select the General tab.
3. Unmark the Macro Virus Protection check box.

**Question: When I try to sign on to ADI, I receive a message stating: “Error: ORA-12505: TNS:listener could not resolve SID given in connect descriptor.” I can successfully use TNSping to verify that there is a listener on the server. What does this error mean?**

This is a SQL Net error indicating that the SID does not exist on this host. Since you can TNSping, there is a listener on the host server but the SID you are trying to connect to does not exist on this host.
You must ensure that the SID defined in your TNSNAMES.ORA file is synchronized with the SID on the host.

**Question:** What does it mean when I receive the message "Could not establish an Oracle Objects session" when I try to sign on to ADI?

This message means that ADI cannot locate the `%ORACLE_HOME%\BIN` directory in the Path. The Oracle Installer should have added this directory to the Path when you installed ADI. For more information, see:


If this directory was not added to the Path, complete the following steps to add it manually:

1. Log in to Windows NT as a user with Administrator privileges.
2. For Windows NT 3.51, choose the Control Panel icon in the Main program group. For Windows NT 4.0, choose Settings > Control Panel from the Start menu.
3. Choose the System icon.
4. For Windows NT 4.0, choose the Environment tab.
5. Select the Path variable, located in the System Variables region in Windows NT 3.51 or the System Variables region in Windows NT 4.0.
6. Add the `%ORACLE_HOME%\BIN` path to the beginning of the variable in the Value region (for example, C:\ORACLE\BIN;%SystemRoot%;...)
7. Choose SET to make the change permanent. Choose OK to close the System window, then close the Control Panel window.
8. Shut down and restart Windows NT before running ADI.

**Question:** Is system security breached by giving users GWYUID, FNDNAM and Connect String information?

No, the transparency of the GWYUID and FNDNAM to users is in accordance with AOL security standards for client/server applications. Access to all tables is not possible with this information. Users may gain limited access to some basic tables through SQL. However, these records can only be viewed, not updated.

**What Formatting features are supported in Web Output?**

The Web Output format recognizes the following report formatting features:
- Column Widths - if there is any value in the column that does not fit within the assigned column width, the browser will automatically increase the width of the entire column to accommodate the entire view.

- Alignment

- Font Name

- Font Size - Excel fonts are mapped to HTML fonts as follows:

<table>
<thead>
<tr>
<th>Excel Font Size</th>
<th>HTML Font Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size &lt; 10</td>
<td>Size = 1</td>
</tr>
<tr>
<td>Size &gt;= 10 and Size &lt; 12</td>
<td>Size = 2</td>
</tr>
<tr>
<td>Size &gt;= 12 and Size &lt; 14</td>
<td>Size = 3</td>
</tr>
<tr>
<td>Size &gt;= 14 and Size &lt; 18</td>
<td>Size = 4</td>
</tr>
<tr>
<td>Size &gt;= 18 and Size &lt; 24</td>
<td>Size = 5</td>
</tr>
<tr>
<td>Size &gt;= 24 and Size &lt; 36</td>
<td>Size = 6</td>
</tr>
<tr>
<td>Size &gt;= 36</td>
<td>Size = 7</td>
</tr>
</tbody>
</table>

- Font Bold

- Font Italic

- Fore Color

- Background Color

- Background Image

- Logo

Features, such as cell borders, background patterns, Font underline, page settings, custom formatting macros, etc., available in Excel are not supported in Web Output.
Getting Started with ADI

You start ADI directly from Microsoft Windows.

To start ADI:

1. For Windows 95 or Windows NT, choose Programs > Oracle ADI > Applications Desktop Integrator from the Start button.

   Note: If you’ve already started the Request Center, you can start ADI by choosing the Applications Desktop Integrator button from the Request Center toolbar.

2. Choose the User Signon button from the ADI toolbar.

3. Signon to ADI using your Oracle Applications username and password.

Security

When you start ADI a toolbar appears. After you sign on, the system determines the functions you are authorized to access. Icons for these functions appear on the toolbar, if you have enabled them in your options settings.
See: ADI Options on page 3-16 for further information on displaying toolbar icons.

Until you successfully sign on to ADI, you have access only to those icons and functions that do not interact with your applications database. For example, you can perform any of the daily work you need to do in an Excel spreadsheet; open a saved budget worksheet, apply budget rules, work with Oracle Assets data, or create a graph. You can also sign on to Oracle Applications, change your ADI options, and access the Help functions. You cannot download budget balances, use Budget Wizard, Journal Wizard, or Report Wizard, upload balances to the interface tables, monitor requests, or submit processes, because these functions require that ADI be connected to your applications database. You also do not have access to Oracle Assets (the Assets icon does not appear on the ADI toolbar until you successfully sign on).

Note: ADI observes the same password security as the application you are accessing. If your password has expired or you experience problems with your password, contact your system administrator for assistance.

After you sign on to ADI, you may not have access to specific features and functions. ADI compares security options, set by your system administrator, to those set for your responsibility to determine which ADI features you can use. If you have trouble accessing certain ADI features, contact your system administrator for assistance.

See Also:

Enabling Security within ADI, Appendix B, Oracle Applications Desktop Integrator Installation Guide

Signing On to ADI on page 3-10

Security on page 3-1

Selecting an Applications Database on page 3-12
Validation and Segment Security

Below are validation and segment security rules ADI performs with Oracle Applications.

**Flexfield Validation**
ADI performs flexfield validation checking as follows:
- Provides full support for table-validated value sets.
- Uses server-side validation if the profile option Flexfields: Validate On Server is set to Yes. Otherwise, ADI uses its own client-side validation logic.

**Cross-Validation Rules**
ADI enforces cross validation rules when the profile option Flexfields: Validate On Server is set to Yes. Otherwise, no cross-validation checking is done in ADI.

**Segment Security**
For journals, ADI enforces the segment security rules that have been defined in General Ledger. For budgets, ADI only enforces segment security rules when the profile option GLDI: Enforce Budget Wizard Segment Security is enabled.

**See Also:**
*Oracle Applications Desktop Integrator Installation Guide*

**ADI Toolbar**

You can access ADI's functions from the toolbar buttons or from the system's hot keys.
Signon: Enter your username and password, then choose a responsibility.
Hot key: [Ctrl-Shift-S]

Change Responsibility: Choose a different responsibility once you’ve signed on to your Application database.
Hot key: [Ctrl-Shift-R]

General Ledger Menu: Choose General Ledger to access the following ADI wizards and General Ledger features.

Enter Budgets: Create Budget worksheets, refresh values in the current budget worksheet, or edit the budget criteria for the current budget worksheet.
Hot key: [Ctrl-Shift-B]

Enter Journals: Create a worksheet for entering journals.
Hot key: [Ctrl-Shift-T]

Define Report: Define FSG reports or download existing report definitions.
Hot key: [Ctrl-Shift-D]

Analyze report: Perform multidimensional analysis with report drilldown, completely within Exce.
**View Account Hierarchy Editor:** Start the Account Hierarchy Editor, which you can use to manage your account structure. The button does not appear unless your responsibility allows you to modify account structures.

**List of Values:** Choose from a list of valid values for a particular item, such as currency or journal category.  
*Hot key:* [Ctrl-Shift-L]

**Upload to Interface:** Upload your budget values or journal entries to the General Ledger interface tables. Provides the option to automatically start the Submit Process function (see below).  
*Hot key:* [Ctrl-Shift-U]

**Submit Process:** Start any of the following processes:
- Import budget values or journal entries from the interface tables to General Ledger. Your process can also be submitted automatically from the Upload to Interface function (see above).
- Delete journal import data from the General Ledger Interface.
- Submit Standard (Fixed Format), Standard (Variable Format) or Financial (FSG) reports and publish on the web, in a spreadsheet or a text file.

**Insert Budget Account:** Insert a new account row into a budget worksheet.

**Apply Budget Rule:** Use budget rules, such as Repeat per Cell or Divide Evenly by Row, to update your budgets.  
*Hot key:* [Ctrl-Shift-Z]

**Add Budget Note:** Append notes to an entire budget, an account or individual amounts in a budget worksheet.  
*Hot key:* [Ctrl-Shift-N]
Create Graph: View your budget balances in graph form.

Hot key: [Ctrl-Shift-G]

Assets Menu: Choose Assets to work with Oracle Assets features.

Create Assets: Create asset data in an Excel spreadsheet.

Hot key: [Ctrl-Shift-B]

Record Physical Inventory: Enter physical inventory data in an Excel spreadsheet.

Import Text File: Import a text file containing asset or physical inventory data, which you format in an Excel spreadsheet and upload into Oracle Assets.

List of Values: Choose from a list of valid values for a particular item, such as currency or journal category.

Hot key: [Ctrl-Shift-L]
Upload to Interface: Upload your asset and physical inventory data to Oracle Assets interface tables. Provides the option to automatically start the Submit Process function (see below).

Hot key: \Ctrl-Shift-U)

Submit Process:

Post MassAdditions from the MassAdditions interface table to Oracle Assets. Your process can also be submitted automatically from the upload to Interface function (see above).

-Submit Physical Inventory Comparison Process.

Applications Menu: Choose applications to access the Request Center, Oracle Applications, or Start Excel.

Request Center: Format, submit, monitor, and publish reports

Hot key: \Ctrl-Shift-W)

Oracle Applications: Start Oracle Applications, if it is installed on your PC. When you select this button, you will be asked to select an applications database. If you use the same database as for your ADI session, you will not have to enter your username and password.

Hot key: [Ctrl-Shift-A]
Excel: Start Microsoft Excel

*Hot key:* [Ctrl-Shift-E]

**Applications Desktop Integrator**

**ADI Options Menu:** Use to access general options for ADI, General Ledger, Request Center, and Language options. Also use to access sign on and ADI release information.

*Hot key:* [Ctrl-Shift-O]

**Toolbar Options:** Use to add, delete or arrange icons on the ADI toolbar.

**General Options:** Define general settings for your ADI interface environment. Set worksheet colors and default formatting for your report themes.


*Hot key:* [Ctrl-Shift-W]

**Request Center Options:** Set defaults for Request Center queries, and sound notifications. Define print settings.

**Language Options:** Change the language ADI uses in windows, menus and tool tips. Set fonts and font characteristics.
**Information:** Check details for the set of books you are using and your current signon information. Check ID numbers related to your signon authority and the set of books you are accessing.

**About ADI:** ADI Release information.

**Tip Wizard:** Set Tip Wizard Options, Display the greeting or disable the Tip Wizard.

**Help:** Access the online help features of ADI.

*Hot key:* Ctrl-Shift-H

**Minimize:** Minimize the toolbar to an icon of the Windows desktop.

*Hot key:* Ctrl-Shift-M

**Exit:** Close and exit ADI.

*Hot key:* [Ctrl-Shift-X]

**See Also:**

- Signing On to ADI on page 3-10
- Frequently Asked Questions on page 2-1
Signing On to ADI

To use Oracle Applications, you need an Oracle Applications sign-on, which consists of a unique username and password. These are different from the username and password you use to sign on to your computer. If you are not sure of your Oracle Applications sign-on, consult your system administrator.

Oracle Applications security is based on your sign-on, since this connects you to your responsibilities, which control your access to applications, functions, reports, and data.

Prerequisite

- You must define at least one database before you can successfully sign on to Oracle Applications.
To sign on to ADI:

1. Start ADI, and choose the Signon button from the toolbar.

2. From the Database poplist, select the applications database to which you want to sign on. ADI displays the name of the database you used during your last session, if any.

   Note: The database name you choose must have at least six characters.

   Note: To add or delete a database to/from the poplist, or to edit the specifications for an existing database, choose the Define Databases button or navigate to the Select Database window.

3. Enter your Username and Password.
   Your password does not appear as you type it, to prevent others from seeing it. Keep your password confidential to prevent access by unauthorized users.

4. Check the Use Last Responsibility check box to use the same responsibility you used during your last session with ADI. To select a new responsibility, make sure the check box is unchecked.

5. Choose OK. If you checked the Use Last Responsibility check box, ADI automatically connects you to your database. If you left the box unchecked, the system prompts you to choose a responsibility.
Disconnecting a Database

There may be situations when you want to disconnect from the applications database without closing ADI. For example, if you are going to be away from your computer for a while, you can disconnect ADI from your applications database as a way to prevent unauthorized users from using your computer to access General Ledger or Oracle Assets.

To disconnect from an applications database:

1. Choose the Signon button from the ADI toolbar.
2. Choose the Disconnect button.
3. Choose Yes to disconnect.

See Also:

Selecting an Applications Database on page 3-12
Choosing a Responsibility on page 3-15

Selecting an Applications Database

From the Select Database window, you can select a database from a list, edit the specifications for a database, add a new database, or delete a database.

To use an applications database with ADI, you specify:

- A Current Database name and Description. You can choose any name and description.

Note: The database name you choose must have at least six characters.
Selecting an Applications Database

- GWYUID (Gateway User ID), FNDNAM, and Connect String, which are system-level parameters for your database. You must supply these. If you do not know them, consult your system administrator.

- NCA Connection. If you want to launch NCA applications from the ADI toolbar, you must specify the entire name and directory location of the applet bat file. See your system administrator for more information.

- Server ID. Required only if the database is using Applications Server Security. See your system administrator.

To select an applications database from a list:
1. From the Signon window, choose the Define Databases button.
2. Select the applications database name from the Current Database poplist.
3. Choose OK to confirm your selection, or Cancel to return to the Signon window.
To edit the specification for a database in the list:
1. Select the applications database name from the Current Database pulldown.
2. Choose the Edit button. The Edit Database Details window appears.
3. Modify the values in the window, as needed.
4. Choose OK to retain your changes, or Cancel to discard them.

To add a new database to the list:
1. Choose the Add button.
2. Complete the fields in the Add Database Details window.
3. Choose OK to save your new instance, or Cancel to discard it.

To delete a database from the list:
1. Select the applications database name from the Current Database poplist.
2. Choose the Delete button.
3. Choose Yes to delete the database from the list, or No to keep it.

See Also:

Signing On to ADI on page 3-10
Choosing a Responsibility on page 3-15

Choosing a Responsibility

A responsibility is the level of authority you have been given to access functions and data in Oracle Applications. Depending on your job requirements, you may have more than one responsibility, each associated with one set of books in Oracle General Ledger or Oracle Assets. Your system administrator sets up your responsibilities.

A responsibility is the level of authority you have been given to access functions and data in Oracle Applications. Depending on your job requirements, you may have more than one responsibility, each of which is associated with one set of books in General Ledger or Oracle Assets. Your system administrator sets up your responsibilities.

You can use ADI to upload journals to the set of books to which you have been given access under a responsibility. You can also download budgets from General Ledger, modify them, and upload your changes if your responsibility allows. You can create and submit reports for that set of books associated with your responsibility. You can create assets, log physical inventory, and upload asset data to the set of books to which you have been given responsibility.

Note: If your responsibility is not associated with a set of books, you will not be able to use ADI’s features.

To choose the responsibility you used during your last ADI session, make sure you check the Use Last Responsibility check box (Signon window) before completing your ADI signon.
You can easily change your responsibility from within ADI.

**To choose a responsibility different from that used in your last session with ADI:**
1. Uncheck the Use Last Responsibility check box on the Signon window.
2. Complete your signon.
3. Select a responsibility from the displayed list of values.
4. Choose OK to confirm your choice, or Cancel to discard your selection.

**To change your responsibility:**
1. Choose the Change Responsibility button from the ADI toolbar.
2. Select a new responsibility from the displayed list of values.
3. Choose OK to confirm your choice, or Cancel to retain your current responsibility.

See Also:
- Signing On to ADI on page 3-10
- Selecting an Applications Database on page 3-12

**ADI Options**

Choose the Options button from the ADI toolbar to set options for ADI components and features.

**Toolbar Options**

Select this option to customize the icons on your toolbar.
Add Icons Tab

Define custom toolbar buttons to invoke programs and processes external to ADI. For each custom icon you choose to display on the toolbar, you must specify:

Description: A name for the button. This name appears when you place the cursor over the button on the toolbar.

Command Line: The path and name of the program you want to associate with the toolbar button. This is the program that launches when you choose the button.

Working Directory: The pathname to the program that is specified under Command Line.
Move Icons Tab

Use this tab to move icons to and from your ADI toolbar. You may also group and arrange icons on the toolbar.

Available Icons: The list of icons you can place on the ADI toolbar. Select the + or - sign to see the contents of poplists related to icons on the main toolbar. You can move these icons to main ADI toolbar.

Toolbar Icons: The list of icons as they appear on the main ADI toolbar.

---

**Note:** Use the separator button to create groups of icons on the main toolbar to reflect your style of working with ADI.

---

**Note:** The Signon, General Options, and Exit icons are always displayed on the toolbar.

Switch Orientation

Select this option to toggle between horizontal and vertical display of the ADI toolbar.
Reset Icons

Select this option to reset your toolbar to the default ADI toolbar.

General Options

Choose general options and default settings for ADI. Choose your settings for worksheet colors and report themes.

To set any of the options discussed in this section:

1. Choose the Options button from the ADI toolbar.
2. Choose General Options from the list of values.
   The General Options window appears.
3. Set your Worksheet Colors, Theme Defaults, Setting, and Installation options.
4. Choose OK to save your work.

Worksheet Colors Tab

Choose default color settings for journal, budget, report, and asset worksheets. You can set colors for Field Text, Field Background, Context Text, Context Background,
Data Entry Area, and Sheet Background. The sample worksheet, to the left of the Workbook Region options, reflects your color choices as you make them.

---

**Note:** These color choices apply only to worksheets on your display; not to report output. You make report output color selections on the Theme Defaults tab of the General Options window.

---

**Theme Defaults Tab**

Choose the Theme Default tab to set the defaults for new report themes. The report theme defaults are also used when the theme you specify for publishing a report does not exist or is damaged.

- **Theme:** From the Region poplist, you can select Report Title, Report Heading, Column Headings, Line Items, or Amounts. Once selected, the choices you make affect the related region, as reflected in the sample report output. For each theme option, you can set the Font to use for displaying text, the font Size, whether text is Bold and/or Italic, the Text and Background colors, and whether the report area should be enclosed by a Border.
Note: To select colors, choose either the text or background color box. Alternatively, choose the text or background area in the report output sample shown in the Wizard Options window. When the Select Color window appears, select a color then choose OK.

- **Logo:** You can specify an image file to be displayed on your report output. Specify the path and filename for the image, or choose the Find button to browse your directory structure for the file you want. Once you select your image, set these options:
  - **Include Border:** Surround the image with a narrow Border.
  - **Include Shadow:** Display the image with a drop-down Shadow.
  - **Align:** Select Left to display the image on the left side of your report output or Right to display the image on the right side.
  - **Width:** Select Title to have the image display to the left or right of your report title. Select Heading to have the image display to the left or right of your report heading.
  - **Banner Use for DB Publishing:** Enable the checkbox to include a banner in your reports published to the database and displayed by Report Manager.

As you make your selections, ADI updates the sample image on the right side of the window.
Settings Tab

Set miscellaneous ADI parameters:

**Start ADI when Opening Workbook:** Check this option if you want ADI to start automatically (if it is not already running) whenever you open a budget, journal, or report worksheet in Excel. If this option is not checked, ADI does not start when you open worksheets.

**Start Request Center at Signon:** Check if you want the Request Center to start automatically when you start ADI.

**Show Upload Success Indicator:** Check if you want ADI to display upload success indicators on your budget, journal, and asset worksheets. The indicators tell you whether related budget, journal, or asset lines uploaded successfully.

**Zero Pad Account Values:** Check if you want account segment values to be zero padded. For example, an account number of 50, where the segment is four characters in length, will display as 0050.

**Enable Hot keys:** Check this box to enable the special hot keys that are mapped from your keyboard to ADI’s functions. This is an alternative to using a mouse.

**Always on Top:** Check this box to force Windows to always display the toolbar on top of all other open windows.

**Tip Wizard:** Check this box if you want to use Microsoft Agent. In the Character File window, enter the path name for the character you wish to use. Choose the Show Characters button to test display the Agent.
Installation Tab

Set miscellaneous parameters:

**Run Custom Macros**: In a future version of ADI, you will be able to run custom macros before and after certain ADI processes.

**Perform Self-Check at Startup**: Check if you want ADI to perform a self-check when you start the system.

**Play Sounds for Events**: Check if you want ADI to play sounds for events such as error messages.

**Write Statistics Files for Support**: Check if you want ADI to gather statistics when you run performance testing scenarios.

See also: Performance Test Scenarios for Journal Wizard Upload on page A-1.

**Directory and Files region** — The Integrator Directory, User Settings Directory, Integrator Program Filename, and the Applications Program Filename. Do not modify these items unless told to do so by your System Administrator.

See Also:

- Specifying a Sound File for Request Completion on page 12-7
- Performance Test Scenarios for Journal Wizard Upload on page A-1


**General Ledger Options**

Enter options for Budget Wizard, Journal Wizard, Report Wizard, and Analysis Wizard such as decimal places, fonts, color selections, graph styles, and various defaults.
To set any of the options discussed in this section:
1. Choose the Options button from the ADI toolbar.
2. Choose Ledger Options from the list of values.
   The Ledger Options window appears.
4. Choose OK to save your work.

Budget Tab

Choose defaults for budget formatting and graphing.

- **Format Region**: Define default options for formatting budget worksheets:
  - **Decimal Places** — The number of decimal places (up to five) the system displays for all values in your worksheet. The default is Database, which draws the decimal places option from your General Ledger database.
  - **Minimum Width of Value Columns** — The Excel column width to use as the minimum width for each of your budget worksheet value columns.
- **Update Budget Status** — Check this box to have the system automatically update the budget status information on the Create Budget Worksheet window anytime you make changes to your budget worksheet parameters.

- **Graph Region**: Define default options for displaying graphs when you choose the Create Graph button from the ADI toolbar:
  - **Style** — From the poplist, you can choose Area, Bar, Column, Line, and Pie charts. The default is Column.
  - **2D or 3D** — To display two-dimensional or three-dimensional graphs. The default is 3D.
  - **Generate Axes** — Check the box to include these values as labels on the axes of your graphs.
  - **Include Budgets and Actuals** — Check the box to instruct ADI to graph both your budget and actual values for Excel workbooks where you’ve elected to include both budget and actual amounts.

---

### Journal Tab

Choose general format settings for journal and asset worksheets. You can change defaults for Format, Layout, and Header.

- **Format**: Change the appearance of fields and hints in your journal worksheet. Fields appear as row and column headings in your template. Hints appear as the detail information underneath or to the right of the headings.
General Ledger Options

- **Apply Format to**: — Select Fields or Hints, then set the following values:
  - **Font**: Select a font name from the list of values.
  - **Size**: Select a type size from the list of values.
  - **Italic**: Check if you want the related text displayed in italic typeface, or leave blank for normal text.
  - **Bold**: Check if you want the related text displayed in bold typeface, or leave blank for normal text.

- **Layout**: Change journal worksheet layout options:
  - **Default Number of Rows** — Select or enter a value from 1 to 65,500, for the number of journal lines to display in your journal worksheet.
  - **Minimum Width of Value Columns** — Select or enter a value from 1 to 20, for the minimum width to be used in displaying amount fields.

- **Header**: Use to set the display widths for Field Name, Context, and Field Value in a journal worksheet header. Width is expressed as the number of Excel worksheet columns used to display the item. The range of values is 1 to 10 columns. Select or enter a valid value for each item in the template header.

![General Ledger Options](image)

**Report Definition Tab**

Choose default settings to define new reports, or to copy report objects. You use the Report Wizard to define report objects which are row sets, column sets, content sets, and row order.

3-26 Oracle Applications Desktop Integrator
General Ledger Options

- **Defaults**: Set the following defaults:
  - *Rows* — Number of rows to use for new report worksheets.
  - *Columns* — Number of columns to use for new report worksheets.
  - *Column Width* — Width to use for each column definition.
  - *Line Item Width* — Width of the report area where the row labels appear.
  - *Format* — Format mask to use for amounts in the report.
  - *Factor* — The factor (Billions, Millions, Thousands, Units, or Percentiles) to use for displaying numeric values.

- **Indicator**: The colors to use to display the Account Assignments, Calculations, and Exceptions report indicators on your report worksheet. The report indicators are the small symbols that appear to the left of your row definitions or above your column definitions. They indicate the number of account ranges assigned to a row or column, as well as whether there are calculations defined or column exceptions applied.

- **Copy Options**: When you use the Report Wizard, the following options determine whether the copy check boxes are checked or unchecked in the wizard windows. You can set the following defaults:
  - *Make Copy Default* — If you select Yes, the copy check boxes are checked whenever you create new report objects or define a new report as you are guided through the wizard windows. If you select No, the copy check boxes are unchecked.
  - *Enforcement Level* — These settings determine ADI prompt messages as you move through report wizard windows.

  - **Prompt**: ADI displays a message asking if you want to make a copy or use the original report or report object as your are guided through the report wizard.
  - **Do Not Prompt**: ADI does not display a message.
  - **Enforce Default**: ADI enforces the setting you select in the Make Copy Default field. If the Make Copy Default is set to Yes, you cannot change the check box settings as you are guided through the report wizard.

---

**Note**: These options are overridden if the ADI security-related profile options are defined in General Ledger.
General Ledger Options

Report Analysis Tab

Set options to help you drill down on financial reports. If you change these settings, the changes only apply to new drills that you initiate.

Drill Options Region

Drill Options can be set in two places:

- Ledger Options/Report Analysis tab: choose the default setting you want to take effect each time you initiate a drill down.

- Drill Options window: You can change the same drill options as you drill down on a report amount. You are not required to return to the Report Analysis tab to change the drill options settings.

- Drill Options: Make your selections to set Drill Options.

  - Display Segment Values: Check the Grouped check box to have your account segments displayed together as one value. Mark the Individually check box to have your account segments displayed separately.

    ‐ Suggestion: Select Individually if you want to perform multidimensional analysis of your drilldown data.

  - Minimum Amount Width: Enter the minimum column width to use for the amount columns in your drill windows.
Include Descriptions for: Mark the appropriate check box to display descriptions in your drill windows for your account Balancing Segment, Cost Center Segment, and Natural Account Segment.

**Note:** On the Current Drill Options window you can choose to include descriptions for each of your account segments.

**Suggestion:** Including descriptions can affect the performance of your drilldowns. We suggest you only include descriptions for critical account segments.

Other Options: Mark the appropriate check box to enable the following options in your drill windows:

- **Show Account Type:** Automatically show the account type when you drill down to detail accounts.

- **Suppress Zero Balances:** Choose this option if you do not want zero balance amounts to be displayed in your drill windows.

- **Show Outline Indicators:** Choose this option to display expand/collapse indicators in your drill windows. This feature is useful when you are performing multidimensional analysis.

- **Show Totals:** Automatically include totals for the rows and columns in your drill windows.

Environment Options Region

Selections you make in the Environment Options region can only be made in this window. If you change the Environment Options during a drill down, your changes become effective the next time you initiate a drill.

- **Environment Options:** Make your selections to set Environment Options.

- **Double Click Drill Enabled:** Mark this check box to enable the ability to drilldown by choosing an amount from one of the displayed drill windows. You can also use this feature to drill down on amounts from your spreadsheet-published report output (i.e., you do not have to choose the Analysis Wizard button from the ADI toolbar).

- **Hide Windows When Navigating:** Mark this check box to close the active drill window when you drill up to the previous or down to the next drill window.
Only one drill window will be open at any one time. If you do not choose this option, all drill windows remain open as you drill up and down to other drill windows.

- Maximum Active Drills: Enter a number for the maximum number of drill context windows you can have active at one time.

---

**Note:** Each open drill window consumes system resources. If you have too many drill windows open at the same time, it can overtax your system. Use the Maximum Active Drills option to prevent accidentally overloading your PC.

---

**See Also:**

- **ADI Options** on page 3-16
- **Applications Desktop Integrator Budget Wizard** on page 4-1
- **Applications Desktop Integrator Journal Wizard** on page 5-1
- **Applications Desktop Integrator Report Wizard** on page 6-1
- **Applications Desktop Integrator Analysis Wizard** on page 7-1
- **The Account Hierarchy Editor** on page 8-1

---

**Request Center Options**

You can set various Request Center options by choosing the Options button from the ADI toolbar and selecting Request Center from the list of values. You can also select the Options button from the Request Center toolbar.

From the Options window, you can set limits, sounds, and the default output viewer. You can also define default print settings and change the language options.
Getting Started  3-31

- **Limits**: Set limits for Request Center functions.
  - *Update Every*: This is the query interval in seconds. For example, if you set the interval to 60, the system checks every 60 seconds to see if your request has completed processing.
  - *Query Last*: Determines how many requests are retrieved in the Select Request to Monitor window when you choose the Query button.
  - *Flash Notification*: The number of times the Request Center title bar flashes when a request completes.
  - *Display*: You can limit which Oracle Applications’ requests are monitored by the Request Center by selecting the application name from the poplist. If you select All, you can monitor requests from all installed Oracle Applications.

- **Sounds**: See: *Specifying a Sound File for Request Completion* on page 12-7.

- **Output Viewer**: Select the program you want to use to view report output or request logs whenever you choose the View Output/Log button from the Request Center toolbar. You can enter the path and program name directly, or choose the Find button to search your computer for the program you want.

- **Printer Settings**: Choose the Printer Settings button to specify a default font to use when printing reports to a local printer.
Language Options

Language Options: Choose the Language Options button to change the language that the Request Center uses in windows, menus, and tool tips.

See: Language Options on page 3-32.

See Also:

Monitoring Requests on page 12-51
The Request Center Toolbar on page 12-2
Specifying Your Printer Settings on page 12-31

Language Options

If U.S. English is not your native language, you can change the language ADI uses in windows, menus, and tool tips. You can also change the font and font characteristics.

![Language Options dialog]

Apply language and font changes by clicking on the OK button. All windows will be closed, and the new settings will be used when you reopen them.
To change the language used by ADI:

1. Choose the Options button from the ADI toolbar, and select Language Options from the list of values. The Language Options window appears.

2. In the Language region, select Use default to use U.S. English. To use any other language, select Specific, then select the language from the poplist.

3. If needed, change the Font (see next task).

4. Chose OK to save your work.

To change the font ADI uses in windows, menus, and tool tips:

1. Choose the Options button from the ADI toolbar, then choose Language Options from the list of values. The Language Options window appears.

2. In the Font region, select Use default to use the standard ADI font, which is MS Sans Serif, 10 point, bold. To use any other font, select Specific, then enter the Font name and Size. You can also choose to display your specific font in Bold and/or Italic typeface.

3. Choose a setting in the Form Resizing Ratio Bar. Your form may require resizing depending on the language you select.

4. Choose OK to save your work.

See Also:

ADI Options on page 3-16

Setting the Help System Location on page 3-33

General Ledger Options on page 3-23

Setting the Help System Location

ADI provides online help that you can view using your default web browser. To use this feature, you must first set the base URL address to the location where ADI's
web-based help files are installed. Your system administrator can provide you with this location.

To set the ADI help system location:

1. Choose the Options button from the ADI toolbar, then choose Language Options from the list of values. The Language Options window appears.

2. In the Help region, enter the base URL address of the Location where ADI’s web-based help files are installed.

3. Select the Help Language. Select Use default to have your help files displayed in U.S. English. To use any other language, select Specific, then select the language from the poplist.

4. Choose OK to save your work.

Note: A profile option, governing the location of help files, can be set in Oracle Applications. If you signon to a database where this profile option is enabled, the location of ADI help files is automatically determined for you. You cannot change the location of help system files.

See your system administrator for additional information.

See Also:

ADI Options on page 3-16
General Ledger Options on page 3-23
Language Options on page 3-32
Installing Client Software, Applications Desktop Integrator Installation Guide

Displaying Signon Information

From the ADI toolbar, you can choose to display information about your signon details. You can display functional information, such as the set of books name associated with your current responsibility, or technical information, such as the language code you are using for ADI.
To display functional signon information:

1. Choose the Options button from the ADI toolbar. Choose Information from the list of values.

2. The Signon Information window appears.

3. Choose the Functional tab. You can review your Set of Books Details and Signon Details.

4. (Optional) Choose the Technical tab to review technical information such as Identification Numbers and Language Details. You can also turn on the SQL Trace function.
5. When you are done reviewing the signon information, choose OK to close the window.

See Also:
- Signing On to ADI on page 3-10
- General Ledger Options on page 3-23
- Language Options on page 3-32

**Displaying ADI Release Information**

You can display information about the release and production status of the ADI version currently installed on your computer.
Choosing Values from Lists

To display ADI release information:
1. Choose the Options button from the ADI toolbar.
2. Choose About ADI from the list of values.
   The Applications Desktop Integrator Release Information window appears.
3. When you are done reviewing the release information, click anywhere to close the window.

See Also:
- General Ledger Options on page 3-23
- Language Options on page 3-32

Choosing Values from Lists
For certain data entry fields on a journal, asset or inventory, or report worksheet, you can select an entry from a list of values. Fields with lists are identified by the word “list” that appears to the left of the field name.
Choosing Account Segment Values

To choose from a list of values:

1. Select the data entry field in your journal, asset, inventory, or report worksheet.

2. Choose General Ledger or Assets from the ADI toolbar and select the List of Values. Alternatively, you can double-click the left mouse button while your cursor is in the field.

3. Select an item from the displayed list of values.

4. Choose OK to confirm your selection, or Cancel to abort.

Account Segment Values

You can also choose from lists of values when you are entering account segment values for your journal entry lines. However, choosing from these lists works a bit differently than described above.

See: Choosing Account Segment Values on page 3-38.

See Also:

Creating Journal Entries Using ADI on page 5-12

Choosing Account Segment Values

When you select the List of Values button while your cursor is located within one of the account segments, ADI displays the Select Account Segment Values window. From this window, you can choose segment values one of four ways:

- Enter them directly.
- Choose from lists of values for each segment, one segment at a time.
- Use a secondary List of Values button to select from valid account code combinations.
- Use a predefined account alias to reduce the selection list.

Regardless of the selection method you use, ADI validates the account you select. If the dynamic inserts feature is not enabled in General Ledger, ADI warns you when
you select an invalid account (one that has not been defined as active in General Ledger). The system does not enter your selection on the journal worksheet.

The Select Account Segment Values window includes a table showing a row for each segment of your account code. The columns displayed are Segment, Value, and Description. For each segment, the Value column has an associated list of values.

▶ To choose account segment values one segment at a time:
1. Place your cursor in the segment Value field.
2. Type the value or choose the button with the small down arrow image on it. The system displays a new List of Values window for this segment of the account code.
Choosing Account Segment Values

3. (Optional) Reduce the number of entries in the list by entering a reduction value in the Find Value field, then choosing the Find button. Alternatively, enable automatic list reduction by checking the box to the left of the Find Value field. As you type each character of your reduction value, the displayed list will get smaller.

Note: To display all values, enter a percent sign (%) in the Find Value field or leave the field blank.

4. Select a value from the displayed list.
5. Choose OK to carry out your selection, or Cancel to abandon it.
6. Repeat steps 1 through 5, as necessary, for each segment in your account code.
7. Choose OK to finish entering your account code combination, or Cancel to start over.

To choose account segment values using the secondary list of values button:
1. Choose the Find Accounts button from the Select Account Segment Values window. The system will display a list of valid account codes.
2. (Optional) Select the All Accounts option or the Subset of Accounts option. If you select Subset of Accounts, the list is reduced to include only those combinations that match the account segment values currently set in the previous window. If you select All Accounts, all account code combinations are shown.

3. Select an account from the displayed list.

4. Choose OK to complete your selection, or Cancel to retain your previous selection. If you select OK, the system enters the related segment values in the Select Account Segment Values window.

5. Choose OK to enable your selection, or Cancel to abandon it.

To choose account segment values using account aliases:

In Oracle General Ledger, you can define aliases for accounts or combinations of account segments. In an account alias, some or all of the account segments have assigned values, providing a shortcut method for entering accounts. If you defined such aliases in General Ledger, ADI displays these in the Account Alias list of values.

1. Select an Account Alias. The system inserts the predefined values into the Select Account Segment Values window.

2. Enter values for any segments that were not defined in the account alias. To make your selections, you can use the list of values feature for each segment, as discussed above under the task, “To choose account segment values one segment at a time.”
Submitting Processes

3. Choose OK to apply your selected account code combination, or Cancel to abandon.

To clear values from the Select Account Segment Values window:
1. Choose the Clear Values button.

See Also:
Creating Journal Entries Using ADI on page 5-12
Choosing Values from Lists on page 3-37

Submitting Processes

You can submit processes, such as importing budgets and journals to General Ledger. You can post mass additions and compare physical inventory to Oracle Assets.

General Ledger

To submit a process for General Ledger, you must make selections in the Select Process Type window. Choose General Ledger from the ADI toolbar and select Submit Process from the list of values to open the window.

Process Type Region

- Choose Budget Import or Journal Import to import amounts to General Ledger from General Ledger Interface tables.

Note: You generally use this feature to complete an upload and import process that was requested previously, but which specified the Do Not Start option for the Budget or Journal Import process.

- Choose Delete Journal to delete journal import data from the GL Interface table.
- Choose the Query button to see the budgets or journal sources available for import.

Parameters Region
The information displayed in the parameters region depends on whether you query budget or journal import in the Process Type region. You can view budgets or journal sources available for import.

To submit a budget import process:
1. Choose General Ledger from the ADI toolbar and select Submit Process from the list of values. Select Budget Import.
   The Select Process Type window appears.
2. Select Budget Import from the Process Type region, then choose the Query button. Any budgets that are available for importing appear in the Parameters region.
3. Select the specific budget and budget organization you want to import.
4. Choose OK to submit your request, or Cancel to abandon.

Note: Once you submit the process, the system starts a budget import concurrent request and displays the budget import request ID. The Request Center automatically monitors the request and notifies you of the completion status when it is done.
To submit a journal import process:

1. Choose General Ledger from the ADI toolbar and select Submit Process from the list of values. Select Journal Import.

   The Select Process Type window appears.

2. Select Journal Import from the Process Type region, then choose the Query button. All available journal sources appear in the Parameters region. Information for each item includes Source, Group ID, and number of Records.

3. Select a specific journal Source to import.

4. (Optional) Check the Create Summary Journals check box to have General Ledger summarize all transactions that share the same account, period, and currency. If you don’t check this box, General Ledger creates a journal line for every row.

5. (Optional) Check the Post Errors to Suspense check box to have journal amounts whose accounts are invalid posted to a predefined suspense account. To use this function, suspense posting must be enabled in Oracle General Ledger.

6. Select an option to Import Descriptive Flexfields. The list of values includes:
   - **Do Not Import** — prevents importing descriptive flexfields.
   - **Import with Validation** — General Ledger validates descriptive flexfield values.
- **Import without Validation** — General Ledger imports descriptive flexfield values without validating them.

7. (Optional) Enter a Date Range in the Start and End fields. Use this step to limit the lines to be imported when there are journal lines with different accounting dates.

8. Choose OK to submit your request, or Cancel to abandon.

---

**Note:** Once you submit the process, the system starts a journal import concurrent request and displays the journal import request ID. The Request Center automatically monitors the request and notifies you of the completion status when it is done.

---

To delete journal import data:

1. Choose General Ledger from the ADI toolbar and select Submit Process from the list of values. Select Journal Import.

   The Select Process Type window appears.

2. Select Delete Journal Import Data from the Process Type region, then choose the Query button. All available journal sources appear in the Parameters region. Information for each journal source includes Source, Group ID, Request ID, and number of Records.
Select the specific journal Source to delete.

Choose OK to submit your request, or Cancel to abandon.

---

**Note:** Once you submit the process, the system starts a concurrent request to delete the journal entry or batch and displays the delete journal import data request ID. The Request Center automatically monitors the request and notifies you of the completion status when it is done.

---

**To submit a report:**

1. Choose the General Ledger button from the ADI toolbar and select Submit Process > Report from the list of values.
2. Complete the information in the Report Submission and Publishing window.
3. Submit your report request to the Request Center.

**See Also:**

- Uploading Journal Entries from ADI to General Ledger on page 5-17
- Uploading Budgets from ADI to General Ledger on page 4-19
- Submitting Reports on page 12-8
- Monitoring Requests on page 12-51

---

**Oracle Assets**

You can start the following processes by choosing Assets > Submit Process from the Assets toolbar:

- Post Mass Additions to Oracle Assets
- Compare Physical Inventory
To submit the Post Mass Additions process:

1. Choose the Assets button from the ADI toolbar and select Submit Process > Post Mass Additions from the list of values.
2. Select the corporate depreciation book for which you want to post your mass additions. ADI displays the number of records associated with each book.
3. Choose OK to submit your request, or Cancel to abandon.

**Note:** Once you submit the process, the system starts a Post Mass Additions concurrent request and displays the Post Mass Additions request ID. The ADI Request Center automatically monitors the request and notifies you of the completion status when it is done.

When you post mass additions to Oracle Assets by choosing Submit Process > Post Mass Additions, this process does not submit the Mass Additions Posting Report. You must submit this request separately.
To submit the Compare Physical Inventory process:

1. Choose the Assets button from the ADI toolbar and select Submit Process > Compare Physical Inventory from the list of values.

2. (Optional) Check the Category check box if you want Oracle Assets to compare assets only for a specific category. ADI displays the number of records associated with each inventory/category/location combination, or each inventory/category combination. If you do not check this box, Oracle Assets compares assets for all categories.

3. (Optional) Check the Location check box if you want Oracle Assets to compare assets only for a specific location. ADI displays the number of records associated with each inventory/category/location combination, or each inventory/location combination. If you do not check this box, Oracle Assets compares assets for all locations.

4. (Optional) Select the Inventory Name, Category, and Location.

5. Check the View Results check box if you want to generate the Physical Inventory Comparison Report.

6. Choose OK to submit your request, or Cancel to abandon.
Note: Once you submit the process, the system starts a Physical Inventory Comparison concurrent request and displays the Physical Inventory Comparison request ID. If you checked the View Results check box, ADI also starts a Physical Inventory Comparison Report concurrent request. The Physical Inventory Comparison Report runs once the Comparison process completes. ADI Request Center automatically monitors the requests and notifies you of the completion status when finished.

See Also:

Uploading Asset Data into Oracle Assets on page 9-8
Uploading Physical Inventory Data into Oracle Assets on page 10-9
Applications Desktop Integrator Budget Wizard

With the Applications Desktop Integrator (ADI) Budget Wizard you can download an existing budget from Oracle General Ledger into Microsoft Excel, modify it in Excel, then automatically upload your revised budget amounts to General Ledger.

You can also analyze budgets by downloading both actual and budget balances from General Ledger, then using Excel to perform comparisons between the actual and budget values.

Since ADI uses Excel to create budget worksheets, you can easily save your worksheets to your local hard disk or floppy disk, making it possible to edit them later, or perform budget analysis work, on a different PC, even when you are disconnected from your corporate database.

Prerequisites:

- Define a budget.
- Open one or more years for your budget.
- Define a budget organization, then assign a budget entry type of Entered to the accounts for which you want to enter budget amounts.

See Also:

Creating Budget Worksheets on page 4-2
Options Available When a Budget Worksheet is Open on page 4-5
Updating Budget Balances Using ADI on page 4-13
Creating Budget Worksheets

- Changing the Budget Worksheet View on page 4-8
- Budget Rules on page 4-16
- Graphing Budgets Using ADI on page 4-18
- Uploading Budgets from ADI to General Ledger on page 4-19
- Budget Upload Options on page 4-22
- Getting Started with ADI on page 3-1
- ADI Toolbar on page 3-3
- ADI Options on page 3-16
To create a budget worksheet:

1. Choose General Ledger from the ADI toolbar and select the Enter Budgets from the list of values.
2. Enter your budget worksheet parameters.
   See: Budget Worksheet Parameters on page 4-6.
3. Choose OK. ADI creates your budget worksheet and downloads any existing budget balances from General Ledger.

Note: If the budget organization you select is password protected, the system prompts you to enter the password. Enter the password, then choose OK.

To limit the number of accounts included on your budget worksheet:

1. When entering your budget worksheet parameters, choose the Limit Accounts button.
2. Enter or choose your account segment values.
   See: Choosing Account Segment Values on page 3-38
3. Choose OK to return to the Create Budget Worksheet window.

To change the display and sort order of the account segment in your budget worksheet:

1. When entering your budget worksheet parameters, choose the Set Characteristics button.
   The Set Display Characteristics window appears. There are four columns:
   Display Order: Determines the sequence in which your account segments appear (as columns) in your budget worksheet.
   Show Desc: Determines which account segment’s descriptions you can display in your budget worksheet.
   Sort Order: Determines the sorting order of your account. For example, you can sort by account within cost center within company, or you can sort cost center within company within account.
Sort Order: Determines the sorting order of your account. For example, you can sort by account within cost center within fund, or you can sort cost center within fund within account.

Sort Direction: Determines whether an account segment is sorted in Ascending or Descending order.

2. In the Display Order column, select the account segment whose display order you want to change, then move it up or down.

3. Mark the check box for each account segment (shown in the Display Order column) whose description you would like to display in your budget worksheet.

4. In the Sort Order column, select the account segment whose sort order you want to change, then move it up or down.

5. For each account segment, select a Sort Direction from the related poplist.

6. Choose OK to return to the Create Budget Worksheet window.

▶ To save a budget worksheet to disk:

1. Select File > Save As from the Excel menu.

2. Enter a name and specify a path for the budget worksheet file.

3. Choose OK to save the file, or Cancel to abandon the operation.

▶ To open a saved budget worksheet:

1. Select File > Open from the Excel menu.

2. Select the path where the budget worksheet is located. Excel displays the names of the files in a separate list.

3. Choose the budget worksheet name from the list of values.

4. Select OK to open the file, or Cancel to abort.
   If ADI is installed, but not running, ADI starts automatically when you open the budget worksheet.

See Also:

Options Available When a Budget Worksheet is Open on page 4-5
Options Available When a Budget Worksheet is Open

Even while you are working on an open budget worksheet, you can use the Budget Wizard to:

- Create Budget Worksheet: Build a new budget worksheet.
- Refresh Budget Values: Restore the budget values from your General Ledger database to your currently open budget worksheet.
- Edit Budget Criteria: Edit the budget worksheet parameters for your currently open budget worksheet.

To create additional budget worksheets in the same session:

1. While viewing a budget worksheet, choose General Ledger from the ADI toolbar and select Enter Budgets from the list of values.
2. Select Create Budget Worksheet.
3. Choose OK. ADI displays the Create Budget Worksheet window, whose default entries are the same as your currently open worksheet.
4. Enter your budget worksheet parameters.
5. Choose OK to create the new budget worksheet.

To refresh budget worksheet values with existing General Ledger budget balances:

1. While viewing a budget worksheet, choose General Ledger from the ADI toolbar and select Enter Budget from the list of values.
2. Select Refresh Budget Values.
3. Choose OK.

---

**Note:** If your budget organization is password-protected, the system prompts you to enter the password. Enter the password, then choose OK.

ADI replaces the worksheet budget values with the existing budget balances from General Ledger, based on the current edited budget worksheet parameters. The system asks you before replacing any worksheet budget values that have changed since you last uploaded amounts to General Ledger.
To change the budget, budget organization, currency, or period range for a budget worksheet:

1. While viewing a budget worksheet, choose General Ledger from the ADI toolbar and select Enter Budget from the list of values.
2. Select Edit Budget Criteria, then choose OK. ADI displays the Edit Budget Worksheet window, showing the entries for your current worksheet.
3. Enter your new budget worksheet parameters.
4. Choose OK to save your changes.

See Also:
Budget Worksheet Parameters on page 4-6
Choosing Account Segment Values on page 3-38

Budget Worksheet Parameters

When you use the Budget Wizard to create a budget worksheet or edit budget criteria, you must specify certain parameters. Once you set these parameters, ADI creates a budget worksheet or modifies the currently open budget worksheet, based on the parameters you've provided.

There are two groups of parameters you can set: budget Criteria and Worksheet Options. In addition, you can view the budget Status.

Criteria

Budget Criteria specify the budget organization and budget you want to use in your budget worksheet, as well as the currency and range of periods to use. For each of these fields, the list of values displays:

- **Organization**: Budget organizations you have defined in General Ledger. Your budget organization determines the accounts against which you can budget.
- **Budget**: Budgets you have defined in General Ledger.

**Note**: You can choose to download data from frozen budgets and budget organizations into a budget worksheet. However, you cannot upload any changes to General Ledger.

- **Currency**: Currencies defined for your selected budget organization.
- **Period Range Start:** Starting period for your selected budget.
- **Period Range End:** Ending period for your selected budget.

**Note:** You make selections for each option in the same manner. Place your cursor in the option field, then use [Down Arrow] to cycle through the available values. Alternatively, you can select the expand list indicator on the right-hand side of the option field to display a scrollable list of all the available values.

**Worksheet Options**

Worksheet Options control the information that appears in your budget worksheet:

- **Workbook:** Specify where the budget worksheets are created:
  - **New:** Create your budget worksheet as a new Excel workbook.
  - **Current:** Create your budget worksheet as a new worksheet within the current Excel workbook. This option is only available when you already have an Excel workbook open.

- **Include:** Determines the budget worksheets to include in the workbook:
  - **Budgets Only:** Creates a single Excel worksheet that contains values only for the budget you defined with your budget criteria selections.
  - **Budgets and Actuals:** Creates two Excel worksheets in the same Excel workbook. One sheet contains budget values; the other, actual values, based on your budget criteria selections.

**Note:** If you choose Budgets and Actuals, you can update your budget balances and view your actual balances. You cannot update actual balances.

**Status**

ADI calculates and displays statistics about your budget in the Status region. The displayed status information includes the number of accounts associated with the selected budget organization and whether the selected budget can be updated.
Changing the Budget Worksheet View

Note: If you change your budget criteria and the Update Budget Status option is not checked on the Budget Wizard Options window, you must manually refresh your statistics display. To do so, choose the small button with the question mark, located next to the field labelled, ”Number of Accounts”.

See Also:  
Creating Budget Worksheets on page 4-2

Changing the Budget Worksheet View

While working on a budget worksheet, you can change the information that is displayed in the worksheet. For example, you can choose to hide or display the context information that normally appears at the top of a budget worksheet. This gives you more room to work with your budget numbers.

You can also hide or display account segment descriptions and you can apply view filters to control which budget worksheet rows appear on your display.
Changing the Budget Worksheet View

To hide or display budget worksheet context information:

- Choose the View Context button at the top of the budget worksheet. This toggles between hiding and displaying the context information.

To view or hide account segment descriptions:

1. When entering your budget worksheet parameters, indicate the account segments whose descriptions you want to display in your budget worksheet. When you first create a budget worksheet, the selected account segment's descriptions appear in your worksheet.

2. To view or hide your account segment descriptions, choose the View Desc button at the top of the budget worksheet. This toggles between viewing and hiding descriptions.
Changing the Budget Worksheet View

---

**Note:** If you have not chosen any segments in the previous step, the View Desc button does not appear on your budget worksheet.

**To view and set your budget worksheet filters:**

1. Choose the View Filter button from the top of the budget worksheet. A poplist appears beside each column description, as follows:

2. Choose the View Filter button from the top of the budget worksheet. A poplist appears beside each column description.

<table>
<thead>
<tr>
<th>Upl</th>
<th>Co</th>
<th>Ctr</th>
<th>Acct</th>
<th>Prd</th>
<th>P/L</th>
<th>Sub</th>
<th>JAN-92</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>01</td>
<td>(A1)</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>6576</td>
<td>7</td>
</tr>
<tr>
<td>01</td>
<td>(Top 10...)</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1200</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1400</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1600</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1700</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>1900</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>2000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>2100</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01</td>
<td>1200</td>
<td>000</td>
<td>000</td>
<td>000</td>
<td>2200</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you choose the poplist button for a column, a list appears showing all the values for that column, plus the options All, Blanks, NonBlanks, Top 10, and Custom.

3. Choose filter values for selected columns. For example, to view only account 4110 for company 01 in the above example, choose 01 for the Co filter value and 4110 for the Acct filter value. Your budget worksheet display immediately changes to show only those rows with matching filter values.

You can also select these special values from any column’s poplist:

- **All** — displays worksheet rows that have any value in the selected column.
- Blanks — displays worksheet rows that have only blanks in the selected column.

- NonBlanks — displays worksheet rows that have only non-blank values in the selected column.

- Top 10 — when applied to a column containing amounts, you can display the largest or smallest amounts in the column. When you select this option, the Top 10 AutoFilter window appears:

  - Top/Bottom: Select Top to display the largest amounts. Select Bottom to display only the smallest amounts.

  - {number}: Enter the number of amounts you want to display. This number is interpreted differently, depending on whether you choose Items or Percent from the next field.

  - Items/Percent: Select Items to display the top or bottom {number} of amounts. Select Percent to display the top or bottom {number} percent of amounts. For example, assume you have 400 budget lines in your worksheet:

    - **Top:10:Items** displays the top 10 amounts.
    - **Bottom:20:Percent** displays the bottom 80 (20% of 400) amounts.

- Custom — allows you to set custom filter values and combinations of filter values. For example, you can select accounts whose values are less than 5000. You can also select one of the logical operators AND and OR, then specify a second custom filter value for the same column.

  When you select Custom, the Custom AutoFilter window appears.
Changing the Budget Worksheet View

From the first poplist, choose a compare value:

- + Shows rows whose value equals what you enter in the next poplist
- > Shows rows whose value is greater than what you enter in the next poplist
- < Shows rows whose value is less than what you enter in the next poplist
- >= Shows rows whose value is greater than or equal to what you enter in the next poplist
- = Shows rows whose value is less than or equal to what you enter in the next poplist
- <> Shows rows whose value is not equal to what you enter in the next poplist
- > Shows rows whose value is greater than what you enter in the next poplist

In the second poplist, enter a value or choose one of the values available from the poplist. When you enter a value, you can use one of two wildcard characters:

- ? To represent a single wildcard character
- * To represent a series of wildcard characters
Caution: You may notice unpredictable results when you apply a custom filter to an account segment value column of your budget worksheet. This is because Excel treats the values in these columns as text, rather than numeric. We recommend that you check your results carefully. Also, you may find that you need to precede your specified filter value with a single or double quote character. For example:

- Choose OK to apply your custom filter.

4. Save your work.

- To turn off your budget worksheet filters:
  - Choose the View Filter button.

- To reset all of your budget worksheet filters to their default values:
  - Choose the Reset Filter button.

See Also:

Creating Budget Worksheets on page 4-2

Updating Budget Balances Using ADI

You can use Excel functions, such as copy and paste values and formulas, to update the values in your budget worksheet. You can easily insert new budget accounts into your budget worksheet, and you can use budget rules to divide a value among a range of cells or multiply the values in a range of cells by a constant. Finally, you can perform additional budget modeling by inserting new worksheets.

If you manually replace existing values in a budget worksheet, the system flags modified rows by placing a flag character in the Upload column. When you upload
your budget worksheet to General Ledger, you can choose to upload all rows in the worksheet, or only those marked with the flag character.

---

**Note:** If you use Excel’s copy and paste functions to replace an existing value, ADI does not enter a flag character in the Upload column. You can manually enter one by placing your cursor in the upload column cell where you want the flag character, then entering any character or number from your keyboard.

---

**To update budget balance manually:**

- While viewing a budget worksheet, edit your budget balances by entering new values, by copying and pasting values from other cells, or by entering Excel formulas. If you copy and paste values from other cells, remember to manually enter a flag character in the Upload column.

When you are building your budget with ADI, you can use the Apply Budget Rule feature to quickly generate entries in your budget. This feature is quite useful when the values in a range of cells are to be the same or are computed in the same manner. You apply a budget rule to a range of cells in your worksheet.

---

**To update budget balance using budget rules:**

1. Select a range of cells in the worksheet. The budget rule you select applies to these cells.
2. Choose the General Ledger button from the ADI toolbar and select Apply Budget Rule. The Apply Budget Rules window appears, indicating the range of cells you selected.

3. Choose a budget Rule, then enter an Amount.

4. Select OK to apply the budget rule, or Cancel to abort.

See Also:

- Changing the Budget Worksheet View on page 4-8
- Budget Rules on page 4-16
- Inserting a New Budget Account on page 4-15
- Adding Budget Notes to a Budget Worksheet on page 4-16

### Inserting a New Budget Account

You can easily insert a new budget account into a budget worksheet using the Insert Budget Account button on the ADI toolbar.

#### To insert a new budget account:

1. Place the cursor anywhere in the row that is to follow the new budget account row.

2. Choose the General Ledger button from the ADI toolbar and select Insert Budget Account. The Select Account Segment Values window appears.

3. Enter the segment values for the new budget account.

   See: Choosing Account Segment Values on page 3-38.

4. Choose OK to create the new budget account.

---

**Note:** Budget Wizard validates the new account before creating it. If the segment values you specify are not a valid account, the account is not created in your budget worksheet.

---

See Also:

- Updating Budget Balances Using ADI on page 4-13
- ADI Toolbar on page 3-3
Budget Rules

There are four budget rules. Each performs a different operation on your range of specified cells:

- **Divide Evenly by Row:** Takes an amount you specify, divides it by the number of columns in your specified range, then enters the result in each cell of the specified range.

  For example, consider a range that consists of three columns and five rows (15 total cells). If the amount you specify is 1,500, the result placed in each cell is 500.

- **Divide Evenly by Cells:** Takes an amount you specify, divides it by the number of cells in your specified range, then enters the result in each cell.

  For example, consider the same range noted in the previous example. If you select Divide Evenly by Cells, the result placed in each cell is 100.

- **Repeat per Cell:** Takes an amount you specify and places it in every cell of the specified range.

- **Multiply Each Cell by a Factor:** Multiplies each cell in the specified range by an amount you enter.

**See Also:**

- Updating Budget Balances Using ADI on page 4-13
- ADI Toolbar on page 3-3

Adding Budget Notes to a Budget Worksheet

You can add notes or comments to the amounts and accounts in your budget worksheet. You can also add a note for the entire budget. Use notes and comments to annotate budget amounts, explain how an amount is calculated, or describe accounts.

---

**Additional Information:** Budget Notes uses the cell note feature of Microsoft Excel. For more information about cell notes, refer to your Excel user’s guide or online help.

➢ **To add budget notes to a budget worksheet:**

1. Position your cursor within the budget worksheet, at one of these locations:
On a budget amount cell: To add a budget note to a specific amount in
your budget worksheet.

On any cell within an account row: To add a budget note for a specific
account in your budget worksheet.

Anywhere: To add a budget note for the entire budget worksheet.

2. Choose General Ledger from the ADI toolbar and select Budget Notes from the
list of values.

3. Select Budget, Account, or Amount from the Add Budget Note window, then
choose OK.

Excel’s Cell Note window appears.

4. Enter the text of your budget note in the Text Note region.

5. Choose OK to attach the note or Close to cancel.

If you choose OK, a small red square appears at the upper right corner of the
cell where the budget note is attached.

Additional Information: To see the note indicator in your budget
worksheet, you must enable the View Note Indicator option in
Excel (Tools > Options > View).

To edit or delete budget notes:

1. Choose the worksheet cell where the note is attached.

2. Choose Insert > Note from the Excel menu. Optionally, choose General Ledger
from the ADI toolbar and select Budget Notes from the list of values, choose
OK, then select the note from the Notes in Sheet region of the Cell Note
window.

3. To edit the note, make your changes in the Text Note region, then choose OK to
save your changes.

4. To delete the note, choose Delete from the Cell Note window, then choose OK.
Choose OK or Close to return to your budget worksheet.

See Also:

Updating Budget Balances Using ADI on page 4-13

ADI Toolbar on page 3-3
Graphing Budgets Using ADI

You can use ADI to view your budget balances as area charts, bar graphs, column graphs, line graphs, or pie charts. If you download both budget and actual balances from General Ledger, you can plot both values on your graph.

To create and display a graph of your budget values:

1. Select the contiguous range of cells you want to view as a graph.

   - **Additional Information:** Select only those worksheet cells that contain or could contain budget values. Do not select column headings and row labels when you specify the range. ADI automatically uses the column headings and row labels from your budget worksheet as labels in your graphs.

2. Choose General Ledger from the ADI toolbar and select Create Graph from the list of values.

The system creates your graph in a new worksheet in your Excel workbook. The appearance of the graph depends on your budget worksheet parameters, as well as the default settings you defined for graphs. The system gives the graph a name relative to the budget worksheet. For example, if the worksheet is named Budget1, the graph is named Chart1A. A second graph for the same budget worksheet is named Chart1B, and so on. There is a limit of 26 graphs for any one budget worksheet.

To change the appearance of your graph:

- Modify the default settings for graphs, then create the graph again, or consult the Excel user’s guide and online Help for further information about Excel’s chart formatting functions.

To delete a graph:

1. With the graph displayed on your screen, select Edit > Delete Sheet from the Excel menu.
2. Choose OK to delete the graph, or Cancel to keep it.
Uploading Budgets from ADI to General Ledger

See Also:

Budget Worksheet Parameters on page 4-6

Uploading Budgets from ADI to General Ledger

After entering or modifying budget balances in a worksheet, you must upload the amounts to General Ledger for posting. You can choose to replace or increment the existing General Ledger budget balances.

Uploading budgets is a two-step process. First, you must upload your worksheet budget balances to the interface table. Second, you must import the balances from the interface table to General Ledger. illustrates this process.

---

**Caution:** If any user-defined information, such as your budget or budget organization, includes an apostrophe in the name, you cannot upload budget changes to General Ledger. To upload successfully, rename any user-defined information in General Ledger so it does not include apostrophes.

---

If any user-defined information, such as your budget or budget organization, includes an apostrophe in the name, you cannot upload budget changes to General Ledger. To upload successfully, rename any user-defined information in General Ledger so it does not include apostrophes.
Figure 4–1 Uploading Budgets

Enter budget information into the budget worksheet.

Upload to Interface

Choose the Upload to Interface button.

This action populates the interface table in General Ledger.

GL_BUDGET_INTERFACE

Submit Budget Import

Automatic Procedure
Submitted automatically if you choose one of the two auto submit options during the budget upload.

Manual Procedure
Choose the Submit Import Process button to start the budget import process.

General Ledger Database
To upload budget balances from a budget worksheet to the interface table:

1. While viewing a budget worksheet that has been modified, choose General Ledger from the ADI toolbar and select Upload to Interface from the list of values.

2. Enter your budget upload options.  
   See: Budget Upload Options on page 4-22

3. Choose OK to initiate the upload process, or Cancel to abandon.

---

**Caution:** If your budget organization is password-protected, the system prompts you to enter the password. Enter the password, then choose OK.

When the process completes, the system notifies you of the completion status. For budget lines which do not upload successfully, the system provides an explanation in the Messages section of the budget worksheet. If you selected Show Upload Success Indicator from the general options window, the system also displays status indicators in the Messages section for each budget line.
To import budget balances from the interface table to General Ledger:

1. Choose General Ledger from the ADI toolbar, select Submit Process > Budget Import from the list of values to view a list of Budgets and Organizations for which values were previously uploaded to the interface table.

2. Select the budget and organization whose balances you want to import to General Ledger.

3. Choose OK to initiate the process, or Cancel to abandon your request. Selecting OK will start a budget import concurrent request.

When the process completes, the system notifies you of the completion status.

See Also:
- Budget Upload Options on page 4-22
- Submitting Processes on page 3-42
- Updating Budget Balances Using ADI on page 4-13
- Monitoring Requests on page 12-51

Budget Upload Options

You can select four options to control uploading and importing your budgets:

- **Rows to Upload**: Controls which rows in the budget worksheet to upload. Select Flagged Rows to upload only those rows that are marked with a flag character in the upload column of your worksheet. Select All Rows to upload all values in your worksheet, regardless of whether changes have been made.

- **Upload Mode**: Determines whether the values in General Ledger are replaced or increased by the values in your budget worksheet. Select Replace to replace the General Ledger amounts; select Increment to increase them.

- **Pre-Validation**: You can prevalidate your budget data before you upload it to General Ledger. Prevalidating can minimize the possibility that the General Ledger budget import process will fail because of a validation error. Prevalidating is useful when you expect that the budget import process will be quite lengthy or when you plan to run it unattended, such as overnight.

**Additional Information**: Regardless of whether you choose to prevalidate your budget data, the General Ledger budget import process still performs its usual server-side validation activities.
You can choose one of two prevalidation options for your budget data:

- **Full** — Prevalidates all budget data for which a list of values is available, and performs segment security checking.
- **None** — Performs segment security checking only.

**Note:** Segment security checking is only performed if you have defined segment security rules.

**Note:** If the General Ledger profile option GLDI: Force Full Validation is set to yes, ADI performs full validation of your budget data. You cannot change this option from the Budget Wizard.

- **Duplicate Rows in Interface Table**: Determines whether the system warns you before older rows of duplicate values, already in the GL Budget Interface table, are deleted by values in the new rows being uploaded. Select Prompt Before Deletion of Existing Row to have the system issue a warning message. Select Always Delete Existing Row to let the system perform the deletion automatically.

- **Start Budget Import**: Check this box to automatically start the budget import concurrent request after uploading your budget amounts. If you do not check this box or if there are errors in the budget upload, the budget import process will not start.

Once the budget upload completes, the system:

- Displays a window showing:
  - Number of rows successfully uploaded.
  - Number of errors in the upload to the GL Budget Interface table.
  - Budget import request ID (if no errors in upload).
  - Message indicating that a watch request has been submitted for the budget post request ID (if no errors in upload).

If there were no errors in the budget upload, the system will:

- Submits your budget import concurrent request.
- Submits a watch request to monitor your concurrent request.
See Also:

Submitting Processes on page 3-42
Uploading Budgets from ADI to General Ledger on page 4-19
Applications Desktop Integrator Journal Wizard

With the Applications Desktop Integrator (ADI) Journal Wizard, you can create journal entries using Microsoft Excel, then automatically upload them to Oracle General Ledger. You make your journal entries using journal worksheets that are created automatically by Journal Wizard. These journal worksheets include fields for all of the journal entry information required by your organization’s specific implementation of Oracle General Ledger.

With Journal Wizard you can:

- Customize journal worksheets by adding supplemental journal entry information.
- Use the powerful spreadsheet features of Excel. For example, you can use formulas to calculate journal amounts.
- Save a journal worksheet to a file, which can then be transferred to another PC for further changes, even while disconnected from your General Ledger database.

Prerequisites:

- Define a set of books.
- Open one or more accounting periods for your set of books.
Creating Journal Worksheets

Profile Options

Set the following optional profile options in General Ledger.

- Journals: Default Category - ADI uses this value, set for General Ledger, as the default category in any single journal worksheet you create.
- GLDI: Create Group ID - ADI automatically generates a group ID during journal upload.
- GLDI: Converted Entry Threshold - ADI forces converted currency journals to balance within a set threshold amount before journal upload.
- GLDI: Balance by Accounting Date - ADI forces journal amounts to balance by accounting date before journal upload.
- GLDI: Force Journal to Balance - ADI forces journals to balance before journal upload.
- GLDI: Force Full Validation - ADI forces full validation during budget and journal uploads from ADI. If validation fails, the upload does not proceed.
- GLDI: Journal Source - When you enable this profile option, you specify a single journal source to be used during upload from ADI to General Ledger.

See Also:

Creating Journal Worksheets on page 5-2
Journal Worksheet Options on page 5-4
Customizing Journal Worksheets on page 5-6
Creating Journal Entries Using ADI on page 5-12
Uploading Journal Entries from ADI to General Ledger on page 5-17
Journal Upload Options on page 5-21

Creating Journal Worksheets

You use Journal Wizard to create customized journal worksheets in Microsoft Excel. From a journal worksheet, you can enter journal entries, then upload and post them to General Ledger.
Creating Journal Worksheets

To create a journal worksheet:

1. Choose General Ledger from the ADI toolbar and select Enter Journals from list of values.

2. Select your journal worksheet options.
   
   See: Journal Worksheet Options on page 5-4.

3. (Optional) Choose the Edit Layout button to customize the journal worksheet.

4. (Optional) Choose the Edit Layout button to customize the journal worksheet.

5. Choose OK. ADI automatically creates your journal worksheet.

Note:  If you choose to create a budget journal worksheet, you must also select a budget Organization from the poplist. If the budget organization you select is password protected, the system asks you to enter the password.

To create additional journal worksheets in the same session:

1. While viewing a journal worksheet, choose General Ledger from the ADI toolbar and select Enter Journals from the list of values.

   Note:  Unprotect your worksheet to insert additional rows into the journal template. Choose Tools > Protection > Unprotect from the Excel menu.
Journal Worksheet Options

2. Select your journal worksheet options.
3. Choose OK.

Note: You can create additional journal worksheets using different applications databases or responsibilities. Simply sign on to the desired database and responsibility before creating your new worksheet.

To save a journal worksheet to disk:
1. Select File > Save As from the Excel menu.
2. Enter a name and specify a path for the journal worksheet file.
3. Choose OK to save the file, or Cancel to abandon the operation.

To open a save journal worksheet
1. Select File > Open from the Excel menu.
2. Select the path where the journal worksheet is located. Excel displays the names of the files in a separate list.
3. Choose the journal worksheet name from the list of values.
4. Select OK to open the file, or Cancel to abort.
   If ADI is installed, but not running, ADI starts automatically when you open the journal worksheet.

See Also:
Journal Worksheet Options on page 5-4
Customizing Journal Worksheets on page 5-6
ADI Options on page 3-16

Journal Worksheet Options
Use the Create Journal Worksheet window to specify the journal type and number of journals you will enter in your journal worksheet.
Choose Journal Type

There are four types of journals you can enter from the Journal Wizard. When you select one, ADI creates a corresponding journal worksheet in Excel:

- **Functional Actuals**: Create actual journal entries using the functional currency for your selected set of books.
- **Foreign Actuals**: Create actual journal entries using a foreign currency. A foreign currency is one which is different from the functional currency for your selected set of books.
- **Budgets**: Create journal entries that are to be posted against a budget.
- **Encumbrances**: Create journal entries to update encumbrance balances.

Number of Journals

You can use a journal worksheet to enter one journal entry or a journal batch. You must specify the number of journal entries you are going to enter before the Journal Wizard creates a journal worksheet:

- **Single**: Use to prepare an individual journal entry. Information common to all lines in your journal entry is reflected in the journal worksheet header. This includes Category, Source, Currency, and Accounting Date. For each line of the actual entry, you enter information such as Account, Debit amount, and Credit amount.

- **Multiple**: Use to prepare multiple journal entries. All information pertaining to a journal entry, even that which is common to more than one line, is entered on each line of a multiple journal entry.

With multiple journal entries, you can combine journal entries that have different categories, sources, and currencies on a single journal worksheet. You can then upload these different journal entries at the same time. When Oracle General Ledger imports the entries from the GL Interface table, it separates the lines into appropriate entries and batches.

Create Worksheet in

- **New Workbook**: Select this option to create your journal worksheet as a new Excel workbook.

- **Current Workbook**: Select to create your journal worksheet as a new worksheet within the current Excel workbook. This option is only available when you already have an Excel workbook open.
Customizing Journal Worksheets

See Also:

Journal Worksheet Options on page 5-4
Customizing Journal Worksheets on page 5-6
Creating Journal Worksheets on page 5-2

Customizing Journal Worksheets

When you create a journal worksheet, you can choose to use the template’s standard layout or customize it. Selecting the Edit Layout button on the Create Journal Worksheet window opens the Define Worksheet Layout window, where you can change the settings for Worksheet, Header, and Lines.

► To customize a journal worksheet:

1. Select your customizing options, as described below for the Worksheet, Header, and Lines tabs.
2. Choose OK to enable your customized options, or Cancel to abort.

Note: When you choose OK to enable your customized options, the system stores your options as default settings for future journal worksheets.
Worksheet Tab

Shows the selected Journal Type and Number of Journals. You can select different options to change the journal type.

See: Journal Worksheet Options on page 5-4.
Customizing Journal Worksheets

Header Tab

Customize the header information for a single-entry journal worksheet. For multiple-entry journal worksheets, the Header tab is disabled and its title changes to "No Header" because the header information appears in the journal lines (you can change their settings on the Lines tab).

Note: If you check the box labelled Database Columns, located at the bottom of the Define Worksheet Layout window, the information in the required and optional fields will change. You can see the GL_INTERFACE column names, rather than the descriptions of what those columns represent. The column names display option is provided for technical users of General Ledger. Under most circumstances, leave this box unchecked.
You can customize the following header items:

- **Required Fields**: Headers for functional actual and foreign actual journals always display the journal Category, Source, Currency, and Accounting Date. Budget journal headers also include Budget name, but do not include Accounting Date. Encumbrance journal headers also include the Encumbrance Type.

  You cannot change which required fields appear in your journal header, but you can rearrange their sequence. See the section “Moving Fields” below.

- **Optional Fields**: You can include additional fields in your journal worksheet. Optional fields include: Group ID, Batch Name, Batch Description, Journal Name, Journal Description, Journal Reference, Reverse Journal, Reversal Period, and Clearing Company.

  To display one of the above items as a row in your header, check the box next to its name. As with required fields, you can change the display sequence. See the section “Moving Fields” below.

- **Moving Fields**: Use the directional buttons to change the display sequence of required or optional fields in your journal worksheet. First, select the field whose sequence you want to change. Then, choose one of the four directional buttons. The field description moves immediately in either the Required Fields list or the Optional Fields list:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Up Arrow" /></td>
<td>Top of Header</td>
</tr>
<tr>
<td><img src="image" alt="Up Arrow" /></td>
<td>Up One Row</td>
</tr>
<tr>
<td><img src="image" alt="Down Arrow" /></td>
<td>Down One Row</td>
</tr>
<tr>
<td><img src="image" alt="Down Arrow" /></td>
<td>Bottom of Header</td>
</tr>
</tbody>
</table>
Customizing Journal Worksheets

Lines Tab

Customize the information displayed on each journal line. In a multiple-entry journal worksheet, the journal lines include the header information discussed earlier.

**Note:** If you check the box labelled Database Columns, located at the bottom of the Define Worksheet Layout window, the information in the required and optional fields will change. You can see the GL_INTERFACE column names, rather than the descriptions of what those columns represent. The column names display option is provided for technical users of General Ledger. Under most circumstances, leave this box unchecked.

You can customize the following items:

- **Required Fields:** Journal lines for functional actual and foreign actual journals always display Account, Debit, and Credit. Multiple-entry journals also include journal Category, Source, Currency, and Accounting Date.
Budget journal lines also include Period. Multiple-entry budget journals also include the Budget name, but do not include Accounting Date. Multiple-entry encumbrance journal lines also include the Encumbrance Type.

You cannot change which required fields appear in your journal lines, but you can rearrange their sequence. See the section “Moving Fields” below.

**Optional Fields:** You can include additional fields of information in your journal worksheet. Optional fields include: Description, Stat Amount, Reconciliation Reference, Invoice Date, Tax Code, Invoice Identifier, Invoice Amount, VAT Context, Line DFF Context, Line DFF 1 to 10, Captured Info Context, Captured Info DFF 1 to 10, Line Detail Report, Source Detail Report, Additional Line Info 1 to 8.

Multiple-entry journal worksheets also include: Group ID, Batch Name, Batch Description, Journal Name, Journal Description, Journal Reference, Reverse Journal, Reversal Period, and Clearing Company.

Foreign Actuals journal worksheets also include Converted Debit and Converted Credit.

To display one of the above items as a column in your journal lines, check the box next to its name. As with required fields, you can change the display sequence. See the section “Moving Fields” below.

**Moving Fields:** Use the directional buttons to change the display sequence of required or optional fields in your journal worksheet. First, select the field whose sequence you want to change. Then, choose one of the four directional buttons. The field description moves immediately in either the Required Fields list or the Optional Fields list. The actual journal worksheet lines move as follows:

<table>
<thead>
<tr>
<th>Top of Header</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up One Row</td>
</tr>
<tr>
<td>Down One Row</td>
</tr>
</tbody>
</table>
Creating Journal Entries Using ADI

You can enter four types of journal entries in your journal worksheet: Functional actuals, Foreign actuals, Budgets, or Encumbrances. There are only slight variations in the information you need to enter for each type of journal entry.

**Note:** You can only enter journals for adjusting periods in General Ledger. For non-adjusting periods, See: *Oracle General Ledger User's Guide.*
To create Functional Actuals, Budgets, or Encumbrances journal entries:

1. Enter the journal header information as requested on the worksheet.

**Additional Information:** Journal worksheets support entering effective and reversal dates for sets of books that have average balance processing enabled.

**Note:** Note that Accounting Date is not required for Budget journals.
Creating Journal Entries Using ADI

1. Enter a Budget for budget journal entries or an Encumbrance Type for encumbrance journal entries.

2. Enter an Account for each journal line by entering the account directly or by choosing from a list of values.
   See: Choosing Account Segment Values on page 3-38.

3. Enter a Debit or Credit amount for each journal line. You can use Excel formulas to enter your amounts.

4. Enter information for any optional fields that you specified if you customized the journal worksheet.

5. Upload your journals to General Ledger.

Note: If the General Ledger profile option GLDI: Journal Source is enabled, the journal source specified in the profile option is inserted automatically into your journal worksheet. You cannot change this value on your journal worksheet.

Note: Unprotect your worksheet to insert additional rows into the journal template. Choose Tools > Protection > Unprotect from the Excel menu.

To create Foreign Actuals journal entries:

1. Enter the Category, Source, Accounting Date, Currency, and Conversion Type.

2. Enter the Conversion Date and/or Conversion Rate, as required:
   - If you selected conversion type User, you must enter a Conversion Rate. You do not enter a Conversion Date.
   - If you selected a conversion type other than User, you must enter a Conversion Date. You do not enter a Conversion Rate. General Ledger provides the rate when you import your journals.

3. Enter an Account for each journal line.

4. Enter a Debit or Credit amount for each journal line.
Creating Journal Entries Using ADI

See the Notes below for information about converted journal entries when the GLDI: Converted Entry Threshold profile option is enabled.

**Note:** General Ledger automatically calculates the converted value for foreign currency amounts. You can override this by activating the Converted Debit and Converted Credit optional fields on the Lines tab of the Define Worksheet Layout window. General Ledger uses the converted value you enter.

See the Notes below for information about converted journal entries when the GLDI: Converted Entry Threshold profile option is enabled.

**Note:** Journals uploaded from ADI to General Ledger must pass EURO currency validation checks.

EMU Fixed is the only type currency that can be used for ADI journals with a Euro derived rate. The exchange rate is derived from rate tables, maintained by General Ledger. See: *Oracle General Ledger User’s Guide* for more information.

5. Enter information for any optional fields that you specified if you customized the journal worksheet.

6. Upload your journals to General Ledger.

**Note:** With the MRC Account Type Specific Conversion feature, you no longer have to repeatedly run revaluation and translation to get your most current reporting currency balances. With ADI Release 7.0 and above, this functionality can be extended to foreign currency journals entered in the primary set of books. See: MRC Account Type Specific Conversion, *Oracle Multiple Reporting Currencies in Oracle Applications*, posted on Metalink.

**Notes:**

For many of the fields on a journal worksheet, you can select from a list of values. See: Choosing Account Segment Values on page 3-38.
The format of a single-entry journal worksheet is slightly different from a multiple-entry journal worksheet. However, the same information is entered for the journal entries.

- Choosing the View Context button displays or hides the journal worksheet context information at the top of the worksheet. Context information includes Template Type, Template Style, Set of Books, and Database.

- Choosing the View Header button displays or hides the journal worksheet header information, located just below the context information. Header information includes Category, Source, Currency, and Accounting Date, plus any optional information you’ve chosen to display.

- ADI automatically places a flag character in the Upload column for every journal line you enter. When you start the journal upload process, you can choose to process all rows or only the rows that are marked for upload.

**Note:** If you copy and paste a journal line, ADI does not place a flag character in the Upload column for your new journal line. You can manually enter a flag by placing your cursor in the upload column cell where you want the flag character, then typing any character or number from your keyboard.

- The Journal Wizard interprets three adjoining blank rows in a journal worksheet as the end of the journal entry. Therefore, any journal lines that appear after three blank rows are ignored when you upload your journals.

- Your system administrator can enable the profile option GLDI: Create Group ID, so that ADI creates a group ID for every journal upload. When enabled, ADI creates a message in the Template Type row in the context region of your worksheet after you upload your journals. The message indicates the type of journal and the last group ID number used. A sample message is: Functional Journal (Last upload Group ID was 1310).

If the profile option GLDI: Create Group ID is enabled and you create a customized journal worksheet with a group ID column, ADI does not override any group ID values you enter in the worksheet when you upload. Instead, a message appears in the message box after every journal entry, stating: Group ID has been replaced with a system generated value. In addition, the standard Group ID message appears in the context region of your worksheet.
Below are profile options, set by your system administrator, that control entered journals. These profile options can influence the success or failure of the journal upload process.

- **GLDI: Force Journal to Balance** - When this profile option is enabled, your journals must balance or upload to General Ledger will fail. A red frowning face with the message, *Journal entries are not balanced*, appears in the message box of your journal worksheet.

- **GLDI: Balance by Accounting Date** - When this profile option is enabled, your journals for a non-average daily balance set of books must balance by accounting date or upload to General Ledger will fail. A red frowning face with the message, *Journal entries are not balanced*, appears in the message box of your journal worksheet.

- **GLDI: Converted Entry Threshold** - When this profile option is enabled, the difference between converted debit and credit entry amounts must be less than or equal to a specific amount. The difference is posted to the largest journal entry line amount.

  When the difference exceeds the threshold amount, journal upload will fail. A red frowning face with the message, *Converted journal imbalance exceeds allowed threshold*, appears in the message box of your journal worksheet.

**See Also:**

- Creating Journal Worksheets on page 5-2
- Uploading Journal Entries from ADI to General Ledger on page 5-17
- Choosing Account Segment Values on page 3-38
- Choosing Values from Lists on page 3-37

**Uploading Journal Entries from ADI to General Ledger**

After creating journal entries in a journal worksheet, you must upload them to Oracle General Ledger for posting. Uploading is a two-step process. First, you must upload your journal entries to the interface table. Second, you must import the journal entries from the interface table to General Ledger. Figure 5–1 illustrates this process:
**Additional Information:** If you specify a Reversal Period but leave the Reverse Journal field blank, the journal upload process will fail for that journal. In a multiple journal worksheet, only the specific journal row will fail during uploading.

**Caution:** The Journal Wizard interprets three adjoining blank rows in a journal worksheet as the end of the journal entry. Therefore, any journal lines that appear after three blank rows are ignored when you upload your journals.

**Caution:** If your account includes multiple segments with the same name, you should rename them so the segment names are unique. Otherwise, you may encounter errors during the ADI journal upload process.

**Note:** If any user-defined information, such as journal source or journal category, includes an apostrophe in the name, you cannot upload journal worksheets that include this information to General Ledger. To upload successfully, rename any user-defined information in General Ledger so it does not include apostrophes.

**Additional Information:** If you experience journal upload performance problems, you can run a series of tests to help identify trouble spots. See: Performance Test Scenarios for Journal Wizard Upload: page

**Note:** EMU Fixed is the only type currency that can be used for ADI journals with a Euro derived rate after December 31, 1998. The exchange rate is derived from rate tables, maintained by General Ledger.
Figure 5–1  Uploading Journal Entries

Enter journal information into the journal worksheet.

Choose the Upload to Interface button.

This action populates the interface table in General Ledger.

GL_INTERFACE

Submit Journal Import

Automatic Procedure
Submitted automatically if you choose one of the two auto-submit options during the journal upload.

Manual Procedure
Choose the Submit Import Process button to start the journal import process.
To upload journal entries from a journal worksheet to the interface table:

1. While viewing your journal worksheet, choose General Ledger from the ADI toolbar and select Upload to Interface from the list of values.
2. Enter your Journal Upload Options.
   
   See: Journal Upload Options on page 5-21.
3. Choose OK to start the journal upload, or Cancel to abandon.

   For rows that do not upload successfully, the system provides an explanation in the Messages section of the journal worksheet. If you selected Show Upload Success Indicator from the general options window, the system also displays status indicators in the Messages section for each journal line.

   Additional Information: You can upload a journal worksheet more than once, effectively creating multiple journals from the same spreadsheet.

To import journals from the interface table to General Ledger:

1. Choose General Ledger from the ADI toolbar, select Submit Process and Journal Import.
2. Enter your Select Process Type options.
3. Choose OK to submit your request, or Cancel to abandon.
4. If the record you selected for import has journal lines with different accounting dates, the system displays the range of accounting dates included in your journal lines. To limit the lines imported, enter a different date range, then Choose OK.

See Also:
- Journal Upload Options on page 5-21
- Submitting Processes on page 3-42
- Monitoring Requests on page 12-51

## Journal Upload Options

You can select three options to control uploading and importing:

- **Rows to Upload**: Controls which rows in the journal worksheet to upload. Select:
  - *Flagged Rows* — to upload only those rows that are marked with a flag character in the upload column of your worksheet.
  - *All Rows* — to upload all rows in your worksheet, regardless of whether changes have been made.

- **Pre-Validation**: You can prevalidate your journal data before you upload it to General Ledger. Prevalidating can minimize the possibility that the General Ledger journal import process will fail because of a validation error. Prevalidating is useful when you expect that the journal import process to be quite lengthy or when you plan to run it unattended, such as overnight.

---

**Additional Information**: Regardless of whether you choose to prevalidate your journal data, the General Ledger journal import process will perform its usual server-side validation activities.
You can choose one of three prevalidation options for your journal data:

- **Full** — validates all journal data, including journal category, journal source, currency, date, and other journal fields for which a list of values is available. The system also performs cross-validation and segment security checking.

- **Partial** — validates all journal data except for accounts. Segment security checking is also performed.

- **None** — performs segment security checking only.

**Note:** Cross-validation checking is only performed if you have the General Ledger profile option Flexfields: Validate On Server set to Yes.

**Note:** Segment security checking is only performed if you have defined segment security rules.

- **Start Journal Import:** Check this box to start the journal import process automatically after the upload completes. When this box is checked, you can select additional options for the journal import process:
  - **Post Account Errors to Suspense** — check this box to have journal entry lines with account errors posted to a predefined suspense account. To use this function, suspense posting must be enabled in General Ledger.
  - **Create Summary Journals** — check this box to have General Ledger summarize all transactions that share the same account, period, and currency. If you don’t check this box, General Ledger creates a journal line for every row in your journal worksheet.
  - **Descriptive Flex** — from the poplist, make your selection:
    - Do Not Import: prevents importing descriptive flexfields
    - Select With Validation: General Ledger validates descriptive flexfield values

**Note:** If the General Ledger profile option GLDI: Force Full Validation is set to yes, ADI performs full validation of your journal data. You cannot change this option from the Journal Wizard.
– Select Without Validation: General Ledger imports descriptive flexfield values without validating them.

If you choose to start the journal import process automatically after the upload completes, the system will do the following:

- Submit your journal import request
- Submit a watch request to monitor your journal import request
- Display a window showing:
  - Number of errors in the upload to the interface table
  - Journal Import Request ID
  - A message indicating that a watch request has been submitted for the Journal Import Request ID

**See Also:**

- Journal Upload Options on page 5-21
- Submitting Processes on page 3-42
- Uploading Journal Entries from ADI to General Ledger on page 5-17
Applications Desktop Integrator Report Wizard

With the Applications Desktop Integrator (ADI) Report Wizard, you can define reports graphically in Microsoft Excel, then upload the report definitions to General Ledger as Financial Statement Generator (FSG) report objects. You can also download existing FSG reports, modify them in Report Wizard, then save the modified definition to General Ledger.

From the Report Wizard, you can directly access the Request Center’s Report Submission and Publishing window to submit your report. You can also choose to download, format, and publish your report output as a spreadsheet, web page, or text file.

You can save reports or report output to a file, which can then be transferred to another PC for further changes or review, even while disconnected from your General Ledger database.

**Suggestion:** Use ADI to distribute custom reports worldwide to your subsidiaries. Create a row and column set in General Ledger and use the Report Wizard to create your report in Excel format. Zip your Excel report and distribute it via the web. Your subsidiaries can open the Excel report and transfer the definitions to their own General Ledgers. Your custom reports can be distributed worldwide in a matter of hours.
Prerequisites

- Define a set of books.
- Open one or more accounting periods for your set of books.

See Also:

- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
- Adding and Deleting Rows Using Report Wizard on page 6-19
- Adding and Deleting Columns Using Report Wizard on page 6-20
- Changing Row Properties Using Report Wizard on page 6-21
- Adding and Deleting Row Account Assignments Using Report Wizard on page 6-23
- Changing Column Properties Using Report Wizard on page 6-25
- Adding and Deleting Column Account Assignments Using Report Wizard on page 6-27
- Generating Content Sets on page 6-28
- Hierarchy Attributes on page 6-31
- Hierarchy Filtering Options on page 6-34
- The Request Center on page 12-1

Reports Toolbar

When you create a new report or open an existing one, Report Wizard displays the Reports Toolbar. You can also display the toolbar as follows:
To open the Reports Toolbar from the ADI toolbar:

1. Choose General Ledger from the ADI toolbar and select Define Report from the list of values.
3. Choose Finish.

See Also:

- Report Wizard Interface on page 6-5
- Report Wizard Tools on page 6-5

---

**Report Objects:** Display all report and object properties. These include Report, Row, Column, Content, and Row Order properties that are active for the currently displayed report.


**Row Properties:** Display the Row Properties window. From here you can see all of the properties associated with each of your row definitions. You can also choose to display additional windows showing Row Account Assignments and Row Calculations.

See: Row Properties Window on page 6-10.

**Column Properties:** Display the Column Properties window. From here you can see all of the properties associated with each of your column definitions. You can also choose to display additional windows showing Column Account Assignments, Column Calculations, and Column Exceptions.

See: Column Properties Window on page 6-11.

**Insert/Delete Row Object:** Insert a new line item (row) into your row set, or, for an existing line item, insert account assignments. You can also delete a line item or its account assignments.

**Insert/Delete Column Object:** Insert a new column or column heading row into your report worksheet. You can also delete a column or column heading row.

**Move Column Left:** Move a column to the left.
Report Wizard Interface

Move Column Right: Move a column to the right.

Save Report to Database: Save your report back to General Ledger. If you want to save your report to a diskette for later editing, use the File Save function in Excel spreadsheet.

Refresh Report From Database: Restore your report from the General Ledger database to your currently open report worksheet.

Hide Tools: Close the Reports Toolbar.

See Also:
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
- Adding and Deleting Rows Using Report Wizard on page 6-19
- Adding and Deleting Columns Using Report Wizard on page 6-20

Report Wizard Interface

Figure 6–1 shows what an existing report looks like when you first open it using Report Wizard. Your report appears as a graphical layout within an Excel worksheet. The report worksheet displays the report title, column headings, and line items that will appear on your report. Also included are number placeholders to indicate where the main body of report information will appear.

Finally, the report worksheet will displays report indicators (left of rows and above the columns), that instantly tell you:
Report Wizard Tools

- How many account ranges are assigned to a row or column. The indicator is the actual number of assigned ranges.
- Whether a calculation has been defined. The indicator is a "C".
- Whether column exceptions are defined. The indicator over the related column will be a "E".

You use the Report Wizard tools to make changes to your report.

**Figure 6–1 Report Wizard Interface**

**Report Wizard Tools**

In addition to the Reports Toolbar, Report Wizard includes many other useful features and tools to make it easy for beginners, intermediate, and advanced users to create reports. You can create or modify row and column properties, column headings, account assignments, and row and column calculations. You can also create and assign Content Sets and Row Orders, and assign Display Sets.

The Report Wizard tools include:

**For Beginning Users:** Collapsible/expandable regions, Excel-based menu options, and right mouse button options
**Report Wizard Tools**

**For Intermediate Users:** Displayable windows, report worksheet buttons, and the Report Object Properties window

**For Advanced Users:** The Row Properties and Column Properties windows

**Collapsible/Expandable Regions**

The report worksheet includes buttons you can choose to expand or collapse various regions of the report worksheet. When a region is expanded, you can see additional information about that region. For example, in Figure 6–1, if you choose the “plus” button at the left margin, adjacent to line #17, Report Wizard displays all of the report’s column properties. The plus button also changes to a “minus” button to indicate that the region can be collapsed.

To display row properties, you must first choose the plus button at the top of the report worksheet to open the row properties region. Then, you must choose the plus button for any specific rows whose properties and account assignments you want to see. For example, if you choose the topmost plus button and the plus button adjacent to the Sales Income row in Figure 6–2, you will see the screen shown in the figure below.

**Figure 6–2 Report Wizard Worksheet**

![Report Wizard Worksheet](image)

**Suggestion:** Choosing either of the “1” buttons from the upper left of the report worksheet, will collapse all related vertical or horizontal regions. Likewise, choosing either of the “2” buttons will expand all of the related vertical or horizontal regions.
Excel-based Menu Options

When you create or open a report worksheet, Report Wizard adds a number of options to your Excel menus. These menu options provide another way to access many of the Report Wizard features.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Menu</strong></td>
<td><strong>Delete Report Object</strong>: Deletes the currently selected report object, either a Line Item, Line Account Assignment, Column, or Column Heading row.</td>
</tr>
<tr>
<td><strong>View Menu</strong></td>
<td><strong>Summary Report Layout</strong>: Changes the view of the report worksheet to a summary layout (same as selecting both the vertical and horizontal &quot;1&quot; buttons).</td>
</tr>
<tr>
<td></td>
<td><strong>Detail Report Layout</strong>: Changes the view of the report worksheet to a detail layout (same as selecting both the vertical and horizontal &quot;2&quot; buttons).</td>
</tr>
<tr>
<td><strong>Insert Menu</strong></td>
<td><strong>Insert Report Object</strong>: Use to insert a Line Item, Line Account Assignment, Column, or Column Heading Row.</td>
</tr>
<tr>
<td><strong>Report Wizard Menu</strong></td>
<td><strong>Show Report Wizard Toolbar</strong>: Display the Reports Toolbar if it has been closed.</td>
</tr>
<tr>
<td></td>
<td><strong>Show Attributes</strong>: Used as follows:</td>
</tr>
<tr>
<td></td>
<td><strong>Line Item</strong> - Displays the properties of the currently selected row.</td>
</tr>
<tr>
<td></td>
<td><strong>Column</strong> - Displays the report’s column properties.</td>
</tr>
<tr>
<td></td>
<td><strong>Report Descriptions</strong> - Displays the report names and descriptions. This is the same as choosing the topmost plus button from the left margin of the worksheet.</td>
</tr>
<tr>
<td></td>
<td><strong>All Objects</strong> - Displays all report objects and properties. This is the same as choosing Detail Report Layout from the View Menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Hide Attributes</strong>: Reverses the actions of Show Attributes.</td>
</tr>
<tr>
<td></td>
<td><strong>Insert Object</strong>: Inserts a new Line Item, Line Account Assignment, Column, or Column Heading Row.</td>
</tr>
<tr>
<td></td>
<td><strong>Delete Object</strong>: Deletes the selected Line Item, Line Account Assignment, Column, or Column Heading Row.</td>
</tr>
<tr>
<td></td>
<td><strong>Move Column Left</strong>: Moves the currently selected column one column to the left.</td>
</tr>
<tr>
<td></td>
<td><strong>Move Column Right</strong>: Moves the currently selected column one column to the right.</td>
</tr>
</tbody>
</table>
Report Wizard Tools

Right Mouse Button Options
When you use the right mouse button while the cursor is resting anywhere within a report worksheet, the system displays a subset of the Report Wizard menu described above. The Save, and Refresh Report options are not available.

Displayable Windows
You can define or modify reports and report objects from any of the many displayable windows that appear when you select certain options from the Reports Toolbar. For example, when you select the Column Properties button, Report Wizard displays the Column Properties window, where you can define your report columns. You can display the Row Properties, Report Object Properties, Row Object Action, Column Object Action, and Format Report Output windows in the same manner.

From many of these windows, you can display yet other windows. For example, from the Row Properties window, you can display the Row Account Assignments window, where you can assign account ranges to your report’s rows.

Report Worksheet Buttons
If you choose to define your report by making entries directly in the report worksheet, the system provides several convenient buttons that makes report creation and editing easier:

**Build:** Creates a report heading definition based on your column properties, such as amount type and period offset. Has the same effect as creating default headings in FSG.

**Trim:** Removes leading and trailing spaces from column headings.

**Refresh:** Applies changes made to column properties to the main body of the report worksheet.
**Report Object Properties Window**

If you are familiar with General Ledger’s Financial Statement Generator (FSG) and all of the options that can be specified for rows, columns, row sets, column sets, and other report objects, then you already know how to use the Report Object Properties window in Report Wizard.

From the Report Object Properties window, you can create an FSG report the same way you do in General Ledger. The window appears when you select the Report Objects button from the Reports Toolbar. There are five tabs on the window — each tab corresponds to a specific FSG function, as described below.

**Report Tab:** Define an FSG report. You specify the report name and description, required components, optional components, and other options.

**Row Tab:** Define rows and row sets. You can enter format options, display options, and advanced options, as well as assign accounts and create row calculations.

**Column Tab:** Define columns and column sets. You can enter balance control, display, and advanced options, as well as format masks. You can also assign accounts, create column calculations, and define column exceptions.

**Content Tab:** Define a content set to apply to your report.

---

**Suggestion:** You can also use the Report Wizard to create or modify content sets.

See: Generating Content Sets on page 6-28.

---

**Row Order Tab:** Define a row order to apply to your report.

**Display Report Navigator:** Choose this button to display the Report Navigator window, which lists all report objects assigned to the currently open report worksheet. Each report object can be expanded or collapsed (similar to expanding or collapsing a directory tree in Windows Explorer) to show the embedded details. Selecting a detail item from the Navigator (a row definition for example), immediately opens the appropriate tab and item in the Report Object Properties window.
Row Properties Window

The Row Properties window is one of several ways you can enter values for your row properties. When you choose the Row Properties button from the Report Wizard toolbar, a poplist appears. From the poplist, you can choose Display Row:

- **Properties**: Opens the Row Properties window. When this window is open, you can choose to open either of the other two windows:
  - Choose the Accts button to open the Row Account Assignments window.
  - Choose the Calcs button to open the Row Calculations window.
- **Account Assignments**: Opens the Row Account Assignments window. Use this window to add, edit, or delete row account assignments
- **Calculations**: Opens the Row Calculations window. Use this window to create, edit, or delete row calculations.

The Row Properties window and its related secondary windows are linked, in that all the row-related windows display the detail information for one row. The linking is controlled by the poplist that appears at the top of each window.

For example, if you change the selection in the poplist of the Row Properties window, the detail information in the other row-related windows changes, as illustrated in the diagram below:
The Column Properties window is one of several ways you can enter values for your column properties. When you choose the Column Properties button from the Report Wizard toolbar, a poplist appears. From the poplist, you can choose Display Column:

- **Properties:** Opens the Column Properties window. When this window is open, you can choose to open either of the other three windows:
  - Choose the Accts button to open the Column Account Assignments window.
  - Choose the Calcs button to open the Column Calculations window.
  - Choose the Excpts button to open the Column Exceptions window.

- **Account Assignments:** Opens the Column Account Assignments window. Use this window to add, edit, or delete column account assignments.

- **Calculations:** Opens the Column Calculations window. Use this window to create, edit, or delete column calculations.

- **Exceptions:** Opens the Column Exceptions window. Use this window to create, edit, or delete column exceptions.
Creating a Report Using Report Wizard

The Column Properties window and its related secondary windows are linked, in that all the column-related windows display the detail information for one column. The linking is controlled by the poplist that appears at the top of each window.

See Also:
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
- The Request Center on page 12-1
- Overview of the Financial Statement Generator, Oracle General Ledger User’s Guide

Creating a Report Using Report Wizard

The Report Wizard guides you step by step through the process of creating a report worksheet. Once you tell Report Wizard what task you want to accomplish, the wizard asks you a series of questions related to that task. Once it has all of the information it needs, Report Wizard creates, then displays, your report worksheet in Excel.

With the Report Wizard, you can create a report from existing FSG report objects, or you can create new report objects. Figure 6–3 illustrates the report creation process.
You can also open and edit reports that were previously saved to diskette as Excel files.

**Figure 6–3  Report Creation Process**

**Report Width**

General Ledger lets you define reports with unlimited width. You can take advantage of this in ADI with the following restrictions:

**Table 6–1**

<table>
<thead>
<tr>
<th>Action</th>
<th>Vehicle</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download Report</td>
<td>to a spreadsheet</td>
<td>number of columns in the column set must be &lt;= 246 less (the number of</td>
</tr>
<tr>
<td>Definitions</td>
<td>Definitions</td>
<td>flexfield segments x2)</td>
</tr>
</tbody>
</table>
Report Width

Table 6–1

<table>
<thead>
<tr>
<th>Action</th>
<th>Vehicle</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Reports</td>
<td>in a spreadsheet</td>
<td>number of columns in the column set must be &lt;= 246 less (the number of flexfield segments x2)</td>
</tr>
<tr>
<td>Submit Reports</td>
<td>n/a</td>
<td>none</td>
</tr>
<tr>
<td>Publish Reports</td>
<td>to a web format</td>
<td>none</td>
</tr>
<tr>
<td>Publish Reports</td>
<td>to a spreadsheet</td>
<td>column set must be &lt;= 255 columns</td>
</tr>
</tbody>
</table>

To create a new report (new report objects):
1. Choose General Ledger from the ADI toolbar and select the Define Report from the list of values. Step 1 of Report Wizard appears.

2. Select Define Report as your Report Wizard task, then choose Next.
3. Select Blank Report, then choose Next.
4. Enter a Report Name, then enter values for each of these fields:
   - **Number of Rows**: The number of rows to use in your report.
   - **Number of Columns**: The number of columns to use in your report.
   - **Default Column Width**: The width to use for each column. These can be changed later.
   - **Line Item Width**: The width of the report area where the row labels will appear.
5. Select the destination for the report worksheet:
   - **New Workbook**: Creates the report worksheet in a new Excel workbook.
   - **Current Workbook**: Creates the report worksheet as a new worksheet in the currently displayed Excel workbook.

6. Choose Next

7. Select a default Format mask and Factor to use in your report worksheet.

8. (Optional) Select Yes to create a trend report. Otherwise, select No.
   
   *If you select No, skip to step 13.*

9. Choose Next.

10. For your trend report’s Balance Type, select Actual, Budget, or Encumbrance, then select an Amount Type from the poplist.

11. Select Roll Forward to create a report where the columns successively move forward in time (for example, Jan, Feb, Mar, Apr, etc.). Select Roll Backward to create a report where the columns successively move backwards in time (for example, Dec, Nov, Oct, Sep, etc.).

12. Select a time Increment for the trend report. You can choose Daily, Monthly, or Quarterly.

13. Choose Finish to create the report worksheet.

14. Use the Report Wizard Tools to define the row and column properties, enter column headings, assign accounts, and create row and column calculations.

15. When you are finished, save the report.

**To create a report using existing report objects:**

1. Choose General Ledger form the ADI toolbar and select Define Report from the list of values.

2. Select Define Report as your Report Wizard task, then choose Next.

3. Select Report Components, then choose Next.

4. To use an existing row set, select it from the Row Set poplist. To create a new row set, select “(new row set)” from the poplist or choose the New button when the system asks you to enter your reduction criteria.
5. To use an existing column set, select it from the Column Set poplist. To create a new column set, select “(new column set)” from the poplist or choose the New button when the system asks you to enter your reduction criteria.

6. (Optional) Select a Content Set, Row Order, and Display Set. To create new report objects, choose the related option from the poplist: “(new content set)” or “(new row order set)”. There is no option to create a new display set.

7. (Optional) To copy a report object, rather than use the original, check the Make Copy? check box to the right of the object you want to copy. If you are creating a new report object, the corresponding Make Copy? check box is not available.

---

**Note:** Report Wizard gives the copied object a unique name by including a date and time stamp. For example, if you copy a row set, the system names it “Row [date] [time]”. You can change the name and description from the Report Object Properties window or directly in the Names and Descriptions region of the report worksheet.

---

8. Choose Next.

9. Enter a Report Name.

10. If you selected “(new row set)” in step 4, enter the Number of Rows to use for this report.

11. If you selected “(new column set)” in step 5, enter the Number of Columns, Default Column Width, and Line Item Width.

12. Select the destination for the report worksheet.

13. Choose Finish to create the report worksheet.

14. Use the Report Wizard Tools to define and/or change the row and column properties, enter column headings, assign accounts, and create row and column calculations.

15. When you are finished, save the report.

**To open an existing report from General Ledger:**

1. Choose General Ledger from the ADI toolbar and select Define Report from the list of values.

2. Select Define Report as your Report Wizard task, then choose Next.
3. Select Load Existing Report, then choose Next.
4. Enter optional Reduction Criteria, then choose OK.
5. Select an existing report from the list of values.
6. (Optional) To make a copy of the existing report, check the Make Copy? check box. The system gives your report a unique name by including a date and time stamp. For example, "Report [date] [time]". You can change the name by using the Report Object Properties window or directly in the Names and Descriptions region of the report worksheet.
7. Select the destination for the report worksheet.
8. Choose Finish to create the report worksheet.

To open a saved report worksheet:
1. Select File > Open from the Excel menu.
2. Select the path where the report worksheet is located. Excel will display the names of the files in a separate list.
3. Choose the report worksheet name from the list of values.
4. Select OK to open the file, or Cancel to abort.

   If ADI is installed, but not running, ADI starts automatically when you open the report worksheet.

See Also:
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
- The Request Center on page 12-1

Saving a Report Using Report Wizard

After creating or modifying a report in Report Wizard, you can save it directly to General Ledger by using Report Wizard, the Reports Toolbar, or the ReportWizard menu. Optionally, you can save a report as an Excel workbook file, perform further
modifications in Excel (even while disconnected from your applications database), then save the report to General Ledger at a later time.

---

**Note:** When you save a report to General Ledger, the system will validate any control values specified in your report.

---

**To save a report:**

*From Report Wizard:*

1. Choose General Ledger from the ADI toolbar and select Report Wizard from the list of values. Step 1 of Report Wizard appears.
2. Select Save Report to Database.
3. Choose Finish.

*From the Reports Toolbar:*

1. If it is not already displayed, open the Reports Toolbar.
2. Choose the Save Report to Database button.

*Using menu options:*


**To save a report worksheet to disk:**

1. Select File > Save As from the Excel menu.
2. Enter a name and specify a path for the report worksheet file.
3. Choose OK to save the file, or Cancel to abandon the operation.

**See Also:**

- [Report Wizard Interface](#) on page 6-5
- [Reports Toolbar](#) on page 6-2
- [Report Wizard Tools](#) on page 6-5
- [The Request Center](#) on page 12-1
Adding and Deleting Rows Using Report Wizard

You can add and delete rows in a report worksheet using the Reports Toolbar, the menu options, or the right mouse button options.

---

**Note:** When you add a new row to a report worksheet, Report Wizard automatically sets the Display Zero property to No.

---

**To add rows to a report worksheet:**

1. Place your cursor in the row that precedes the new row.

   **From the Reports Toolbar:**
   1. Choose the Insert/Delete Row Object button.
   2. Select Insert Line Item, then choose OK.

   **Using menu options:**
   1. Select Insert > Insert Report Object > Line Item from the main menu.
      Alternatively, select ReportWizard > Insert Object > Line Item from the main menu.

   **Using the right mouse button:**
   1. Select the right mouse button.
   2. Choose Insert Object > Line Item from the menu.

**To delete rows from a report worksheet:**

1. Place your cursor in the row to be deleted.

   **From the Reports Toolbar:**
   1. Choose the Insert/Delete Row Object button.
   2. Select Delete Line Item, then choose OK.
Adding and Deleting Columns Using Report Wizard

Using menu options:
1. Select Edit > Delete Report Object > Line Item from the main menu.
   Alternatively, select ReportWizard > Delete Object > Line Item from the main menu.

Using the right mouse button:
2. Select the right mouse button.
3. Choose Delete Object > Line Item from the menu.

See Also:
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
- The Request Center on page 12-1
- Overview of the Financial Statement Generator, Oracle General Ledger User’s Guide

Adding and Deleting Columns Using Report Wizard

You can add and delete columns in a report worksheet using the Reports Toolbar, the menu options, or the right mouse button options.

Note: When you add a new column to a report worksheet, Report Wizard automatically sets the Display Zero property to No.

➢ To add columns to a report worksheet:
1. Place your cursor in the column that precedes the new column.

   From the Reports Toolbar:
   1. Choose the Insert/Delete Column Object button.
   2. Select Insert Column, then choose OK.
Using menu options:

1. Select Insert > Insert Report Object > Column from the main menu.
   Alternatively, select ReportWizard > Insert Object > Column from the main menu.

Using the right mouse button:

1. Select the right mouse button.
2. Choose Insert Object > Column from the menu.

To delete columns from a report worksheet:

1. Place your cursor in the column to be deleted.

From the Reports Toolbar:

1. Choose the Insert/Delete Column Object button.
2. Select Delete Column, then choose OK.

Using menu options:

1. Select Edit > Delete Report Object > Column from the main menu.
   Alternatively, select ReportWizard > Delete Object > Column from the main menu.

Using the right mouse button:

1. Select the right mouse button.
2. Choose Delete Object > Column from the menu.

Changing Row Properties Using Report Wizard

You can change the properties assigned to a row by using the Reports Toolbar or by making changes directly in the report worksheet. You can also create row calculations.
To change row properties:

From the Reports Toolbar:

1. Choose the Row Properties button. Select Properties, then choose OK. The Row Properties window appears.

   Note: You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separator and moving it to the left or right.

2. From the poplist, select the row whose properties you want to change.
3. Locate the specific property to change, then place your cursor in the right column of the property row.
4. Enter a new value for the property. Alternatively, you can select a value if a poplist is displayed.
5. Repeat steps 2 through 4 for each specific property you want to change.
6. Choose the Apply button from the Row Properties window to see your changes reflected in the report worksheet.

Within the report worksheet:

1. Place your cursor in the row whose properties you want to change.
2. If the row’s properties are not currently visible, choose ReportWizard > Show Attributes > Line Item from the main menu. You can also select the right mouse button, then choose Show Attributes > Line Item from the menu.
3. Place your cursor in the active cell of the row property whose value you want to change.
4. Enter a new value.

To change row calculations:

1. From the Reports Toolbar, choose the Row Properties button. Select Calculations, then choose OK. Alternatively, you can choose the Calcs button from the Row Properties window.

   The Row Calculations window appears.
2. From the poplist, select the row whose calculations you want to change.
3. Change the calculation information, as needed.

**Note:** You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separators and moving them to the left or right.

4. Choose the Apply button to see your changes reflected in the report worksheet.

**See Also:**
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- The Request Center on page 12-1

**Adding and Deleting Row Account Assignments Using Report Wizard**

You can add or delete row account assignments directly in the report worksheet, or by using the Reports Toolbar.

**To change account assignments for a row:**

*From the Reports Toolbar:*

1. Choose the Row Properties button. Select Account Assignments, then choose OK. Alternatively, you can choose the Accts button from the Row Properties window.

   The Row Account Assignments window appears.
2. From the poplist, select the row whose account assignment information you want to change.

3. Change the account assignment information, as needed.

   **Suggestions:**
   - Many of the fields in the Row Account Assignments window have poplists where you can select from a list of values.
   - To easily change the actual account range, choose an existing account assignment from the Low Account or High Account columns. The Select Account Segment Ranges window appears, where you can select values for your account range.
   - If you plan to use the Analysis Wizard to perform account drilldowns, we suggest you use null ranges for detail account ranges rather than using ranges that include “T” for parent segment values. This generally makes Analysis Wizard drilldown operations more efficient.

4. Choose the Apply button to see your changes reflected in the report worksheet.

   **Within the report worksheet:**
   1. Place your cursor in the row whose account assignments you want to change.
   2. If the row’s properties are not currently visible, choose ReportWizard > Show Attributes > Line Item from the main menu. You can also select the right mouse button, then choose Show Attributes > Line Item from the menu.
   3. Enter the new account assignments directly into the related cells of the report worksheet.

**See Also:**
- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12

---

**Note:** You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separators and moving them to the left or right.
Changing Column Properties Using Report Wizard

You can change the properties assigned to a column by using the Reports Toolbar or by making changes directly in the report worksheet. You can also create column calculations.

➢ To change column properties:

From the Reports Toolbar:

1. Choose the Column Properties button. Select Properties, then choose OK. The Column Properties window appears.

   Note: You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separator and moving it to the left or right.

2. From the poplist, select the column whose properties you want to change.

3. Locate the specific property to change, then place your cursor in the right column of the property row.

4. Enter a new value for the property. Alternatively, you can select a value if a poplist is displayed.

5. Repeat steps 2 through 4 for each specific property you want to change.

6. Choose the Apply button from the Column Properties window to see your changes reflected in the report worksheet.

Within the report worksheet:
1. If the column properties are not currently visible, choose Report Wizard > Show Attributes > Column from the Excel menu. You can also select the right mouse button, then choose Show Attributes > Column from the menu.

2. Place your cursor in the active cell of the column property whose value you want to change.

3. Enter a new value.

**To change column calculations:**

1. Choose the Column Properties button from the Reports Toolbar. Select Calculations, then choose OK. Alternatively, you can choose the Calcs button from the Column Properties window.

   The Column Calculations window appears.

   **Note:** You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separators and moving them to the left or right.

2. From the poplist, select the column whose calculations you want to change.

3. Change the calculation information, as needed.

   **Suggestion:** Many of the fields in the Column Calculations window have poplists where you can select from a list of values.

4. Choose the Apply button to see your changes reflected in the report worksheet.

**See Also:**

- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
Adding and Deleting Column Account Assignments Using Report Wizard

You can add or delete column account assignments by using the Reports Toolbar.

To change account assignments for a column:

1. Choose the Column Properties button from the Reports Toolbar. Select Account Assignments, then choose OK. Alternatively, you can choose the Accts button from the Column Properties window.

   The Column Account Assignments window appears.

   **Note:** You can resize this window as needed. You can also resize the columns displayed within the window, by selecting the column separators and moving them to the left or right.

2. From the poplist, select the column whose account assignment information you want to change.

3. Change the account assignment information, as needed.

   **Suggestions:**
   - Many of the fields in the Column Account Assignments window have poplists where you can select from a list of values.

4. To easily change the actual account range, choose an existing account assignment from the Low Account or High Account columns. The Select Account Segment Ranges window appears, where you can select values for your account range.

5. Choose the Apply button to see your changes reflected in the report worksheet.

See Also:

- Report Wizard Interface on page 6-5
- Reports Toolbar on page 6-2
- Report Wizard Tools on page 6-5
- Creating a Report Using Report Wizard on page 6-12
- Saving a Report Using Report Wizard on page 6-17
Generating Content Sets

Use the Report Wizard to easily create content sets to use with your financial reports. You can automatically maintain content sets that you subsequently use to produce reports for all levels of your reporting hierarchy (e.g., cost center, department, fund). When your reporting hierarchy changes, you can easily create a new content set to produce reports based on the changed reporting hierarchy. By maintaining multiple “point-in-time” content sets, you can easily perform time-based reporting by simply selecting the appropriate point-in-time content set when you run your financial report.

When generating a content set with the Report Wizard, you specify one or more hierarchies, based on different parent segment values. The Report Wizard expands each hierarchy, beginning with the parent segment value, to create the individual rows of the content set. You control how each hierarchy is expanded by defining hierarchy attributes and filtering options.

1. Choose General Ledger from the ADI toolbar and select Define Report from the list of values.
2. Select Generate Content Set, then choose the Next button. The Report Wizard - Step 2 Generate Content Set window appears.
3. Enter a Name for your new content set.
4. Specify the segment and related parent value for your first content set hierarchy.

To create a new content set:
**Segment:** The account segment on which you want the report to break. For example, choose your company segment to create separate reports for each of your companies.

**Parent Value:** A specific parent segment value. Report Wizard expands the parent to all of its detail levels and creates the necessary rows in the content set definition. All parent values underneath the root parent node are found, even if they are technically part of a child range.

---

**Note:** To specify multiple hierarchies for a content set, add each additional hierarchy separately. See the next task, “To add a hierarchy to an existing content set.”

---

5. Choose Next. The Report Wizard - Step 3 Generate Content Set window appears.

6. Enter your hierarchy attributes.
   
   See: Hierarchy Attributes on page 6-31.


8. Enter your hierarchy filtering options.
   
   See: Hierarchy Attributes on page 6-31.

To add a hierarchy to an existing content set:

1. Choose General Ledger from the ADI toolbar and select Define Report from the list of values.
2. Select Generate Content Set, then choose the Next button.
3. Enter the Name of the content set to which you want to add the hierarchy.
4. Select Add as the Action you want to take.
5. Specify the segment and related parent value for the new hierarchy.
6. Enter your hierarchy attributes, then choose Next.
7. Enter your hierarchy filtering options.

To replace an existing content set:

1. Choose General Ledger from the ADI toolbar and select Define Report from the list of values.
2. Select Generate Content Set, then choose the Next button.
3. Enter the Name of the content set you want to replace.
4. Select Replace as the Action you want to take.
5. Complete the content set definition as described above under the task “To create a new content set.”

See Also:

Hierarchy Attributes on page 6-31
Hierarchy Filtering Options on page 6-34
Hierarchy Attributes

For each hierarchy you add to a content set definition, enter the hierarchy attributes that control how the hierarchy is expanded. You can also specify whether you want the separate reports generated by the content set to be run sequentially or in parallel.

**Include:** Choose the Parents check box to generate a separate report for each parent value in your hierarchy. Choose the Children check box to generate a separate report for each child value in your hierarchy. In this context:

- Parents are those parent values which are children of the hierarchy’s parent value (as shown in the Parent Value display field) regardless of how they were defined on the Child Ranges window in Oracle General Ledger.

- Children are those child values which are children of the hierarchy’s parent value that were defined in Oracle General Ledger using the Child Values Only option on the Child Ranges window.

**Sort By:** Select Branch to sort reports by organization branch. Select Level to sort reports by organization level. For example, assume your account structure includes a cost center segment whose segment values are as shown in the figure below:
Figure 6–4  Example Cost Center Segment Values

Note that cost centers 999, 100, 200, 300, and 400 are all parent segment values. Assuming you choose to include both parents and children in your report, the cost center segment values will appear in the following order on your detail report:

Table 6–2

<table>
<thead>
<tr>
<th>Sort by Branch</th>
<th>Sort by Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>999 - All cost centers</td>
<td>999 - All cost centers</td>
</tr>
<tr>
<td>100 - Northern cost centers</td>
<td>100 - Northern cost centers</td>
</tr>
<tr>
<td>110 - Region 110</td>
<td>200 - Southern cost centers</td>
</tr>
<tr>
<td>120 - Region 120</td>
<td>300 - Eastern cost centers</td>
</tr>
<tr>
<td>130 - Region 130</td>
<td>400 - Western cost centers</td>
</tr>
<tr>
<td>200 - Southern cost centers</td>
<td>110 - Region 110</td>
</tr>
<tr>
<td>210 - Region 210</td>
<td>120 - Region 120</td>
</tr>
<tr>
<td>300 - Eastern cost centers</td>
<td></td>
</tr>
<tr>
<td>310 - Region 310</td>
<td></td>
</tr>
<tr>
<td>320 - Region 320</td>
<td></td>
</tr>
<tr>
<td>400 - Western cost centers</td>
<td></td>
</tr>
<tr>
<td>410 - Region 410</td>
<td></td>
</tr>
<tr>
<td>420 - Region 420</td>
<td></td>
</tr>
<tr>
<td>430 - Region 430</td>
<td></td>
</tr>
<tr>
<td>440 - Region 440</td>
<td></td>
</tr>
</tbody>
</table>
Display Type: Enter the content set display type. This display type applies to all of the rows that Report Wizard generates in the content set definition for the parent segment specified in your hierarchy.

See: Content Set Display Types, Oracle General Ledger User’s Guide

See: Content Set Display Type—conset-display:gl

Run Reports: Choose Sequentially to process your multiple reports in sequential order. Choose In Parallel to process your multiple reports at the same time.

<table>
<thead>
<tr>
<th>Sort by Branch</th>
<th>Sort by Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>220 - Region 220</td>
<td>130 - Region 130</td>
</tr>
<tr>
<td>230 - Region 230</td>
<td>210 - Region 210</td>
</tr>
<tr>
<td>240 - Region 240</td>
<td>220 - Region 220</td>
</tr>
<tr>
<td>300 - Eastern cost centers</td>
<td>230 - Region 230</td>
</tr>
<tr>
<td>310 - Region 310</td>
<td>240 - Region 240</td>
</tr>
<tr>
<td>320 - Region 320</td>
<td>310 - Region 310</td>
</tr>
<tr>
<td>330 - Region 330</td>
<td>320 - Region 320</td>
</tr>
<tr>
<td>340 - Region 340</td>
<td>330 - Region 330</td>
</tr>
<tr>
<td>350 - Region 350</td>
<td>340 - Region 340</td>
</tr>
<tr>
<td>400 - Western cost centers</td>
<td>350 - Region 350</td>
</tr>
<tr>
<td>410 - Region 410</td>
<td>410 - Region 410</td>
</tr>
<tr>
<td>420 - Region 420</td>
<td>420 - Region 420</td>
</tr>
<tr>
<td>430 - Region 430</td>
<td>430 - Region 430</td>
</tr>
<tr>
<td>440 - Region 440</td>
<td>440 - Region 440</td>
</tr>
</tbody>
</table>

Note: The run reports option operates on the entire content set, rather than for each hierarchy within the content set.

See Also:

Hierarchy Filtering Options on page 6-34
Generating Content Sets on page 6-28
Hierarchy Filtering Options

For each hierarchy you add to a content set definition, enter optional filtering options that control how the hierarchy is expanded. You can specify segment value ranges and set different display types for each segment of the range.

The filter is applied to each row that is created in the content set for this hierarchy.

**Low/High:** Enter the account range for the rows that will be created in the content set for this hierarchy. Any Low/High values you enter for the parent segment associated with the hierarchy are ignored here.

**Display:** Enter the display type for each segment of your account range. Any display type you enter for the parent segment associated with the hierarchy is ignored here.

**Filter Balances:** Choose None to report all balances for the accounts in this hierarchy when you use the content set. Choose Detail Only to report only detail balances. Choose Summary Only to report only summary balances.

**See Also:**

- [Reports Toolbar](#) on page 6-2
- [Report Wizard Tools](#) on page 6-5
- [Creating a Report Using Report Wizard](#) on page 6-12
- [Saving a Report Using Report Wizard](#) on page 6-17
Generating Content Sets on page 6-28
Hierarchy Attributes on page 6-31
Hierarchy Filtering Options on page 6-34
The Request Center on page 12-1
The Account Hierarchy Editor on page 8-1
Overview of the Financial Statement Generator, Oracle General Ledger User’s Guide
The Applications Desktop Integrator Analysis Wizard combines multidimensional analysis with report drilldown, completely within Excel. You can select amounts from spreadsheet-based FSG reports and drill into the underlying financial information within Oracle Applications.

Analysis Wizard provides access to the complete range of accounts that support a particular reported amount. You can select an individual account and drill into its summary balances, detail balances, journal lines, and down to the subledger details. You can view journal entries and associated detail that originate from Oracle subledgers: Payables, Receivables, Assets, Projects, Purchasing, Inventory, and WIP. During drilldown you can use drag-and-drop capabilities to pivot accounting dimensions, quickly reorganizing financial data to perform “what-if” and “what-happened” analysis of both summary and detail financial information. The versatility of Analysis Wizard helps you quickly detect trends and exceptions in the financial data that underlies your reported amounts.

See Also:
- Drilling Down to Summary and Detail Accounts on page 7-6
- Analysis Wizard Toolbar on page 7-10
- Setting Analysis Wizard Options on page 7-11
- Analysis Wizard Drilldown Flows on page 7-13
- Applications Desktop Integrator Budget Wizard on page 4-1
- Applications Desktop Integrator Journal Wizard on page 5-1
Analysis Wizard Features

Analysis Wizard includes the following features:

- Full support for average balances.
- Cross set of books drilldown.
- Segment security is enforced using the General Ledger profile option FSG: Enforce Segment Value Security.
- Multidimensional data analysis. From your drill windows you can drag account segments, periods and other “dimensions” to different areas of your drill window. Analysis Wizard reorganizes the displayed financial information to reflect your new dimensions.
- Exporting data to Excel or to the Windows clipboard.
- Drilling down to summary accounts, detail accounts, journal details, and subledger details including: Payables, Receivables, Assets, Projects, Purchasing, Inventory, and WIP.
- Full support for multiple database access.
- User definable options.
- Printing.

Prerequisite:

- Your System Administrator must grant you permission to use the Analysis Wizard by enabling the profile option GLDI: Analysis Wizard Privileges for your responsibility. Also, to drill down across sets of books, your System Administrator must enable the profile option GLDI: Allow Drilldown Across Books for your responsibility.

Your System Administrator can also set the profile option, GLDI: Maximum Effective Ranges for Drilldown. This setting, a positive integer greater than zero, specifies the maximum account ranges that can be drilled on with the
Analysis Wizard. See your System Administrator to optimize this setting to meet your drilldown and system performance needs.

---

**Note:** If these profile options are not available in your Release of Oracle General Ledger, all ADI users are given access to the Analysis Wizard automatically. See: Security (*Applications Desktop Integrator Installation Guide*)

---

☐ Use Request Center to publish a financial (FSG) report’s output to an Excel spreadsheet.

---

**Suggestion:** When you define your FSG report rows and columns, use null ranges for detail account ranges rather than using ranges that include “T” for parent segment values. This generally makes Analysis Wizard drilldown operations more efficient.

---

When you define your FSG report rows and columns, use null ranges for detail account ranges rather than using ranges that include “T” for parent segment values. This generally makes Analysis Wizard drilldown operations more efficient.

---

**Starting Analysis Wizard**

▸ **To start Analysis Wizard:**

1. Select a specific financial amount from one of your report output worksheets.

2. Choose the General Ledger button from the ADI toolbar and select Analyze Report from the List of Values.

   The Analysis Wizard window appears. This window includes the Analysis Wizard toolbar and Context window.
The Context window shows you information about the amount on which you’ve chosen to drill down. Fields in the Context window are: the Amount, what the Amount Includes (Detail, Summary, or Both balances), the Period, Currency, whether the currency is your functional currency or a foreign currency, the Amount Type, and the number of Effective Ranges selected.

From the Context window, you can change the Period (or the effective date when average balance processing is enabled for your set of books) and the Amount Type without returning to the FSG report output spreadsheet to select a different amount on which to drill down.

**Note:** If there are missing columns in your FSG report output, the Analysis Wizard context information may be displayed incorrectly. You can change the Period in the Context window to display the correct information.

The Context window includes five buttons:

**View/Filter:** Choose this button to see all of the effective account ranges associated with the amount in the Context window. The effective account ranges are based on the row account assignments, column account assignments, content set, report segment override, and column segment override used to generate the FSG report.
The profile option: GLDI Maximum Effective Ranges for Drilldown controls the number of effective ranges you can drilldown upon. If there are more effective ranges than the number set for the profile option, the View/Filter button label is colored blue. If there are fewer effective ranges than the number set for the profile option, the View/Filter button label is black.

You can choose the View/Filter button to open the Effective Ranges window. Toward the bottom of the Effective Ranges window, the message Up to ___ ranges can be selected, is displayed, reflecting the current profile option setting.

**Show Summary Accounts:** If summary account ranges have been defined for the amount in the Context window, you can choose this button to drill down to see the summary accounts and amounts. If no summary accounts are defined, this button is not available.

**Show Detail Accounts:** If detail account ranges have been defined for the amount in the Context window, you can choose this button to drill down to see the detail accounts and amounts. If no detail accounts are defined, this button is not available.

**Drill Options:** Choose this button to change the options for the current drill.

See: Drill and Environment Options on page 3-28.

**Data Source:** Choose this button to open the Drill Source window, which shows reference information pertaining to the amount in the Context window. The information includes the General Ledger Database, Application, Workbook Name, Worksheet Name, and Worksheet Cell.

To select an effective account range in subsequent drilldowns:

1. From the Context window, choose the View/Filter button.
2. For each effective account range you want included in your drilldowns, check the Include check box. Otherwise, leave the check box unmarked. You must select at least one effective account range. You cannot select more ranges than
Drilling Down to Summary and Detail Accounts

From the Context window, you can drill down to the summary and detail accounts and balances. From detail accounts you can drill down further to view journal details. Within any drilldown window, you can pivot and filter the displayed information for analysis purposes.

To drill down to summary accounts:
1. From the Context window, choose the Show Summary Accounts button. The Summary Balances window appears.

See Also:
Drilling Down to Summary and Detail Accounts on page 7-6
Analysis Wizard Toolbar on page 7-10
Setting Analysis Wizard Options on page 7-11
Analysis Wizard Drilldown Flows on page 7-13
Applications Desktop Integrator Budget Wizard on page 4-1
Applications Desktop Integrator Journal Wizard on page 5-1
Applications Desktop Integrator Report Wizard on page 6-1
ADI Options on page 3-16
The Request Center on page 12-1
2. To drill down further, select a summary balance, then choose the Show Detail Accounts button. This displays the balances of the detail accounts associated with the summary balance.

3. To drill down to journal details, select a detail balance, then choose the Show Journal Details button. Alternatively, choose the Return to Summary Accounts button to return to the Summary Balances window.

For more information about how drilldowns work, see: Analysis Wizard Drilldown Flows on page 7-13.

**To drill down to detail accounts:**

1. From the Context window, choose the Show Detail Accounts button. The Detail Balances window appears.

2. Choose the Show Summary Accounts button to view the summary balances for the detail account. To drill down to journal details, select a detail balance, then choose the Show Journal Details button.

For more information about how drilldowns work, see: Analysis Wizard Drilldown Flows on page 7-13.
Drilling Down to Summary and Detail Accounts

To pivot information in drilldown windows:

1. From the drilldown window, select one of the relocatable grey heading boxes from the row headings, column headings, or page areas.

2. Drag the heading box to a new location in one of the three areas, then drop it. Alternatively, choose the right mouse button, then choose the desired pivot action from the menu. You can choose Move to Page, Move to Column, or Move to Row.

The Analysis Wizard rearranges the displayed data as needed to give you a different view for analysis.

To filter information in drilldown windows:

1. In the drilldown window, place your cursor in the area directly below the row heading or column heading whose displayed values you want to filter.

2. Choose the right mouse button, then choose filter values from the menu. The Filter Values window appears.
3. Mark the Show check box for each value you want displayed on your drilldown window. Leave the check box unmarked if you do not want the value displayed.

4. Choose OK to save your work.

To remove filters in drilldown windows:

1. In the drilldown window, place your cursor in the area directly below the row heading or column heading whose displayed values are currently filtered.

2. Choose the right mouse button, then choose Show All Values from the menu.

Drilling Down to View Subledger Detail

You can view subledger transaction activity supporting journal entries for Oracle subledgers. The table below details the subledgers you can drill to depending on the version of ADI and Oracle Applications you are using.

Additional Information:

To Drilldown to subledger detail:

1. From the Detail Accounts window, select a detail balance and choose the Show Journal Details button.

   The Journal Details window appears.

2. Select a journal entry and choose the Show Subledger Details button.

   The Subledger Details window appears.

   You can see detail for transactions that originated from the Oracle subledger.
Analysis Wizard Toolbar

See Also:

Drilling Down to Summary and Detail Accounts on page 7-6
Analysis Wizard Toolbar on page 7-10
Setting Analysis Wizard Options on page 7-11
Analysis Wizard Drilldown Flows on page 7-13
Applications Desktop Integrator Budget Wizard on page 4-1
Applications Desktop Integrator Journal Wizard on page 5-1
Applications Desktop Integrator Report Wizard on page 6-1
ADI Options on page 3-16
The Request Center on page 12-1

Analysis Wizard Toolbar

From the Analysis Wizard toolbar you can access all of Analysis Wizard’s features for drilling down to detail accounts and balances.

Window: Navigate to an open drilldown window.

Export to Spreadsheet: Export the highlighted balance information to a Microsoft Excel worksheet.

Export to Clipboard: Export the highlighted balance information to the Window clipboard. You can then paste the information into any other Windows application.
Setting Analysis Wizard Options

You can set default drill options or you can change the options for the drill that is currently displayed in the Context window.

See Also:

Setting Analysis Wizard Options on page 7-11
Analysis Wizard Drilldown Flows on page 7-13
Applications Desktop Integrator Budget Wizard on page 4-1
Applications Desktop Integrator Journal Wizard on page 5-1
Applications Desktop Integrator Report Wizard on page 6-1
ADI Options on page 3-16
The Request Center on page 12-1

Print: Print the currently active drill window. Analysis Wizard displays a print preview window first. From the preview window, you can set your print options and change the width of individual drill window columns.

Help: Access the online help features of Analysis Wizard.

Exit: Close and exit Analysis Wizard.
To set any of the options discussed in this section:

1. To change the default drill options, choose the General Options button from the ADI toolbar and select Ledger Options from the List of Values. The Ledger Options window appears.

2. Select the Report Analysis tab.

3. Set your Drill and Environment options.

   See: Drill and Environment Options on page 3-28.

4. Choose OK to save your work.

See Also:

Setting Analysis Wizard Options on page 7-11
Analysis Wizard Drilldown Flows on page 7-13
Applications Desktop Integrator Budget Wizard on page 4-1
Applications Desktop Integrator Journal Wizard on page 5-1
Applications Desktop Integrator Report Wizard on page 6-1
ADI Options on page 3-16
The Request Center on page 12-1
Analysis Wizard Drilldown Flows

The following diagram depicts graphically the drilldown flows that are possible with the Analysis Wizard.

Figure 7–1 Analysis Wizard Drilldown Flows
Notes

- The Show Summary Accounts button is only available when summary ranges are defined for the context amount.
- The Show Detail Accounts button is only available when detail account ranges are defined for the context amount.
- The Show Subleger Details button is available for transactions that originated from Oracle Payables, Receivables, Assets, Projects, Purchasing, Inventory and WIP.

See Also:

- Setting Analysis Wizard Options on page 7-11
- Analysis Wizard Drilldown Flows on page 7-13
- Applications Desktop Integrator Budget Wizard on page 4-1
- Applications Desktop Integrator Journal Wizard on page 5-1
- Applications Desktop Integrator Report Wizard on page 6-1
- ADI Options on page 3-16
- The Request Center on page 12-1
The Account Hierarchy Editor

With the Account Hierarchy Editor you can graphically create, maintain, and review account structure hierarchies. You can define new parent and child segment values, as well as change parent/child dependencies. You can also create new rollup groups from the Account Hierarchy Editor and have your changes reflected automatically in both the Key Segment Values and Rollup Groups windows.

**Additional Information:** There is a General Ledger profile option, GL AHE: Saving Allowed, that must be set to Yes if you want to modify and save account hierarchies.

See: Setting General Ledger Profile Options *Oracle General Ledger User’s Guide*

**Attention:** When you change parent/child relationships that affect existing summary accounts, you must delete and recreate your summary templates in General Ledger.
The diagram below illustrates the concept of parent levels in an account hierarchy. This concept is used throughout the remainder of this chapter.

A parent level contains a parent segment value that has one or more child segment values associated with it. Parent levels are displayed in Account Hierarchy Editor in a top-down fashion. The level 1 parent is always the topmost parent, as shown in the diagram. The remaining parent levels, starting with level 2, are referred to as lower level parents.
As illustrated in the diagram, a parent value can be a child of a higher level parent. For example, in the diagram, parent value 3110 has two child segment values, 3111 and 3115. The parent is itself a child of the higher level parent value 3100, which also includes the child values 3150 and 3180. Parent value 3100 is, in turn, a child of the topmost parent value, 3000, which also includes the lower level parent values 3200 and 3300, as well as all of their child values.

When you select a parent level in Account Hierarchy Editor, you are selecting the parent segment value plus all of its child values, which include lower level parents and their associated child values. For example, if you select the parent value 3300 from the hierarchy shown in the diagram above, you are selecting the values 3300, 3310, 3311, 3312, 3315, 3318, 3350, and 3370.

See Also:
The Account Hierarchy Editor Interface

To start the Account Hierarchy Editor, choose the Ledger button from the ADI toolbar, then select the View Account Hierarchy option from the list of values.

See: ADI Toolbar on page 3-3.

See:

**Note:** The View Account Hierarchy option is only visible if your responsibility allows you to modify account structures.

The Account Hierarchy Editor window includes two subwindows — the Segment Values window and the Hierarchy Diagram window.
The Account Hierarchy Editor Interface

When you select a Chart of Accounts and Segment using the poplists located just below the toolbar, the Account Hierarchy Editor displays all of the segment values in the Segment Values window. The system uses the following symbols to represent the hierarchy status of a segment value:

- **Child value**:
  ![Child value icon]

- **Parent Value**:
  ![Parent value icon]
In addition to existing segment values, selections for New Parent Value and New Child Value appear at the top of the Segment Values window. You can use these selections to define new parent or child segment values.
The Account Hierarchy Editor displays your account hierarchies graphically in one or more scrolling Hierarchy Diagram windows.

From a Hierarchy Diagram window, you can build, modify, and view account hierarchies. You build hierarchies by selecting values from the Segment Values window, dragging them to the Hierarchy Diagram window, then “dropping” them. Select, drag, and drop are defined as follows:

- **Select**: Position your cursor on the segment value. Press and hold down the left mouse button.
- **Drag**: While continuing to hold down the left mouse button, move the cursor to the location on your hierarchy diagram where you want to add the new value.
- **Drop**: Release the left mouse button.
The first value you place in the Hierarchy Diagram window becomes the topmost (parent) node of the displayed hierarchy. When you place this first value, the Account Hierarchy Editor automatically displays the value, plus any currently assigned descendants.

**Note:** If the first value has parents of its own, the Account Hierarchy Editor does display them. This is because the system always treats the first value you place as the topmost node of your hierarchy.

To continue building a hierarchy, you select additional values from the Segment Values window, then drag and drop them in the Hierarchy Diagram window. Any new values must be added to existing values on the hierarchy diagram. For example, you can select a child value, drag it to the Hierarchy Diagram window, then drop it onto the topmost node. You can also select a parent value, drag it to the Hierarchy Diagram window, and drop it between two existing, connected nodes.

However, there are instances when you cannot drop a selected value onto an existing value in the hierarchy diagram. For example, you cannot drop a child value onto another child value. The Account Hierarchy Editor shows you when it is OK or not OK to drop a selected value. While you are dragging a value through a “no drop” area of the Hierarchy Diagram window, the cursor includes the disabled symbol. When it is OK to drop your selection, the disabled symbol disappears and the cursor changes to include a small rectangle at the lower right of the arrow.

### Expanding and Collapsing Hierarchy Diagrams

The symbol displayed for each value in your hierarchy diagram includes one of the following buttons on either its left, right, or bottom edge, depending on the diagram view you are using (See: View Menu on page 8-12). These buttons indicate whether a parent/child relationship exists and, if so, whether the relationship details are currently displayed or hidden:

- Collapsible Parent - children are currently displayed
Choosing an expanded parent button hides the assigned child values. Choosing a collapsed parent button displays the assigned child values.

**Displaying Multiple Hierarchy Diagrams**

To display multiple hierarchies simultaneously, you must create a new Hierarchy Diagram window for each hierarchy. From the Segment Values window, select the value to use as the topmost node of the new hierarchy, then choose Open from the File menu. Optionally, you can select the File: Open button from the toolbar.

**Displaying Segment Value Details**

When you choose a segment value, from either the Segment Values or Hierarchy Diagram windows, the Account Hierarchy Editor displays a related Attributes window, which shows segment value details, as follows:

- **Parent Attributes**: Segment Value, Description, Rollup Group, Effective From and To dates, Account Type, and assigned Child Ranges.

  **Note**: If you drag and drop new child values onto a parent in the Hierarchy Diagram window, the assigned Child Ranges in the Parent Attributes window are automatically updated.

- **Child Attributes**: Segment Value, Description, Effective From and To dates, Account Type, Allow Budgeting, and Allow Posting.

**See Also:**

- [The Account Hierarchy Editor Menu](#) on page 8-10
- [The Account Hierarchy Editor Toolbar](#) on page 8-14
- [Finding Segment Values](#) on page 8-15
The Account Hierarchy Editor Menu

You can use the Account Hierarchy Editor’s menu to change your hierarchy views, edit hierarchies, and change the properties of the hierarchy nodes. There are six main menu selections:

- **File**: Use to create a new Hierarchy Diagram window, open or close a Hierarchy Diagram or Attributes window, save hierarchies, print the current window, or exit from the Account Hierarchy Editor.
- **Edit**: Use to undo changes, remove a hierarchy node, create or modify rollup groups, or to change
  1. display properties of Hierarchy Diagram windows
  2. display fonts
  3. display node properties.
- **View**: Use to change the display view of the Hierarchy Diagram window.
- **Window**: Use to cascade or tile your Hierarchy Diagram windows, or to activate a specific window.
- **Help**: Use to get help about the Account Hierarchy Editor.

**File Menu**

The File Menu includes the following selections:

**New Window**: Opens a new Hierarchy Diagram window for the current chart of accounts and segment. There is a toolbar icon for this menu selection.
Open Window: If you select a segment value from the Segment Values window, this menu selection creates a new Hierarchy Diagram window and uses the selected value as the topmost node of the hierarchy. There is a toolbar icon for this menu selection.

Clear Window: Clears the currently displayed hierarchy from a window. Only affects the hierarchy diagram, not the underlying data. Once cleared, you can drag and drop a new hierarchy onto the window.

Close All Windows: Closes all active windows, without asking you if you want to save your changes. You must select a new chart of accounts and segment or exit from the Account Hierarchy Editor.

Close All Windows: Closes all active windows, without asking you if you want to save your changes. You must select a new chart of accounts and segment or exit from the Account Hierarchy Editor.

Save: Launches a concurrent process to apply any changes you have made to the account hierarchy since you last saved it. There is a toolbar icon for this menu selection.

Revert: Discards all changes made since you last saved the hierarchy and reverts to the previously saved version.

Print: Prints the contents of the current active window. There is a toolbar icon for this menu selection.

Print Preview: Previews your print output.

Print Setup: Gives you print and page layout options.

Exit: Closes the Account Hierarchy Editor.

Edit Menu

The Edit Menu includes the following selections:

Duplicate Hierarchy: Duplicates an existing hierarchy.

Modify Node Descriptions: Changes the descriptions of parent and child segment values.

Find: Finds segment values and descriptions in the Segment Values window.

Remove: Deletes the selected segment value node from the account hierarchy. Note that if you remove a parent node, you also remove its assigned child values. There is a toolbar icon for this menu selection.
The Account Hierarchy Editor Menu

Rollup Groups: Opens the Rollup Groups window, where you can create a new rollup group or edit an existing rollup group.

Node Properties: Changes the color and style of the rectangles used to represent parent and child nodes in a hierarchy diagram. You can also choose to display segment values, descriptions, or both as the node labels. Also, you can change the text color of the node label. There is a toolbar icon for this menu selection.

Font: Changes the Font, Font Style, and Size of the text used in your hierarchy diagrams. Note that if you want your fonts to display correctly when using the View: Zoom In and View: Zoom Out functions, you must change the default font (System).

Color

  Background Color: Changes the background color of the Hierarchy Diagram windows.

  Line Color: Changes the color of the connecting lines in hierarchy diagrams.

View Menu

The View Menu includes the following selections:

Value List: If the Segment Values window is closed, this menu item opens it.

Vertical: Changes the orientation of the hierarchy diagram to a typical tree structure. Child nodes are displayed beneath and slightly indented from the parent node. There is a toolbar icon for this menu selection.

Column: Changes the orientation of the hierarchy diagram to a modified tree structure. Child nodes are displayed to the right of their parent node, in a separate column. There is a toolbar icon for this menu selection.

Horizontal: Changes the orientation of the hierarchy diagram to that of a typical horizontal organization chart. There is a toolbar icon for this menu selection.

Zoom In: Zooms in on the current hierarchy diagram. The items on your display are larger and easier to read, but you see less of the overall diagram. There is a toolbar icon for this menu selection.
The Account Hierarchy Editor Menu

Zoom Out: Zooms out of the current hierarchy diagram. You see more of the overall hierarchy diagram on your display, but the individual items are smaller (and might be difficult to read if you zoom out too far). There is a toolbar icon for this menu selection.

Note: The hierarchy diagram may not display correctly when using this function, unless you first change the default font.

The hierarchy diagram may not display correctly when using this function, unless you first change the default font.

Toolbar: Toggles the toolbar on and off.

Status Bar: Toggles the Account Hierarchy Editor status line on and off.

Window Menu

The Window Menu includes the following options:

Cascade: Overlaps all windows.

Tile: Displays all windows vertically.

Auto-Tile: Hierarchy Diagram windows are tiled automatically depending on whether you choose the Tile Vertical or Tile Horizontal option (below). Windows are tiled vertically or horizontally whenever you perform an action to create a new window.

Tile Vertical: Multiple Hierarchy Diagram windows are tiled vertically when Auto-Tile is on, or when you choose Tile from the Window menu.

Tile Horizontal: Multiple Hierarchy Diagram windows are tiled horizontally when Auto-Tile is on, or when you choose Tile from the Window menu.

List on Left: Displays the Segment Values window on the left side of the Account Hierarchy Editor window.

List on Right: Displays the Segment Values window on the right side of the Account Hierarchy Editor window.
The Account Hierarchy Editor Toolbar

See Also:
- The Account Hierarchy Editor Interface on page 8-4
- The Account Hierarchy Editor Menu on page 8-10
- The Account Hierarchy Editor Toolbar on page 8-14

The Account Hierarchy Editor Toolbar

The Account Hierarchy Editor toolbar provides pushbutton shortcuts for various menu commands, as follows:

See Also:

<table>
<thead>
<tr>
<th>File: New</th>
<th>View: Column</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="File: New" /></td>
<td><img src="image2" alt="View: Column" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File: Open</th>
<th>View: Horizontal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="File: Open" /></td>
<td><img src="image4" alt="View: Horizontal" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File: Save</th>
<th>Edit: Node Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="File: Save" /></td>
<td><img src="image6" alt="Edit: Node Properties" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File: Print</th>
<th>View: Zoom In</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image7" alt="File: Print" /></td>
<td><img src="image8" alt="View: Zoom In" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit: Remove</th>
<th>View: Zoom Out</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image9" alt="Edit: Remove" /></td>
<td><img src="image10" alt="View: Zoom Out" /></td>
</tr>
</tbody>
</table>
Finding Segment Values

The Account Hierarchy Editor Interface on page 8-4
The Account Hierarchy Editor Menu on page 8-10
Finding Segment Values on page 8-15
Adding or Changing Account Hierarchies with the Account Hierarchy Editor on page 8-17
Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
Adding or Changing Child Values with the Account Hierarchy Editor on page 8-24
Duplicating Parent Hierarchies on page 8-26
Modifying Segment Value Descriptions on page 8-34
Adding and Changing Rollup Groups with the Account Hierarchy Editor on page 8-37
Closing the Account Hierarchy Editor on page 8-39

Finding Segment Values

The Account Hierarchy Editor lets you quickly search for a segment value by specifying the segment value or the segment value’s description. To narrow your search, you can specify if the segment value or description is a parent or child value.
Finding Segment Values

In addition, you can specify if you want to match upper and lower case or whole words for your segment value or description.

◿ To search for segment values or segment value descriptions:
1. Open the Account Hierarchy Editor.
2. Choose your chart of accounts and segment hierarchy.
3. Select any segment value in the Segment Values window. Right-click to open the Find menu and choose Find or choose Find from the Edit menu. The Find Segment window appears.
4. Complete the following fields per your search requirements:

   Find What: Enter the segment value or description of the segment value you want to find.

   Parent: Check this check box to limit your search to Parent values.

   Child: Check this check box to limit your search to Child values.

   Match Case: Check this check box to use a case sensitive search.

   Match Whole Words Only: Choose this check box to match whole words in your search. Your search locates the next instance of the word you specify.

   Search for Segment Region: Choose the check box that corresponds with your search: Segment Value or Segment Value Description.

   Direction Region: You can direct your search up or down your chart of accounts to speed your search. Choose the appropriate direction.

See Also:
The Account Hierarchy Editor Interface on page 8-4
The Account Hierarchy Editor Menu on page 8-10
The Account Hierarchy Editor Toolbar on page 8-14
Adding or Changing Account Hierarchies with the Account Hierarchy Editor

You can use the Account Hierarchy Editor, instead of the Key Segment Values window in General Ledger, to define a hierarchy for a segment of your chart of accounts. In addition to building new hierarchies, you can use the Account Hierarchy Editor to change existing hierarchies, regardless of where you defined them.

You can use the Account Hierarchy Editor, instead of the Key Segment Values window, to define a hierarchy for a segment of your chart of accounts. In addition to building new hierarchies, you can use the Account Hierarchy Editor to change existing hierarchies, regardless of where you defined them.

---

**Note:** You can only use the Account Hierarchy Editor for segments with value sets using Independent validation.

---

You can only use the Account Hierarchy Editor for segments with value sets using Independent validation.
You change a hierarchy by:

- Adding child and parent segment values
- Moving child or parent values within a hierarchy
- Removing values

**Prerequisite**

- Define the Accounting Flexfield structure that represents your chart of accounts.
  
  See: Defining Your Account Structure *Oracle General Ledger User’s Guide*

**To create a new hierarchy:**

1. Start the Account Hierarchy Editor by choosing the Ledger button from the ADI toolbar, then selecting the View Account Hierarchy option from the list of values.

2. From the related poplists, select the Chart of Accounts and Segment for which you want to create a hierarchy.

3. Select the parent segment value representing the topmost node of your hierarchy. Optionally, you can create a new parent segment value.
   
   See: Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21.

4. Drag the selected parent segment value to the hierarchy diagram window and drop it. Alternatively, choose the Open Window option from the File menu or the related toolbar button.

5. Add values to your hierarchy, as needed, working down from the topmost node (See the next task).

6. Save your work.

---

**Suggestion:** When you create a hierarchy, start from the top of the hierarchy organization and build down. In other words, start with a top level grandparent, then add parents, then child nodes.
To add values to an existing hierarchy:

1. From within the Account Hierarchy Editor, select the Chart of Accounts and Segment for the existing hierarchy diagram.

2. Select the parent segment value that represents the topmost node of your hierarchy, then drag and drop it in the Hierarchy Diagram window. The Account Hierarchy Editor displays the parent value, plus all of its child values.

3. From the Segment Values window, select the value you want to add to your hierarchy.

4. Drag the selected value to the intended parent value in the Hierarchy Diagram window, then drop it.

---

Note: The appearance of your cursor changes to include a small rectangle when the cursor is positioned over a parent value.

---

Additional Information: You can add a parent segment value between existing parent and child values. Drop the new parent value on one of the lines connecting existing parent and child values. The Account Hierarchy Editor inserts the new parent value.

---

Attention: When you change parent/child relationships that affect existing summary accounts, you must delete and recreate your summary templates.

---

5. Save your work.

To move values within an existing hierarchy:

1. Choose the hierarchy diagram within which you want to move values.

2. Select the child value you want to move and drag it to the new intended parent value.
Adding or Changing Account Hierarchies with the Account Hierarchy Editor

3. Save your work.

To remove values from an existing hierarchy:
1. Choose the hierarchy diagram from which you want to remove values.
2. Select the value you want to remove, then use one of these methods to remove it:
   - Drag it to the segment values window and drop it.
   - Choose Remove from the Edit menu
   - Choose the Remove icon from the toolbar.
   - Choose [Delete].

   Note: You are not deleting the value, you are simply removing it from the hierarchy.

3. Save your work.

See Also:
The Account Hierarchy Editor Interface on page 8-4
The Account Hierarchy Editor Menu on page 8-10
The Account Hierarchy Editor Toolbar on page 8-14
Finding Segment Values on page 8-15
Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
Adding or Changing Child Values with the Account Hierarchy Editor on page 8-24
Duplicating Parent Hierarchies on page 8-26
Modifying Segment Value Descriptions on page 8-34
Adding and Changing Rollup Groups with the Account Hierarchy Editor on page 8-37
Adding or Changing Parent Values with the Account Hierarchy Editor

You can use the Account Hierarchy Editor to add new parent segment values, assign child ranges for a parent segment value, change parent attributes, and merge child ranges.

► To create a new parent segment value:

1. Start the Account Hierarchy Editor by choosing the Ledger button from the ADI toolbar, then selecting the View Account Hierarchy option from the list of values.
2. From the related poplists, select the Chart of Accounts and Segment for the existing hierarchy.
4. Enter a new Segment Value. The segment value must comply with the security rules you defined for the value set associated with the segment. The Account Hierarchy Editor validates the value when you close the Parent Attributes window.
5. Optionally, enter a Description, assign a Rollup Group, and specify a range of Effective Dates.
6. If you are creating a new parent value for the natural account segment, specify an Account Type.
7. Mark the Enable check box if you want to use this segment value—for example, in the Enter Journals window in General Ledger.

Additional Information: If you create a new parent segment value, you cannot delete it. You can, however, disable the segment value at any time, by unmarking the Enable check box on the Parent Attributes window.
8. Mark the appropriate check boxes if you want to Allow Posting and Allow Budgeting for this segment value.

9. Optionally, assign child value ranges to your parent value (See the next task).

10. Choose OK, then save your work.

**To assign child value ranges to a parent value:**

1. Choose the parent value (from the Segment Values window) to which you want to assign child value ranges. The Parent Attributes window appears.

2. Choose New. The Range window appears.

3. Select Parent Range or Child Range as the range type.

4. Enter a segment value range. Range segment values must comply with the security rules you defined for the value set associated with the segment. Values are validated when you close the Parent Attributes window.

**Note:** A parent range includes only the parent segment values falling within the range. A child range includes all child values falling within the range.

5. Choose OK to close the Range window. The newly defined Child or Parent range is shown in the Child Ranges region of the Parent Attributes window.

6. Choose OK when you are finished assigning child ranges.

7. Save your work.

---

**Note:** A parent range includes only the parent segment values falling within the range. A child range includes all child values falling within the range.

**Additional Information:** You can enter overlapping child ranges for a parent segment value. However, each segment value in the overlapping ranges is only assigned to the parent once.

**Attention:** If you change parent/child relationships that affect existing summary accounts, you must delete and recreate your summary templates in General Ledger.

5. Choose OK to close the Range window. The newly defined Child or Parent range is shown in the Child Ranges region of the Parent Attributes window.

6. Choose OK when you are finished assigning child ranges.

7. Save your work.
To change the attributes for a parent segment value:

1. Choose the parent node (from the Segment Values window) whose attributes you want to change.

2. Make any changes in the Parent Attributes window, then save your work.

---

**Note:** If you edit a node that appears more than once in a hierarchy, the Account Hierarchy Editor changes all occurrences of that node to keep the attributes consistent.

---

**Warning:** When you upload segment value attribute changes to General Ledger, you can also change General Ledger account code combination attributes. See: Segment Value Inheritance, *General Ledger User’s Guide.*

---

**Merging Ranges**

When you create hierarchies using the drag and drop feature of the Account Hierarchy Editor, the system automatically updates parent segment attributes as you build your hierarchies. For example, if you drag the child segment value “1100-Accounts Receivable” to the parent segment value “Asst-Assets,” the Account Hierarchy Editor changes the attributes of Asst to include the child range 1100-1100.

If you do this repeatedly for multiple child values, a parent segment can accumulate many entries for child ranges—ranges which are actually adjacent in your chart of accounts. You can use the Account Hierarchy Editor to consolidate adjacent child ranges into a single entry in the Parent Attributes window. For example, separate entries for child ranges 1100-1000, 1200-1200, 1300-1300, and 1400-1400, are combined into one range, 1100-1400.

If you do this repeatedly for multiple child values, a parent segment can accumulate many entries for child ranges—ranges which are actually adjacent in your chart of accounts. You can use the Account Hierarchy Editor to consolidate adjacent child ranges into a single entry in the Parent Attributes window. For example, separate entries for child ranges 1100-1000, 1200-1200, 1300-1300, and 1400-1400, are combined into one range, 1100-1400.

To merge child ranges for a parent segment value:

1. Choose the parent value whose ranges you want to merge.
The Parent Attributes window appears.

2. Choose Merge.

The Preview Merged Ranges window appears. The left region shows the current child ranges. The right region shows the merged ranges as they will appear if you confirm the merge operation.

3. Choose Accept Merge to confirm the merge operation or choose Cancel to abort.

See Also:

- The Account Hierarchy Editor Interface on page 8-4
- The Account Hierarchy Editor Menu on page 8-10
- The Account Hierarchy Editor Toolbar on page 8-14
- Finding Segment Values on page 8-15
- Adding or Changing Account Hierarchies with the Account Hierarchy Editor on page 8-17
- Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
- Adding or Changing Child Values with the Account Hierarchy Editor on page 8-24
- Modifying Segment Value Descriptions on page 8-34
- Adding and Changing Rollup Groups with the Account Hierarchy Editor on page 8-37
- Closing the Account Hierarchy Editor on page 8-39
- Defining Segment Values, Defining Key Flexfields, Oracle General Ledger User’s Guide

Adding or Changing Child Values with the Account Hierarchy Editor

You can use the Account Hierarchy Editor to add new child segment values or modify existing child values.

To create a new child segment value for your hierarchy:

1. Start the Account Hierarchy Editor by choosing the Ledger button from the ADI toolbar, then selecting the View Account Hierarchy option from the list of values.
2. From the related poplists, select the Chart of Accounts and Segment for the existing hierarchy.


4. Enter a new Segment Value. The segment value must comply with the security rules you defined for the value set associated with the segment. The Account Hierarchy Editor validates the value when you close the Child Attributes window.

5. Optionally, enter a Description and specify a range of Effective Dates.

6. If you are creating a new child value for the natural account segment, specify an Account Type.

7. Mark the Enable check box if you want to use this segment value—for example, in the Enter Journals window in General Ledger.

**Additional Information:** If you create a new child segment value, you cannot delete it. You can, however, disable the segment value at any time, by unmarking the Enable check box on the Child Attributes window.

8. Mark the appropriate check boxes if you want to Allow Posting and Allow Budgeting for this segment value.

9. Choose OK to close the Child Attributes window.

10. Save your work.

**To change the attributes for a child segment value:**

1. Choose the child node whose attributes you want to change.

2. Make any changes in the Child Attributes window, then save your work.

**Note:** If you edit a child node that appears more than once in a hierarchy, the Account Hierarchy Editor changes all occurrences of that node to keep the attributes consistent.
Duplicating Parent Hierarchies

**Warning:** When you upload segment value attribute changes to General Ledger, you can also change General Ledger account code combination attributes. See: Segment Value Inheritance, General Ledger User's Guide.

When you upload segment value attribute changes to General Ledger, you can also change General Ledger account code combination attributes. See: Segment Value Inheritance, General Ledger User's Guide.

**See Also:**
- The Account Hierarchy Editor Interface on page 8-4
- The Account Hierarchy Editor Menu on page 8-10
- The Account Hierarchy Editor Toolbar on page 8-14
- Finding Segment Values on page 8-15
- Adding or Changing Account Hierarchies with the Account Hierarchy Editor on page 8-17
- Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
- Duplicating Parent Hierarchies on page 8-26
- Modifying Segment Value Descriptions on page 8-34
- Adding and Changing Rollup Groups with the Account Hierarchy Editor on page 8-37
- Closing the Account Hierarchy Editor on page 8-39

**Duplicating Parent Hierarchies**

You can use the Account Hierarchy Editor to duplicate existing parent hierarchies. The duplicated hierarchy inherits all the attributes from the source hierarchy, such as account type, rollup groups, effective dates, enabled status, and lower level parents and children.

The new hierarchy is completely independent of the source hierarchy. Any changes you make to the new hierarchy do not affect the source hierarchy unless both hierarchies share the same parent and child values.
When you duplicate a hierarchy, you can replace lower level parent segment values using wild card searches, or you can specify the new parent segment values directly.

See: Parent Levels in an Account Hierarchy on page 8-2.

**Note:** You can replace lower level parent values when you duplicate hierarchies but you cannot replace child values. To change child segment values in the duplicate hierarchy, delete the child segment value, then create a new value or drag and drop an existing one from the Segment Values window.

**Additional Information:** To help you complete fields in the Duplicate Hierarchy window, text dynamically appears in the Helpful Hints region at the bottom of the window.
Duplicating Parent Hierarchies

To duplicate an existing parent hierarchy:

1. In the Segment Values window, select a parent value whose hierarchy you want to duplicate, then drag/drop it in the Hierarchy Diagram window.

2. Select the top level parent value if you want to duplicate the entire hierarchy. To duplicate a portion of the hierarchy, select the lower level parent whose structure you want to duplicate.

   **Suggestion:** You can only duplicate parents that have child values assigned to them.

3. Choose Duplicate Hierarchy from the Edit menu. The Duplicate Hierarchy window appears.

4. Enter the segment value for the New Top Level Parent. Also enter a Description.
5. (Optional) To replace lower level parent segment values with different values to be used in your duplicate hierarchy, define replacement criteria by completing the Replace Lower Level Parent Value(s) region.

See: Replacing Parent Segment Values on page 8-30.

**Note:** If you do not complete this optional step, you will get an exact duplicate of your original hierarchy.

If you do not complete this optional step, you will get an exact duplicate of your original hierarchy.

**Suggestion:** To build your duplicate hierarchy one step at a time, repeat this optional step as often as necessary, making small changes each time. To see the effect of each incremental change, choose the Preview button before making the next change.

To build your duplicate hierarchy one step at a time, repeat this optional step as often as necessary, making small changes each time. To see the effect of each incremental change, choose the Preview button before making the next change.

6. Choose the Preview button to review your duplicate hierarchy, which appears in a new hierarchy diagram window. Make sure the results match your expectations.

**Suggestion:** As you edit your duplicate hierarchy, choose the Preview button as needed to update the hierarchy display.

7. As you review your duplicate hierarchy, choose one of the following buttons from the Duplicate Hierarchy window to take the corresponding action:

- **Undo:** Reverses the last change you made to your duplicate hierarchy using the Replace Lower Level Parent Value(s) region. Choosing this action also restores the replacement criteria to the Replacement Order list. You can then remove the criteria and define new replacement criteria using the Replace Lower Level Parent Value(s) region.

- **Undo All:** Reverses all of your changes and closes the duplicate hierarchy diagram window.
Replacing Parent Segment Values

- Accept: Saves your duplicate hierarchy locally. This action does not save the duplicate hierarchy to the database.

Warning: To ensure that you save your hierarchy to the database, make sure you complete step 8.

To ensure that you save your hierarchy to the database, make sure you complete step 8.

- Cancel: Cancels your hierarchy duplication process and closes the Duplicate Hierarchy window.

8. When you are done creating your duplicate hierarchy, save your changes to the database. To do this, choose the Save button from the Account Hierarchy toolbar, or choose File > Save from the menu.

Suggestion: Refresh the Account Hierarchy Editor after you save hierarchies to the database. To refresh, choose a different segment in the Segment Field then choose Yes when asked, Do you want to save your changes? To continue working, select the segment you want to work with, from the Segment Field poplist.

Refresh the Account Hierarchy Editor after you save hierarchies to the database. To refresh, choose a different segment in the Segment Field then choose Yes when asked, Do you want to save your changes? To continue working, select the segment you want to work with, from the Segment Field poplist.

Replacing Parent Segment Values

When you duplicate a hierarchy, you can choose to replace the lower level parent segment values in the existing hierarchy with new values to be used in the duplicate hierarchy. You can:

- Replace all lower level parent segment values.
- Modify parent segment values for specific lower levels of the hierarchy, following an order that you define.
Replacing Parent Segment Values

**Note:** You must replace higher level parent segment values first. For example, you must replace level 2 parent segment values before replacing level 3 parent segment values.

You must replace higher level parent segment values first. For example, you must replace level 2 parent segment values before replacing level 3 parent segment values.

- Replace only the topmost lower level parent segment value, leaving the remaining lower level parent segment values intact.

You define the replacement criteria that Account Hierarchy Editor uses to replace the lower level parent segment values. You do this by entering values in the Find Parent, Replace With, and In Level fields, then adding those values to the Replacement Order list. You can use wildcards in these three fields to look for and replace complete or partial parent segment values.

You can specify multiple replacement criteria and the order in which Account Hierarchy Editor applies them when duplicating the hierarchy.

**To replace lower level parent values:**

1. Complete the following fields:

   - **Find Parent:** Enter the lower level parent segment value you want to replace. You can enter a single parent segment value or use the wildcard symbol (?) to select multiple parent segment values. Note that Account Hierarchy Editor interprets the wildcard symbol to mean any character, including blanks.

   **Note:** When you first open the Duplicate Hierarchy window, the Find Parent field includes all wildcard symbols — one for each character position in the account segment.

When you first open the Duplicate Hierarchy window, the Find Parent field includes all wildcard symbols — one for each character position in the account segment.

For example, assume your account segment consists of four characters. If you enter 32?5 as your Find Parent value, Account Hierarchy Editor will replace the parent segment values 3205, 3215, 3225, 3235, 3245, 3255, 3265, 3275, 3285, 3295, and 32T5.
**Note:** Leave this field blank to create a complete copy of your original parent level hierarchy. Account Hierarchy Editor does not replace any parent segment values.

Leave this field blank to create a complete copy of your original parent level hierarchy. Account Hierarchy Editor does not replace any parent segment values.

**Replace With:** Enter the parent segment value that is to replace the original parent segment value. You can enter a single parent segment value or use the wildcard symbol (?) to have Account Hierarchy Editor use the character that occupies the same position in the original parent segment value. Note that Account Hierarchy Editor interprets the wildcard symbol to mean any character, including blanks.

**Suggestion:** When you first open the Duplicate Hierarchy window, the Replace With field includes all wildcard symbols — one for each character position in the account segment.

For example, assume your account segment consists of four characters and your Find Parent value is set to 32?5. The following table shows what replacement parent segment values Account Hierarchy Editor uses in the duplicate hierarchy, given different Replace With values:

<table>
<thead>
<tr>
<th>Original Parent Segment Value</th>
<th>Replace With: 5????</th>
<th>Replace With: ???0</th>
<th>Replace With: 9999</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Parent: 32?5</td>
<td>5205</td>
<td>3700</td>
<td>9999</td>
</tr>
<tr>
<td>3205</td>
<td>5215</td>
<td>3710</td>
<td>9999</td>
</tr>
<tr>
<td>3225</td>
<td>5225</td>
<td>3720</td>
<td>9999</td>
</tr>
<tr>
<td>3235</td>
<td>5235</td>
<td>3730</td>
<td>9999</td>
</tr>
<tr>
<td>3245</td>
<td>5245</td>
<td>3740</td>
<td>9999</td>
</tr>
<tr>
<td>3255</td>
<td>5255</td>
<td>3750</td>
<td>9999</td>
</tr>
<tr>
<td>3265</td>
<td>5265</td>
<td>3760</td>
<td>9999</td>
</tr>
</tbody>
</table>
Replacing Parent Segment Values

Table 8–1  Example of Replacing Parent Segment Values

<table>
<thead>
<tr>
<th>Original Parent Segment Value</th>
<th>Replace With: 32?5</th>
<th>Replace With: 5???5</th>
<th>Replace With: ???70</th>
<th>Replace With: 9999</th>
</tr>
</thead>
<tbody>
<tr>
<td>3275</td>
<td>5275</td>
<td>3770</td>
<td>9999</td>
<td></td>
</tr>
<tr>
<td>3285</td>
<td>5285</td>
<td>3780</td>
<td>9999</td>
<td></td>
</tr>
<tr>
<td>3295</td>
<td>5295</td>
<td>3790</td>
<td>9999</td>
<td></td>
</tr>
<tr>
<td>32T5</td>
<td>52T5</td>
<td>37T0</td>
<td>9999</td>
<td></td>
</tr>
</tbody>
</table>

In Parent Level: From the poplist, select All to apply the replacement criteria to all parent levels in the original hierarchy that have parent segment values matching the Find Parent criteria. Alternatively, select a specific parent level (2 through the highest value) from the poplist.

Note: The poplist displays the levels of your original hierarchy as numbers, with 1 being the topmost level. Since the segment value for level 1 of your duplicate hierarchy is determined by the value you enter in the New Top Level Parent field, defining a replacement criteria with In Parent Level set to 1 has no effect.

The poplist displays the levels of your original hierarchy as numbers, with 1 being the topmost level. Since the segment value for level 1 of your duplicate hierarchy is determined by the value you enter in the New Top Level Parent field, defining a replacement criteria with In Parent Level set to 1 has no effect.

2. Choose the Add button to move your replacement criteria to the Replacement Order list.

Replacement Order List

As you define replacement criteria, a new line appears in the Replacement Order list each time you press the Add button on the Duplicate Hierarchy window. You can add as many replacement criteria to the list as you want. When you choose the Preview button, Account Hierarchy Editor applies your replacement criteria in the order they appear in the Replacement Order list.

The order of your replacement criteria is important. You must replace higher level parent segment values before you replace any lower level parent segment values.
Modifying Segment Value Descriptions

You can use the Modify Node Descriptions window to change descriptions for groups of Parent and Child segment values within a hierarchy. You can search for

See Also:
The Account Hierarchy Editor Interface on page 8-4
The Account Hierarchy Editor Menu on page 8-10
The Account Hierarchy Editor Toolbar on page 8-14
Finding Segment Values on page 8-15
Adding or Changing Account Hierarchies with the Account Hierarchy Editor on page 8-17
Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
Adding or Changing Child Values with the Account Hierarchy Editor on page 8-24
Duplicating Parent Hierarchies on page 8-26
Modifying Segment Value Descriptions on page 8-34
Adding and Changing Rollup Groups with the Account Hierarchy Editor on page 8-37
Closing the Account Hierarchy Editor on page 8-39
Defining Segment Values, Defining Key Flexfields, Planning Your Summary Accounts Oracle General Ledger User’s Guide)
and replace groups of descriptions, isolate changes to a specific hierarchy level, or modify individual segment value descriptions.

To modify segment value descriptions:

1. In the Hierarchy Diagram window, drag an existing hierarchy or build a hierarchy for which you want to change descriptions.

2. Select the entire hierarchy by choosing the top most parent or select another level within the hierarchy.

3. Choose Modify Node Descriptions from the menu or right-click to choose Modify Node Descriptions from the menu that appears.

   The Modify Node Descriptions window appears.

   Note: The top level segment value in the hierarchy you selected appears in the window title bar.

4. Complete the following fields:

   Find What: Enter the description you want to change.

   Replace With: Enter the new description.

   Level: Specify the level of your hierarchy you want to change. For example, if you specify 2 for the second level, your description changes apply only to the segment values in the second level.

   You can limit your description search by checking the following check boxes:

   Parent Value or Child Value

   Match Case: Your search is case sensitive.

   Match Whole Words Only: Your search matches only the whole word(s) you specify in the Find What field.

5. Choose the Find button to initiate your search.

   The Replacement Description region appears.
Use the Replacement Description region to review your new and original descriptions before you apply your changes. In this window you can choose to preserve your original descriptions, adopt the new descriptions, or edit the new descriptions for any listed segment value before you commit your changes.

6. Complete the following fields:

**Description Check Box:** Retain the check to use the new segment value description. Clear the check box to retain the original segment value description.

**New Description:** You can edit any new description. To complete your edits, choose the new description or press the right mouse button, then choose Rename.

7. Choose the Replace button to apply your changes.

---

**Note:** To discard your changes, choose the New Find button, enter a new description in the Find What field, complete the remaining fields, and choose the Find button. The region below refreshes with new segment values and descriptions.

---

**See Also:**

The Account Hierarchy Editor Interface on page 8-4

The Account Hierarchy Editor Menu on page 8-10
Adding and Changing Rollup Groups with the Account Hierarchy Editor

You can create new rollup groups or edit existing rollup groups using the Account Hierarchy Editor. Rollup groups are groups of parent segment values you use to create summary accounts.

Attention: When you change the contents of a rollup group that is used in a summary template, you must delete and recreate your summary accounts.

Prerequisites:

- Rollup groups must be unfrozen for the current chart of accounts. See: Defining Key Flexfields (Oracle Applications Flexfields Guide).

To create a new rollup group:

1. Start the Account Hierarchy Editor by choosing the Ledger button from the ADI toolbar, then selecting the View Account Hierarchy option from the list of values.

2. From the related poplists, select the Chart of Accounts and Segment for the existing hierarchy.
3. From the related poplists, select the Chart of Accounts and Segment for the existing hierarchy.


6. Enter a name and description for the new rollup group.

7. Choose OK to close the Rollup Group window.

8. Repeat steps 4 through 6 for each rollup group you want to create. When you are finished, choose OK to close the Rollup Groups window.

9. Save your work.

To change an existing rollup group:

1. Choose the existing hierarchy whose rollup groups you want to change.

2. Choose Rollup Groups from the Edit menu.

3. Select the rollup group you want to change.

4. Choose Edit.

5. After making your changes, choose OK.

6. Repeat steps 3 through 5 for each rollup group you want to change. When you are finished, choose OK.

7. Save your work.

See Also:

The Account Hierarchy Editor Interface on page 8-4
The Account Hierarchy Editor Menu on page 8-10
The Account Hierarchy Editor Toolbar on page 8-14
Finding Segment Values on page 8-15
Adding or Changing Account Hierarchies with the Account Hierarchy Editor on page 8-17
Adding or Changing Parent Values with the Account Hierarchy Editor on page 8-21
Adding or Changing Child Values with the Account Hierarchy Editor on page 8-24
Duplicating Parent Hierarchies on page 8-26
**Closing the Account Hierarchy Editor**

To close the Account Hierarchy Editor:

1. Choose File > Exit from the Account Hierarchy Editor menu.

2. If you have not already done so, the system asks if you want to save any changes you’ve made. Choose Yes to save your work, or No to abandon your changes. Choose Cancel to leave your Account Hierarchy Editor session open.

**See Also:**

- The Account Hierarchy Editor Interface on page 8-4
- The Account Hierarchy Editor Menu on page 8-10
- The Account Hierarchy Editor Toolbar on page 8-14
Create Assets Feature

The Create Assets feature provides a spreadsheet-based interface to simplify asset creation in a disconnected environment. Use the Create Assets feature to automatically build personalized asset entry spreadsheets based on the information required by your organization’s specific implementation of Oracle Assets. You can enter your asset data manually, use the list of values, and take advantage of Excel’s data entry shortcuts. You can also map data files from legacy systems or third party payables applications into the asset worksheet. When you are satisfied with the worksheet, the Create Assets feature automatically uploads the data into Oracle Assets.

With the Create Assets feature, you can:

- Create and customize asset worksheets.
- Use the powerful spreadsheet features of Excel.
- Save an asset worksheet to a file, which can then be transferred to another PC for further changes, even while disconnected from your Oracle Assets database.

**Prerequisites:**
- Complete Oracle Assets setup steps.

**See Also:**

- Creating Asset Worksheets on page 9-2
- Asset Worksheet Parameters on page 9-3
- Uploading Asset Data into Oracle Assets on page 9-8
Creating Asset Worksheets

Asset Upload Options on page 9-11
Choosing Values from Lists on page 3-37
Choosing Account Segment Values on page 3-38

Creating Asset Worksheets

To create an asset worksheet:
1. Choose the Assets button from the ADI toolbar.
2. Choose the Create Assets button from the Assets toolbar.
4. Choose OK. ADI automatically creates your asset worksheet.

To create additional asset worksheets in the same session:
1. While viewing an asset worksheet, choose the Create Assets button from the Assets toolbar.
2. Enter your asset worksheet parameters. See: Asset Worksheet Parameters on page 9-3.
3. Choose OK. ADI automatically creates your asset worksheet.
To save an asset worksheet to disk:
1. Select File > Save As from the Excel menu.
2. Enter a name and specify a path for the asset worksheet file.
3. Choose OK to save the file, or Cancel to abandon the operation.

To open a saved asset worksheet:
1. Select File > Open from the Excel menu.
2. Select the path where the asset worksheet is located. Excel will display the names of the files in a separate list.
3. Choose the asset worksheet name from the list of values.
4. If ADI is installed, but not running, it will start automatically when you open the asset worksheet.

Asset Worksheet Parameters

When you create an asset worksheet, you must specify certain parameters. Once you set these parameters, ADI creates an asset worksheet based on the parameters you provided.

There are three parameters you must set: corporate depreciation book, layout template, and worksheet options.

Select Corporate Depreciation Book

Select the corporate depreciation book in which you want to create assets.

The Oracle Assets profile option, FA: Security Profile extends to users working with Oracle Assets in ADI. Your list of choices may be limited to sets of books associated with your responsibility. For more information, see your System Administrator or the Oracle Assets User Guide.

Select Layout

Layout templates allow you to select the fields that should be included in the asset worksheet. They also control the order in which the data fields appear on your worksheet.

You can create a new layout template, or edit, view, copy, rename, or delete an existing layout template.
You can make a layout template available to other users by checking the Public check box on the Edit Layout window.

To create a new layout template:
1. From the Create Assets window, choose the Actions button.
2. Choose the New option from the poplist.
3. Enter a name for the new layout template.
4. At the Edit Layout window, use the drag and drop functions and the directional buttons to arrange the fields on your layout template. Choose OK.

   See: Editing Layout Templates on page 9-6.

To customize an existing layout template:
1. From the Create Assets window, select a layout to customize and choose the Actions button.
2. Choose the View/Edit option from the poplist.
3. At the Edit Layout window, edit the layout. Choose OK.
To copy an existing layout template:
1. From the Create Assets window, select a layout to copy. Choose the Actions button.
2. Choose the Copy option from the poplist.
3. Enter a unique name for the copied layout template. Choose OK.

To rename an existing layout template:
1. From the Create Assets window, select a layout to rename. Choose the Actions button.
2. Choose the Rename option from the poplist.
3. Enter the new name of the layout template. Choose OK.
4. From the Create Assets window, choose the layout template you want to delete.
5. Choose the Actions button.
6. Select the Delete option from the poplist.
7. Choose Yes to confirm that you want to delete the layout template.

To view an existing layout template:
1. From the Create Assets window, select a layout to view and choose the Actions button.
2. Choose the View/Edit option from the poplist.
3. Choose Cancel when you are finished viewing the layout template.

Actions Button Options

- **New**: Choose this option to create a new layout template.
- **View/Edit**: Choose this option to view or edit an existing layout template.

**Note**: When you choose this option when the default template is selected, you have the option only to view the default template. You cannot edit the default template.
Asset Worksheet Parameters

- **Copy**: Choose this option to copy an existing layout template.
- **Rename**: Choose this option to rename an existing layout template.

  **Note**: You cannot rename the default template.

- **Delete**: Choose this option to delete an existing layout template.

  **Note**: You cannot delete the default template.

**Editing Layout Templates**

- **Required Fields**: When editing a layout template, you must ensure you include all required fields in the template. Otherwise, ADI will not be able to create your asset worksheet. Required fields are indicated by a red asterisk (*).

- **Directional Buttons**: Use the directional buttons to change the display sequence of fields in the header or body of your asset worksheet. First, select the field whose sequence will change. Then, choose one of the four directional buttons. The field description will move immediately.

- **Drag and Drop**: To move fields from the Available Fields region to the Header or Lines region, or to move fields between the Header and Lines regions, use your left mouse button to drag and drop fields to the proper location.

- **Right Mouse Button**: You can also access directional functions by clicking the right mouse button to move fields to different regions or within the same region.

**Create Worksheet in**

- **New Workbook**: Select this option to create your asset worksheet as a new Excel workbook.

- **Current Workbook**: Select this option to create your asset worksheet as a new worksheet within the current Excel workbook. This option is only available when you already have an Excel workbook open.

**See Also:**

Creating Asset Worksheets on page 9-2
Entering Data in Your Asset Worksheet

You can enter data in an asset worksheet manually or by importing it from a text file.

Entering Data Manually

To enter information manually, you simply type directly in the worksheet. Because you are in a spreadsheet environment, you can use Excel’s data entry functionality to drag and drop or copy and paste information. You can also use the list of values to select data from a drop down box.

See Also:
- Choosing Values from Lists on page 3-37
- Choosing Account Segment Values on page 3-38

Importing Data into Your Worksheet

You can import data from legacy systems or third party payables applications to your asset worksheet.

Once you have created a data file map using the Import Text File feature, you can save it and apply it to future conversion.

Notes

- For many of the fields on an asset worksheet, you can select from a list of values.
  
  See: Choosing Values from Lists on page 3-37.

- Choosing the View Context button will display or hide the asset worksheet context information at the top of the worksheet. Context information includes Corporate Book and Database.

- Choosing the View Header button will display or hide the asset worksheet header information, located just below the context information.

- ADI will automatically place a flag character in the Upload column for every asset entry. When you start the asset upload process, you can choose to process all rows or only the rows that are marked for upload.
Uploading Asset Data into Oracle Assets

Note: If you copy and paste an asset entry, ADI does not place a flag character in the Upload column for your new asset entry. You can manually enter one by placing your cursor in the upload column cell where you want the flag character, then typing any character or number from your keyboard.

See Also:
- Creating Asset Worksheets on page 9-2
- Asset Worksheet Parameters on page 9-3
- Import Text File Feature on page 11-1

Uploading Asset Data into Oracle Assets

After creating asset data in an asset worksheet, you must upload them to Oracle Assets. Uploading is a two-step process. First, you must upload your asset data to the interface table. Second, you must post the asset data from the interface table to Oracle Assets. Figure 9–1 illustrates this process:

Caution: The Create Assets feature interprets three adjoining blank rows in an asset worksheet as the end of the asset entry. Therefore, any lines that appear after three blank rows will be ignored when you upload your asset data.
Figure 9-1  Uploading Asset Data

Enter asset information into the asset worksheet.

Upload to interface.

Choose the Upload to interface button.

This action populates the interface table in Oracle Assets.

FA_MASS_ADDITIONS

Automatic Procedure
Submitted automatically if you choose the auto-submit option during asset upload

Manual Procedure
Choose the Submit Process button to start the Post Mass Additions process.
To upload asset data from an asset worksheet to the interface table:
1. While viewing your asset worksheet, choose the Upload to Interface button from the Assets toolbar.
2. Enter your Asset Upload Options.
   See: Asset Upload Options on page 9-11.
3. Choose OK to start the asset upload, or Cancel to abandon.
   For rows that do not upload successfully, ADI provides an explanation in the Messages section of the asset worksheet. If you selected Show Upload Success Indicator from the general options window, ADI will also display status indicators in the Messages section for each asset entry.

To post assets from the interface table to Oracle Assets:

   **Note:** When you post mass additions to Oracle Assets by choosing Submit Process > Post Mass Additions, this process will not submit the Mass Additions Posting Report. You need to submit this request separately.

2. Select the corporate depreciation book for which you want to post your mass additions.
3. Choose OK to submit your request, or Cancel to abandon.
See Also:

Asset Upload Options on page 9-11

Asset Upload Options

You can select from the following options to control uploading and importing:

- **Rows to Upload**: Controls which rows in the asset worksheet to upload. Select:
  - Flagged Rows — to upload only those rows that are marked with a flag character in the upload column of your worksheet.
  - All Rows — to upload all rows in your worksheet, regardless of whether changes have been made.

  **Note**: The Upload process validates all asset data, verifying field type and length. ADI also performs flexfield validation, cross-validation and segment security checking. In addition, ADI makes sure that required fields are entered when the asset status is set to POST. If the asset status is set to either ON HOLD or NEW, null entries in the required data fields are accepted.

- **Create Assets Now (Post)**: Check this box to start the Create Assets process and create assets automatically after the upload completes.

  **Note**: You can only check the Create Assets Now (Post) check box if you have also selected an asset status of POST. You cannot check this box if the asset entries have a status of ON HOLD or NEW.

If you choose to start the Create Assets process automatically, ADI will do the following after the upload completes:

- Submit your Create Assets request.
- Submit a concurrent request to monitor your Create Assets request.
- Display a window showing:
  - Number of errors in the upload to the interface table.
  - Post Mass Additions request ID.
-A message indicating that a concurrent request has been submitted for the Post Mass Additions request ID.

- **Asset Status:** Choose whether asset entries have a status of New, On Hold, or Post.

**See Also:**

- Import Text File Feature on page 11-1
- Submitting Processes on page 3-42
Record Physical Inventory Feature

The Record Physical Inventory feature provides a spreadsheet-based interface to simplify the physical inventory process. Use the Record Physical Inventory feature to automatically build personalized inventory spreadsheets based on the information required by your organization’s specific implementation of Oracle Assets. You can enter your inventory data manually, use the list of values, and take advantage of Excel’s data entry shortcuts. You can also map files created from scanned barcode data into the inventory worksheet. When you are satisfied with the worksheet, the Record Physical Inventory feature automatically uploads the data into Oracle Assets.

With the Record Physical Inventory feature, you can:

- Customize physical inventory worksheets.
- Use the powerful spreadsheet features of Excel.
- Save a physical inventory worksheet to a file, which can then be transferred to another PC for further changes, even while disconnected from your Oracle Assets database.
- Generate comparison reports to determine if assets are missing or in the wrong location

Prerequisites:
- Open a physical inventory in Oracle Assets
Ensure that the In Physical Inventory check box is checked for all assets in Oracle Assets that you want included when you run the Physical Inventory Comparison program.

See Also:
Creating Physical Inventory Worksheets
Physical Inventory Worksheet Parameters on page 10-3
Entering Data in Your Physical Inventory Worksheet on page 10-7
Uploading Physical Inventory Data into Oracle Assets on page 10-9
Physical Inventory Upload Options on page 10-12
Choosing Values from Lists on page 3-37
Choosing Account Segment Values on page 3-38
Physical Inventory, Oracle Assets User’s Guide

Creating Physical Inventory Worksheets

To create a physical inventory worksheet:
1. Choose the Assets button from the ADI toolbar.
2. Choose the Record Physical Inventory button from the Assets toolbar.
3. Enter your physical inventory worksheet parameters.
   See: Physical Inventory Worksheet Parameters on page 10-3.

4. Choose OK. ADI automatically creates your physical inventory worksheet.

❖ To create additional physical inventory worksheets in the same session:
   1. While viewing a physical inventory worksheet, choose the Record Physical
      Inventory button from the Assets toolbar.
   2. Enter your physical inventory worksheet parameters.
      See: Physical Inventory Worksheet Parameters on page 10-3.
   3. Choose OK. ADI automatically creates your physical inventory worksheet.

❖ To save a physical inventory worksheet to disk:
   1. Select File > Save As from the Excel menu.
   2. Enter a name and specify a path for the physical inventory worksheet file.
   3. Choose OK to save the file, or Cancel to abandon the operation.

❖ To open a saved physical inventory worksheet:
   1. Select File > Open from the Excel menu
   2. Select the path where the physical inventory worksheet is located. Excel will
      display the names of the files in a separate list.
   3. Choose the physical inventory worksheet name from the list of values.
   4. If ADI is installed, but not running, it will start automatically when you open
      the physical inventory worksheet.

Physical Inventory Worksheet Parameters

When you use the Record Physical Inventory feature to create a physical inventory
worksheet, you must specify certain parameters. Once you set these parameters,
ADI creates a physical inventory worksheet based on the parameters you provided.

There are three parameters you must set: physical inventory, layout template, and
worksheet options.
Select Physical Inventory

Select the physical inventory for which you want to run the Physical Inventory comparison.

Select Layout

Layout templates allow you to select the fields that should be included in the physical inventory worksheet. They also control the order in which the data fields appear on your worksheet.

You can create a new layout template, or edit, view, copy, rename, or delete an existing layout template.

You can make a layout template available to other users by checking the Public check box on the Edit Layout window.

To create a new layout template:

5. From the Record Physical Inventory window, choose the Actions button.
6. Choose the New option from the poplist.
7. Enter a name for the new layout template.

8. At the Edit Layout window, use the drag and drop functions and the directional buttons to arrange the fields on your layout template. Choose OK.

   See: Editing Layout Templates on page 10-6.

To customize an existing physical inventory layout template:

1. From the Record Physical Inventory window, select a layout to customize and choose the Actions button.

2. Choose the View/Edit option from the poplist.

3. At the Edit Layout window, edit the layout. Choose OK.

   See: Editing Layout Templates on page 10-6.

To copy an existing layout template:

1. From the Record Physical Inventory window, select a layout to copy. Choose the Actions button.

2. Choose the Copy option from the poplist.

3. Enter a unique name for the copied layout template. Choose OK.

To rename an existing layout template:

1. From the Record Physical Inventory window, select a layout to rename and choose the Actions button.

2. Choose the Rename option from the poplist.

3. Enter the new name of the layout template. Choose OK.

To delete an existing layout template:

1. From the Record Physical Inventory window, choose the layout template you want to delete.

2. Choose the Actions button.

3. Select the Delete option from the poplist.

4. Choose Yes to confirm that you want to delete the layout template.
To view an existing layout template:
1. From the Record Physical Inventory window, select a layout to view and choose the Actions button.
2. Choose the View/Edit option from the poplist.
3. Choose Cancel when you are finished viewing the layout template.

Actions Button Options

- **New**: Choose this option to create a new layout template.
- **View/Edit**: Choose this option to view or edit an existing layout template.

**Note**: When you choose this option when the default template is selected, you have the option only to view the default template. You cannot edit the default template.

- **Copy**: Choose this option to copy an existing layout template.
- **Rename**: Choose this option to rename an existing layout template.

**Note**: You cannot rename the default template.

- **Delete**: Choose this option to delete an existing layout template.

**Note**: You cannot delete the default template.

Editing Layout Templates

- **Required Fields**: When editing a layout template, you must ensure you include all required fields in the template. Otherwise, ADI will not be able to create your physical inventory worksheet.

Required fields are indicated by a red asterisk (*).

There are several fields that are conditionally required: Asset Number, Tag Number, and Serial Number. You must include at least one of these fields in your template. If one is included, the other two fields are optional.

Conditionally required fields are marked with a green asterisk (*).
Entering Data in Your Physical Inventory Worksheet

- **Directional Buttons:** Use the directional buttons to change the display sequence of fields in the header or body of your physical inventory worksheet. First, select the field whose sequence will change. Then, choose one of the four directional buttons. The field description will move immediately.

- **Drag and Drop:** To move fields from the Available Fields region to the Header or Lines region, or to move fields between the Header and Lines regions, use your left mouse button to drag and drop fields to the proper location.

- **Right Mouse Button:** You can also access directional functions by clicking the right mouse button to move fields to different regions or within the same region.

### Create Worksheet in

- **New Workbook:** Select this option to create your physical inventory worksheet as a new Excel workbook.

- **Current Workbook:** Select this option to create your physical inventory worksheet as a new worksheet within the current Excel workbook. This option is only available when you already have an Excel workbook open.

**See Also:**

- Creating Physical Inventory Worksheets

### Entering Data in Your Physical Inventory Worksheet

You can enter data in a physical inventory worksheet manually or by importing it from a text file.

#### Entering Data Manually

To enter information manually, you simply type the data directly into the data fields. Because you are in a spreadsheet environment, you can use Excel's data entry functionality to drag and drop or copy and paste data. You can also use the list of values to select data from a drop down box.

**See Also:**

- Choosing Values from Lists on page 3-37
- Choosing Account Segment Values on page 3-38
Entering Data in Your Physical Inventory Worksheet

Importing Data into Your Worksheet

You can import data from barcode scanner devices into your physical inventory worksheet.

Once you have created the map using the Import Text File feature, you can save it and apply it to future conversions.

Notes

- For many of the fields on a physical inventory worksheet, you can select from a list of values.
  
  See: Choosing Values from Lists on page 3-37.

- Choosing the View Context button will display or hide the physical inventory worksheet context information at the top of the worksheet. Context information includes Physical Inventory Name and database.

- Choosing the View Header button will display or hide the physical inventory worksheet header information, located just below the context information.

- ADI will automatically place a flag character in the Upload column for every physical inventory entry. When you start the physical inventory upload process, you can choose to process all rows or only the rows that are marked for upload.

  Note: If you copy and paste a physical inventory entry, ADI does not place a flag character in the Upload column for your new physical inventory entry. You can manually enter one by placing your cursor in the upload column cell where you want the flag character, then typing any character or number from your keyboard.

- The Record Physical Inventory feature interprets three adjoining blank rows in a physical inventory worksheet as the end of the physical inventory entry. Therefore, any information that appears after three blank rows will be ignored when you upload your physical inventory data.

See Also:

Import Text File Feature on page 11-1
Uploading Physical Inventory Data into Oracle Assets

After creating physical inventory data in a physical inventory worksheet, you must upload them to Oracle Assets. Figure 10–1 illustrates this process:

**Note:** The Record Physical Inventory feature interprets three adjoining blank rows in a physical inventory worksheet as the end of the physical inventory entry. Therefore, any lines that appear after three blank rows will be ignored when you upload your physical inventory data.
Figure 10–1  Uploading Physical Inventory Data

This section populates the interface table in Oracle Assets.
To upload physical inventory data from a physical inventory worksheet to the interface table:

1. While viewing your physical inventory worksheet, choose the Upload to Interface button from the Assets toolbar.
2. Enter your Physical Inventory Upload Options.
   See: Physical Inventory Upload Options on page 10-12.
3. Choose OK to start the physical inventory upload, or Cancel to abandon.
   For rows that do not upload successfully, the system provides an explanation in the Messages section of the physical inventory worksheet. If you selected Show Upload Success Indicator from the general options window, the system will also display status indicators in the Messages section for each physical inventory entry.

To import physical inventory data from the interface table to Oracle Assets:

1. Choose Submit Process > Compare Physical Inventory from the toolbar.
2. Enter your Select Process Type options.
3. Choose OK to submit your request, or Cancel to abandon.

See Also:

Physical Inventory Upload Options on page 10-12
Choosing Values from Lists on page 3-37
Physical Inventory Upload Options

You can select from the following options to control uploading and importing:

- **Rows to Upload**: Controls which rows in the physical inventory worksheet to upload. Select:
  - Flagged Rows — to upload only those rows that are marked with a flag character in the upload column of your worksheet.
  - All Rows — to upload all rows in your worksheet, regardless of whether changes have been made.

ADI validates all physical inventory data, including field length and type, required fields, and flexfields.

- **Duplicate Assets**: Determines what action ADI will take when the Upload process detects older rows containing duplicate values already in the Physical Inventory Interface table.
  - Do Not Upload — ADI will not upload the physical inventory worksheet rows. An error message will be displayed on the worksheet indicating which rows did not upload successfully.
  - Increment Units — ADI will add the units in the physical inventory worksheet row to the corresponding entry already in the interface table.
  - Replace Units — ADI will replace the entries in the interface table with the new rows in the physical inventory worksheet.

- **Run Comparison**: Check this box to start the Physical Inventory Comparison process automatically after the upload completes.

  If you choose to start the Physical Inventory Comparison process automatically, the system will do the following after the upload completes:
  - Submit your Physical Inventory Comparison request.
  - Submit a concurrent request to monitor your Physical Inventory Comparison request.
  - Display a window showing:
    - Number of errors in the upload to the interface table.
- Physical Inventory Comparison Request ID.
- A message indicating that a concurrent request has been submitted for the Physical Inventory Comparison Process Request ID.

- **View Comparison:** Check this box to automatically run the Physical Inventory Comparison Report when you upload the physical inventory data.

**See Also:**

[Submitting Processes](#) on page 3-42
Import Text File Feature

The Import Text File feature allows you to import data from legacy systems, third party payables applications, barcode scanners, or any other flat data file sources, to your worksheet. Using the Import Text File feature, you can map fields in your source file to fields in your worksheet. Once you have created the map using the Import Text File feature, you can save it and apply it to future conversions.

Prerequisites:
- Create an asset or inventory worksheet in which you will import data.

See Also:
- Importing Data into a Worksheet on page 11-1
- Import Text File Parameters on page 11-2

Importing Data into a Worksheet

To import data into your worksheet:

1. Open the asset or physical inventory worksheet to which you are mapping data.
2. Choose the Assets button from the ADI toolbar.
3. Choose Import Text File from the Assets toolbar.
4. Enter your Import Text File parameters.
Import Text File Parameters

When you import a text file into an asset or physical inventory worksheet, you must specify certain parameters. Once you set these parameters, ADI imports the text file based on the parameters you provided.

There are three parameters you must set: source file, delimiter, and mapping template.

Choose Source File

Choose the source file from which you want to import data into your asset or physical inventory worksheet.

Check the First Row Contains Field Names check box to indicate that the first row of your data file contains header information.

Delimiter

Choose the delimiter used to separate data fields in your data file. Choose either Tab, Comma, Semicolon, or Other. If you choose Other, enter the delimiter used in your data file.

Mapping Templates

Mapping templates allow you to map data in a text file to the fields on your asset or inventory worksheets.

You can create a new mapping template, or edit, view, copy, rename, or delete an existing mapping template.

You can make a mapping template available to other users by checking the Public check box on the Mapping window.
To create a new mapping template:
1. From the Import Assets Text File window, choose the Actions button.
2. Choose the New option from the poplist.
3. Enter a name for the new mapping template.
4. At the Edit window, use the drag and drop functions and the directional buttons to arrange the fields on your mapping template. Choose OK.

See: Editing Mapping Templates on page 11-5.

To customize an existing mapping template:
1. From the Import Assets Text File window, select a mapping template to customize and choose the Actions button.
2. Choose the View/Edit option from the poplist.
3. At the Mapping window, edit the layout. Choose OK.

See: Editing Mapping Templates on page 11-5.
To copy an existing mapping template:
1. From the Import Assets Text File window, select a template to copy. Choose the Actions button.
2. Choose the Copy option from the poplist.
3. Enter a unique name for the copied mapping template. Choose OK.

To rename an existing mapping template:
1. From the Import Assets Text File window, select a mapping template to rename and choose the Actions button.
2. Choose the Rename option from the poplist.
3. Enter the new name of the mapping template. Choose OK.

To delete an existing mapping template:
1. From the Import Assets Text File window, choose the mapping template you want to delete.
2. Choose the Actions button.
3. Select the Delete option from the poplist.
4. Choose Yes to confirm that you want to delete the mapping template.

To view an existing mapping template:
1. From the Import Assets Text File window, select a mapping template to view and choose the Actions button.
2. Choose the View/Edit option from the poplist.
3. Choose Cancel when you are finished viewing the mapping template.

## Actions Button Options

- **New**: Choose this option to create a new mapping template.
- **View/Edit**: Choose this option to view or edit an existing mapping template.

**Note:** When you choose this option when the default template is selected, you have the option only to view the default template. You cannot edit the default template.
When you choose this option when the default template is selected, you have the option only to view the default template. You cannot edit the default template.

- **Copy**: Choose this option to copy an existing mapping template.
- **Rename**: Choose this option to rename an existing mapping template.

**Note**: You cannot rename the default template.

- **Delete**: Choose this option to delete an existing mapping template.

**Note**: You cannot delete the default template.

---

**Editing Mapping Templates**

You can use either the directional buttons or the drag and drop feature to move fields from the Import File Fields region to the corresponding field in the Excel Spreadsheet Fields region.
Import Text File Parameters

See Also:

- Creating Asset Worksheets on page 9-2
- Creating Physical Inventory Worksheets on page 10-2
The Request Center

Use the Request Center as a centralized tool for submitting, monitoring, and publishing your reports. With the Request Center, you can:

**Submit Reports:** You can submit Standard (Fixed Format), Standard (Variable Format), or Financial Statement reports from the Request Center. You can also schedule your reports to run at specific times and intervals using Oracle Application’s standard request submission features.

**Publish Report or Request Sets:** Publish a set of reports, Standard Reports, or Financial Reports you frequently use from Oracle General Ledger and Oracle Assets. Use the Request Center to process all reports in your Request Set based on the themes, submission, and publishing options you apply to each report.

**View Requests:** Retrieve request submission details or logs and view them in your preferred text viewer.

**Cancel Requests:** You can cancel any pending requests you submitted from your responsibility.

**Format Reports:** Use report themes to format report output. You can create new themes or customize existing themes and apply their formatting to reports you create.

**Publish Reports:** Publish your reports to a spreadsheet, text file, or to web pages stored on a local server or remote database.

**View or Print Reports:** View your reports from a spreadsheet, text viewer or web browser. Reports you publish to a database can be accessed via Oracle Self Service
Web Applications or the Report Manager Kiosk and access governed by security models.

**Monitor Requests:** Monitor specific requests and receive automatic notification when they have completed.

**Sign On/Off:** Sign on to or disconnect from applications databases. You can change your responsibility from within the Request Center.

**Launch Other Products:** You can launch ADI and other Oracle Applications directly from the Request Center toolbar.

▶ **To start the Request Center:**
1. Choose Programs > Oracle ADI > Request Center from the Start menu.
2. Sign on to a database, using your Oracle Applications username and password.

**See Also:**
The Request Center Toolbar on page 12-2
Setting Request Center Options on page 12-5
Submitting Reports on page 12-8
Formatting Report Output on page 12-33

---

**The Request Center Toolbar**

From the Request Center toolbar, you can access all of Request Center’s features for submitting, monitoring, and publishing your reports.

*Submit Report:* Submit standard or FSG reports to be run on your server.
Show Request Details: Show submission details, such as phase, status, and request date, for a selected request.

Cancel Request: Cancel a concurrent request.

View Output/Log: Download a selected request report output or log file and view it in the default output viewer that you select on the Request Center options window.

Format Report Output: Set the formatting options for your report output. You can also select from predefined report themes or define your own.

Publish Output: Download and publish a selected request’s report output to a web page, Excel worksheet, text viewer, or into the database.

Publish Report and Request Sets: Publish Report and Request sets generated by your Oracle Application. You can assign publishing options to all the reports in your set and save these options to use again.

Report Manager Tools: Activate the Report Manager toolbar.

Print Output/Log: Download a selected request’s report output or log file and print it.

Monitor Request: Select a request to monitor. The request is added to the Pending or Completed tab in the Request Center window, depending on the request status.
The Request Center Toolbar

Add Request to Hotlist: Place a completed request in a special hotlist holding area so you can review it later. Deleting requests from the Completed tab of the Request Center window will not affect the entries in the hotlist.

Stop Monitoring Selected Request: Remove a selected request from either the Pending, Completed, or Hotlist tabs of the Request Center window.

Stop Monitoring All Requests: Remove all requests from either the Pending, Completed, or Hotlist tabs of the Request Center window.

Signon: Sign on to an Oracle Applications database. You must sign on before you can monitor requests for a specific database. All databases to which you are signed on are shown in the Databases tab of the Request Center window.

Disconnect: Disconnect from the selected Oracle Applications database.

Change Responsibility: Choose a different responsibility once you’ve signed on to your chosen database. If ADI is running and you change your responsibility from within the Request Center, you do not need to change the ADI responsibility.

Applications Desktop Integrator: Start Applications Desktop Integrator, if it is installed on your PC.

Oracle Applications: Start Oracle Applications. When you select this button, you are asked to select an applications database. If you select the same database you are using for your Request Center session, you do not have to enter your username and password in Oracle Applications.

Options: Set the Request Center options.
Setting Request Center Options

You can set various Request Center options by choosing the Options button from the Request Center toolbar. From the Options window, you can set Limits, toolbar Icon Size, Sounds, and the default Output Viewer. You can also define default print settings and change the language options.
### Setting Request Center Options

**Update Every** — This is the interval, in seconds, that the Request Center waits between queries it makes to the server while monitoring requests. For example, if you set the interval to 60, the system checks every 60 seconds to see if your request has completed processing.

**Query Last** — Determines how many requests are retrieved in the Select Request to Monitor window when you choose the Query button.

**Flash Notification** — The number of times the Request Center title bar flashes when a request completes.

**Display** — You can limit which Oracle Applications' requests are monitored by the Request Center by selecting the application name from the poplist. If you select All, you can monitor requests from all installed Oracle Applications.

**Sounds** — See: [Specifying a Sound File for Request Completion](#) on page 12-7.

**Output Viewer** — Select the program you want to use to view report output or request logs whenever you choose the View Output/Log button from the Request Center toolbar. You can enter the path and program name directly, or choose the Find button to search your computer for the program you want.

**Printer Settings** — Choose the Printer Settings button to specify a default font to use when printing reports to a local printer.

See: [Specifying Your Printer Settings](#) on page 12-31.
Specifying a Sound File for Request Completion

Language Options — Choose the Language Options button to change the language that the Request Center uses in windows, menus, and tool tips.

See: Language Options on page 3-32.

See Also:
The Request Center Toolbar on page 12-2
Monitoring Requests on page 12-51
Specifying a Sound File for Request Completion on page 12-7

Specifying a Sound File for Request Completion

You can have the Request Center give you an audible alert when a request finishes processing. You do this by defining a sound (WAV) file the system plays when a request completes processing. You can also specify a sound file to be played when an error occurs.

Note: When you install Applications Desktop Integrator, some sound files are added to either the Orant\GLD190\Sounds or Orawin95\GLD190\Sounds directory on your PC. You can use one of these sound files or provide your own.

To specify a sound file:
1. Choose the Options button from the Request Center toolbar.
2. Check the Play Sound When Request Completes check box.
3. Choose the Find button for the Normal field.
4. From the Choose Sound File window, select the drive, directory, and filename for your sound file.

Note: You can use the Files of Type list to reduce the number of files that are displayed in the filename list. Select a file type from the list.

5. Choose OK.
Submitting Reports

6. (Optional) Choose the Test button to hear the sound you selected.
7. Choose OK to save your selection.

To specify a sound file to play when errors occur:
1. Choose the Options button from the Request Center toolbar.
2. Check the Play Sound When Request Completes check box.
3. Choose the Find button for the Error field.
4. Select the drive, directory, and filename for your sound file.
5. Choose OK.
6. (Optional) Choose the Test button to hear the sound you selected.
7. Choose OK to save your selection.

See Also:
The Request Center Toolbar on page 12-2
Setting Request Center Options on page 12-5
Monitoring Requests on page 12-51

Submitting Reports

You can submit the following types of reports by choosing the Submit button from the Request Center toolbar:

- Standard (Fixed Format): You can submit any of the standard reports that are available in Oracle Applications, if they are available to your responsibility.
- Standard (Variable Format): You can submit any standard (variable format) report for Oracle Assets if your responsibility allows.
- Financial Statement: You can submit any financial statement reports (FSG) that have been defined, if your responsibility allows you to access the reports.
- Ad Hoc: You can define and submit an ad hoc report.
- RXi Reports: Submit RXi reports with attribute sets defined in Oracle Applications.
To submit a Standard (Fixed Format) report:


2. Select Standard (Fixed Format) as the Report Type.

3. (Optional) Mark the Publish Report check box if you want the report to be published automatically after it finishes running. The Request Center publishes the report using the options you specify in step 7.

   **Note:** If you do not check the Publish Report check box, the Publishing button is not available. To set the publishing options and publish the report, you must do so manually.


4. Choose the Submission button to display the standard report submission parameters.
5. From the poplist, select the standard report you want to run. Optionally, choose the Find button to query a report name.

6. Enter your standard report parameters in the region below the poplist.

---

**Additional Information:** See the related Oracle application’s user’s guide for details about each report’s parameters. For example, see Running Standard Reports and Listings (*Oracle General Ledger User’s Guide*) for a further description of General Ledger report parameters.

---

7. (Optional) Choose the Publishing button to set your report publishing options.

8. (Optional) Choose the Options button to set your report submission options.

9. Choose OK to submit your request, or Cancel to abandon. Alternatively, if you want to run additional reports, choose Submit to submit your request.

**To submit a Standard (Variable Format) report:**

1. Make sure you are signed on with a responsibility that includes access to Oracle General Ledger, Receivables, or Assets data. You can change your responsibility from the Request Center or ADI toolbars.


3. Select Standard (Variable Format) as the Report Type.

4. Mark the Publish Report check box. The Request Center will publish the report using the options you specify in steps 9-11.

5. Choose your report from the Report poplist.

6. Choose the Submission button to display the variable report submission parameters.

7. Complete your submission parameters.


9. Choose an attribute set from the Apply Attribute Set poplist.
See: Attribute Sets on page 12-21.

10. Set your other report publishing options.


11. (Optional) Choose the Options button to set your report submission options.


12. Choose OK to submit your request, or Cancel to abandon. Alternatively, if you want to run additional reports, choose Submit to submit your request.

To submit a Financial Statement or Ad Hoc report:


2. Select Financial Statement as the Report Type.

3. (Optional) Mark the Publish Report check box if you want the report to be automatically published after it finishes running. The Request Center publishes the report using the options you specify in step 8.
4. Choose the Submission button to display the FSG submission parameters.

5. You can select a report from the Existing Report poplist or choose the Find button to query a report name.
   To create an ad hoc report, leave the Existing Report field blank and choose the Select Components button.


7. Enter or select your other report parameters, including Period, Date, Content Set, Segment Override, Rounding Option, Currency, and Exceptions Only.

   **Suggestion:** If you run an existing report that already has a content set defined, you can override the original content set by specifying a new one when you submit the report.

8. (Optional) Choose the Publishing button to set your report publishing options.

   **Note:** When publishing to a spreadsheet, the column set in the report must be <= 255 columns.

9. (Optional) Choose the Options button to set your report submission options.

10. Choose OK to submit your request, or Cancel to abandon. Alternatively, if you want to run additional reports, choose the Submit button to submit your request.
When you submit a request, you receive a message containing the Request ID number. The request ID number is listed on the Pending and Completed tabs of the Request Center.

Locate your request by choosing the Pending or Completed tabs in the Request Center. Each tab lists reports by:

- Request ID number
- Financial report name under the column Program Name
- Program name under the column Program Name (for Standard (Fixed Format) and Standard (Variable Format) reports)

See Also:

Ad Hoc Report Components on page 12-13
Setting Report Publishing Options on page 12-18
Setting Report Submission Options on page 12-30
Formatting Report Output on page 12-33
Monitoring Requests on page 12-51

Ad Hoc Report Components

Before you can submit an ad hoc report from the Report Submission and Publishing window, you must specify the report objects you want to use to create the report.

To specify report objects for an ad hoc report:

1. From the Report Submission and Publishing window, choose the Select Components button.
The Select Ad Hoc Report Components window appears.

2. Select your required report objects from the Row Set and Column Set poplists.

   **Note:** When publishing to a spreadsheet, the column set in the report must be <= 255 columns.

3. (Optional) Select any additional report objects from the Content Set, Row Order, and Display Set poplists.

4. Choose OK to save your work and return to the Report Submission and Publishing window.

5. Complete the report submission process.

   See: Submitting Reports on page 12-8.

**See Also:**

- Overview of the Financial Statement Generator, *Oracle General Ledger User’s Guide*
- Deleting Ad Hoc Reports, *Oracle General Ledger User’s Guide*
- Defining Ad Hoc Reports, *Oracle General Ledger User’s Guide*

**Request Sets**

You can submit Report Sets and Request Sets from your standard application. Submit Sets to group reports you frequently need, such as reports you rely on for month end closing.

- Reports Sets: support FSG reports submitted from Oracle General Ledger
- Request Sets: support Financial and Standard reports submitted from any Oracle Application, such as Oracle General Ledger, Assets, Receivables, or Payables.

For each report in your Set, you can apply formatting and publishing options. You can save these options in a template to use again.

**See Also:**

- *Oracle Applications User’s Guide*
- *Oracle General Ledger User’s Guide*
Oracle Assets User’s Guide

To publish a Report or Request Set:

1. Submit a Report or Request Set from your standard Oracle Application, Oracle General Ledger or Oracle Assets. Note the Request ID.

2. Navigate to the Request Center.

3. Choose the Submit and Publish Sets button from the toolbar.

   The Submit and Publish Sets window appears.

4. Choose the Publish button.

   The Publish - Select a Set window appears.

5. Select from the Financial Reports listed or query the report you want to publish. Choose OK.

   The Select Publishing Options for (your Set) appears. All the reports and their publishing options for your Set are listed.
6. Check the check box for each report you want to publish in the set.

**Note:** You can use the Publish all or Publish none buttons to enable or disable publishing for all the reports in your set.

7. Place your cursor in the Publishing Options column on the same row as your report. Double click or choose the Publishing (P) button.

The Publishing Options window appears.

8. Apply Themes and Request Center publishing options to your report.

9. Define publishing options for all other reports in your set.

10. If you do not like the default template name for your set, change the name in the Publishing Template field.

11. Choose OK.

The reports in your Set will be published and your publishing options will be saved under the template name you defined.
To change publishing options for a defined template:

1. Navigate to the Submit and Publish Sets window.
2. Choose the Define button.
   
   The Define-Select a Set window appears. The 100 most recent sets are listed in the Financial Report and Standard Request Sets regions of the window.
3. Select a set and choose OK or double-click on a set.
   
   The Select Publishing Options for <your set name> appears. The reports in your set appear in this window along with the last publishing options you defined for each report.
4. Select a report for which you want to change publishing options. Place your cursor in the Publishing Options column on the same row as your report. Double click or choose the Publishing (P) button.
   
   The Select Publishing Options for <your report name> window appears.
5. Change the publishing options for your report and choose OK.
6. Change the publishing options for any other reports in your set.
7. Choose OK to update your template with the new changes. To create a new template, enter a new template name in the Publishing Template field before you choose OK.
8. Your publishing options are saved. You are returned to the Request Center.

**RXi Reports**

You can submit any RXi Report defined in Oracle Applications from the Request Center. The Request Center will monitor the submission and publication of your report. Formatting attributes and publishing parameters are defined in Oracle...
Applications and applied to your report. In addition, security rules, defined in Oracle Applications, are extended to users submitting RXi reports from the Request Center.

Standard Request Center formatting and publishing options, such as report themes and output types, cannot be applied to RXi reports from the Request Center.

**Prerequisites:**
Create RXi reports in Oracle Applications with applied attribute sets and publishing parameters.

**To submit an RXi report:**
2. In the Submission Tab, choose the Standard Report radio button.
3. From the poplist, choose the RXi report you want to publish.
4. Formatting and publishing options will automatically be assigned by the Request Center. You can choose the Publishing and Options buttons to review how formatting and publishing options were applied in Oracle Applications. These options cannot be changed.
5. Choose OK to submit your RXi report. The Request Center will monitor the submission and publication of your RXi report.

**See Also:**
*Oracle Financials RXi Report Administration Tool User’s Guide*

### Setting Report Publishing Options

You can publish your report output to web pages, a spreadsheet, a text file, or into a database. You can also choose to have the report automatically published after your request completes processing. Report requests listed on the Request Center’s Completed or Hotlist tabs can be manually published.

**To publish report output automatically:**
1. When you are submitting the report from the Report Submission and Publishing window, check the Publish Report check box.

See: *Submitting Reports* on page 12-8.
2. Check the Prompt check box to have the system ask you before it publishes the report. If this check box is clear, your report publishes automatically.

3. Choose the Publishing button.

4. From the Apply Themes poplist, select the report theme you want to use for the published report.

Note: If you republish a financial report, the Request Center applies the last theme you used to your republished financial report output. You can choose a different theme from the Apply Themes poplist.

See: Formatting Report Output on page 12-33.

5. Select the Output Type for your report:
   
   **Local Web Page:** Publish your report output to web pages on a local drive.
   
   **Spreadsheet:** Publish your report output to an Excel spreadsheet.
   
   **Text:** Publish your report output to a text file.
   
   **Database Web Page:** Publish your report output to web pages stored in the database.
   
6. Complete the publishing options for the Output Type you selected in the previous step. See:

7. Complete the publishing options for the Output Type you selected in the previous step
   
   **Local Web Page Options** on page 12-23
   
   **Spreadsheet Options** on page 12-26
   
   **Text Options** on page 12-29
   
   Publishing Reports to the Database, *Report Manager Users Guide*
8. Complete the report submission process.
   See: Submitting Reports on page 12-8.

To publish report output manually:
1. Select the report from the Request Center Completed or Hotlist tabs.

   Note: To publish a financial report that was submitted from Oracle General Ledger, the Output Option on the Define Financial Report window in Oracle General Ledger must be set to Spreadsheet.

2. Choose the Publish Output button from the Request Center toolbar.

3. From the Apply Themes poplist, select the report theme you want to use for the published report.

   Note: If you republish a financial report, the Request Center applies the last theme you used to your republished financial report output. You can choose a different theme from the Apply Themes poplist.

4. Select the Output Type for your report.

5. Complete the appropriate publishing options for the Output Type you selected in the previous step.

6. Choose OK to publish the report or Cancel to abandon.
The Request Center Messages window appears informing you your report has been published.

**Attribute Sets**

Use attribute sets to arrange information for Oracle General Ledger, Accounts Receivable, and Asset reports using the Standard (Variable Format) report type. You can access attribute sets by choosing the report type, Standard (Variable Format), and choosing the Publishing button in the Report Submission and Publishing window.
To work with an attribute set:

1. Choose one of the following actions:

   New: To create a new attribute set, choose the Actions Button and select New.

   View or Edit: To view or edit an existing attribute set, select an attribute set
   from the Apply Attribute Set poplist. Choose the Actions Button and select
   View/Edit.

   Copy or Rename: To copy or rename an attribute set, select an attribute set from
   the Apply Attribute Set poplist. Choose the Actions Button and select Copy or
   Rename.

   Suggestion: You can copy or rename the default attribute set as a
   base template to create a new attribute set.

   Delete: To delete an attribute set, select an attribute set from the Apply
   Attribute Set window. Choose the Actions button and select Delete.
2. Name your attribute set in the window that appears following your selection:
   - **New**: New Attribute Set window.
   - **Copy**: Copy Attribute Set window.
   - **Rename**: Rename Attribute Set window.

3. Drag and drop from the list of Available Attributes to the Selected Attributes grid to create your own attribute set, OR
   - Use the Add and Delete buttons to move or delete available attributes to and from the Selected Attributes grid.

4. Apply sorting and group characteristics to attributes in a column by using the Ascending, Descending, and Group By buttons.

5. Move columns within the Selected Attributes grid to specify the order in which they should appear in your report.

6. Save your work.

**Local Web Page Options**

You can publish your reports in HTML so that others can access them by web browser. Local Web Page reports are automatically stored on a local drive you specify. If you used content sets when you defined your reports, you can create a
published web report that contains a separate directory frame with navigation links adjacent to the report output.

Background colors you specify in a report theme are automatically applied to web published reports.

**Suggestion:** If you use content sets in your report definition and you want to publish to the web, use Link Reports and Separate Directories together to create meaningful web reports.

Set the following options if you choose Local Web Page as your Output Type when publishing a report.

**Publish To:** Enter a path and filename for the web page that ADI creates. Optionally, press the Find button to locate the directory you want.

**Note:** If a Publish To value has been defined in the theme you’ve chosen, it overrides any value you enter now.
Launch Browser: When the report output is complete, ADI starts your browser software, downloads the report, and displays it in your browser if this box is checked.

Include Spreadsheet: Check this box to download both web page and spreadsheet output. When you view the report in your browser, there is a link you can choose to retrieve the spreadsheet version of the report. This option only appears for FSG and Ad Hoc reports.

Include Text (Plain) File: Check this box to download both web page and text output. When you view the report in your browser, there is a link you can choose to retrieve the text version of the report.

Note: This option only appears for standard reports.

Include Printable Copy: Check this box to download a web-based version of the report that is suitable for printing. When you view the report in your browser, there is a link you can choose to display the printable version of the report.

Note: This option only appears for standard reports.

If you use content sets in your report definition, use the following together to create meaningful web reports:

Link Reports: If you used a content set when you defined your report, you can check the Link Reports check box to include links to the separate report pages.

Note: Link Reports influences the appearance of your web reports. If you do not check the Link Reports check box, your web report appears within a single frame.

If you check the Link Report check box, ADI creates a separate frame which contains navigation entries to all the report files created by ADI.

Separate Directories: If you used a content set when you defined your report, check the Separate Directories check box to save each report page to distinct subdirectories of the Publish To directory. You may want to create distinct directories for each report for security reasons. You cannot define security access for files but you can define security access for directories.
Spreadsheet Options

Set the following options if you choose Spreadsheet as your Output Type when publishing a report.
New Workbook: The report is published to a new Excel workbook using the theme you selected in the Apply Theme poplist.

Current Workbook: The report is published to the currently active Excel workbook. You can choose:

Add Output: To create the report as a new worksheet.

Replace Output: To overwrite an existing worksheet.

Apply Formatting: Leave this check box blank if you want your report to use the same theme as the report you are replacing. Check this box if you want to apply the theme specified in the Apply Theme poplist.

If you want to create a worksheet with no formatting, choose the nocolor.xls theme from the Apply Theme poplist.
## Setting Report Publishing Options

### How Will a Report Output Worksheet Be Formatted? (Standard Reports: Standard (Variable Reports))

<table>
<thead>
<tr>
<th>Spreadsheet Option:</th>
<th>New Workbook</th>
<th>Current Workbook</th>
<th>Current Workbook</th>
<th>Current Workbook</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Add Output</td>
<td>Replace Output</td>
<td>Apply Formatting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Output 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### First report output worksheet in the workbook
- If the specified theme contains a formatted report output worksheet:
  - Applies background formatting and uses logo from specified report theme
- If the specified theme is missing or does not contain a report output worksheet:
  - No background formatting applied. Uses logo from Theme Defaults tab of ADI options, only if the logo is in BMP format

### Newest report output worksheet in the workbook
- If the specified theme contains a formatted report output worksheet:
  - Applies background formatting and uses logo from specified report theme
- If the specified theme is missing or does not contain a report output worksheet:
  - No background formatting applied. Uses logo from Theme Defaults tab of ADI options, only if the logo is in BMP format

#### FSG or Ad Hoc Reports

<table>
<thead>
<tr>
<th>Spreadsheet Option:</th>
<th>New Workbook</th>
<th>Current Workbook</th>
<th>Current Workbook</th>
<th>Current Workbook</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Add Output</td>
<td>Replace Output</td>
<td>Apply Formatting</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Output 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### First report output worksheet in the workbook
- If the specified theme contains a formatted report output worksheet:
  - Applies formatting specified on the Theme Defaults tab of ADI options
- If the specified theme is missing or does not contain a report output worksheet:
  - Applies default formatting specified on the Theme Defaults tab of ADI options

#### Newest report output worksheet in the workbook
- If the specified theme contains a formatted report output worksheet:
  - Applies default formatting specified on the Theme Defaults tab of ADI options
- If the specified theme is missing or does not contain a report output worksheet:
  - Applies default formatting specified on the Theme Defaults tab of ADI options

---

12-28 Oracle Applications Desktop Integrator
Text Options

Set the following options if you choose Text as your Output Type when publishing a report.

**Publish To:** Enter a path and filename for the text file that the Request Center will create. Optionally, press the Find button to locate the directory you want.

**Launch Viewer:** When the report output is complete, the Request Center starts your specified output viewer, downloads the report, and displays it if this box is checked.

**See Also:**
- Using Report Output Themes on page 12-33
- Setting Report Submission Options on page 12-30
- Submitting Reports on page 12-8
- Formatting Report Output on page 12-33
- Monitoring Requests on page 12-51
Setting Report Submission Options

When you submit a report for processing, you can set the Oracle Applications request submission options. You can schedule the report to be processed at a specific time on a specific date. You can also choose to print your report to a local or network printer, and you can specify the number of copies to print.

To set the report submission options:
1. From the Report Submission and Publishing window, choose the Options button.
2. Enter the Date and Time you want to submit your report. Alternatively, choose the Set Date/Time button to use the graphical Calendar window to select a date and time.
3. Check the Local Printer check box and select the printer name if you want to print your report to your local printer.

4. Check the Server Printer check box and select the printer name if you want to print your report to one of your organization’s network printers. Enter the number of Copies of the report you want to print.

5. Complete the report submission process.

See Also:

Setting Report Submission Options on page 12-30

Submitting Reports on page 12-8

Specifying Your Printer Settings

You can specify a default font to use when printing reports to a local printer, rather than to a network printer. You can also choose to put a border around the page.
1. To specify your local printer settings:

2. Choose the Options button from the Request Center toolbar.

3. Choose the Print Settings button.

4. From the list of values, choose the Font to use for your locally printed reports.

5. Specify the font Size.

6. Check the Bold and/or Italic check boxes if you want your report to be printed in bold, italic, or bold and italic text.

7. Check the Page border check box if you want a border placed around the outside edge of each page of your report.

8. Choose OK to save your work.

**See Also:**

- Setting Report Publishing Options on page 12-18
- The Request Center Toolbar on page 12-2
- Setting Request Center Options on page 12-5
Using Report Output Themes

Formatting Report Output

To format your report output, you can apply themes to any report request you submit through the Request Center. You create new themes or customize existing themes in a spreadsheet environment using a combination of ADI and Excel formatting features. You can define fonts, font styles, and sizes, report backgrounds and colors, add a corporate logo to your report, and more.

You can fine tune your themes by using tokens and cell level formatting to control the appearance of your report output down to the cell level.

See Also:

General Options on page 3-19

Using Report Output Themes

You can define specific report formatting options, then save them as a report output theme. Once saved, you can apply the theme to any report output that you download into Excel or publish as a web page. You can also edit themes and create new ones.

➢ To apply a report theme to your report output:

When you submit the report from the Report Submission and Publishing window or publish a report using Request Center’s Publish Output button, enter the path and name of the theme you want to use in the Apply Theme field.


➢ To change the current theme:

When you republish a report, the Request Center automatically applies the last theme you applied to your report type.

Republish your report by choosing the Publish Output button from the Request Center toolbar. Make sure you change the system selected theme.

Suggestion: When you change the theme of a spreadsheet-based report, use the Replace Output feature. Otherwise, you will get two copies of the same report, but with different formatting.
To create a theme:


2. Choose the Create button. Choose from the following report types in the window that appears:
   - Financial Statement
   - Standard (Fixed Format)
   - Standard (Variable Format)

3. ADI creates a theme worksheet using the options specified on the New Theme Tab of General Ledger Options window.
   - See: General Options on page 3-19, Theme Defaults Tab.

4. Customize the theme worksheet, as described in the next task.

5. Save your theme by choosing File > Save As from the Excel menu.

Suggestion: Choose any of the light bulb icons from the Report Output Themes window to display helpful tips about creating or customizing themes.
Customizing Themes for Financial Reports

Suggestion: Store all of your themes in the same directory on your PC. This makes it easier to find them. Also, if you have a lot of themes, group them in subdirectories under your main themes directory.

Customizing Themes for Standard (Fixed Format) Reports
You can customize themes for Standard (Fixed Format) reports for:

- Background - choose the Background button in the Report Output Themes window to use a background for any report you create with this report theme.
- Logo - insert a logo into your report themes by selecting a cell and choosing Insert > Picture from the Excel menu.
- Column Width - format the column widths in your theme using Excel's formatting capabilities.

Customizing Themes for Financial Reports
You have many formatting options to control the appearance of your Standard (Fixed Format) reports and Financial reports.

To customize a theme for a Standard (Fixed Format) report or a Financial Report:
1. From the Report Output Themes window, choose the Open Theme button to open the theme you want to customize. Alternatively, create a new theme as described above.
2. Choose the Customize button. From the menu that appears, select the report output feature whose formatting you want to change.
   You can change the formatting of the Report Title, Report Heading, Column Headings, Line Items, and Amounts.
   The Format Cells window opens.
3. Define your formatting choices within each tab of the Format Cells window.
Customizing Themes for Financial Reports

Note: The Format Cells window is part of Excel’s standard functionality. Please refer to your Excel reference manual or Excel’s online help for more information on formatting cells.

Warning: Cell level formatting and formatting with tokens will override the General formats you establish using customize themes.

4. Choose OK to save your changes, then choose OK to close the Style window.

5. Repeat steps 2 through 4 above for each report output feature you want to customize in this theme.

Caution: Make sure you close the Style window in step 4 before you change the formatting for other report output features. If you don’t close the Style window, you may lose the formatting changes you’ve already made.

6. (Optional) As desired, insert pictures into your theme by selecting Insert Picture from the Excel menu.

Additional Information: The Request Center cannot extract the names of embedded images from a theme that is used to publish report output to the Web. Instead, the Request Center looks in the theme directory for a GIF or JPEG file with the same name as the theme. If it finds a matching GIF or JPEG file, the Request Center displays the image at the top of each report page. The picture’s alignment is the same as the image in your theme. Only this one picture is included in your web-published report output.

7. (Optional) Choose the Publish To button, then select a default path and filename to use for publishing web-based reports with this theme. The related HTML files for the report are always stored in this location, regardless of the location you specify when you submit the report request. Use this feature when you need to periodically publish reports to a consistent location.

8. (Optional) Choose the Background button, then select an image file to use as a background on any report you create with this report output theme. The
background you choose is automatically applied to spreadsheet and web published reports.

The Request Center uses the most appropriate graphics file format when publishing reports that include a background. For example, if you choose a BMP file when publishing web output, the Request Center will first try to locate a GIF file of the same name. If a GIF file cannot be found, Request Center will use the BMP file specified.

**Note:** Not all web browsers can display BMP files.

9. When you are finished making changes, save the theme.

**See Also:**

- Formatting Report Output
- Formatting with Tokens
- Cell Level Formatting
- General Options on page 3-19
Customizing Themes for Financial Reports

Positioning Line Items

You can position the line item column in any column of your theme. Choose the right or left Line Item Position button to move the line item column to your desired column location.

Your report output positions the line item column based on your theme definition.

Formatting with Tokens

You can customize themes applied to financial reports, using tokens to place titles, set of books, reporting period, report date and more anywhere in your financial report. Choose from the list of tokens in the table below.

- To place a token in your report theme:
  1. Create a new theme or modify an existing report theme.
  2. Select a cell and type the ampersand symbol (&) followed by the token. Refer to the table of tokens below.
  3. Format the cell using Excel’s formatting features.

Your financial report output displays the formatting you specified.
Note: Enter &Blank in a cell to prevent the display of any information from that cell in your report output.

Note: Enter &FastFormatting in any empty cell in your worksheet to disable all cell level formatting. This allows you to quickly publish FSG reports when there is a large volume of reports and cell level formatting is not a requirement.

Table 12–1  Formatting Tokens

<table>
<thead>
<tr>
<th>Description</th>
<th>Token</th>
<th>n</th>
<th>Reference Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank</td>
<td>&amp;Blank</td>
<td>n/a</td>
<td></td>
</tr>
<tr>
<td>Content Set Expansion Value</td>
<td>&amp;ContentSetExpansionValue</td>
<td></td>
<td>Report Submission and Publishing window</td>
</tr>
<tr>
<td>Day of Interest Date</td>
<td>&amp;DOIDATE[n]</td>
<td>where n is the offset number</td>
<td>Period, Report Submission and Publishing window</td>
</tr>
<tr>
<td>Day of Interest Day</td>
<td>&amp;DOIDAY[n]</td>
<td>where n is the offset number</td>
<td>Period, Report Submission and Publishing window</td>
</tr>
<tr>
<td>FastFormatting</td>
<td>&amp;FastFormatting</td>
<td></td>
<td>Disables all cell level formatting</td>
</tr>
<tr>
<td>Period of Interest Month</td>
<td>&amp;POIMonth[n]</td>
<td>where n is the offset number</td>
<td>Period, Report Submission and Publishing window</td>
</tr>
<tr>
<td>Period of Interest Quarter</td>
<td>&amp;POIQUARTER[n]</td>
<td>where n is the offset number</td>
<td>Period, Report Submission and Publishing window</td>
</tr>
<tr>
<td>Period of Interest Start Date</td>
<td>&amp;POIStartDate[n]</td>
<td>where n is the offset number</td>
<td>Period, Report Submission and Publishing window</td>
</tr>
</tbody>
</table>
You can also use line item tokens, listed in the table below, to replace line item text and expanded line item text in your financial report output. Line item tokens can be placed anywhere in the line item column. Formatting you apply to any cell in the Parent line item row is applied to expanded rows in your financial report output.

### Table 12–1 Formatting Tokens

<table>
<thead>
<tr>
<th>Description</th>
<th>Token</th>
<th>n</th>
<th>Reference Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period of Interest Year</td>
<td>&amp;POIYear[n]</td>
<td></td>
<td>Period, Report Submission and Publishing window</td>
</tr>
<tr>
<td>Report Title</td>
<td>&amp;ReportTitle</td>
<td></td>
<td>Existing Report, Report Submission and Publishing window</td>
</tr>
<tr>
<td>Report Published by</td>
<td>&amp;ReportPublished By</td>
<td></td>
<td>User Name</td>
</tr>
<tr>
<td>Request ID</td>
<td>&amp;ConcurrentRequestID</td>
<td></td>
<td>Request Center</td>
</tr>
<tr>
<td>Set of Books</td>
<td>&amp;SetofBooksName</td>
<td></td>
<td>Set of books name</td>
</tr>
<tr>
<td>Save In XL 95 Format</td>
<td>&amp;SaveInXL95Format</td>
<td></td>
<td>Report accessibility: Excel 97 users can publish web output viewable by Excel 95 users</td>
</tr>
<tr>
<td>Submission Date</td>
<td>&amp;SubmissionDate</td>
<td></td>
<td>Date, Report Submission and Publishing window</td>
</tr>
</tbody>
</table>

### Formatting with Line Item Tokens

You can also use line item tokens, listed in the table below, to replace line item text and expanded line item text in your financial report output. Line item tokens can be placed anywhere in the line item column. Formatting you apply to any cell in the Parent line item row is applied to expanded rows in your financial report output.

### Table 12–2 Line Item Tokens

<table>
<thead>
<tr>
<th>Description</th>
<th>Token</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replace Total value for parent - replaces the Total value for an expanded row.</td>
<td>&amp;T &lt;Parent Line Item&gt; &lt;Replacement Text&gt;</td>
</tr>
<tr>
<td>Replace line item text - replaces any line item text.</td>
<td>&amp;R &lt;Line Item Text&gt; &lt;Replacement Text&gt;</td>
</tr>
</tbody>
</table>
To place a line item token in your report theme:

1. Choose any blank cell in the line item column to place your token.
2. Enter &T or &R to let ADI know you wish to use a token.
3. Enter a space and the Parent line item or line item text you want to replace, surrounded by brackets. For example, enter _<Revenue>.
4. Enter a space and the new name you wish to use. For example, _<Total Revenue>.
5. Save your work.

---

**Note:** Any line item text you wish to replace must be specified exactly as it appears in the report definition. Indented text and multiple words must be entered exactly as the original, including all spaces and case.

---

**Formatting with Line Item Image Tokens**

You can use line item image tokens with sequence numbers to format lines above or below the row you specify.

You must enter this token information in a specific order:

\[&L \text{<position number>} \text{<line image above the row>} \text{<line image below the row>}\]

Where:

- **&L:** signals you want to use a line item image token.
- **Sequence number:** is the sequence number of the row you want to format.
- **Line image above the row:** is the token indicating the line type above the row.
- **Line image below the row:** is the token indicating the line type below the row.

For example, the token line, &L<30>ND, instructs ADI to locate the row identified by sequence number 30 and to place no line above the row and a double line below the row.

---

**Table 12–3  Line Item Tokens**

<table>
<thead>
<tr>
<th>Description</th>
<th>Token</th>
<th>Reference Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Line</td>
<td>&amp;N</td>
<td>&lt;first setting above the row&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;second setting below the row&gt;</td>
</tr>
</tbody>
</table>
To place a line item token in your report theme:

1. Choose any blank cell in the line item column to place your token.
2. Enter &L to let ADI know you wish to use a token.
3. Enter the sequence number of the row you want to format.
4. Enter N (no line), S (single line), or D (double line) for the type of line you want above the row.
5. Enter N (no line), S (single line), or D (double line) for the type of line you want below the row.
6. Save your work.

---

**Table 12-3  Line Item Tokens**

<table>
<thead>
<tr>
<th>Description</th>
<th>Token</th>
<th>Reference Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Line</td>
<td>&amp;S</td>
<td>&lt;first setting above the row&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;second setting below the row&gt;</td>
</tr>
<tr>
<td>Double Line</td>
<td>&amp;D</td>
<td>&lt;first setting above the row&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;second setting below the row&gt;</td>
</tr>
</tbody>
</table>

---

**Cell Level Formatting**

You can format individual cells in your financial report themes to refine the appearance of your report output. This feature works for financial reports with General Ledger Release 11i, 11.0, and 10.7.

**Warning:** Cell level formatting overrides formatting you defined for Report Title, Report Headings, Column Headings, Line Items, and Amounts when you created or customized report output themes.

---

**Note:** Whenever you want only a single or double line to appear below a row, you must enter N to instruct ADI that no line appears above the row.

For example, you must enter &L<30>ND to create a double line below the row identified by sequence number 30. The N instructs ADI that no line appears above the row.

---
Customizing Themes for Financial Reports

**Note:** Cell level formatting for Release 11i, 11.0, and 10.7 follow different processes. See the tasks below.

### Heading Regions, Report Title, Report Heading, and Column

In the report title, report heading, and column heading regions of your theme, you can format any cell or range of cells and the formatting is expressed in your report output. You may also enter tokens, text, or numbers in any cell within these regions to be displayed in your report output.

**Note:** You can remove rows from the Header region in your theme. Your report output reflects the deleted rows.
Line Item and Amounts Regions

To apply cell level formatting to the line item and amounts regions of your theme, follow the tasks below for General Ledger Release 11i, 11.0, or 10.7.

Release 11.0 and later

Your report definition, created in General Ledger or ADI, uses sequence numbers to locate the position of rows and columns in your report output. Use these sequence numbers in your report themes to apply formatting to specific areas of your report definition. The Request Center matches the formatting specified in your report theme with the information in your report definition to generate formatted report output.

Sequence numbers also act as tokens by automatically inserting row and column descriptions in the Line Item and Column Heading areas of your report output.

To view sequence numbers associated with your report, refer to your report definition in General Ledger, or choose the View Output/Log Button in the Request Center toolbar and select View Output File.

See Also:


To apply individual cell formatting to your financial statement report output, Release 11.0 and later:

1. Use your report definition or view output in the Request Center to note the row and column sequence numbers for the cell or range of cells you wish to format.

2. In column A of your report theme, select the row you wish to format.

3. Enter the ampersand symbol (&) followed by the row sequence number you wish to use.

4. Locate the column you wish to format and select the cell beneath the column heading.

5. Enter the ampersand symbol (&) followed by the column sequence number you wish to use.

6. Use Excel's formatting capabilities to format a cell or range of cells as you like.

The Request Center uses sequence numbers to reference formatting instructions in your report theme with the information in your report definition to generate your formatted report output.
To apply individual cell formatting to your financial statement report output, Release 10.7:

1. In column A of your report theme, select the cell for the row you wish to format.
2. Enter the name of the line item you wish to use as a format definition. For example, if your financial report definition contains a line item, Net Income, type Net Income in the selected cell.
3. Use Excel’s formatting capabilities to format a cell or range of cells in that row. The Request Center will use the theme to format information in the Net Income row of your report definition.

Attention: The Request Center searches for sequence numbers in your report output theme to determine format. If sequence numbers are not specified in your report output theme, the Request Center formats your report output following the steps below for Release 10.7.

Note: If you have upgraded to ADI 4.0 or later versions, tokens, line items, and sequence numbers are applied to report themes you created in earlier ADI releases when you first publish a financial report using that theme.
**Note:** The Request Center runs a series of processes to format your financial reports:

1. The Request Center first looks for line item names in your report theme and your report definition. If the search finds matching line item names, for example Net Income, then formatting for Net Income in the report theme is assigned to the designated row in your report output.

2. If your report definition has more rows than specified in your report theme, the Request Center formats those extra rows based on the criteria below:
   - High level formatting for themes is based on region styles. Your spreadsheet contains report title, report heading, column heading, line item, and amounts regions. ADI provides default styles for these regions. If all other format choices listed above are exhausted, the Request Center uses default styles to format your report output.
   - The first cell in any column in the amounts region determines the formatting for all cells below it in that column.

**See Also:**

- [Formatting Report Output](#) on page 12-33
- [General Options](#) on page 3-19

**Expanded Rows**

Your report definitions may include children rows as an expansion of a parent row. You format cells in the first expanded row and the following expanded rows assume the same formatting. You can also format a cell or range of cells in any expanded row.

If formatting is not applied to any expanded rows, the Request Center uses the defaults (above) to assign formatting.

**To format an expanded row:**

1. Activate the cell below the Parent row in column A of your report theme.
2. Enter the ampersand symbol (&) and sequence number of the Parent row.
3. After the sequence number, enter E and the number for the position of the child row (for example, &20E1).
4. Use Excel’s formatting capabilities to format any cell or range of cells.
Formatting Standard (Variable Format) Reports

You can create themes to format Standard (Variable Format) reports to use with Oracle General Ledger, Receivables, and Assets reporting. Format the regions of your report and further refine your report by using tokens unique to Standard (Variable Format) reports.

To customize a theme for a Standard (Variable Format) report:

1. From the Report Output Themes window, choose the Open Theme button to open the theme you want to customize. Alternatively, create a new theme.

2. Choose the Customize button. From the menu that appears, select the report output feature whose formatting you want to change.

You can change the formatting of the Report Title, Report Heading, Column Headings, Line Items, and Amounts.

The Format Cells window opens.

3. Define your formatting choices within each tab of the Format Cells window.

Note: You must enter and format each expanded row as a separate row in your report theme.
4. Choose OK to save your changes, then choose OK to close the Style window.

5. Repeat steps 2 through 4 above for each report output feature you want to customize in this theme.

6. (Optional) As desired, insert pictures into your theme by selecting Insert Picture from the Excel menu.

7. (Optional) Choose the Publish To button, then select a default path and filename to use for publishing web-based reports with this theme. The related HTML files for the report are always stored in this location, regardless of the location you specify when you submit the report request. Use this feature when you need to periodically publish reports to a consistent location.

8. (Optional) Choose the Background button, then select an image file to use as a background on any report you create with this report output theme. The background you choose is automatically applied to spreadsheet and web published reports.

9. When you are done making changes, save the theme.
Formatting with Tokens

You can use three tokens to format columns in your Standard (Variable Format) reports.

Table 12–4  Formatting Tokens

<table>
<thead>
<tr>
<th>Token</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&amp;AF</td>
<td>Autofit - ADI sets the width of the column to the number of characters of the largest output in that column.</td>
</tr>
<tr>
<td>&amp;default_line_format</td>
<td>The formatting you define for this cell determines formatting for displayed output. All other cells below this cell in a column assume the same formatting characteristics.</td>
</tr>
<tr>
<td>&amp;printable_format</td>
<td>The formatting you define for this cell determines formatting for printed output. All other cells below this cell in a column assume the same formatting characteristics.</td>
</tr>
</tbody>
</table>

To use tokens in Standard (Variable Format) reports:
1. Select the appropriate cell for which you want to use a token. For example, if you want to format displayed output, locate the &default_line_format cell.

   The cell level formatting features are not available for Standard (Variable Format) reports.

Custom Macro

You can enter a custom macro in your report theme to take advantage of Excel’s macro functionality. The macro is run at the time the report is published.

To create a custom macro:

1. Enter the name of the macro in the Spreadsheet Custom Macro cell.

   If your macro and report theme are located in the same workbook, you enter the name of the macro.

   Note: If your macro is located in a separate workbook that workbook must be open. You can save the workbook that contains the macro in the xlStart directory so that it is always loaded when Excel is launched. With this option you enter the name of the workbook and macro (workbook.xls! macro).
Viewing Report Output and Logs

To view other output or log files using the Request Center:

1. From the Completed tab of the Request Center window, select the entry for the completed report.

2. Choose the View Output/Log button from the Request Center toolbar. A poplist appears. For other output reports, choose View Output File. For log files, choose View Log File.

The output or log file is downloaded, then opened in the default output viewer you specified in the Request Center Options window.

See: Setting Request Center Options on page 12-5.

Cancelling Requests

From the Request Center, you can cancel pending requests or requests that are still running.

You can cancel any request you submit under your responsibility. In addition, anyone with a system administrator responsibility can cancel any pending request.

Note: When you submit report or request sets, a request ID is created for each report processed in the set. You cannot cancel request sets, only individual reports that have a request id.

To cancel requests:

1. Select a request from the Pending tab.

2. Choose the Cancel Request button from the Request Center toolbar.

A confirmation message is displayed. Select Yes to cancel the request.
3. Choose the Completed tab. Note that the cancelled request is displayed with a status of either Cancelled or Terminated. The cancelled status indicates that the request was still pending at the time it was cancelled. The terminated status indicates that the request was already running at the time it was cancelled.

Monitoring Requests

When you start ADI, the Request Center is also started. Any request that you submit from ADI is automatically monitored. When one of these requests finishes, the Request Center notifies you of the completion status, if you checked the Notify When Complete box when you submitted the request.

You can choose to monitor other requests as well, including those which are submitted from other Oracle Applications. New requests are placed automatically on either a “pending” or “completed” list, depending on the status. When a pending request is finished, the Request Center automatically moves the monitored request from the pending list to the completed list.

**Note:** When you submit an FSG report request, the name of the report appears in the column Program Name, on the Pending or Completed tab.

You can use the toolbar in the Request Center window to access Request Center features. (See: Request Center Toolbar: page ). There are also four tabs you can select to view different information:

Pending: All pending requests that you have submitted are listed on this tab. You can add a request to the pending list by choosing the Monitor Request button from the Request Center toolbar.
Completed: All completed requests that you submitted are shown on this tab. You can add a request to the completed list by choosing the Monitor Request button from the Request Center toolbar.

Hotlist: This tab shows any completed requests that you have added to the hotlist by using the Add Request to Hotlist button from the Request Center toolbar.

Databases: Shows all applications databases you have defined. This tab also indicates whether you are connected to the database and shows how many requests related to the database are Complete, Pending, and Hotlisted.

To monitor a request:
1. Start the Request Center if it is not already running.

   **Suggestion:** If ADI is running, you can start the Request Center by choosing the Applications button from the ADI toolbar and selecting Request Center from the list of values.

2. Choose the Monitor Request button from the Request Center toolbar. The Select Request to Monitor window appears, listing all requests submitted by your sign-on userid.
3. Choose which requests to include in the list by setting the following Selection Criteria:

**Request Status:**
- Incomplete: Mark this check box to include pending, running, or paused requests in the list.
- Complete: Mark this check box to include completed requests in the list.

**Request Owner:**
- [username]: Select this option to view only your own requests.
- All Users: Select this option to view requests submitted by all users.

**Note:** The Request Center displays the username you used to sign on to Oracle Applications.

**Note:** This option is only available to system administrators.

**Further Limit By:**
- Nothing: All requests that meet your Request Status and Request Owner selections appear in the list.
- Program Name: Select this option, then specify a program name, to limit the requests that appear in the list to only those with the same program name.
- Request ID: Select this option, then specify a request ID, to limit the requests that appear in the list to only those with the same request ID.

**Attention:** To query FSG reports, choose Program Name from the Further Limit By poplist. In the second poplist, choose Financial Statement Generator. The query results present you with a list of FSG report names.

4. Choose the Query button to have the Request Center retrieve a list of requests that meet the selection criteria you specified above. You can limit this list to the most recent number of requests you specified on the Options window, by checking the Return Last Requests check box.

5. Select a request from the list.
6. Choose Add to add the request. The Request Center places the request on either the Pending or Completed tab, depending on the status.

7. Repeat the above steps to add multiple requests.

8. Choose Close when you are finished adding requests.

---

**Note:** When a monitored request has completed, its entry is automatically moved from the Pending tab to the Completed tab of the Request Center window.

---

» To stop monitoring a request:

1. Select the request you want to stop monitoring from the Pending, Completed, or Hotlist tab of the Request Center window.

2. Choose the Stop Monitoring Selected Request button from the Request Center toolbar.

---

**Additional Information:** To stop monitoring all requests and remove them from the Pending, Completed, or Hotlist tab, choose the Stop Monitoring ALL Requests button from the Request Center toolbar.

---

**See Also:**

- The Request Center Toolbar on page 12-2
- Setting Request Center Options on page 12-5
- Submitting Reports on page 12-8
- Formatting Report Output on page 12-33
4-4-5 calendar
A depreciation calendar with 12 uneven periods: four cycles of a four-week period, followed by a four-week period, followed by a five-week period. Depreciation is usually divided by days for a 4-4-5 calendar. Since a 4-4-5 calendar has 364 days per year, it has different start and end dates for the fiscal year each year.

1099 form
The forms the Internal Revenue Service supplies to record a particular category of payment or receipt.

1099 number
The tax identification number for a supplier. According to IRS rules in the United States, lack of a valid tax identification number may result in tax withholding. Applications Desktop Integrator stores the tax identification number for each supplier. Applications Desktop Integrator also enables you to enter a withholding status for each supplier.

1099 types
A 1099 classification scheme used in the United States for types of payments. Each 1099 form has one or more payment types. A 1099 supplier may receive payments from more than one type. The 1099-MISC form has the following types: rents, royalties, prizes and awards, federal income tax withheld, fishing boat proceeds, medical and health care payments, non-employee compensation, and substitute payments in lieu of dividends or interest. Applications Desktop Integrator records 1099 payments by type so that you can report them according to IRS requirements.
2-way matching
The process of verifying that purchase order and invoice information matches within accepted tolerance levels. Applications Desktop Integrator uses the following criteria to verify two-way matching:

Invoice price <= Order price
Quantity billed <= Quantity ordered

See also matching.

24-hour format
A time format that uses a 24 hour clock instead of am and pm, so that 3:30 would be 3:30 am, 16:15 would be 4:15 pm, 19:42 would be 7:42 pm, etc.

3-way matching
The process of verifying that purchase order, invoice, and receiving information matches within accepted tolerance levels. Applications Desktop Integrator uses the following criteria to verify three-way matching:

Invoice price <= Purchase Order price
Quantity billed <= Quantity ordered
Quantity billed <= Quantity received

See also matching.

4-way matching
The process of verifying that purchase order, invoice, and receiving information matches within accepted tolerance levels. Applications Desktop Integrator uses the following criteria to verify four-way matching:

Invoice price <= Order price
Quantity billed <= Quantity ordered
Quantity billed <= Quantity received
Quantity billed <= Quantity accepted

See also matching.
accepted quantity
The quantity of inventory items received from a customer, based on a return authorization for which you credit the customer. See also received quantity.

Account Generator
A feature that uses Oracle Workflow to provide various Oracle Applications with the ability to construct Accounting Flexfield combinations automatically using custom construction criteria. You define a group of steps that determine how to fill in your Accounting Flexfield segments. You can define additional processes and/or modify the default process(es), depending on the application. See also activity, function, item type, lookup type, node, process, protection level, result type, transition, Workflow Engine

account groups
Fixed asset or long-term liabilities for which governments usually maintain separate accountability. Governments usually maintain these transactions in account groups known as the general fixed assets account group and the general long-term debt account group.

account hierarchy
An Oracle Financials feature you use to perform summary level funds checking. An account hierarchy lets Oracle Purchasing and Applications Desktop Integrator quickly determine the summary accounts into which your detail accounts roll up.

Account segment
One of up to 30 different sections of your Accounting Flexfield, which together make up your general ledger account code. Each segment is separated from the other segments by a symbol you choose (such as -, /, or \). Each segment typically represents an element of your business structure, such as Company, Cost Center or Account. One of the sections of an Accounting Flexfield, separated from the other sections by a symbol you choose (such as -, /, or \). You can have up to 30 different Accounting Flexfield segments. Each segment can be up to 25 characters long. Each Accounting Flexfield segment typically captures one element of your agency’s structure, such as Fund, Division, Department, or Program.

Account segment value
A series of characters and a description that define a unique value for a particular value set.
account structure
See: Accounting Flexfield structure.

accounting calendar
The calendar that defines your accounting periods and fiscal years in Oracle General Ledger. You define accounting calendars using the Accounting Calendar window. Oracle Financial Analyzer will automatically create a Time dimension using your accounting calendar.

accounting classification code structure
The data elements a government activity uses to classify the financial aspects of a transaction.

Accounting Flexfield
The code you use to identify a general ledger account in an Oracle Financials application. Each Accounting Flexfield segment value corresponds to a summary or rollup account within your chart of accounts.

Accounting Flexfield structure
The account structure you define to fit the specific needs of your organization. You choose the number of segments, as well as the length, name, and order of each segment in your Accounting Flexfield structure.

Accounting Flexfield value set
A group of values and attributes of the values. For example, the value length and value type that you assign to your account segment to identify a particular element of your business, such as Company, Division, Region, or Product. A group of values and attributes of the values. For example, the value length and value type that you assign to your Accounting Flexfield segment to identify a particular element of your business, such as Company, Division, Region, or Product.

Accounting Flexfield value set
A group of values and attributes of those values. For example, the value length and value type that you assign to your account segment to identify a particular element of your business, such as Company, Division, Region, or Product. A group of values and attributes of the values. For example, the value length and value type that you assign to your Accounting Flexfield segment to identify a particular element of your organization, such as Agency, Division, Region, or Project.
accounting method
The method you select for recording accounts payable transactions. You can choose between accrual basis, cash basis, or combined basis of accounting. With accrual basis accounting, Applications Desktop Integrator creates journal entries for invoices and payments. With cash basis accounting, Applications Desktop Integrator creates journal entries only after you make payments. With combined basis accounting, Applications Desktop Integrator creates journal entries for invoices and payments to post to your accrual set of books and creates journal entries for payments to post to your cash set of books.

accounting period
The periods that make up your fiscal year. You depreciate assets each period. A time period making up your fiscal year, used on financial statements. They can be of any length, but are usually a month, quarter, or year. Periods are defined in Oracle General Ledger.

accounting rule start date
The date Oracle Receivables uses for the first accounting entry it creates when you use an accounting rule to recognize revenue. If you choose a variable accounting rule, you need to specify a rule duration to let Receivables know how many accounting periods to use for this accounting rule.

accounting rules
Rules that Oracle Receivables AutoInvoice uses to specify revenue recognition schedules for your transactions. You can define an accounting rule where revenue is recognized over a fixed or variable period of time. For example, you can define a fixed duration accounting rule with monthly revenue recognition for a period of 12 months.

accrual accounting
An accounting method you use to recognize revenue when you create invoices.

accrual basis accounting
A method of accounting in which you recognize revenues in the accounting period in which you earn revenues and recognize expenses in the accounting period in which you incur the expense. Both revenues and expenses need to be measurable to be reportable.
**accrue through date**
The date through which you want to accrue revenue for a project. Oracle Projects picks up expenditure items having an expenditure item date on or before this date, and events having a completion date on or before this date, when accruing revenue. An exception to this rule are projects that use cost-to-cost revenue accrual; in this case, the accrue through date used is the PA Date of the expenditure item’s cost distribution lines.

**accumulation**
An obsolete term. See also *summarization*.

**accumulated depreciation**
The total depreciation taken for an asset since it was placed in service. Also known as *life-to-date depreciation* and *depreciation reserve*.

**ACE**
See *adjusted current earnings*.

**ACE book**
A tax book for Adjusted Current Earnings ("ACE") tax calculations.

**action**
See *cycle action*.

**action result**
A possible outcome of an order cycle action. You can assign any number of results to a cycle action. Combinations of actions/results are used as order cycle action prerequisites. See also *order cycle, cycle action*.

**activity**
An Oracle Workflow unit of work performed during a business process. Also, a name that you use to refer to a receivables activity such as a payment, credit memo, or adjustment. See also *activity attribute, function activity, receivables activity name*.

**activity attribute**
A parameter for an Oracle Workflow function activity that controls how the function activity operates. You define an activity attribute by displaying the activity’s Attributes properties page in the Activities window of Oracle Workflow Builder. You assign a value to an activity attribute by displaying the activity node’s Attribute Values properties page in the Process window.
**ad hoc**
Concerned with or formed for a particular purpose. For example, ad hoc tax codes or an ad hoc database query.

**address validation**
The type of validation you want the system to use for your address, if you are not using a flexible address format for validation. You can implement address validation at three levels: Error, No Validation, or Warning. ‘Error’ ensures that all locations exist for your address before it can be saved. ‘Warning’ displays a warning message if a tax rate does not exist for this address (allows you to save the record). ‘No Validation’ does not validate the address.

**adjusted current earnings ("ACE")**
A set of depreciation rules defined by United States tax law. Oracle Assets supports the Adjusted Current Earnings tax rules.

**adjustment**
A Oracle Receivables feature that allows you to increase or decrease the amount due of your invoice, debit memo, chargeback, deposit, or guarantee. Applications Desktop Integrator lets you create manual or automatic adjustments.

**advance**
An amount of money prepaid in anticipation of receipt of goods, services, obligations or expenditures. In Oracle Payables, an advance is a prepayment paid to an employee. You can apply an advance to an employee expense report during expense report entry, once you fully pay the advance. An amount of money prepaid in anticipation of receipt of goods, services, obligations or expenditures. Generally, an advance is made by a government to a payee to whom the government has an obligation, and not more than the obligation. For example, a government might issue a travel advance to an employee before the beginning of a trip.

**agency** An executive branch department, independent board, commission, bureau, committee, section, office, or other establishment of a government. A representative organization of a federal government, state or local government, or institution of higher education.

**agent** An individual responsible for providing goods or services or authorizing their provision to another government entity or recipient.
aggregate balance
The sum of the end-of-day balances for a range of days. There are three types of aggregate balances: period-to-date (PTD), quarter-to-date (QTD), and year-to-date (YTD). All three are stored in the General Ledger database for every calendar day.

agent
The customer name or supplier name on a bank statement line.

aging buckets
Time periods you define to age your debit items. Aging buckets are used in the Aging reports to see both current and outstanding debit items. For example, you can define an aging bucket that includes all debit items that are 1 to 30 days past due. Applications Desktop Integrator uses the aging buckets you define for its Invoice Aging Report. Used to define time periods represented in the forecast. Examples of aging buckets are date ranges or accounting periods.

agreement
A contract with a customer that serves as the basis for work authorization. An agreement may represent a legally binding contract, such as a purchase order, or a verbal authorization. An agreement sets the terms of payment for invoices generated against the agreement, and affects whether there are limits to the amount of revenue you can accrue or bill against the agreement. An agreement can fund the work of one or more projects. An arrangement with a customer that sets business terms for sales orders in advance. Oracle Order Entry lets you assign pricing, accounting, invoicing, and payments terms to an agreement. You can assign discounts to agreements that are automatically applied. You can refer to an agreement when you enter an order for a particular customer, and have relevant default values automatically fill in the order using standard value rule sets. See also customer family agreement, generic agreement.

agreement type
A classification for agreements. Reference agreement types in defining discounts or automatic note rules, classify your agreements to control selection of agreements during order entry, as well as for reporting purposes. (Order Entry QuickCode) An implementation-defined classification of agreements. Typical agreement types include purchase order and service agreement.

alert
An entity you define that checks your database for a specific condition and sends or prints messages based on the information found in your database.
alert input
A parameter that determines the exact definition of the alert condition. You can set the input to different values depending upon when and to whom you are sending the alert. For example, an alert testing for users to change their passwords uses the number of days between password changes as an input. Oracle Alert does not require inputs when you define an alert.

alert output
A value that changes based on the outcome at the time Oracle Alert checks the alert condition. Oracle Alert uses outputs in the message sent to the alert recipient, although you do not have to display all outputs in the alert message.

allocation entry
A recurring journal entry you use to allocate revenues or costs.

alternative region
An alternative region is one of a collection of regions that occupy the same space in a window where only one region can be displayed at any time. You identify an alternative region by a poplist icon that displays the region title, which sits on top of a horizontal line that spans the region.

Always Take Discount
A Oracle Payables feature you use to always take a discount on a supplier’s invoice if the payment terms for the invoice include a discount. You define Always Take Discount as a Payables option that Payables assigns to new suppliers you enter. When Always Take Discount is enabled for a supplier site, you take a discount on that supplier’s invoice site regardless of when you pay the invoice. When Always Take Discount is disabled, you only take a discount if you pay the invoice on or before the discount date.

applied
Payment in which you record the entire amount as settlement for one or more debit items.

appropriation
An authorization by a legislative body that permits a government to incur obligations and make payments for specified purposes. An appropriation usually follows enactment of authorizing legislation. Appropriations are limitations on the amounts agencies can obligate during the time specified in the appropriation act.
**approval action**

A cycle action that you can define in your order cycle to require explicit approval of an order or order line before that order or line progresses further through the order cycle. You can define an approval step at the order or order line level. When you define an approval step, you must approve all orders or order lines using that order cycle, depending on the approval step level. You can also use approvals in order cycles for returns (RMAs). See also *configure-to-order*.

**approval limits**

Limits you assign to users for adjustment entry. Applications Desktop Integrator enforces the limits that you define here as your users enter receivables adjustments. When users enter adjustments that are within their approval limit, Applications Desktop Integrator automatically approves the adjustment. When users enter adjustments outside their approval limit, Applications Desktop Integrator assigns a status of pending to the adjustment.

**approved date**

The date on which an invoice is approved.

**archive**

To archive a fiscal year is to copy the depreciation expense and adjustment transaction data for that year to a storage device.

**archive**

To store historical transaction data outside your database.

**archive table**

Applications Desktop Integrator copies your account balances from the Balances Table (GL_BALANCES) to your Archive Table (GL_ARCHIVE_BALANCES). Applications Desktop Integrator copies your journal details from the Journal Entry tables (GL_JE_BATCHES, GL_JE_HEADERS, and GL_JE_LINES) to your archive tables (GL_ARCHIVE_BATCHES, GL_ARCHIVE_HEADERS, and GL_ARCHIVE_LINES). Oracle Assets copies depreciation expense and adjustment transaction data for a fiscal year to temporary tables called archive tables.

**archive tablespace**

The tablespace where your archive table is stored. A tablespace is the area in which an Oracle7 database is divided to hold tables.
attribute
An Oracle Financial Analyzer database object that links or relates the values of two dimensions. For example, you might define an attribute that relates the Sales District dimension to the Region dimension so that you can select data for sales districts according to region.

assemble-to-order (ATO)
An environment where you open a final assembly order to assemble items that customers order.

assemble-to-order (ATO) item
An item you make in response to a customer order.

assemble-to-order (ATO) model
A configuration you make in response to a customer order that includes optional items.

assembly
An item that has a bill of material. You can purchase or manufacture an assembly item. See also assemble-to-order, bill of material.

asset
An object of value owned by a corporation or business. Assets are entered Oracle Projects as non-labor resources. See non-labor resource. See fixed asset.

asset account
A general ledger account to which you charge the cost of an asset when you purchase it. You must define an account as an asset account.

Asset Key Flexfield
Oracle Assets lets you define additional ways to sort and categorize your assets without any financial impact. You use your Asset Key Flexfield to define how you want to keep the information.

ATO
See assemble-to-order.

ATO item
See assemble-to-order (ATO) item.
**ATO Model**

See assemble-to-order (ATO) model.

**ATP**

See available to promise.

**ATR**

See available to reserve.

**attribute**

See activity attribute, item type attribute

**Audit Set**

The group of forms that are available for auditing in your application.

**AutoAccounting**

A feature used by Oracle Projects to automatically determine the account coding for an accounting transaction based on the project, task, employee, and expenditure information. A feature that lets you determine how the Accounting Flexfields for your revenue, receivable, freight, tax, unbilled receivable and unearned revenue account types are created.

**AutoAccounting function**

A group of related AutoAccounting transactions. There is at least one AutoAccounting function for each Oracle Projects process that uses AutoAccounting. AutoAccounting functions are predefined by Oracle Projects.

**AutoAccounting Lookup Set**

An implementation-defined list of intermediate values and corresponding Accounting Flexfield segment values. AutoAccounting lookup sets are used to translate intermediate values such as organization names into account codes.

**AutoAccounting parameter**

A variable that is passed into AutoAccounting. AutoAccounting parameters are used by AutoAccounting to determine account codings. Example AutoAccounting parameters available for an expenditure item are the expenditure type and project organization. AutoAccounting parameters are predefined by Oracle Projects.
**AutoAccounting Rule**
An implementation-defined formula for deriving Accounting Flexfield segment values. AutoAccounting rules may use a combination of AutoAccounting parameters, AutoAccounting lookup sets, SQL statements, and constants to determine segment values.

**AutoAccounting Transaction**
A repository of the account coding rules needed to create one accounting transaction. For each accounting transaction created by Oracle Projects, the necessary AutoAccounting rules are held in a corresponding AutoAccounting Transaction. AutoAccounting transactions are predefined by Oracle Projects.

**AutoAdjustment**
A feature used to automatically adjust the remaining balances of your invoices, debit memos, and chargebacks that meet the criteria that you define.

**Approval**
A feature that prevents you from paying an invoice when your supplier overcharges you or bills you for items you have not received, ordered or accepted. Approval also validates tax, period, currency, budgetary, and other information. If you use budgetary control and encumbrance accounting, Approval also creates encumbrances for unmatched invoices or for invoice variances. Approval prevents payment or posting of invoices that do not meet defined approval criteria by placing holds on the invoice. Approval also releases holds when you resolve invoice exceptions. You must submit Approval for each invoice to pay and post the invoice.

**AutoAssociate**
An option that allows you to specify whether you want Applications Desktop Integrator to determine the customer using invoice numbers if the customer cannot be identified from either the magnetic ink character recognition (MICR) number or the customer number. Applications Desktop Integrator checks the invoice numbers until it finds a unique invoice number for a customer. Applications Desktop Integrator then uses this invoice number to identify the customer. You can only use this feature if your bank transmits invoice numbers and if the AutoLockbox Validation program can identify a unique customer for a payment using an invoice number. Otherwise, Applications Desktop Integrator treats the payment as unidentified. See also MICR number.
**AutoCash Rule**
A feature that Post QuickCash uses to automatically apply receipts to a customer’s open items. AutoCash Rules include: Apply to the Oldest Invoice First, Clear the Account, Clear Past Due Invoices, Clear Past Due Invoices Grouped by Payment Term, and Match Payment with Invoice. See also *AutoCash Rule Set, Post QuickCash.*

**AutoCash Rule Set**
A feature that determines the order of the AutoCash Rules that the Post QuickCash program will use when automatically applying receipts to a customer’s open items. You can choose to include discounts, finance charges, and items in dispute when calculating your customer’s open balance.

**AutoClear**
Formerly an Oracle Payables feature, this was replaced by Oracle Cash Management features in Release 10SC.

**AutoReconciliation**
An Oracle Cash Management feature that allows you to reconcile bank statements automatically. This process automatically reconciles bank statement details with the appropriate batch, journal entry, or transaction, based on user-defined system parameters and setup. Oracle Cash Management generates all necessary accounting entries. See also *reconciliation tolerance.*

**available transactions**
Receivables and payables transactions that are available to be reconciled by Cash Management.

**AutoCopy - budget organizations**
A feature that automatically creates a new budget organization by copying account assignments from an existing budget organization.

**AutoCopy - budgets**
A feature that automatically creates a new budget by copying all of the data from an existing budget. Budget AutoCopy copies budget amounts only from open budget years.

**AutoInvoice**
A program that imports invoices, credit memos, and on account credits from other systems to Oracle Receivables.
**AutoLockbox**
See *lockbox*.

**automatic event**
An event with an event type classification of Automatic. Billing extensions create automatic events to account for the revenue and invoice amounts calculated by the billing extensions.

**automatic asset numbering**
A feature that automatically numbers your assets if you do not enter an asset number.

**automatic note**
A standard note that you assign automatic application rules to so that it can be applied automatically to orders, returns, order lines and return lines. See also *one-time note, standard note*.

**automatic payment**
A Payables process that automatically selects invoices based on your selection criteria, creates a payment (check or electronic funds transfer), and confirms the status of each payment.

**automatic payment processing**
A Payables process that produces payments for groups of invoices. The complete process includes: invoice selection (payment batch), payment building, manual modification/addition to invoice payments in the payment batch, payment formatting, and confirmation of results. You can modify a payment batch up until the time you format payments for the payment batch. You can cancel a payment batch up until the time you confirm the payment batch.

**automatic receipt**
In addition to standard check processing, you can use the automatic receipt feature to automatically generate receipts for customers with whom you have predefined agreements. These agreements let you transfer funds from the customer’s bank account to yours on the receipt maturity date.

**automatic reconciliation**
See *AutoReconciliation*.
**AutoOffset**
A feature that automatically determines the offset (or credit) entry for your allocation entry. AutoOffset automatically calculates the net of all previous journal lines in your allocation entry, reverses the sign, and generates the contra amount.

**AutoReduction**
An Oracle Applications feature in the list window that allows you to shorten a list so that you must scan only a subset of values before choosing a final value. Just as AutoReduction incrementally reduces a list of values as you enter additional character(s), pressing [Backspace] incrementally expands a list.

**AutoSelection**
A feature in the list window that allows you to choose a valid value from the list with a single keystroke. When you display the list window, you can type the first character of the choice you want in the window. If only one choice begins with the character you enter, AutoSelection selects the choice, closes the list window, and enters the value in the appropriate field.

**AutoSkip**
A feature specific to flexfields where Oracle Applications automatically moves your cursor to the next segment as soon as you enter a valid value into a current flexfield segment. You can turn this feature on or off with the user profile option Flexfields:AutoSkip.

**average balance**
The amount computed by dividing an aggregate balance by the number of calendar days in the related range.

**available to promise (ATP)**
The quantity of current on-hand stock, outstanding receipts and planned production that has not already been committed, either through a reservation or placing demand. In Oracle Inventory, you define the types of supply and demand that should be included in your ATP calculation.

**available-to-promise quantity**
See available to promise (ATP).
available-to-promise rule
A set of Yes/No options for various entities that the user enters in Oracle Inventory. The combination of the various entities are used to define what is considered supply and demand when calculating available to promise quantity.

Available-to-reserve (ATR)
The quantity of on-hand stock that is available for reservation. ATR is the current on-hand stock less any reserved stock.

average exchange rate
An exchange rate that is the average rate for an entire accounting period. General Ledger automatically translates revenue and expense account balances using period-average rates in accordance with FASB 52 (U.S.). And, for companies in highly inflationary economies, General Ledger uses average exchange rates to translate your non-historical revenue and expense accounts in accordance with FASB 8 (U.S.). Also known as period-average exchange rate. The average rate for an entire accounting period. General Ledger automatically translates revenue and expense account balances using period-average rates in accordance with FASB 52 (U.S.). For organizations in highly inflationary economies, General Ledger uses average exchange rates to translate non-historical revenue and expense accounts in accordance with FASB 8 (U.S.). Also known as period-average exchange rate.

back-value transactions
Transactions whose effective date is prior to the current accounting date. Also known as value-dated transactions.

B-record
A summary record of all 1099 payments made to a supplier for one tax region.

backorder
An unfulfilled customer order or commitment. Oracle Order Entry allows you to create backorders either automatically or manually from released order lines. See also Pick Release.

BACS
See Bankers Automated Clearing System.
BAI
An acronym for the Banking Administration Institute. This organization has recommended a common format that is widely accepted for sending lockbox data. If your bank provides you with this type of statement, you can use Bank Statement Open Interface to load your bank statement information into Oracle Cash Management. See also Bank Statement Open Interface.

balances table
A General Ledger database table that stores your account balances, called GL_BALANCES.

balancing segment
An Accounting Flexfield segment that you define so that General Ledger automatically balances all journal entries for each value of this segment. For example, if your company segment is a balancing segment, General Ledger ensures that, within every journal entry, the total debits to company 01 equal the total credits to company 01. An Accounting Flexfield segment that you define so that Applications Desktop Integrator automatically balances all journal entries for each value of this segment. For example, if your fund segment is a balancing segment, Oracle Public Sector General Ledger assures that, with every journal entry, the total debits to Fund 01 equals the total credits to Fund 01.

bank file
The data file you receive from the bank that contains all of the payment information that the bank has deposited in your bank account. The electronic statement file you receive from your bank (for example, BAI format or SWIFT940). It contains all transaction information that the bank has processed through your bank account.

bank statement
A report sent from a bank to a customer showing all transaction activity for a bank account for a specific period of time. Bank statements report beginning balance, deposits made, checks cleared, bank charges, credits, and ending balance. Enclosed with the bank statement are cancelled checks, debit memos, and credit memos. Large institutional banking customers usually receive electronic bank statements as well as the paper versions.

bank statement tables
The primary database tables Oracle Cash Management works with for each bank statement. Bank statement tables are populated manually or by importing data.
from Bank Statement Open Interface. There are two tables for each bank statement—a bank statement headers table and a bank statement lines table.

**Bank Statement Open Interface**

The database interface tables that must be populated when you automatically load an electronic bank file into Oracle Cash Management. The Bank Statement Open Interface consists of one header and multiple detail lines for each bank statement.

**bank transaction code**

The transaction code used by a bank to identify types of transactions on a bank statement, such as debits, credits, bank charges, and interest. You define these codes for each bank account using the Cash Management Bank Transaction Codes window.

**Bankers Automated Clearing System (BACS)**


**base amount**

The amount that represents the denominator for the ratio used to determine the amount due. You specify your base amount when you define your payment terms.

Amount Due = Relative Amount/Base Amount * Invoice Amount

**base model**

The model item from which a configuration item was created.

**baseline budget**

The authorized budget for a project or task which is used for performance reporting and revenue calculation.

**basis reduction rate**

Each Investment Tax Credit Rate has a basis reduction rate associated with it. Oracle Assets applies the basis reduction rate to the ITC basis to determine the amount by which it will reduce the depreciable basis. Oracle Assets displays the basis reduction rate with its corresponding investment tax credit rate in the Assign Investment Tax Credit form so you can easily see whether the rate you choose will reduce the depreciable basis of the asset.
**batch source**
A source you define in Oracle Receivables to identify where your invoicing activity originates. The batch source also controls invoice defaults and invoice numbering. Also known as transaction batch sources.

**beginning balance**
The beginning balance is the balance of the transaction item as of the beginning GL Date that you specified. This amount should be the same as the Outstanding Balance amount of the Aging - 7 Buckets Report where the As Of Date is the same as the beginning GL Date.

**best discount**
The most advantageous discount for the customer. For example, you have a customer discount of 15% and a item discount of 25% for Product B. If you enter an order line for the customer for Product A, the line is discounted 15%. If you enter an order line for the customer for product B, the line is discounted 25%.

**bill in advance**
An invoicing rule that enables you to record the receivable at the beginning of the revenue recognition schedule for invoices that span more than one accounting period. See also invoicing rules, bill in arrears.

**bill in arrears**
An invoicing rule that records the receivable at the end of the revenue recognition schedule for invoices that span more than one accounting period. See also invoicing rules, bill in advance.

**Bill of Exchange**
A method of payment. Also known as a future dated payment in some countries, including France. See also Future Date Payment. An agreement made with your customer in which they promise to pay a specified amount on a specific date (called the maturity date) for goods or services. This process involves the transfer of funds from your customer’s bank account to your bank account. (BOE) A method of payment involving the transfer of funds between bank accounts, where one party promises to pay another a specified amount on a specified date.

**Bill of Lading**
A carrier’s contract and receipt of goods transported from one location to another.
bill of material (BOM)
A listing of all the subassemblies, intermediates, parts, and raw materials that go into a parent assembly or product configuration. It shows the quantity of each part required to make an assembly. You may think of a bill of material as a recipe or formula for a configuration. Oracle Order Entry uses a bill of material format to define configurations. See also configuration, model.

bill rate
A rate per unit at which an item accrues revenue and/or is invoiced for time and material projects. Employees, jobs, expenditure types, and non-labor resources can have bill rates.

bill rate schedule
A set of standard bill rates that maintains the rates and percentage markups over cost that you charge clients for your labor and non-labor expenditures.

bill site
The customer address to which project invoices are sent.

bill through date
The date through which you want to invoice a project. Oracle Projects picks up revenue distributed expenditure items having an expenditure item date on or before this date, and events having a completion date on or before this date, when generating an invoice.

Bill To Address
The address of the customer who is to receive the invoice. Equivalent to Invoice To Address in Oracle Order Entry.

Bill To Site
A customer location to which you have assigned a Bill-To business purpose. You can define your customer’s bill-to sites in the Customers windows.

billing
The functions of revenue accrual and invoicing.

billing invoice number
A system-generated number assigned to a consolidated billing invoice when you print draft or final versions of these invoices. This number appears in some Oracle
Receivables windows (next to the transaction number) and reports if the profile option AR: Show Billing Number is set to Yes. See also consolidated billing invoice.

billing cycle
The billing period for a project. Examples of billing cycles you can define are: a set number of days, the same day each week or month, or the project completion date. You can optionally use a client extension to define a billing cycle.

billing title
See Employee Billing Title, Job Billing Title.

block
Every Oracle Applications window (except root and modal windows) consists of one or more blocks. A block contains information pertaining to a specific business entity. Generally, the first or only block in a window assumes the name of the window. Otherwise, a block name appears across the top of the block with a horizontal line marking the beginning of the block.

book
See depreciation book.

booking
An action on an order signifying that the order has all the necessary information to be a firm order and processed through its order cycle.

Borrowed and Lent revenue
A revenue entry that is created to record when an employee works on a project that is managed by a different organization than the expenditure organization. This revenue entry is created to separately track project organization revenue versus employee organization revenue.

budget
Estimated cost, revenue, labor hours or other quantities for a project or task. Each budget may optionally be categorized by resource. Different budget types may be set up to classify budgets for different purposes. In addition, different versions can exist for each user-defined budget type: current, original, revised original, and historical versions. The current version of a budget is the most recently baselined version. See also budget line, resource.
budget book
A book that you use to track planned capital expenditures.

budget formula
A mathematical expression used to calculate budget amounts based on actual results, other budget amounts and statistics. With budget formulas, you can automatically create budgets using complex equations, calculations and allocations.

budget hierarchy
A group of budgets linked at different levels such that the budgeting authority of a lower-level budget is controlled by an upper-level budget.

budget interface table
An Oracle General Ledger database table that stores information needed for budget upload. The interface table from which Oracle Assets uploads budget information.

budget line
Estimated cost, revenue, labor hours, or other quantity for a project or task categorized by a resource.

budget organization
An entity (department, cost center, division or other group) responsible for entering and maintaining budget data. You define budget organizations for your company, then assign the appropriate accounts to each budget organization. An entity, such as a department, division, or activity, responsible for entering and maintaining budget data.

budget rules
A variety of shorthand techniques you can use to speed manual budget entry. With budget rules you can divide a total amount evenly among budget periods, repeat a given amount in each budget period or enter budget amounts derived from your account balances.

budget upload
The ability to transfer budget information from a spreadsheet to Applications Desktop Integrator. For example, with the spreadsheet interface you can upload budget information from your spreadsheet to Applications Desktop Integrator. The process by which Oracle Assets loads budget information from the Budget Interface table into the Budget worksheet. You can use the Budget Upload process to transfer budget information from a feeder system, such as a spreadsheet, to Oracle Assets.
**budget worksheet**
Oracle Assets holds your budget in the budget worksheet so that you can review and change it before you load it into your budget book. Your budget must be in a budget book before you can run depreciation projections or reports.

**budgetary account**
An account segment value (such as 6110) that is assigned one of the two budgetary account types. You use budgetary accounts to record the movement of funds through the budget process from appropriation to expended appropriation.

**Budgetary Account**
An account that contains a budgetary account.

**budgetary account type**
Either of the two account types Budgetary DR and Budgetary CR.

**budgetary control**
An Oracle Financials feature you use to control actual and anticipated expenditures against a budget. When budgetary control is enabled, you can check funds online for transactions, and you can reserve funds for transactions by creating encumbrances. Oracle Financials automatically calculates funds available (budget less encumbrances less actual expenditures) when you attempt to reserve funds for a transaction. Oracle Financials notifies you online if funds available are insufficient for your transaction.

**burden cost code**
An implementation-defined classification of overhead costs. A burden cost code represents the type of burden cost you want to apply to raw cost. For example, you can define a burden cost code of G&A to burden specific types of raw costs with General and Administrative overhead costs.

**business day**
Days on which financial institutions conduct business. In General Ledger, you choose which days of the calendar year are defined as business days. You can include or exclude weekends and holidays as needed.

**burden costs**
Burden costs are legitimate costs of doing business that support raw costs and cannot be directly attributed to work performed. Examples of burden costs are fringe benefits, office space, and general and administrative costs.
burden multiplier
A numeric multiplier associated with an organization for burden schedule revisions, or with burden cost codes for projects or tasks. This multiplier is applied to raw cost to calculate burden cost amounts. For example, you can assign a multiplier of 95% to the burden cost code of Overhead.

burden schedule
An implementation-defined set of burden multipliers that is maintained for use across projects. Also referred to as a standard burden schedule. You may define one or more schedules for different purposes of costing, revenue accrual, and invoicing. Oracle Projects applies the burden multipliers to the raw cost amount of an expenditure item to derive an amount; this amount may be the total cost, revenue amount, or bill amount. You can override burden schedules by entering negotiated rates at the project and task level. See also Firm Schedule, Provisional Schedule, Burden Schedule Revision, Burden Schedule Overrides.

burden schedule override
A schedule of negotiated burden multipliers for projects and tasks that overrides the schedule you defined during implementation.

burden schedule revision
A revision of a set of burden multipliers. A schedule can be made of many revisions.

burden structure
A burden structure determines how cost bases are grouped and what types of burden costs are applied to the cost bases. A burden structure defines relationships between cost bases and burden cost codes and between cost bases and expenditure types.

burdened cost
The cost of an expenditure item, including raw cost and burden costs.

business entity
A person, place, or thing that is tracked by your business. For example, a business entity can be an account, a customer, or a part.

business group
The highest level of organization and the largest grouping of employees across which a company can report. A business group can correspond to an entire
company, or to a specific division within the company. Each installation of Oracle Projects uses one business group with one hierarchy.

**business purpose**
The business reason you have for communicating with a customer’s address. For example, you would assign the business purpose of Ship To to an address if you ship products to that address. If you also send invoices to that address, you could also assign the business purpose Bill To. Bill To and Ship To are the only business purposes recognized in Oracle Order Entry. (Receivables QuickCode)

**button**
You choose a button to initiate a predefined action. Buttons do not store values. A button is usually labeled with text to describe its action or it can be an icon whose image illustrates its action.

**cache**
A temporary storage area for holding information during processing.

**calculated depreciation method**
A depreciation method that uses the straight-line method to calculate depreciation based on the asset life and the recoverable cost.

**call actions**
Actions that you record and plan to take as a result of a call with a customer. Examples of actions that you might note for future reference include creating a credit memo, excluding a customer from dunning, or alerting another member of your staff about an escalated issue.

**call topics**
Each call can have many points or topics of discussion. Examples include invoice, debit memo, invoice lines, and customer problems.

**cancellation code**
A reason that justifies the cancellation of an order or order line. To cancel an order you must enter a cancellation code to record why the customer wants to nullify the order or order line. (Order Entry QuickCode)
**candidate**
A record that Applications Desktop Integrator selects to purge based on the last activity date you specify. Applications Desktop Integrator only selects records that you have not updated since the last activity date you specify. Applications Desktop Integrator does not purge a candidate until you confirm a purge.

**capital gain threshold**
The minimum time you must hold an asset for Applications Desktop Integrator to report it as a capital gain when you retire it. If you hold an asset for at least as long as the capital gain threshold, Fixed Assets reports it as a capital gain when you retire it. If you hold the asset for less than the threshold, Fixed Assets reports it as an ordinary income from the retirement.

**capitalized assets**
Capitalized assets are assets that you depreciate (spread the cost expense over time). The Asset Type for these assets is “Capitalized”.

**capital project**
A project in which you build one or more depreciable fixed assets.

**carrier**
See freight carrier.

**cash basis**
An accounting method that lets you recognize revenue at the time payment is received for an invoice.

**cash basis of accounting**
An accounting method in which you only recognize an expense when you incur the expense. With the Cash Basis of Accounting, Applications Desktop Integrator only creates journal entries for invoice payments.

**Cash Clearing Account**
The cash clearing account you associate with a payment document. You use this account if you integrate Oracle Payables with Oracle Cash Management, or if you generate future dated payment documents. Oracle Payables credits this account instead of your Asset (Cash) account and debits your Liability account when you post uncleared payments. Oracle Payables debits this account and credits your Asset (Cash) account once you clear your payments in Oracle Cash Management.
You must enable the Allow Reconciliation Accounting Payables option to be able to enter a cash clearing account for a bank account and payment document.

**cash flow**
Cash receipts minus cash disbursements from a given operation or asset for a given period.

**cash forecast**
Projection or estimate of cash position based on estimated future sales, revenue, earnings, or costs.

**category**
See *item category*. A feature you use to purge a particular group of records from the database. Applications Desktop Integrator lets you choose from 5 separate categories:

- Suppliers
- Simple Invoices
- Simple Requisitions (only if you installed Oracle Purchasing)
- Simple Purchase Orders (only if you installed Oracle Purchasing)
- Matched Invoices and POs (only if you installed Oracle Purchasing)

**category flexfield**
Fixed Assets lets you group your assets and define what descriptive and financial information you want to keep about your asset categories. You use your Category Flexfield to define how you want to keep the information.

**chargebacks**
A new debit item that you assign to your customer when closing an existing, outstanding debit item.

**child segment value**
A detail-level segment value that is part of a parent segment value.

**chart of accounts**
The account structure your organization uses to record transactions and maintain account balances.
**chart of accounts structure**

A classification of account segment values that assigns a particular range of values a common characteristic. For example, 1000 to 1999 might be the range of segment values for assets in the account segment of your accounting flexfield.

**check**

A bill of exchange drawn on a bank and payable on demand. Or, a written order on a bank to pay on demand a specified sum of money to a named person, to his or her order, or to the bearer out of money on deposit to the credit of the maker.

A check differs from a warrant in that a warrant is not necessarily payable on demand and may not be negotiable. It differs from a voucher in that a voucher is not an order to pay.

**check box**

You can indicate an on/off or yes/no state for a value by checking or unchecking its check box. One or more check boxes can be checked since each check box is independent of other check boxes.

**check overflow**

A check printing situation where there are more invoices paid by a check than can fit on the remittance advice of the check.

**child request**

A concurrent request submitted by another concurrent request (a parent request.) For example, each of the reports and/or programs in a report set are child requests of that report set.

**CIP assets**

See *construction-in-process assets*.

**chargeable project**

For each expenditure, a project to which the expenditure can be charged or transferred.

**class category**

An implementation-defined category for classifying projects. For example, if you want to know the market sector to which a project belongs, you can define a class category with a name such as *Market Sector*. Each class category has a set of values (class codes) that can be chosen for a project. See *class code*.
**class code**

An implementation-defined value within a class category that can be used to classify a project. See *class category*.

**clear**

A payment status when the bank has disbursed funds for the payment, and the payment has been cleared but not matched to a bank statement within Oracle Cash Management.

**clearing**

A process that assigns a cleared date and status to a transaction and creates accounting entries for the cash clearing account. See also *manual clearing, reconciliation*.

**clearing account**

An account used to ensure that both sides of an accounting transaction are recorded. For example, when you purchase an asset, your payables group creates a journal entry to the asset clearing account. When your fixed assets group records the asset, they create another journal entry to the asset clearing account to balance the entry from the payables group.

**closed order**

An order and its order lines that have completed all actions of the order cycle and on which the Close Orders program has been run.

**column set**

A Financial Statement Generator report component you build within Applications Desktop Integrator by defining all of the columns in a report. You control the format and content of each column, including column headings, spacing and size, calculations, units of measure, and precision. A typical column set includes a header column for headings and subheadings, currency assignments, amount types, and calculation columns totals. You can also define a column set with each column representing a different company to enhance consolidation reporting. You can also define a column set with each column representing a different fund to enhance reporting by fund group.

**columns**

Oracle database tables consist of columns. Each column contains one type of information. The format to indicate tables and columns is: (TABLE_NAME.COLUMN_NAME).
combination block
A combination block displays the fields of a record in both multi-record (summary) and single-record (detail) formats. Each format appears in its own separate window that you can easily navigate between.

combination of segment values
A combination of segment values uniquely describes the information stored in a field made up of segments. A different combination of segment values results when you change the value of one or more segments. When you alter the combination of segment values, you alter the description of the information stored in the field.

combination query
See Existing Combinations.

combined basis accounting
A method of accounting that combines both Accrual Basis Accounting and Cash Basis Accounting. With Combined Basis of Accounting, you use two separate sets of books, one for the accrual basis accounting method and the other for the cash basis accounting method. Applications Desktop Integrator creates journal entries for invoices and payments to post to your accrual set of books and creates journal entries for payments to post to your cash set of books.

comment alias
A user-defined name for a frequently used line of comment text, which can be used to facilitate online entry of timecards and expense reports.

commitment
A contractual guarantee with a customer for future purchases, usually involving deposits or prepayments. You can create invoices against the commitment to absorb the deposit or prepayment. Oracle Receivables automatically records all necessary accounting entries for your commitments. Oracle Order Entry allows you to enter order lines against commitments. A journal entry you make to record an anticipated expenditure as indicated by approval of a requisition. Also known as pre-commitment, pre-encumbrance or pre-lien. An encumbrance you record when you complete a purchase requisition. A journal entry you make to record an anticipated expenditure as indicated by approval of a requisition. Also known as pre-commitment, pre-encumbrance or pre-lien.
common bill
A bill of material that is shared between organizations. This enables you to reduce your maintenance effort by sharing the same bill structure among two or more bills of material. For example, if you have identical bills of material that produce the same product in two different organizations, you can define common bills of material for the identical structures.

compensation rule
An implementation-defined name for an employee compensation method. Also known as pay type. Typical compensation rules include Hourly and Exempt.

complete invoice
An invoice whose status is Complete. When you enter a new invoice, the status remains incomplete until you actually choose to complete it. To have a status of Complete, the invoice total must be greater than or equal to zero, the invoice must have at least one invoice line, revenue records must exist for each line, revenue records for each line must add up to the line amount, and a tax and revenue credit record must exist for each line. An invoice whose status is Complete. In order for an invoice to have a status of Complete, the invoice total must be greater than or equal to zero, have at least one invoice line, revenue records must exist for each line, revenue records for each line must add up to the line amount, and a tax and sales credit record must exist for each line.

compound tax
A method of calculating tax on top of other tax charges. You can create compound taxes in the Transactions window or with AutoInvoice.

complete matching
A condition where the invoice quantity matches the quantity originally ordered, and you approve the entire quantity. See also matching, partial matching.

consolidated billing invoice
An invoice that you send to a customer to provide a summary of their receivables activity for the month. This invoice includes a beginning balance, the total amount of any payments received since the prior consolidated billing invoice, an itemized list of new charges (for example, invoices, credit memos, and adjustments) in either summary or detail format, a separate reporting of consumption tax, and the total balance due for this customer.

construction-in-process (CIP) asset A depreciable fixed asset you plan to
build during a cap

ital project. The costs associated with building CIP assets are referred to as CIP costs. See also capital project.

component

See Standard Component.

component item

An item associated with a parent item on a bill of material.

concurrent manager

A unique facility that manages many time-consuming, non-interactive tasks within Oracle Applications for you, so you do not have to wait for their completion. When you submit a request in Oracle Applications that does not require your interaction, such as releasing shipments or running a report, the Concurrent Manager does the work for you, enabling you to complete multiple tasks simultaneously.

concurrent process

A non-interactive task that you request Oracle Applications to complete. Each time you submit a non-interactive task, you create a new concurrent process. A concurrent process runs simultaneously with other concurrent processes (and other interactive activities on your computer) to help you complete multiple tasks at once.

concurrent processing

Allows a single processor to switch back and forth between different programs.

concurrent queue

A list of concurrent requests awaiting completion by a concurrent manager. Each concurrent manager has a queue of requests waiting to be run. If your system administrator sets up your Oracle Application to have simultaneous queuing, your request can wait to run in more than one queue.

concurrent request

A request to Oracle Applications to complete a non-interactive task for you. You issue a request whenever you submit a non-interactive task, such as releasing a shipment, posting a journal entry, or running a report. Once you submit a request, Oracle Applications automatically takes over for you, completing your request without further involvement from you or interruption of your work.
configuration
A group of order lines that correspond to a customer’s selection of a base model and associated options. Configurations can either be shipped as individual pieces, as a set (kit), or as an assemble (configuration item). See also assemble-to-order model, configuration item, model, pick-to-order model.

configuration item
The item that corresponds to a base model and a specific list of options chosen by the customer. Oracle Bills of Material creates a new configuration item each time a customer orders an ATO model. A PTO model appears as a list of items on the pick slip for the picker to gather for shipment. See also assemble-to-order model, configuration, pick-to-order model.

configurator
The Enter Configuration Options form that allows you to choose options that are available for a particular model, thus defining a particular configuration for the model.

configure-to-order
An environment where you enter customer orders by choosing a base model and then selecting options from a list of choices.

consolidation
A General Ledger feature that allows you to combine the results of multiple companies, even if they are in different sets of books with different currencies, calendars, and charts of account. The Consolidated Billing Invoice program lets you print a single, monthly invoice that includes all of your customer’s transactions for the period. This lets you send one consolidated billing invoice instead of a separate invoice for each transaction.

consolidated billing invoice
A single, monthly invoice that includes all of your customer’s transactions for the period. This feature lets you send a customer one, consolidated billing invoice instead of a separate invoice for each transaction.

consolidation
A General Ledger feature that allows you to combine the results of multiple funds, even if they are in different sets of books with different currencies, calendars, and account classification code structures.
**consolidation set of books**
A set of books that has average balance processing enabled and that is defined as a consolidation set of books. A consolidation set of books must be used to consolidate average balances using the balances consolidation method.

**construction-in-process (CIP) assets**
You construct CIP assets over a period of time rather than buying a finished asset. Oracle Assets lets you create, maintain, and add to your CIP assets as you spend money for material and labor to construct them. When you finish the assets and place them in service (capitalize them), Oracle Assets begins depreciating them.

**consumption tax**
An indirect tax imposed on transfer of goods and services at each stage of their supply. The difference between output tax (tax collected for revenue earned from the transfer) and the input tax (tax paid on expense paid on the transfer) will be the tax liability to the government. This tax is, in concept, value added tax (VAT).

**contact**
A representative who is responsible for communication between you and a specific part of your customer’s agency. For example, your customer may have a shipping contact person who handles all questions regarding orders shipped to that address. Applications Desktop Integrator lets you enter contacts for your customers, addresses, and business purposes. A representative who is responsible for communication between you and a specific part of your customer’s company. For example, your customer may have a shipping contact person who handles all questions regarding orders shipped to that address. Applications Desktop Integrator lets you enter contacts for your customers, addresses, and business purposes. A customer representative who is involved with a project. For example, a contact can be a billing contact, the customer representative who receives project invoices.

**contact role**
A responsibility that you associate to a specific contact. Applications Desktop Integrator provides ‘Bill To’, ‘Ship To’, and ‘Statements,’ but you can enter additional responsibilities.

**contact type**
An implementation-defined classification of project contacts according to their role in the project. Typical contact types are Billing and Shipping.
content set
A report component you build within General Ledger that defines the information in each report and the printing sequence of your reports. For example, you can define a departmental content set that prints one report for each department.

context field prompt
A question or prompt to which a user enters a response, called a context field value. When Oracle Applications displays a descriptive flexfield pop-up window, it displays your context field prompt after it displays any global segments you have defined. Each descriptive flexfield can have up to one context prompt.

context field value
A response to your context field prompt. Your response is composed of a series of characters and a description. The response and description together provide a unique value for your context prompt, such as 1500, Journal Batch ID, or 2000, Budget Formula Batch ID. The context field value determines which additional descriptive flexfield segments appear.

context response
See context field value.

context segment value
A response to your context-sensitive segment. The response is composed of a series of characters and a description. The response and description together provide a unique value for your context-sensitive segment, such as Redwood Shores, Oracle Corporation Headquarters, or Minneapolis, Merrill Aviation’s Hub.

context-sensitive segment
A descriptive flexfield segment that appears in a second pop-up window when you enter a response to your context field prompt. For each context response, you can define multiple context segments, and you control the sequence of the context segments in the second pop-up window. Each context-sensitive segment typically prompts you for one item of information related to your context response.

contract project
A project for which you can generate revenue and invoices. Typical contract project types include Time and Materials and Fixed Price. Formerly known as a direct project.
**control amount**
A feature you use to specify the total amount available for payment of a recurring payment. When you generate invoices for a recurring payment, Oracle Payables uses the control amount and the total number of payments to determine the invoice amount.

**control book**
A tax book, used for mass depreciation adjustments, that holds the minimum accumulated depreciation for each asset.

**control file**
A file used by SQL*Loader to map the data in your bank file to tables and columns in the Oracle database. You must create one control file for each different bank file you receive, unless some or all of your banks use the exact same format.

**conversion**
A process that converts foreign currency transactions to your functional currency. See also foreign currency conversion.

**Corporate book**
A depreciation book that you use to track financial information for your balance sheet.

**corporate exchange rate**
An exchange rate you can optionally use to perform foreign currency conversion. The corporate exchange rate is usually a standard market rate determined by senior financial management for use throughout the organization. You define this rate in Oracle General Ledger.

**cost base**
A cost base refers to the grouping of raw costs to which burden costs are applied. Examples of cost bases are Labor and Materials.

**cost budget**
The estimated cost amounts at completion of a project. Cost budget amounts can be summary or detail, and can be burdened or unburdened.

**cost burden schedule**
A burden schedule used for costing to derive the total cost amount. You assign the cost burden schedule to a project type that is burdened; this default cost burden
schedule defaults to projects that use the project type; and then from the project to
the tasks below the project. You may override the cost burden schedule for a project
or a task if you have defined the project type option to allow overrides of the cost
burden schedule.

cost distribution
The act of calculating the cost and determining the cost accounting for an
expenditure item.

cost rate
The monetary cost per unit of an employee, expenditure type, or resource.

Cost-to-Cost
A revenue accrual method that calculates project revenue as budgeted revenue
multiplied by the ratio of actual cost to budgeted cost. Also known as percentage
of completion method or percentage spent method.

credit check
An Oracle Order Entry feature that automatically checks a customer order total
against predefined order and total order limits. If an order exceeds the limit, Oracle
Order Entry places the order on hold for review by your finance group. See also
credit check rule

credit check rule
A rule that defines the components used to calculate a customer’s outstanding
credit balance. Components include open receivables, uninvoiced orders, and
orders on hold. You can include or exclude components in the equation to derive
credit balances consistent with your company’s credit policies.

credit invoice
An invoice you receive from a supplier representing a credit amount that the
supplier owes to you. A credit invoice can represent a quantity credit or a price
reduction. You can create a mass addition line from a credit invoice and apply it to
an asset.

credit items
Any item you can apply to an open debit item to reduce the balance due for a
customer. Applications Desktop Integrator includes credit memos, on account
credits, and unapplied and on account cash as credit items. Credit items remain
open until you apply the full amount to debit items.
credit memo
A document that partially or fully reverses an original invoice. You can create credit memos in the Oracle Receivables Credit Memo window or with AutoInvoice.

credit memo reasons
Standard explanations as to why you credit your customers. (Receivables QuickCode) See also return reason.

cross currency receipt
A receipt that is applied to a transaction denominated in a currency different than that of the receipt. Cross currency receipt applications usually generate a foreign exchange gain or loss due to fluctuating exchange rates between currencies.

cross site and cross customer receipts
Receipts that you apply across customers and sites and are fully applied. Each of these receipts appears on the statements of the customer site that owns the receipt. The invoice(s) to which you have applied a cross receipt appear on the statement of the customer or site that owns the invoice.

credit receiver
A person receiving credit for project or task revenue. One project or task may have many credit receivers for one or many credit types.

credit type
An implementation-defined classification of the credit received by a person for revenue a project earns. Typical credit types include Quota Credit and Marketing Credit.

cross rate
An exchange rate you use to convert one foreign currency amount to another foreign currency amount. In Applications Desktop Integrator, you use a cross rate to convert your invoice currency to your payment currency.

Cross-Project responsibility
A responsibility that permits users to view and update any project.

cross-project user
A user who is logged into Oracle Projects using a Cross-Project responsibility.
cross-validation rules
Rules that define valid combinations of segment values a user can enter in an account. Cross-validation rules restrict users from entering invalid combinations of account segment values. Rules that define valid combinations of segment values that a user can enter in an key flexfield. Cross-validation rules restrict users from entering invalid combinations of key flexfield segment values.

Cumulative Translation Adjustment
A balance sheet account included in stockholder’s equity in which Applications Desktop Integrator records net translation adjustments in accordance with FASB 52 (U.S.). You specify the account you want to use for Cumulative Translation Adjustment when you define each set of books in the Set of Books window.

current dimension
The Oracle Financial Analyzer dimension from which you are selecting values. The current dimension is the one you specified in the Dimension box of the Selector window. Choices you make and actions you take in lower-level windows ultimately affect this dimension by selecting values from it to include in a report, graph, or worksheet.

current object
The Oracle Financial Analyzer object upon which the next specified action takes place. Generally, the current object is the one most recently selected. However, if you use a highlight a group of objects, such as data cells in a column, the first object in the group is the current object.

current budget
The most recently baselined budget version of the budget.

current record indicator
Multi-record blocks often display a current record indicator to the left of each record. A current record indicator is a one character field that when filled in, identifies a record as being currently selected.

customer address
A location where your customer can be reached. A customer can have many addresses. You can also associate business purposes with addresses.
**customer agreement**
See agreement.

**customer agreement type**
See agreement type.

**customer bank**
A bank account you define when entering customer information to allow funds to be transferred from these accounts to your remittance bank accounts as payment for goods or services provided. See also remittance bank.

**customer business purpose**
See business purpose.

**customer class**
A method to classify your customers by their business type, size, or location. You can create an unlimited number of customer classes. (Receivables QuickCode)

**customer contact**
A specific customer employee with whom you communicate. Applications Desktop Integrator lets you define as many contacts as you wish for each customer. You can also define contacts for an address and assign previously defined contacts to each business purpose.

**customer family agreement**
An agreement for a specific customer, available to any related customer. See also agreement, generic agreement.

**customer interface**
A program that transfers customer data from foreign systems into Oracle Receivables.

**customer interface tables**
A series of two Oracle Receivables database tables from which Customer Interface inserts and updates valid customer data into your customer database.
customer merge
A program that merges business purposes and all transactions associated to that business purpose for different sites of the same customer or for unrelated customers.

customer number
The number a supplier assigns to your organization.

customer number
A number assigned to your customers to uniquely identify them. A customer number can be assigned manually or automatically, depending on how you set up your system.

customer phone
A phone number that is associated with a customer. You can also assign phone numbers to your customer contacts.

customer profile
A method used to categorize your customers based on credit information. Oracle Receivables uses credit profiles to assign statement cycles, dunning letter cycles, salespersons, and collectors to your customers. You can also decide whether you want to charge your customers interest. Oracle Order Entry uses the order and total order limits when performing credit checking.

customer profile class
A category for your customers based on credit information, payment terms, currency limits, and correspondence types.

customer relationship
An association that exists between customers which lets you apply payments to related customers, apply invoices to related customer’s commitments, and create invoices for related customers.

customer response
Explanations, comments, or claims that customers make during conversation with a collector regarding the call reason.
**customer site**
A site where a customer is located. A customer can have more than one site. Site names can more easily identify a customer address, facilitating invoice and order entry. See also **location**.

**customer status**
The Active/Inactive flag you use to inactivate customers with whom you no longer do business. If you are using Oracle Order Entry, you can only enter orders, agreements, and returns for active customers, but you can continue to process returns for inactive customers. If you are using Oracle Receivables, you can only create invoices for active customers, but you can continue collections activities for inactive customers.

**cutoff day**
The day of the month that determines when an invoice with proxima payment terms is due. For example, if it is January and the cutoff day is the 10th, invoices dated before or on January 10 are due in the next billing period; invoices dated after the 10th are due in the following period.

**cycle action**
A cycle action is a discrete event that can occur one or more times during the life of an order. Actions can occur at the order level (where all lines on the order are processed together), such as credit or legal reviews. Actions can also occur at the line level (where each line can be processed independently), such as shipping confirmation or backordering. Oracle Order Entry uses actions to identify each step in your order cycle. See also **action result**, **order cycle**.

**DBA library**
If an Oracle Financial Analyzer database object belongs to a DBA library, it means that the object was created by an administrator and cannot be modified by a user.

**database table**
A basic data storage structure in a relational database management system. A table consists of one or more units of information (rows), each of which contains the same kind of values (columns). Your application’s programs and windows access the information in the tables for you. See also **customer interface tables**.
**date placed in service**
The calendar date on which you start using an asset.

**debit invoice**
An invoice you generate to send to a supplier representing a credit amount that the supplier owes to you. A debit invoice can represent a quantity credit or a price reduction.

**debit items**
Any item that increases your customer’s balance. Applications Desktop Integrator includes invoices, debit memos, and chargebacks as debit items. Debit items remain open until the balance due is zero.

**debit memo reversal**
A reversal of a payment that generates a new debit memo, instead of reopening old invoices and debit memos.

**debit memos**
Debits that you assign to your customer for additional charges that you want to collect. For example, you may want to charge your customers for unearned discounts taken, additional freight charges, taxes, and finance charges.

**deferred depreciation**
The difference between the depreciation expense for an asset in a tax book and its depreciation expense in the associated corporate book.

**deferred revenue**
An event type classification that generates an invoice for the amount of the event, and has no immediate effect on revenue. The invoice amount is accounted for in an unearned revenue account that will be offset as the project accrues revenue.

**delete group**
A set of items, bills, and routings you choose to delete.

**demand**
An effective method of communicating current or future product need to Inventory and other manufacturing products. Effective demand management allows you make timely decisions on product procurement and resource scheduling.
**demand class**
A category you can use to segregate scheduled demand and supply into groups, so that you can track and consume the groups independently. You can define a demand class for a very important customer or a group of customers.
(Manufacturing QuickCode)

**demand management**
The function of recognizing and managing all demands for products, to ensure the master scheduler is aware of them. This encompasses forecasting, order entry, order promising (available to promise), branch warehouse requirements, and other sources of demand.

**demand time fence**
A date within which the planning process does not consider forecast demand when calculating actual demand. Within the demand time fence, sales orders are the only source of demand. Outside the demand time fence, the planning process considers forecast entries.

**dependent segment**
An account segment in which the available values depend on values entered in a previous segment, called the independent segment. For example, the dependent segment Sub-Account 0001 might mean Bank of Alaska when combined with the independent segment Account 1100, Cash, but the same Sub-Account 0001 might mean Building #3 when combined with Account 1700, Fixed Assets.

**deposit**
A type of commitment whereby a customer agrees to deposit or prepay a sum of money for the future purchase of goods and services.

**depreciable basis**
The amount of your asset that is subject to depreciation, generally the cost minus the salvage value. Also known as recoverable cost.

**depreciate**
To depreciate an asset is to spread its cost over the time you use it. You charge depreciation expense for the asset each period. The total depreciation taken for an asset is stored in the accumulated depreciation account.
**depreciation book**
A book to store financial information for a group of assets. A depreciation book can be corporate, tax, or budget. Also known as book.

**depreciation calendar**
The depreciation calendar determines the number of accounting periods in a fiscal year. It also determines, with the divide depreciation flag, what fraction of the annual depreciation amount to take each period. You must specify a depreciation calendar for each book.

**depreciation projection**
The expected depreciation expense for specified future periods.

**depreciation reserve**
See accumulated depreciation.

**descriptive flexfield**
Descriptive Flexfield A field that your organization can extend to capture extra information not otherwise tracked by Oracle Applications. A descriptive flexfield appears in your window as a single character, unnamed field. Your organization can customize this field to capture additional information unique to your business.

**direct project**
An obsolete term. See contract project.

**detail budget**
A budget whose authority is controlled by another budget.

**dimension**
An Oracle Financial Analyzer database object used to organize and index the data stored in a variable. Dimensions answer the following questions about data: "What?" "When?" and "Where?" For example, a variable called Units Sold might be associated with the dimensions Product, Month, and District. In this case, Units Sold describes the number of products sold during specific months within specific districts.
**dimension label**
A text label that displays the name of the Oracle Financial Analyzer dimension associated with an element of a report, graph, or worksheet. For example, the data markers in a graph’s legend contain dimension labels that show what data each data marker represents. Dimension labels can be short, meaning they display the object name of a dimension, or user-specified, meaning they display a label that you typed using the Dimension Labels option on the Graph, Report, or Worksheet menus.

**dimension values**
Elements that make up an Oracle Financial Analyzer dimension. For example, the dimension values of the Product dimension might include Tents, Canoes, Racquets, and Sportswear.

**direct debit**
An agreement made with your customer to allow the transfer of funds from their bank account to your bank account. The transfer of funds occurs when the bank receives a document or tape containing the invoices to be paid.

**disbursement type**
A feature you use to determine the type of payment for which a payment document is used. For example, computer-generated payments and recorded checks or wire transfers.

**discount**
(Order Entry) A reduction of the list price of an item. In Oracle Order Entry, you can associate discounts with price lists and apply them either automatically or manually to an order or order line. The amount or percentage that you allow a customer to decrease the balance due for a debit item. In Receivables, you use Payment Terms to define customer discounts and can choose whether to allow earned and unearned discounts. See also best discount, fixed price discount, price adjustment, earned discounts. See also earned discounts, unearned discounts, payment terms.

**discrete job**
A production order for the manufacture of a specific (discrete) quantity of an assembly, using specific materials and resources, within a limited range of time. A discrete job collects the costs of production and allows you to report those costs -- including variances -- by job. Also known as work order or assembly order.
**display group**
A range of rows or columns in your row set or column set for which you want to control the display in your report. You assign a display group to a display set where you specify whether you want to display or hide your rows or columns.

**display set**
A Financial Statement Generator report component you build within Applications Desktop Integrator to control the display of ranges of rows and columns in a report, without reformating the report or losing header information. You can define a display set that works for reports with specific row and column sets. Alternatively, you can define a generic display set that works for any report.

**distribution line**
A line corresponding to an accounting transaction for an expenditure item on an invoice, or a liability on a payment. Information such as employee, general ledger depreciation expense account, and location to which you have assigned an asset. You can create any number of distribution lines for each asset. Oracle Assets uses distribution lines to allocate depreciation expense and to produce your Property Tax and Responsibility Reports.

**distribution list**
A distribution list is a set of mail names to whom Oracle Alert sends a message when it finds an exception condition. An alert can have many distribution lists and each distribution list can have its own set of input variables to increase your control over who gets messages about what. For example, to send a message about furniture to Joe Smith and about telecommunications equipment to Sally Jones, you can define two distribution lists and enter the appropriate item class as an input variable to each list.

**distribution rule**
See revenue distribution rule.

**distribution set**
A predefined group of general ledger accounting codes that determine the debit accounts for other receipt payments. Receivables lets you relate distribution sets to receivables activities to speed data entry. A Payables feature you use to assign a name to a predefined expense distribution or combination of distributions (by percentage). Payables displays on a list of values the list of Distributions Sets you define. With Distribution Sets, you can enter routine invoices into Payables without having to enter accounting information.
distribution total
The total amount of the distribution lines of an invoice. The distribution total must equal the invoice amount before you can pay or post an invoice.

document category
A document category is used to split transactions into logical groups. You can assign a different sequence to each category and, by doing so, separately number each logical group. Each category is associated with a table. When you assign a sequence to a category, the sequence numbers the transactions in that table. Applications Desktop Integrator lets you set up categories for each type of transaction, receipt, and adjustment.

document sequence
Used to uniquely number documents created by Applications Desktop Integrator. A Document Sequence has a sequence name, an initial value, and a type of either Automatic or Manual. Used to uniquely number documents, such as bank statements in Cash Management and invoices in Receivables. A Document Sequence has a sequence name, an initial value, and a type of either Automatic or Manual.

document sequence number
A number that is manually or automatically assigned to your documents to provide an audit trail. For example, you can choose to sequentially number invoices in Oracle Receivables or journal entries in General Ledger. See also voucher number.

domestic transaction
Transactions between registered traders in the same EU (European Union) country. Domestic transactions have VAT charged on goods and services with different countries applying different VAT rates to specific goods and services. See also external transaction, EU.

document sets
A grouping of shipping documents that you can run from the Confirm Shipment window.

draft budget
A preliminary budget which may be changed without affecting revenue accrual on a project.
**draft invoice**
A potential project invoice that is created, adjusted, and stored in Oracle Projects. Draft invoices require approval before they are officially accounted for in other Oracle Applications.

**draft revenue**
A project revenue transaction that is created, adjusted, and stored in Oracle Projects. You can adjust draft revenue before you transfer it to other Oracle Applications.

**drilldown**
A software feature that allows you to view the details of an item in the current window via a window in a different application.

**due from**
A liability account you use to record noncurrent portions of a long-term debt, owed by one fund to another fund, within the same reporting entity.

**due to**
An asset account you use to record the noncurrent portion of a long-term loan, from one fund to another fund, within the same reporting entity.

**dunning letter set**
A group of dunning letters that you can assign to your customer’s credit profile.

**dunning letters**
A letter that you send to customers to inform them of past due debit items. Oracle Receivables lets you specify the text and format of each letter and whether to include unapplied and on-account payments.

**duplicate**
An exception that Oracle Alert has previously sent to the same distribution list. You can choose to suppress duplicates completely for detail messages, or to identify them with asterisks (*) in summary messages. For example, if on Monday Oracle Alert notifies a purchasing agent that a supplier shipment is overdue, then on Tuesday Oracle Alert finds that the shipment is still overdue, you can choose whether Oracle Alert should renotify the purchasing agent or suppress the message.

**dynamic distribution**
A distribution that includes at least one recipient whose electronic mail ID is represented by an alert output. Oracle Alert locates the actual electronic mail ID in
one of the application tables, and substitutes it into the distribution before sending the alert message.

**dynamic insertion**

An Accounting Flexfields feature that allows you to enter and define new combinations of segment values directly in a flexfield pop-up window. The new combination must satisfy any cross-validation rules before it is accepted. Your organization can decide if an Accounting Flexfield supports dynamic insertion. If an account does not support dynamic insertion, you can only enter new combinations of segment values using the Define Accounts window. A feature specific to key flexfields that allows you to enter and define new combinations of segment values directly into a flexfield pop-up window. The new combination must satisfy any cross-validation rules, before your flexfield accepts the new combination. Your organization can decide if a key flexfield supports dynamic insertion. If a flexfield does not support dynamic insertion, you can only enter new combinations of segment values using a combinations form (a form specifically used for creating and maintaining code combinations). An Oracle Applications feature that lets you automatically create new key flexfield combinations when you enter transactions or customers. If you do not use dynamic insertion, you can only create new key flexfield combinations using the various flexfield setup forms.

**effective date**

The date a transaction affects the balances in the general ledger. This does not have to be the same as the posting date. Also known as the *value date*.

**earned discounts**

Discounts your customers are allowed to take if they remit payment for their invoices on or before the discount date. The discount date is determined by the payment terms assigned to an invoice. Applications Desktop Integrator takes into account any discount grace days you assign to this customer’s credit profile. For example, if the discount due date is the 15th of each month, but discount grace days is 5, your customer must pay on or before the 20th to receive the earned discount. Discounts are determined by the terms you assign to an invoice during invoice entry. See also *unearned discounts*.

**EFT**

See *Electronic Funds Transfer (EFT)*.
Electronic Funds Transfer (EFT)
A method of payment in which your bank transfers funds electronically from your bank account into another bank account. In Oracle Payables, your bank transfers funds from your bank account into the bank account of a supplier you pay with the Electronic payment method.

employee billing title
An employee title, which differs from a job billing title, that may appear on an invoice. Each employee can have a unique employee billing title.

employee organization
The organization to which an employee is assigned.

encumbrance
See encumbrance journal entry. An entry you make to record anticipated expenditures of any type. Oracle Financials create requisition encumbrances and purchase order encumbrances automatically when encumbrance accounting or budgetary control is enabled. You can also record other encumbrances manually. For example, you can record encumbrances for your payroll.

encumbrance accounting
An Oracle Financials feature you use to create encumbrances automatically for requisitions, purchase orders, and invoices. The budgetary control feature uses encumbrance accounting to reserve funds for budgets. If you enable encumbrance accounting only, you can create encumbrances automatically or manually; however, you cannot check funds online and Oracle Financials does not verify available funds for your transaction. See also budgetary control. An Oracle Government Financials feature that creates encumbrances automatically for requisitions, purchase orders, and invoices. If you enable encumbrance accounting only, you can create encumbrances automatically or manually. You cannot check funds online unless you also enable budgetary control. See also budgetary control.

encumbrance journal entry
A journal entry that increases or relieves encumbrances. Encumbrance entries can include encumbrances of any type.

If you have enabled encumbrance accounting, when you successfully approve an invoice matched to an encumbered purchase order, Applications Desktop Integrator automatically creates encumbrance journal entries that relieve the original encumbrance journal entries. Applications Desktop Integrator also creates new
encumbrance journal entries for any quantity or price variance between an invoice and the matched purchase order.

Applications Desktop Integrator automatically creates encumbrance journal entries for an unmatched invoice when you approve the invoice. A journal entry you create online that increases or relieves your encumbrances. Encumbrance entries can include encumbrances of any type. You can enter manual encumbrance entries, define encumbrance allocations, or use Journal Import to import encumbrance entries from other financial systems.

**encumbrance type**
An encumbrance category that allows you to track your anticipated expenditures according to your purchase approval process and to more accurately control your planned expenditures. Examples of encumbrance types are commitments (requisition encumbrances) and obligations (purchase order encumbrances). An encumbrance category that allows you to track your anticipated expenditures according to your purchase approval process and better control your planned expenditures. You can also attach an encumbrance type to your invoices for reporting purposes. Examples of encumbrance types are commitments (requisition encumbrances) and obligations (purchase order encumbrances)

**end-of-day balance**
The actual balance of a general ledger account at the end of a day. This balance includes all transactions whose effective date precedes or is the same as the calendar day.

**ending balance**
The ending balance represents the balance of the transaction as of the ending GL Date that you have specified. This column should be the same as the Outstanding Balance of the Aging - 7 Buckets Report for this item.

**EU**
The EU (European Union) is a single European market where customs and tariff barriers between member states have been removed.

**engineer-to-order**
An environment where customers order unique configurations that engineering must define and release custom bills for material and routings that specify how to build them. Oracle Manufacturing Release 10 does not provide special support for
this environment beyond the support it provides for assemble-to-order manufacturing.

**engineering change order (ECO)**
A record of revisions to one or more items usually released by engineering.

**euro**
A single currency adopted by the 11 member countries of the European Monetary Union (EMU) beginning January 1, 1999. These countries include Austria, Belgium, France, Finland, Germany, Ireland, Italy, Luxemburg, the Netherlands, Portugal, and Spain. The official abbreviation for the euro is EUR. This abbreviation is used for all commercial, business, and financial purposes, and has been registered with the International Standards Organization (ISO).

**event**
A summary level transaction assigned to a project or top task that records work completed and generates revenue and/or billing activity, but is not directly related to any expenditure items. For example, unlike labor costs or other billable expenses, a bonus your business receives for completing a project ahead of schedule is not attributable to any expenditure item, and would be entered as an event.

**event alert**
An alert that runs when a specific event that you define occurs. For example, you can define an event alert to immediately send a message to the buyer if an item is rejected on inspection. An alert that runs when a specific event occurs that you define. For example, you can define an event alert to send a message to the Accounts Payable Supervisor when an Accounts Payable Clerk enters an invoice that exceeds your maximum invoice amount for that supplier.

**event type**
An implementation-defined classification of events that determines the revenue and invoice effect of an event. Typical event types include Milestones, Scheduled Payments, and Write-Offs.

**exception**
A single occurrence of an event returned by an alert check. For example, if an alert checking for invoices that Approval places on funds hold finds five such invoices, each invoice is an exception.
exception reporting
Exception reporting is an integrated system of alerts, messages and distribution lists to focus attention on time-sensitive or critical information, streamline your communication channels, shorten your reaction time, and eliminate your information clutter. Exception reporting communicates information by either electronic mail or paper reports.

exchange rate
A rate that represents the amount of one currency that you can exchange for another at a particular point in time. Oracle Applications use the daily, periodic, and historical exchange rates you maintain to perform foreign currency conversion, revaluation, and translation. A rate that represents the amount in one currency that you can exchange for another at a particular point in time. You can enter and maintain daily exchange rates for Applications Desktop Integrator to use to perform foreign currency conversion. Applications Desktop Integrator multiplies the exchange rate by the foreign currency to calculate the functional currency.

exchange rate type
A specification of the source of an exchange rate. For example, a user exchange rate or a corporate exchange rate. See also corporate exchange rate, spot exchange rate.

exchange rate variance
The difference between the exchange rate for a foreign-currency invoice and its matched purchase order. Payables tracks any exchange rate variances for your foreign-currency invoices.

exemption certificate
A document obtained from a taxing authority which certifies that a customer or item is either partially or fully exempt from tax. The document details the reason for the exemption and the effective and expiration dates of the certificate.

Existing Combinations
A feature specific to key flexfields in data entry mode that allows you to enter query criteria in the flexfield to bring up a list of matching predefined combinations of segment values to select from.

expenditure
A group of expenditure items incurred by an employee or an organization for an expenditure period. Typical expenditures include Timecards and Expense Reports.
**expenditure (week) ending date**
The last day of an expenditure week period. All expenditure items associated with an expenditure must be on or before the expenditure ending date, and must fall within the expenditure week identified by the expenditure week ending date.

**expenditure category**
An implementation-defined grouping of expenditure types by type of cost. For example, an expenditure category with a name such as Labor refers to the cost of labor.

**expenditure comment**
Free text that can be entered for any expenditure item to explain or describe it in further detail.

**expenditure cost rate**
The monetary cost per unit of a non-labor expenditure type.

**expenditure cycle**
A weekly period for grouping and entering expenditures.

**expenditure group**
A user-defined name used to track a group of pre-approved expenditures, such as Timecards, or Expense Reports.

**expenditure item**
The smallest logical unit of expenditure you can charge to a project and task. For example, an expenditure item can be a timecard item or an expense report item.

**expenditure item date**
The date on which work is performed and is charged to a project and task.

**expenditure operating unit**
For an expenditure, the operating unit where the expenditure item was incurred against a project.

**expenditure organization**
For timecards and expense reports, the organization to which the incurring employee is assigned, unless overridden by organization overrides. For usage,
supplier invoices, and purchasing commitments, the incurring organization entered on the expenditure.

**expenditure type**
An implementation-defined classification of cost that you assign to each expenditure item. Expenditure types are grouped into cost groups (expenditure categories) and revenue groups (revenue categories).

**expenditure type class**
An additional classification for expenditure types that indicates how Oracle Projects processes the expenditure types. For example, if you run the Distribute Labor Costs process, Oracle Projects will calculate the cost of all expenditure items assigned to the Straight Time expenditure type class. Formerly known as *system linkage*.

**expenditures**
Activities that represent payments, repayments, or receipts for goods or services provided. For some governments, expenditures include anticipated expenses, such as encumbrances, in addition to activity that directly leads to an outlay of cash, such as an invoice. In Oracle Public Sector Financials, the term *expenditures* includes actual expenses and accrued liabilities. Expenditures do not include anticipated expenses, such as encumbrances.

**expense report**
A document that details expenses incurred by an employee for the purpose of reimbursement. You can enter expense reports online in Payables or Web Employees, or you can import them from Projects.

**expense report**
A document that, for purposes of reimbursement, details expenses incurred by an employee. You can set up expense report templates to match the format of your expense reports to speed data entry. You must create invoices from Payables expense reports using Invoice Import before you can pay the expense reports.

**expensed asset**
An asset that you do not depreciate, but charge the entire cost in a single period. Oracle Assets does not depreciate an expensed asset, or create any journal entries for it. You can, however, use Oracle Assets to track expensed assets. The Asset Type for these assets is “Expensed”.
expensed item
Items that do NOT depreciate; the entire cost is charged in a single period to an expense account. Applications Desktop Integrator tracks expensed items, but does not create journal entries for them.

export
A utility that enables you to copy data from an Oracle7 table to a file in your current directory. The export utility is part of the Oracle7 Relational Database Management System.

export
To move archive data to a different storage device.

external transaction
Transactions between an EU (European Union) trader and a supplier or customer located in a non-EU country. Customers and sites in non-EU countries are tax exempt and should have a zero tax code assigned to all invoices. See also domestic transaction, EU.

export file
The file the export utility creates in your directory. Export files must have the extension .dmp. It is wise to name the export file so it identifies the data in the table. For example, if you are saving fiscal year 1994 for your Fremont set of books, you might call your export file FY94FR.dmp.

external organization
See organization.

factor
Data upon which you perform some mathematical operation. Fixed amounts, statistical account balances, account balances, and report rows and columns are all data types you can use in formulas. The payee of an invoice when the payee differs from the supplier on the invoice. For example, a supplier may have sold their receivables to a factor.
**factoring**
The process by which you sell your accounts receivable to a financial institution (such as a bank) in return for cash. Financial institutions usually charge a fee for factoring.

**FASB 52 (U.S.)**
See SFAS 52.

**FASB 8 (U.S.)**
See SFAS 8.

**Federal Identification Number**
See **Tax Identification Number**.

**feeder program**
A custom program you write to transfer your transaction information from an original system into Oracle Application interface tables. The type of feeder program you write depends on the environment from which you are importing data.

**feeder system**
Another system from which you can pass information into Oracle Assets. For example, you can pass budget or production information from a spreadsheet into Oracle Assets.

**fiduciary funds**
A fund type for which the accounting and reporting techniques depend on whether the fund is expendable or nonexpendable. Examples of fiduciary funds include Trust and Agency funds.

**financial data item**
An Oracle Financial Analyzer database object that is made up of either a variable, or a variable and a formula. For example, a financial data item called “Actuals” would be a variable, while a financial data item called “Actuals Variance” would be made up of a variable (Actuals) and a formula that calculates a variance.

**field**
A position on a window that you use to enter, view, update, or delete information. A field prompt describes each field by telling you what kind of information appears in the field, or alternatively, what kind of information you should enter in the field.
field type
Each record you import is divided into regions and each region holds a different piece of information. Applications Desktop Integrator calls these regions “fields” and provides you with a list of the types of fields that can be interfaced through AutoLockbox.

final assembly order
A discrete job created from a custom configuration or a standard configure to order item and linked to a sales order. Also known as final assembly schedule.

finance charges
Additional charges that you assign to customers for past due items. You specify whether you want to charge your customers finance charges in their customer profiles. Finance charges can be included on your customer’s statements and dunning letters.

Financial Statement Generator
A powerful and flexible tool you can use to build your own custom reports without programming. You can define reports online with complete control over the rows, columns and contents of your report.

firm schedule
A burden schedule of burden multipliers that will not change over time. This is compared to provisional schedules in which actual multipliers are mapped to provisional multipliers after an audit.

first bill offset days
The number of days that elapse between a project start date and the date that the project’s first invoice is issued.

fiscal year
Any yearly accounting period without regard to its relationship to a calendar year. Any yearly accounting period without regard to its relationship to a calendar year.

fixed asset
An item owned by your business and used for operations. Fixed assets generally have a life of more than one year, are acquired for use in the operation of the business, and are not intended for resale to customers. Assets differ from inventory items since you use them rather than sell them.
**fixed assets unit**
A measure for the number of asset parts tracked in Oracle Assets. You can assign one or more units to a distribution line.

**fixed date**
See schedule fixed date.

**fixed price discount**
A discount that fixes the final selling price of the item so it is not affected by changes to the list price of the item. This is a method of implementing discounts to the list price where the final price is contractually fixed regardless of changes to the list price, as is the case with GSA prices. For example, if Item A has a list price of $100, a fixed price discount specifying a selling price of $90 results in a selling price of $90 even if the list price later increases to $110.

**fixed rate currencies**
Currencies with fixed exchange rates. For example, the Euro and currencies of countries in the European Monetary Union (EMU).

**flat file**
A file where the data is unformatted for a specific application.

**flat tax**
A specific amount of tax, regardless of the amount of the item. There is no rate associated with flat taxes. Flat taxes are charged on items such as cigarettes, gasoline, and insurance.

**flat-rate depreciation method**
A depreciation method that calculates the depreciation for an asset based on a fixed rate each year. This method uses a constant rate which Applications Desktop Integrator multiplies by an asset’s recoverable cost or net book value as of the beginning of each fiscal year.

**FlexBudgeting**
A feature that uses budget formulas and statistics to create a flexible budget. For example, a manufacturing organization may want to maintain a flexible budget based on actual units of production to eliminate volume variances during an analysis of actual versus budgeted operating results.
**flexfield**
An Oracle Applications field made up of segments. Each segment has an assigned name and a set of valid values. Oracle Applications uses flexfields to capture information about your organization. There are two types of flexfields: key flexfields and descriptive flexfields.

**flexfield segment**
One of the sections of your key flexfield, separated from the other sections by a symbol that you define (such as -, /, or \). Each segment typically represents an element of your business, such as cost center, product, or account.

**flexible address format**
Oracle Applications allows you to enter an address in the format most relevant for the country of your customer, supplier, bank, or remit-to site. This is done by using descriptive flexfields to enter and display address information in the appropriate formats. The descriptive flexfield opens if the country you enter has a flexible address style assigned to it, allowing you to enter an address in the layout associated with that country.

**FOB**
(Free On Board) The point or location where the ownership title of goods is transferred from the seller to the buyer. This indicates that delivery of a shipment will be made on board or into a carrier by the shipper without charge, and is usually followed by a shipping point or destination (e.g. 'FOB Our warehouse in New York'). (Receivables QuickCode)

**folder**
A flexible entry and display window in which you can choose the fields you want to see and where each appears in the window.

**follow up date**
The date when you plan to perform a subsequent action. Examples include a date that you specify for verifying that you have received payment or a date that you note for calling the customer again.
**forecast**

An estimate of future demand on inventory items. A forecast contains information on the original and current forecast quantities (before and after consumption), the confidence factor, and any specific customer information. You can assign any number of inventory items to the forecast and use the same item in multiple forecasts. For each inventory item you specify any number of forecast entries.

**forecast level**

The level at which a forecast is defined. Also, the level at which to consume a forecast. Examples of forecast levels include items, customers, customer bill-to, and customer ship to locations.

**foreign currency**

A currency that you define for your set of books for recording and conducting accounting transactions in a currency other than your functional currency. When you enter and pay an invoice in a foreign currency, Applications Desktop Integrator automatically converts the foreign currency into your functional currency based on the exchange rate you define. See also *exchange rate*, *functional currency*. A currency that you define for your set of books to record and conduct accounting transactions in a currency other than your functional currency.

**foreign currency conversion**

A process that converts a foreign currency journal entry into your functional currency. Applications Desktop Integrator automatically converts currency whenever you enter a journal entry in a currency other than your functional currency. Applications Desktop Integrator multiplies the daily exchange rate you define or the exchange rate you enter to convert amounts for your functional currency. You can view the results of foreign currency conversion in the Enter Journals window. The conversion of a foreign currency transaction, such as an invoice or a payment, into your functional currency. Applications Desktop Integrator automatically performs this conversion whenever you enter an invoice or make a payment in a currency other than your functional currency. See also *foreign exchange gain or loss*.

**foreign currency exchange gain or loss**

The difference in your functional currency between the invoiced amount and the payment amount when applying a receipt to an invoice. A realized gain exists if the receipt amount in your functional currency exceeds the invoice amount; a loss exists if the invoice amount in your functional currency exceeds the amount of the payment. Such gains and losses arise from fluctuations in exchange rates of the
receipt currency between the invoice date and the payment date. See also realized gain or loss, unrealized gain or loss.

**foreign currency journal entry**

A journal entry in which you record transactions in a foreign currency. Applications Desktop Integrator automatically converts foreign currency amounts into your functional currency using an exchange rate you specify. See also foreign currency, functional currency.

**foreign currency revaluation**

A process that allows you to revalue assets and liabilities denominated in a foreign currency using a period-end (usually a balance sheet date) exchange rate. Applications Desktop Integrator automatically revalues your foreign assets and liabilities using the period-end exchange rate you specify. Revaluation gains and losses result from fluctuations in an exchange rate between a transaction date and a balance sheet date. Applications Desktop Integrator automatically creates a journal entry in accordance with FASB 52 (U.S.) to adjust your unrealized gain/loss account when you run revaluation.

**foreign currency translation**

A process that allows you to restate your functional currency account balances into a reporting currency. Applications Desktop Integrator multiplies the average, periodic, or historical rate you define by your functional currency account balances to perform foreign currency translation. Applications Desktop Integrator translates foreign currency in accordance with FASB 52 (U.S.). Applications Desktop Integrator also remeasures foreign currencies for companies in highly inflationary economies, in accordance with FASB 8 (U.S.).

**form**

A logical collection of fields, regions, and blocks that appear on a single screen. Oracle Applications forms look just like the paper forms you use to run your business. All you need to do to enter data is type onto the form. See window.

**formula entry**

A recurring journal entry that uses formulas to calculate journal entry lines. Instead of specifying amounts, as you would for a standard entry, you use formulas, and Applications Desktop Integrator calculates the amounts for you. For example, you might use recurring journal entries to do complex allocations or accruals that are computed using statistics or multiple accounts.
**Free On Board (FOB)**

See *FOB*.

**freeze**

To fix the definition of a flexfield or a bill of material at a certain moment in time.

**freight carrier**

A commercial company used to send product shipments to your customers.

**freight charges**

A shipment-related charge added during ship confirmation and billed to your customer. (Order Entry QuickCode)

**freight terms**

An agreement indicating who pays the freight costs of an order and when they are to be paid. Freight terms do not affect accounting freight charges. (Order Entry QuickCode)

**function**

A PL/SQL stored procedure referenced by an Oracle Workflow function activity that can enforce business rules, perform automated tasks within an application, or retrieve application information. The stored procedure accepts standard arguments and returns a completion result. See also *function activity*.

**function activity**

An automated Oracle Workflow unit of work that is defined by a PL/SQL stored procedure. See also *function*.

**function security**

An Oracle Applications feature that lets you control user access to certain functions and windows. By default, access to functionality is not restricted; your system administrator customizes each responsibility at your site by including or excluding functions and menus in the Responsibilities window.

**functional currency**

The principal currency you use to record transactions and maintain accounting data within Applications Desktop Integrator. The functional currency is usually the currency in which you perform most of your business transactions. You specify the functional currency for each set of books in the Set of Books window. The principal currency you use to record transactions and maintain your accounting data for your
set of books. You define the functional currency for each set of books within your organization. When you enter and pay an invoice in a foreign currency, Applications Desktop Integrator automatically converts the foreign currency into your functional currency based on the exchange rate you define. Applications Desktop Integrator creates journal entries for your multiple currency invoices and payments in both your foreign and functional currencies.

**fund**
A fiscal and accounting entity with a self-balancing set of accounts in which cash and other financial resources, all related liabilities and residual equities or balances and changes to these balances are recorded. A fund is segregated to carry on specific activities or attain certain objectives in accordance with special regulations, restrictions, or limitations. When you implement Oracle Public Sector Financials, Fund is typically the balancing segment of your Accounting Flexfield.

**fund balance**
Fund balance is the equity portion of a fund balance sheet. Fund balance may contain one or more of the following subdivisions: **reserved** - A portion of the fund balance not available for expenditure or legally segregated for a specific future use. For example, Reserve for Encumbrances and Reserve for Inventory are reserved portions of fund balance. **Unreserved, designated** - A portion of the fund balance established to indicate tentative plans for the future use of current resources. **Unreserved, undesignated** - Fund balance available for use without predefined restrictions.

**fund group**
A general category of funds for which you report fund activity as a whole. Plant funds, restricted funds, and general operating funds are examples of fund groups. Each fund group can have one or more funds associated with it. In Oracle Public Sector Financials, you can summarize funds into fund groups using rollup groups.

**fund segment**
The segment of your Accounting Flexfield that you use to record fund, appropriation, or other information relating to a fiscal entity. In Oracle Public Sector Financials, *fund segment* is a generic term for the balancing segment you specify when you implement Oracle Public Sector Financials.

**fund type**
A classification of funds for specifying accounting attributes. GAAP and other accounting authorities specify the fund types in general use and the appropriate
accounting method, use of encumbrance, use of budgetary or proprietary accounts, and other attributes. For example, governmental units typically use the following fund types: General, Special Revenue, Capital Projects, Debt Service, Internal Service, Enterprise, and Trust & Agency.

**funding budget**
A budget against which accounting transactions are checked for available funds when budgetary control is enabled for your set of books.

**funds available**
The difference between budgeted amounts and all actual and anticipated expenditures. Oracle Public Sector Financials lets you check funds available online for requisitions, purchase orders, and invoices. The difference between the amount you are authorized to spend and all actual and anticipated expenditures. In other words, funds available is the amount budgeted less actual expenses and encumbrances of all types. Oracle Financials lets you check funds available online for requisitions, purchase orders, and invoices.

Funds Available = Budget - (Actual Expenses + Encumbrances)
The difference between the amount you are authorized to spend and the amount of your expenditures plus commitments. You can track funds availability at different authority levels using the Online Funds Available inquiry window, or you can create custom reports with the Applications Desktop Integrator Financial Statement Generator.

**funds checking**
The process of certifying funds available. You can check funds when you enter a requisition, purchase order, or invoice. You can check funds when you enter actual, budget, or encumbrance journals. When you check funds, Oracle Financials compares the amount of your transaction against your funds available and notifies you online whether funds are available for your transaction. Oracle Financials does not reserve funds for your transaction when you check funds.

**funds reservation**
The creation of requisition, purchase order, or invoice encumbrance journal entries. Applications Desktop Integrator reserves funds for your invoice when you approve the invoice. Approval creates encumbrance journal entries for an unmatched invoice or for price and quantity variances between an invoice and the purchase order to which you match the invoice. Applications Desktop Integrator immediately updates your funds available balances and creates an encumbrance journal entry that you can post in your general ledger. The process of reserving
funds available. You can reserve funds when you enter actual, budget, or encumbrance journals. When you reserve funds, Oracle Financials compares the amount of your transaction against your funds available and notifies you online whether funds are available for your transaction.

**future date**

A date you use to record the payment date of a future dated payment document. You only use future dates on payment documents with a future payment method.

Applications Desktop Integrator displays the future date on the future dated payment document to inform your supplier and bank when the bank should transfer funds to the supplier’s bank. In Applications Desktop Integrator the future date of a future dated payment is the same as the scheduled payment due date of the invoices being paid. Applications Desktop Integrator also refers to the future date as the Payment Due Date.

**gain / loss**

The profit or loss resulting from the retirement of an asset.

**gain**

See realized gain or loss, unrealized gain or loss.

**general ledger date**

The date used to determine the correct accounting period for your transactions. The Applications Desktop Integrator posting program uses this date when posting transactions to your general ledger.

**general ledger**

The accounting system that tracks the journal entries that affect each account.

**General Services Administration**

See GSA.

**generic agreement**

An agreement without a specified customer, so it is available to all customers. See also agreement, customer family agreement.
**GL Date**
The date used to determine the correct accounting period for your invoice and payment transactions. You assign a GL Date to your invoices during invoice entry and your payments during payment creation. The date used to determine the correct accounting period for your accounting transactions. The end date of the GL Period in which costs or revenue are transferred to Oracle General Ledger. This date is determined from the open or future GL Period on or after the PA Date of a cost distribution line or revenue. For invoices, the GL Date is the date within the GL Period on which an invoice is transferred to Oracle Receivables, and is based on the invoice date.

**GL Date range**
An accounting cycle that is defined by a beginning and ending GL Date.

**global segment prompt**
A non-context-sensitive descriptive flexfield segment. Each global segment typically prompts you for one item of information related to the zone or form in which you are working.

**global segment value**
A response to your global segment prompt. Your response is composed of a series of characters and a description. The response and description together provide a unique value for your global segment, such as J. Smith, Financial Analyst, or 210, Building C.

**governmental funds**
A type of fund whose objective is to provide services to the public. Governmental funds are concerned with the availability of resources to provide services. Examples of governmental funds are General, Special Revenue, Capital Projects, and Debt Service.

**grace period**
See Receipt Acceptance Period.

**grant**
Assistance awards in which a government agency provides funding to another government agency or other recipient, and in which the granting agency does not have substantial involvement with the receiving agency or recipient during the performance of the grant activity. For example, a state government might give
grants to regional and local governments for various purposes. The regional and local governments administer the grant for the state government.

**grouping rule**

A rule set you define that AutoInvoice uses to group revenue and credit transactions into invoices, debit, and credit memos. See *line ordering rules*.

**GSA**

(General Services Administration) A customer classification that indicates the customer is a U.S. government customer and pricing for products on the GSA price sheet should reflect the fixed pricing of the GSA contract. Whenever a product is on the GSA price sheet, it cannot be sold to commercial customers for the same or less price than the government customer.

**guarantee**

A contractual obligation to purchase a specified amount of goods or services over a predefined period of time.

**hard limit**

An option for an agreement that prevents revenue accrual and invoice generation beyond the amount allocated to a project or task by the agreement. If you do not impose a hard limit, Oracle Projects automatically imposes a soft limit of the same dollar amount. See also *soft limit*.

**historical exchange rate**

A weighted-average rate for transactions that occur at different times. Applications Desktop Integrator uses historical rates to translate owner’s equity accounts in accordance with FASB 52 (U.S.). For agencies in highly inflationary economies, Applications Desktop Integrator uses historical rates to remeasure specific historical account balances, according to FASB 8.

**historical exchange rate**

A weighted-average rate for transactions that occur at different times. Applications Desktop Integrator uses historical rates to translate owner’s equity accounts in accordance with FASB 52 (U.S.). For companies in highly inflationary economies, Applications Desktop Integrator uses historical rates to remeasure specific historical account balances, according to FASB 8.
**hold**
An Oracle Applications feature that prevents a transaction from occurring or completing until the hold has been released. You can place a hold on an invoice or an invoice schedule line in Payables. All holds in Payables prevent payment; some holds also prevent posting to your general ledger. A feature that prevents an order or order line from progressing through the order cycle. You can place a hold on any order or order line.

**hold parameter**
A criterion you use to place a hold on an order or order line. Valid hold parameters are customer, customer site, order and item.

**hold source**
An instruction for Oracle Order Entry to place a hold on all orders or lines that meet criteria you specify. Create a hold source when you want to put all current and future orders for a particular customer or for a particular item on automatic hold. Oracle Order Entry gives you the power to release holds for specific orders or order lines, while still maintaining the hold source. Oracle Order Entry holds all new and existing orders for the customer or item in your hold source until you remove the hold source.

**hold type**
A term that indicates the kind of hold you place on an order or order line. (Order Entry QuickCode)

**HP Notation**
Mathematical logic upon which EasyCalc is based. HP Notation is used by Hewlett-Packard calculators. HP Notation emphasizes straightforward, logical entry of data, and de-emphasizes complicated parenthetical arrangements of data.

**import**
A utility that enables you to bring data from an export file into an Oracle7 table. The import utility is part of the Oracle7 Relational Database Management System. This utility is used to restore archived data.
import journal entry
A journal entry from a non-Oracle application, such as accounts payable, accounts receivable, and fixed assets. You use Journal Import to import these journal entries from your feeder systems.

integer data type
Any Oracle Financial Analyzer variables with an integer data type containing whole numbers with values between -2.14 billion and +2.14 billion.

import program
A program that imports your bank file from an external system into Applications Desktop Integrator. Applications Desktop Integrator is set up to work with SQL*Loader as the import program. Two sample SQL*Loader control files are included with Applications Desktop Integrator to assist you in writing your own custom control file.

imported invoice
An invoice that is imported into Applications Desktop Integrator using the AutoInvoice program. An invoice that is imported into Applications Desktop Integrator using the Invoice Import program.

included item
A mandatory standard item in a bill of material that is shippable, indicating that it ships whenever an order that includes its parent item is shipped. Included items are shippable components of models, kits, option classes, and option items. See also bill of material, pick-to-order, standard item.

income tax region
The region or state you assign to paid invoice distribution lines for a 1099 supplier. If you participate in the Combined Filing Program, Applications Desktop Integrator produces K records for all income tax regions participating in the Combined Filing Program that have qualifying payments.

income tax type
A type of payment you make to 1099 suppliers. With Applications Desktop Integrator you can assign an income tax type to each paid invoice distribution line for a supplier. The Internal Revenue Service (IRS) requires that you report, by income tax type, payments made to 1099 suppliers.
incomplete invoice
An invoice whose status has not been changed to Complete or that has failed validation.

indirect project
A project for which you cannot generate revenue or invoices. Generally you use indirect projects for the administration of overhead costs, such as overtime. Typical indirect project types include Bid and Proposal and Overtime.

installment
One of many successive payments of a debt. You specify a payment schedule when you define your payment terms.

installment number
A number that identifies the installment for a specific transaction.

intraEU, taxed transaction
Transactions between non-registered traders in different EU (European Union) countries. VAT must be charged to customers within the EU if you do not know their VAT registration number. The destination country and inventory item controls which VAT rate to use.

intraEU, zero rated transactions
Transactions between registered traders in different EU (European Union) countries. An Intra-EU transaction is zero rated if and only if you know the customer’s VAT registration number; otherwise, VAT must be charged on the invoice.

intangible asset
A long term asset with no physical substance, such as a patent, copyright, trademark, leasehold, and formula. You can depreciate intangible assets using Applications Desktop Integrator.

intangible item
A non-physical item sold to your customers such as consulting services or a warranty. Intangible items are non-shippable and do not appear on pick slips and pack slips. See also shippable item.
**inter-organization transfer**
Transfer of items from one inventory organization to another. You can have freight charges and transfer credits associated with inter-organization transfer. You can choose to ship items directly or have them go through in transit inventory.

**intercompany account**
A general ledger account that you define in an Accounting Flexfield to balance intercompany transactions. You can define multiple intercompany accounts for use with different types of accounts payable journal entries.

**intercompany journal entry**
A journal entry that records transactions between affiliates. General Ledger keeps your accounting records in balance for each company by automatically creating offsetting entries to an intercompany account you define.

**interest invoice**
An invoice that Applications Desktop Integrator creates to pay interest on a past-due invoice. Applications Desktop Integrator automatically creates an expense distribution line for an interest invoice using an Accounting Flexfield you specify. You cannot modify an interest invoice.

**interface table**
A temporary database table used for transferring data between applications or from an external application. See also *database table*.

**interfund account**
A general ledger account you define in an Accounting Flexfield to balance interfund transactions. You can define multiple interfund accounts for use with different types of journal entries. You can define multiple interfund accounts and link them with balancing segment values so each fund can have multiple interfund accounts. For example, fund A can have an interfund payable account for fund B and an interfund receivable account for fund B. Fund A can have an interfund payable account for fund C and an interfund receivable account for fund C.

**interfund entry**
A transaction between two or more funds. For example, an activity funded out of the General Fund that is to be reimbursed by the Plant Fund is an interfund transaction. Oracle Public Sector Financials can automatically create basic interfund entries when you post a journal entry that does not balance by balancing segment value or fund.
interfund journal entry
A journal entry that records transactions between affiliates. Applications Desktop Integrator keeps your accounting records in balance for each fund by automatically creating offsetting entries to an interfund account you define.

interfund transfer
All interfund transactions except for loans, advances, quasi-external transactions, and reimbursements.

intermediate value
The parameter value, constant, or SQL statement result that is determined during the first step in the execution of an AutoAccounting rule.

internal organization
See organization.

internal requisition
See internal sales order, purchase requisition.

internal sales order
A request within your company for goods or services. An internal sales order originates from an employee or from another process as a requisition, such as inventory or manufacturing, and becomes an internal sales order when the information is transferred from Purchasing to Order Entry. Also known as internal requisition or purchase requisition.

intransit inventory
Items being shipped from one inventory organization to another. While items are intransit you can view and update arrival date, freight charges, and so on.

inventory controls
Parameter settings that control how Oracle Inventory will function, such as lot, locator, and serial number control.

inventory item
Items that you stock in inventory. You control inventory for inventory items by quantity and value. Typically, the inventory item remains an asset until you consume it. You recognize the cost of an inventory item as an expense when you consume it or sell it. You generally value the inventory for an item by multiplying the item standard cost by the quantity on hand. See also item.
**investment tax credit (ITC)**
A United States tax credit that is based on asset cost.

**invoice**
A document that you create in Oracle Receivables that lists amounts owed for the purchases of goods or services. This document also lists any tax, freight charges, and payment terms. A document you receive from a supplier that lists amounts owed to the supplier for purchased goods or services. In Oracle Payables, you create an invoice online using the information your supplier provides on the document. Payments, inquiries, adjustments and any other transactions relating to a supplier’s invoice are based upon the invoice information you enter. A summarized list of charges, including payment terms, invoice item information, and other information that is sent to a customer for payment.

**invoice batch**
A group of invoices you enter together to ensure accurate invoice entry. Invoices within the same batch share the same batch source and batch name. Receivables displays any differences between the control and actual counts and amounts. An invoice batch can contain invoices in different currencies. A Payables feature that allows you to enter multiple invoices together in a group. You enter the batch count, or number of invoices in the batch, and the total batch amount, which is the sum of the invoice amounts in the batch, for each batch of invoices you create. You can also optionally enter batch defaults for each invoice in a batch. When you enable your batch control system option, Applications Desktop Integrator automatically creates invoice batches for Payables expense reports, prepayments, and recurring invoices, as well as all standard invoices.

**invoice burden schedule**
A burden schedule used for invoicing to derive the bill amount of an expenditure item. This schedule may be different from your revenue burden schedule, if you want to invoice at a different rate at which you want to accrue.

**invoice date**
The date that appears on a customer invoice. This date is used to calculate the invoice due date, according to the customer’s payment terms. The date an invoice was created. This is also the date that Applications Desktop Integrator prints on each invoice. Applications Desktop Integrator also use this date to determine the payment due date based on the payment terms you specify on the invoice. Applications Desktop Integrator ensures that your invoice date always matches
your general ledger date. The date you assign to an invoice you enter in Applications Desktop Integrator. Applications Desktop Integrator uses this date to calculate the invoice due date, according to the payment terms for the invoice. The invoice date can be the date the invoice was entered or it can be a different date you specify.

**invoice distribution line**
A line representing an expenditure item on an invoice. A single expenditure item may have multiple distribution lines for cost and revenue. An invoice distribution line holds an amount, account code, and accounting date.

**invoice distribution line types**
A feature that classifies every invoice distribution line as an item, tax, freight, or miscellaneous distribution.

**invoice format**
The columns, text, and layout of invoice lines on an invoice.

**Invoice Import**
An Oracle Payables process you use to import invoices from non-Oracle payables systems and to create invoices from Payables expense reports. You can also use Invoice Import to create invoices from expense reports in Oracle Projects.

When you initiate Invoice Import, Oracle Payables imports the required invoice or expense report information and automatically creates invoices with invoice distribution lines from the information. Oracle Payables also produces a report for all invoices or expense reports it could not import.

**invoice item**
A single line of a project’s draft invoice, formatted according to the project invoice formats.

**invoice number**
A number or combination of numbers and characters that uniquely identifies an invoice within your system. Usually generated automatically by your receivables system to avoid assigning duplicate numbers.

**invoice price variance**
The difference between the item price for an invoice and its matched purchase order. For your inventory items, Payables tracks any invoice price variances.
**invoice quantity variance**
The difference between the quantity-billed for an invoice and the quantity-ordered (or received/accepted, depending on the level of matching you use) for its matched purchase order. Payables distributes invoice quantity variances to the Accounting Flexfield for your invoice distribution lines.

**invoice set**
For each given run of invoice generation for a project, if multiple agreements exist and multiple invoices are created, Oracle Projects creates the invoices within a unique set ID. You approve, release, and cancel all invoices within an invoice set.

**invoice split amount**
See **split amount**.

**invoice transaction type**
An Oracle Receivables transaction type that is assigned to invoices and credit memos that are created from Oracle Projects draft invoices.

**invoice write-off**
A transaction that reduces the amount outstanding on an invoice by a given amount and credits a bad debt account.

**invoicing**
The function of preparing a client invoice. Invoice generation refers to the function of creating the invoice. Invoicing is broader in the terms of creating, adjusting, and approving an invoice.

**invoicing rules**
Rules that Oracle Receivables uses to determine when you will bill your customer and the accounting period in which the receivable amount is recorded. You can bill In Advance or In Arrears. See also *bill in advance*, *bill in arrears*.

**ITC**
See *investment tax credit*.

**ITC amount**
The investment tax credit allowed on an asset. The ITC amount is based on a percentage of the asset cost. When you change an asset’s cost in the accounting period you enter it, Oracle Assets automatically recalculates the ITC amount.
**ITC basis**
The maximum cost that Oracle Assets can use to calculate an investment tax credit amount for your asset. If you enabled ITC ceilings for the asset category you assigned to an asset, the ITC basis is the lesser of the asset’s original cost or the ITC ceiling.

**ITC ceiling**
A limit on the maximum cost that Oracle Assets can use to calculate investment tax credit for an asset. You can use different ceilings depending on the asset’s date placed in service.

**ITC rate**
A rate used to calculate the investment tax credit amount. This percentage varies according to the expected life of the asset and the tax year.

**ITC recapture**
If you retire an asset before the end of its useful life, Oracle Assets automatically calculates what fraction of the original investment tax credit must be repaid to the government. This amount is called the investment tax credit recapture.

**item**
Anything you make, purchase, or sell including components, subassemblies, finished products, or supplies. Oracle Manufacturing also uses items to represent planning items that you can forecast, standard lines that you can include on invoices, and option classes that you can use to group options in model and option class bills. See also *inventory item*. Anything you buy, sell, or handle in your business. An item may be a tangible item in your warehouse, such as a wrench or tractor, or an intangible item, such as a service.

**item attribute control level**
A method to maintain item attributes at the item master attribute level or the organization specific level by defining item attribute control consistent with your company policies. For example, if your company determines serial number control at headquarters regardless of where items are used, you define and maintain serial number attribute control at the item master level. If each organization maintains serial number control locally, they maintain those attributes at the organization specific level.
item attributes
Specific characteristics of an item, such as order cost, item status, revision control, COGS account, and so on.

item category
Code used to group items with similar characteristics, such as plastic, metal, or glass items.

Item Flexfield
See System Items Flexfield.

item groups
A group of related products that can be added to one or more price list.

item type
A term used by Oracle Workflow to refer to a grouping of all items of a particular category that share the same set of item attributes, used as a high level grouping for processes. For example, each Account Generator item type (e.g. FA Account Generator) contains a group of processes for determining how an Accounting Flexfield code combination is created. See also item type attribute

item type attribute
A feature of a particular Oracle Workflow item type, also known as an item attribute. An item type attribute is defined as a variable whose value can be looked up and set by the application that maintains the item. An item type attribute and its value is available to all activities in a process.

Item Validation Organization
The organization that contains your master list of items. You define this organization by setting the OE: Item Validation Organization profile option. You must define all items and bills in your Item Validation Organization, but you also need to maintain your items and bills in separate organizations if you want to ship them from other warehouses. Oracle Order Entry refers to organizations as warehouses on all Order Entry forms and reports. See also organization.

job
A name for a set of duties to which an employee may be assigned. You create jobs in Oracle Projects by combining a job level and a job discipline using your job key
flexfield structure. For example, you can combine the job level Staff with the job discipline Engineer to create the job Staff Engineer.

**job billing title**
A job billing title, which differs from a job title, that may appear on an invoice.

**job discipline**
A categorization of job vocation, used with Job Level to create a job title. For example, a job discipline may be Engineer, or Consultant.

**job level**
A categorization of job rank, used with Job Discipline to create a job title. For example, a job level may be Staff, or Principal.

**Japanese consumption tax**
The Value Added Tax (VAT) paid on any expense (Input VAT) is usually recoverable against the VAT charged on revenue (Output VAT). This ensures that VAT is not inflationary within a supply chain.

**job title**
A unique combination of job level and job discipline that identifies a particular job. A brief description of your customer contact’s role within their organization.

**journal details tables**
Journal details are stored in the database tables GL_JE_BATCHES, GL_JE_HEADERS, and GL_JE_LINES.

**journal entry**
A debit or credit to a general ledger account. A debit or credit to a general ledger account. See also manual journal entry. A debit or credit to a general ledger account.

**journal entry batch**
A method used to group journal entries according to your set of books and accounting period. When you initiate the transfer of invoice or payment information to your general ledger for posting, Applications Desktop Integrator transfers the necessary information to create journal entry batches for the information you transfer. Journal Import in General Ledger uses the information to create a journal entry batch for each set of books and accounting period.

You can name your journal entry batches the way you want for easy identification.
in your general ledger. Applications Desktop Integrator attaches the journal entry category, date, and time of transfer to your batch name so that each name is unique. If you choose not to enter your own batch name when you transfer posting information, Applications Desktop Integrator uses the journal entry category, date, and time of transfer.

**journal entry category**
A category used to indicate the purpose or nature of your journal entry. General Ledger associates each of your journal entry headers with a journal entry category. Journal entry categories specify what kind of transaction the journal entry represents. A category used to indicate the purpose or nature of your journal entry. General Ledger associates each of your journal entry headers with a journal entry category. There are three journal entry categories in Applications Desktop Integrator if you use the accrual basis accounting method: Invoices, Payments, and All (both Invoices and Payments). If you use the cash basis accounting method, Applications Desktop Integrator only assigns the Payment journal entry category to your journal entries. A category in which Applications Desktop Integrator describes the purpose or type of journal entry. Standard journal entry categories include accruals, payments, and vouchers.

**journal entry header**
A method used to group journal entries by currency and journal entry category within a journal entry batch. When you initiate the transfer of invoices or payments to your general ledger for posting, Applications Desktop Integrator transfers the necessary information to create journal entry headers for the information you transfer. Journal Import in General Ledger uses the information to create a journal entry header for each currency and journal entry category in a journal entry batch. A journal entry batch can have multiple journal entry headers.

**journal entry lines**
Each journal entry header contains one or more journal entry lines. The lines are the actual journal entries that your general ledger posts to update account balances. The number and type of lines in a journal entry header depend on the volume of transactions, frequency of transfer from Applications Desktop Integrator, and your method of summarizing journal entries from Applications Desktop Integrator.

**journal entry source**
An indicator of which feeder system your journal entries come from, such as Applications Desktop Integrator. General Ledger associates each of your journal entries with one journal entry source. This allows you to group related journal entry transactions for reporting and analysis in your general ledger. The source by
which Applications Desktop Integrator identifies and differentiates the origin of journal entries. Standard journal entry sources include payables, payroll, personnel, and receivables.

**Journal Import**

A General Ledger program that creates journal entries from transaction data stored in the General Ledger GL_INTERFACE table. Journal entries are created and stored in GL_JE_BATCHES, GL_JE_HEADERS, and GL_JE_LINES.

**jurisdiction code**

An abbreviated address that is specific to a Tax Supplier and more accurate than a simple five digit zip code.

**K**

**K-record**

A summary record of all 1099 payments made to suppliers for a single tax region that participates in the Combined Filing Program.

**key flexfield**

An Oracle Applications feature you use to build custom fields in which you can enter and display information relating to your business. The General Ledger Accounting Flexfield is a key flexfield. An intelligent key that uniquely identifies an application entity. Each key flexfield segment has a name you assign, and a set of valid values you specify. Each value has a meaning you also specify. You use this Oracle Applications feature to build custom fields used for entering and displaying information relating to your business. The Accounting Flexfield in your Oracle General Ledger application is an example of a key flexfield used to uniquely identify a general ledger account. An Oracle Applications feature you use to build custom fields used for entering and displaying information relating to your business. Applications Desktop Integrator uses the following key flexfields:

- Accounting Flexfield
- Category Flexfield
- Location Flexfield
- Asset Key Flexfield

An Oracle Applications feature you use to build custom fields used for entering and displaying information relating to your business. Applications Desktop Integrator uses the following key flexfields:

- Accounting Flexfield
- Item Catalogs
- Item Categories Flexfield
- Sales Order Flexfield
Sales Tax Location Flexfield
Stock Locators Flexfield
System Items Flexfield
Territory Flexfield

An Oracle Applications feature you use to build custom fields used for entering and displaying information relating to your business.

Applications Desktop Integrator uses the following key flexfields:

- Accounting Flexfield
- System Items Flexfield
- Sales Tax Location Flexfield
- Territory Flexfield

**key flexfield segment**

One of up to 30 different sections of your key flexfield. You separate segments from each other by a symbol you choose (such as -, / or \\). Each segment can be up to 25 characters long. Each key flexfield segment typically captures one element of your business or operations structure, such as company, division, region, or product for the Accounting Flexfield and item, version number, or color code for the Item Flexfield.

**key flexfield segment value**

A series of characters and a description that provide a unique value for this element, such as 0100, Eastern region, or V20, Version 2.0.

**key indicators**

A report that lists statistical receivables and collections information that lets you review trends and projections. Also an Oracle Applications feature you can use to gather and retain information about your productivity, such as the number of invoices paid. You define key indicator periods and Applications Desktop Integrator provides a report that shows productivity indicators for your current and prior period activity.

**key member**

An employee who is assigned a role on a project. A project key member can view and update project information and expenditure details for any project to which they are assigned. Typical key member types include Project Manager and Project Coordinator.
**kit**
An item that has a standard list of components (or included items) that you ship when you process an order for that item. A kit is similar to a pick-to-order model because it has shippable components, however it has no options and you order it directly by its item number, not using the configuration selection screen. See also *pick-to-order model*.

**labor cost**
The cost of labor expenditure items.

**labor cost multiplier**
A multiplier that is assigned to an indirect project task and applied to labor costs to determine the premium cost for overtime or other factors.

**labor cost rate**
The hourly raw cost rate for an employee. This cost rate does not include overhead or premium costs.

**labor invoice burden schedule**
A burden schedule used to derive invoice amounts for labor items.

**labor multiplier**
A multiplier that is assigned to a project or task, and is used to calculate the revenue and/or bill amount for labor items by applying the multiplier to the raw cost of the labor items.

**labor revenue burden schedule**
A burden schedule used to derive revenue amounts for labor items.

**legal entity**
An organization that represents a legal company for which you prepare fiscal or tax reports. You assign tax identifiers and other relevant information to this entity.

**lamp**
A one-word message that Oracle Applications displays in the message line of any window to notify you that a particular feature is available for a particular field. A single word message that appears on the message line to indicate whether a function such as <Insert> or <List> is available for the current field.
leasehold improvement
An improvement to leased property or leasehold. Leasehold improvements are normally amortized over the service life or the life of the lease, whichever is shorter.

lien
See commitment, obligation.

life-based depreciation method
A depreciation method that spreads out the depreciation for an asset over a fixed life, usually using rates from a table.

life-to-date depreciation
The total depreciation taken for an asset since it was placed in service. Also known as accumulated depreciation.

line ordering rules
You define line ordering rules for invoice lines that you import into Receivables using AutoInvoice. AutoInvoice uses these rules to order invoice lines when it groups the transactions it creates into invoices, debit memos, and credit memos.

listing
An organized display of Oracle Applications information, similar to a report, but usually showing setup data as opposed to transaction data.

list price
Your base item cost to your customers. You define the item list price on a price list and Oracle Order Entry applies all price adjustments against the item list price.

location
A shorthand name for an address. Location appears in address list list of values to let you select the correct address based on an intuitive name. For example, you may want to give the location name of 'Receiving Dock' to the Ship To business purpose of 100 Main Street. A key flexfield combination specifying a particular place. You assign each asset to a location. Oracle Assets uses location information to produce Responsibility and Property Tax Reports.

Location Flexfield
Oracle Assets lets you define what information you want to keep about the locations you use. You use your Location Flexfield to define how you want to keep the information.
locator
Physical area within a subinventory where you store material. For example, a row, aisle, bin, or shelf.

locator control
A system technique for enforcing use of locators during a material transaction.

lockbox
A service that commercial banks offer corporate customers to enable them to outsource their accounts receivable payment processing. Lockbox processors set up special postal codes to receive payments, deposit funds and provide electronic account receivable input to corporate customers.

lookup code
The internal name of a value defined in an Oracle Workflow lookup type. See also lookup type.

lookup type
An Oracle Workflow predefined list of values. Each value in a lookup type has an internal and a display name. See also lookup code.

loss
See realized gain or loss, unrealized gain or loss.

lot
A specific batch of an item identified by a number.

lot control
A system technique for enforcing use of lot numbers during material transactions thereby enabling the tracking of batches of items throughout their movement in and out of inventory.

make-to-order
An environment where customers order unique configurations that must be manufactured using multiple discrete jobs and/or final assembly orders where the product from one discrete job is required as a component on another discrete job. Oracle Manufacturing Release 10 does not provide special support for this environment beyond the support it provides for assemble-to-order manufacturing.
**mandatory component**

A component in a bill that is not optional. Usually refers to components in an assemble-to-order model or option class bill that are not optional, to distinguish them from options. Mandatory components in pick-to-order model bills are often referred to as included items, especially if they are shippable.

**manual clearing**

The process where, prior to receiving their bank statement, users mark transactions that are known to be cleared through the bank, which creates an up-to-date cash position. These cleared transactions are still available for the actual reconciliation process. Once the bank statement is received, Oracle Cash Management can automatically perform all appropriate reconciliation steps. See also *clearing*.

**manual reconciliation**

The process where you manually reconcile bank statement details with the appropriate batch or detail transaction. Oracle Cash Management generates all necessary accounting entries. See also *AutoReconciliation, reconciliation.reconciliation*.

**manual invoice**

An invoice that you enter using either the Transactions or Transactions Summary window.

**manual journal entry**

A journal entry you enter at a computer terminal. Manual journal entries can include regular, statistical, intercompany and foreign currency entries. A journal entry you create online using the Enter Journals window. Manual journal entries include regular, statistical, interfund, and foreign currency journal entries.

**Many-to-Many attribute**

In Oracle Financial Analyzer, a relationship between one or more values of one base dimension with one or more values of a second base dimension. For example, if you have a Many-to-Many attribute definition where the first base dimension is Organization and the second base dimension is Line Item, then a single organization can be related to several line items, and a single line item can be related to several organizations.

**Mass Additions**

An Oracle Assets feature that allows you to copy asset information from another system, such as Oracle Payables. Create Mass Additions for Oracle Assets creates mass addition lines for potential assets. You can review these mass addition lines in
the Prepare Mass Additions window, and actually create an asset from the mass addition line by posting it to Oracle Assets. Invoice distribution lines that you transfer to Oracle Assets for creating assets. Applications Desktop Integrator only creates mass additions for invoice distribution lines that are marked for asset tracking. Invoice distribution lines distributed to Asset Accounting Flexfields are automatically marked for asset tracking.

Oracle Assets does not convert the mass additions to assets until you complete all of the required information about the asset and post it in Oracle Assets.

**Mass Change**
A feature that allows you to change the prorate convention, depreciation method, life, rate, or capacity for a group of assets in a single transaction.

**mass change order**
A record of a plan to replace, delete, or update one or more component items in many bills of material at the same time.

**Mass Copy**
A feature that allows you to copy a group of asset transactions from your corporate book to a tax book. Use Initial Mass Copy to create a new tax book. Then use Periodic Mass Copy each period to update the tax book with new assets and transactions.

**Mass Depreciation Adjustment**
A feature that allows you to adjust the depreciation expense in the previous fiscal year for all assets in a tax book. Oracle Assets adjusts the depreciation expense between the minimum and maximum depreciation amounts by a depreciation adjustment factor you specify.

**Mass Purge**
See archive, purge, restore.

**Mass Revaluation**
See revaluation.

**Mass Transfers**
A feature that allows you to transfer a group of assets between locations, employees, and general ledger depreciation expense accounts.
**MassAllocations**

A single journal entry formula that allocates revenues and expenses across a group of cost centers, departments, divisions, and so on. For example, you might want to allocate your employee benefit costs to each of your departments based on headcount in each department.

**MassBudgeting**

A feature that allows you to build a complete budget using simple formulas based on actual results, other budget amounts, and statistics. For example, you may want to draft next year’s budget using last year’s actual results plus 10 percent or some other growth factor. With MassBudgeting, you can apply one rule to a range of accounts.

**master budget**

A budget that controls the authority of other budgets.

**master-detail relationship**

A master-detail relationship is an association between two blocks—a master block and its detail block. When two blocks are linked by a master-detail relationship, the detail block displays only those records that are associated with the current (master) record in the master block, and querying between the two blocks is always coordinated. Master and detail blocks can often appear in the same window or they can each appear in separate windows.

**matching**

The process where batches or detailed transactions are associated with a statement line based on the transaction number, amount, currency and other variables, taking Cash Management system parameters into consideration. In Oracle Cash Management, matching can be done manually or automatically. See also clearing, reconciliation. The process of comparing purchase order, invoice, and receiving information to verify that ordering, billing, and receiving information is consistent within accepted tolerance levels. Applications Desktop Integrator uses matching to control payments to suppliers. You can use the matching feature in Applications Desktop Integrator if you have Oracle Purchasing or another purchasing system. Applications Desktop Integrator supports two-, three-, and four-way matching.
matching tolerances
The acceptable degrees of variance you define for matched invoices and purchase orders. Applications Desktop Integrator measures variance between quantities and item prices for invoices and purchase orders. You can define tolerances for order quantities, including Maximum Quantity Ordered and Maximum Quantity Received. You can also define tolerances for price variances, including exchange rate amounts, shipment amounts, and total amounts. If any of the variances between a matched invoice and purchase order exceed the tolerances you specify, Approval places the invoice on hold.

material transaction
Transfer between, issue from, receipt to, or adjustment to an inventory organization, subinventory, or locator. Receipt of completed assemblies into inventory from a job or repetitive schedule. Issue of component items from inventory to work in process.

maturity date
A date that determines when funds for an automatic receipt can be transferred from your customer’s bank account to your bank account. See also Bill of Exchange.

maximum depreciation expense
The maximum possible depreciation expense for an asset in a mass depreciation adjustment. The maximum depreciation expense for an asset is the greatest of the depreciation actually taken in the tax book, the amount needed to bring the accumulated depreciation up to the accumulated depreciation in the corporate book, or the amount needed to bring the accumulated depreciation up to the accumulated depreciation in the control book.

memo pad
An area where you write as many notes as you need regarding your conversation with a customer.

message
The text or data that Oracle Alert sends when it finds an exception while running an alert.

message distribution
See distribution list. A line at the bottom of the toolbar that displays helpful hints, warning messages, and basic data entry errors. On the same line, ZOOM, PICK, EDIT, and HELP lamps appear, to let you know when Zoom, QuickPick, Edit, and online help features are available.
message line  
A line on the bottom of a window that displays helpful hints or warning messages when you encounter an error.

meta data  
Data you enter in Oracle General Ledger to represent structures in Oracle Financial Analyzer. Meta data consists of the dimensions, segment range sets, hierarchies, financial data items, and financial data sets you define in Oracle General Ledger. When you load financial data from Oracle General Ledger, Oracle Financial Analyzer creates dimensions, dimension values, hierarchies, and variables based on the meta data.

model  
A set of interrelated equations for calculating data in Oracle Financial Analyzer.

MICR number  
(Magnetic Ink Character Recognition number) A number that appears on a receipt and associates your customer with a bank. This number consists of two segments. The first segment is the Transit Routing number, which identifies the bank from which your customer draws their check. The second segment identifies your customer’s account at that bank. These segments correspond to the Bank Branch Number and the Bank Account Number fields in the Banks and Bank Accounts windows.

minimum accountable unit  
The smallest meaningful denomination of a currency (this might not correspond to the standard precision). While a currency may require a precision of three places to the right of the decimal point, for example, .001 (one thousandth), the lowest denomination of the currency may represent 0.025 (twenty-five thousandths). Under this example, the Minimum Accountable Unit would be .025. Calculations in this currency would be rounded to .025 (the Minimum Accountable Unit), not .001 (the precision).

min-max planning  
An inventory planning method used to determine when and how much to order based on a fixed user-entered minimum and maximum inventory levels.

minimum depreciation expense  
The minimum possible depreciation expense for an asset in a mass depreciation adjustment. The minimum depreciation expense for an asset in a tax book is the
amount needed to bring the accumulated depreciation up to the accumulated depreciation in the corporate book or control book, or zero, whichever is greater.

**minimum interest amount**
The amount below which Applications Desktop Integrator does not pay interest on an overdue invoice. Applications Desktop Integrator automatically compares the interest amount it calculates on past due invoices with the minimum interest amount you have defined, and does not create an interest invoice unless the amount of interest exceeds the minimum interest amount.

**miscellaneous receipts**
A feature that lets you record payments that you do not apply to debit items, such as refunds and interest income.

**modal window**
Certain actions that you perform may cause a modal window to display. A modal window requires you to act on its contents before you can continue, usually by choosing OK or Cancel.

**model**
(model item) An item whose bill of material lists options and option classes available when you place an order for the model item.

**model bill of material**
A bill of material for a model item. A model bill lists option classes and options available when you place an order for the model item.

**model invoice**
An invoice used as a template that you copy to create new invoices.

**multi-org**
See multiple organizations.

**multiple organizations**
The ability to define multiple organizations and the relationships among them within a single installation of Oracle Applications. These organizations can be sets of books, business groups, legal entities, operating units, or inventory organizations.
**multiple payment formats**

You can choose from several payment methods to pay your supplier invoices. Within each payment method you can define as many payment formats as you want. A payment format determines your payment creation and remittance advice programs.

**Multiple Reporting Currencies**

An Oracle General Ledger feature that allows you to report in your functional currency and in one or more foreign currencies.

**NACHA**

National Automated Clearing House Association. This is the US system for making direct deposit payments to employees.

**natural account segment**

In Oracle General Ledger, the segment that determines whether an account is an asset, liability, owners’ equity, revenue, or expense account. When you define your chart of accounts, you must define one segment as the natural account segment. Each value for this segment is assigned one of the five account types.

**Natural Application Only**

A Transaction Type parameter that, if enabled, does not let you apply a transaction to a debit item if the application will reverse the sign of the debit item (for example, from a positive to a negative balance). Natural Application does not apply to chargebacks and adjustments. See *Overapplication*.

**navigation preference set**

A series of user-defined navigational options in the Enter Orders and Enter Return Material Authorizations forms. You can define as many navigation preference sets as you want and assign one to each order type.

**nesting**

The act of grouping calculations to express the sequence of routines in a formula. Traditional mathematical nesting uses parenthesis and brackets. Applications Desktop Integrator EasyCalc uses a straightforward and logical nesting method that eliminates the need for parenthetical expressions.
net allocation

Allocation in which you post the net of all allocations to an allocated-out account.

node
An instance of an activity in an Oracle Workflow process diagram as shown in the Process window of Oracle Workflow Builder. See also process.

non-labor invoice burden schedule
A burden schedule used to derive invoice amounts for non-labor items.

non-labor resource
An implementation-defined asset or pool of assets. For example, you can define a non-labor resource with a name such as PC to represent multiple personal computers your business owns.

non-labor revenue burden schedule
A burden schedule used to derive revenue amounts for non-labor items.

non-posting hold
A hold that prevents you from paying your invoice, but allows posting. All holds prevent payment but you can decide if you want to allow or disallow posting for each hold you define.

non-quota sales credit
See non-revenue sales credit.

non-revenue credit
Revenue credit you assign to your agents that is not associated with your invoice lines. This is revenue credit given in excess of your revenue credit. See also revenue credit.

non-revenue sales credit
Sales credit you assign to your salespeople that is not associated with your invoice lines. This is sales credit given in excess of your revenue sales credit. See also revenue sales credit.
object or object classification
A means of identifying transactions by the nature of the goods or services purchased, such as personnel compensation, supplies and material, or equipment. Typically, Object is a segment of your Accounting Flexfield when you implement Oracle Public Sector Financials. Many agencies have standard object classification codes. Objects are also known as “Detail” in some governments.

obligation
An encumbrance you record when you turn a requisition into a purchase order. A transaction representing a legally binding purchase. See also commitment, purchase order encumbrance, encumbrance.

One-to-Many attribute
A relationship in Oracle Financial Analyzer where one or more values of a base dimension are related to a single value of an aggregate dimension. For example, if you have a One-to-Many attribute definition where the base dimension is Organization and the aggregate dimension is Level, each organization can be related to only a single level.

offset account
An offset account is used to balance journal entries in your General Ledger. For example, offsetting accounts for a guarantee are the Unbilled Receivables and the Unbilled Revenue accounts.

on account
Payments where you intentionally apply all or part of the payment amount to a customer without reference to a debit item. On account examples include prepayments and deposits.

on account credits
Credits that you assign to your customer’s account that are not related to a specific invoice. You can create on account credits in the Transactions window or using AutoInvoice.
on account payment
The status of a payment of which you apply all or part of its amount to a customer
without reference to a specific debit item. Examples of these are prepayments and
deposits.

one time billing hold
A type of hold that places expenditure items and events on billing hold for a
particular invoice; when you release that invoice, the items are billed on the next
invoice.

operating unit
An organization that partitions data for subledger products (AP, AR, PA, PO, OE).
It is roughly equivalent to a single pre-Multi-Org installation.

one-time note
A unique message you can attach to orders, returns, order lines and return lines to
convey important information. See also standard note.

online processing
When, during the execution of a single process, no further input is allowed until the
process is complete.

open batch
Status of a batch that is in balance, but contains unapplied or unidentified
payments.

open interface transaction
Any transaction not created by an Oracle Financial Applications system. See also
Reconciliation Open Interface.

open items
Any item, such as an invoice, debit memo, credit memo, chargeback, on account
credit, on account payment, or unapplied payment, whose balance due is not yet
zero.

operator
A mathematical symbol you use to indicate the mathematical operation in your
calculation.
option
See option item.

option class
A group of related option items. An option class is orderable only within a model. An option class can also contain included items.

option class bill of material
A bill of material for an option class item that contains a list of related options.

option class item
An item whose bill of material contains a list of related options.

option group
An option group is a set of option buttons. You can choose only one option button in an option group at a time, and the option group takes on that button’s value after you choose it. An option button or option group is also referred to as a radio button or radio group, respectively.

option item
A non-mandatory item component in an option class or model bill of material.

Oracle8 tables
A table is a two-dimensional graphic representation of data consisting of columns and rows. Categories of information are listed across the top of each table, while individual listings of information are listed down the left side. In this format, you can readily visualize, understand, and use the information. Oracle Financials products use Oracle8 tables to store the information you need to run your business.

order cycle
An order cycle is a sequence of actions you or Oracle Order Entry perform on an order to complete the order. An order cycle lets you define the activity an order follows from initial entry through closing. You can define as many order cycles as your business requires. Order cycles are assigned to order types. See also action result.

order cycle action
See cycle action.
order date
The date upon which an order for goods or services is entered.

order scheduling
See scheduling.

order type
A classification of an order. In Oracle Order Entry order type controls order cycle, order numbering source, point in the cycle to credit check, transaction type, standard value rule set and navigation preference set of an order.

OrderImport
An Oracle Order Entry open interface that allows you to import your transaction information from an original system into Applications Desktop Integrator. See also feeder program.

organization
A business unit such as a plant, warehouse, division, department, and so on. Oracle Order Entry refers to organizations as warehouses on all Order Entry windows and reports. A business unit such as a company, division, or department. Organization can refer to a complete company, or to divisions within a company. Typically, you define an organization or a similar term as part of your account when you implement Oracle Financials. See also business group. A government or public sector entity or sub-entity. Organization can refer to an entire agency or to divisions within an agency. For example, an agency might be composed of several bureaus, each of which has several departments. Each department is an organization, as is each bureau and the agency itself. A state university system is an organization, as is each campus within the university system, and each department within each campus. Typically, you define organization or a similar term as part of your Accounting Flexfield when you implement Oracle Public Sector Financials. Internal organizations are divisions, groups, cost centers or other organizational units in a company. External organizations can include the contractors your company employs. Organizations can be used to demonstrate ownership or management of functions such as projects and tasks, non-labor resources, and bill rate schedules. See also Item Validation Organization.

organization hierarchy
An organizational hierarchy illustrates the relationships between your organizations. A hierarchy determines which organizations are subordinate to
other organizations. The topmost organization of an organization hierarchy is generally the business group.

**organization structure**
See *organization hierarchy*.

**original budget**
The budget amounts for a project at the first successful baselining of the project.

**original system**
The external system from which you are transferring data into Applications Desktop Integrator tables.

**other receipts**
See *miscellaneous receipts*.

**out of balance batch**
The status of a batch when the control count or amount does not equal the actual count or amount.

**Overapplication**
A Transaction Type parameter that, if enabled, lets you apply a transaction to a debit item even if it will reverse the sign of the debit item (for example, from a positive to a negative balance). Overapplication applies to debit items such as debit memos, deposits, guarantees, credit memos, and on-account credits. See also *Natural Application Only*.

**overflow record**
A type of bank file record that stores additional payment information that could not fit on the payment record. Each overflow record must have a payment record as a parent. Typically, an overflow record will store additional invoice numbers and the amount of the payment to apply to each invoice.

**Overtime Calculation Program**
A program that Oracle Projects provides to determine which kind of overtime to award an employee based on the employee’s compensation rule and hours worked. If your company uses this automatic overtime calculation feature, you may need to modify the program based on the overtime requirements of your business.
overtime cost
The dollar amount over straight time cost that an employee is paid for overtime hours worked. Also referred to as Premium Cost.

PA Date
The end date of the PA Period in which costs are distributed, revenue is created, or an invoice is generated. This date is determined from the open or future PA Period on or after the latest date of expenditure item dates and event completion dates included in a cost distribution line, revenue, or an invoice.

PA Period
See Project Accounting Period.

PA Period Type
The Period Type as specified in the PA implementation options for Oracle Projects to copy project accounting periods. Oracle Projects uses the periods in the PA Period Type to populate each Operating Unit’s PA periods. PA periods are mapped to GL periods which are used when generating accounting transactions. PA periods drive the project summary for Project Status Inquiry. You define your accounting periods in the Operating Unit’s Set of Books Calendar.

pack slip
An external shipping document that accompanies a shipment itemizing in detail the contents of that shipment.

packing instructions
Notes that print on the pack slip. These instructions are for external shipping personnel. For example, you might wish to warn your carriers of a fragile shipment or your customer’s receiving hours.

parallel processing
Parallel processing allows segments of a program to be processed by different processors at the same time to reduce the overall time to complete the program.

parameter (report)
See report parameter.
parent asset
A parent asset has one or more subcomponent assets. First you add the parent asset. Then, you add the subcomponent asset and assign it to the parent asset in the Additions form. You can change parent/subcomponent relationships at any time.

parent request
A concurrent request that submits other concurrent requests (child requests). For example, a report set is a parent request that submits reports and/or programs (child requests).

parent segment value
An account segment value that references a number of other segment values, called child segment values. Applications Desktop Integrator uses parent segment values for creating summary accounts, for reporting on summary balances, and in MassAllocations and MassBudgeting. You can create parent segment values for independent segments, but not for dependent segments. An Accounting Flexfield segment value that references a number of other segment values, which are referred to as child segment values. Applications Desktop Integrator uses parent segment values for creating Accounting Flexfields that summarize others and for creating summary reports. Oracle Financial Analyzer uses parent and child segment values to create hierarchies. See also child segment value.

partial matching
A condition where the invoice quantity is less than the quantity originally ordered, in which case you are matching only part of a purchase order shipment line. See also matching, complete matching.

partial retirement
A transaction that retires part of an asset. You can retire any number of units of a multiple unit asset or you can retire part of an asset cost. If you retire by units, Oracle Assets automatically calculates the cost retired.

passing result
A passing result signals successful completion of an order cycle approval action. Once an order or order line has achieved an approval action passing result, it no longer appears on the approval window. See also approval action, order cycle.

Pay Date Basis
A feature you assign to suppliers to determine when AutoSelect selects invoices for payment in a payment batch. Pay Date Basis (Due or Discount) defaults from the
system level when you enter a new supplier, but you can override it. When Pay Date Basis is Due for a supplier site, Applications Desktop Integrator selects that supplier’s sites invoices for payment only when the invoice due date falls on or before the Pay-Through-Date for the payment batch. If Pay Date Basis is Discount, Applications Desktop Integrator selects the supplier’s sites invoices for payment if the discount date or due date is before the pay-through-date.

**Pay Group**
A feature you use to select invoices for payment in a payment batch. You can define a PayGroup and assign it to one or more suppliers. You can override the supplier’s PayGroup on individual invoices. For example, you can create an Employee PayGroup to pay your employee expenses separately from other invoices.

**pay on receipt**
A Financials feature that allows you to automatically create supplier invoices in Payables based on receipts and purchase orders you enter in Purchasing.

**Pay Only When Due**
A feature you use to determine whether to pay invoices in a payment batch during the discount period. If you Pay Only When Due (Yes), Applications Desktop Integrator only selects invoices for which payment is due; it postpones payment of invoices still in the discount period until another payment batch, or until they are due. If you do not Pay Only When Due (No), Applications Desktop Integrator also selects those invoices in the discount period for which the pay date basis is Discount.

**pay site**
A supplier site that is able to receive payments.

A supplier must have at least one supplier site defined as a pay site before Payables allows payments to be issued to that supplier. You cannot enter an invoice for a supplier site that is not defined as a pay site. See also purchasing site, RFQ Only Site.

**pay type**
See compensation rule.

**Pay-Through-Date**
A feature you use during automatic payment processing. You define a payment cycle (the number of days between regular payment batches), and Payables calculates the Pay-Through-Date by adding the number of days in the payment
cycle to the payment date. Payables selects an invoice for payment if either the due date or discount date is before the Pay-Through-Date.

**PayGroup**

See *Pay Group*.

**payment**

A document that includes the amount disbursed to any supplier/pay site combination as the result of a payment batch. A payment can pay one or more invoices. Any form of remittance, including checks, cash, money orders, credit cards, and Electronic Funds Transfer.

**payment application**

This report column represents the payments that were applied to the item within the GL Date range that you specified. If the transaction number corresponds to the item the payment was applied to, then the amount should be positive. If the transaction number is the payment itself, then the amount should be negative. The amount in this column should match the sum of the amounts in the Applied Amount, Earned Discount, and Unearned Discount columns of the Applied Receipts Register Report.

**payment batch**

A group of invoices selected for automatic payment processing. Applications Desktop Integrator creates a payment batch when you initiate AutoSelect. Applications Desktop Integrator selects invoices, according to criteria you specify, and produces payments for the invoices in the payment batch. Applications Desktop Integrator uses the payment method and format you specify for the bank account you choose for a payment batch to build and format payments for the invoices in the batch.

See also *Automatic Payment Processing*. (Also known as a receipt batch.) A group of payments that you enter together to help you ensure accurate payment entry. Payments within the same batch share the same batch source and batch name. Applications Desktop Integrator displays any differences between the control and actual counts and amounts.

**payment date**

The date on which the status of an invoice is updated to ‘Paid.’ Applications Desktop Integrator uses the payment date as the GL Date for each payment.
**payment distribution line**
A line representing the liability transaction on a payment. Each payment has at least one liability distribution line, but may have additional lines to record discounts taken and realized gains and losses (foreign currency payments only).

**payment document**
A medium you use to instruct your bank to disburse funds from your bank account to the bank account or site location of a supplier. With Applications Desktop Integrator you can make payments using several types of payment documents. You can send your supplier a check that you manually create or computer-generate. You can instruct your bank to wire funds to the bank account of a supplier. You can create a tape or diskette for an electronic funds transfer. For each payment document, you can generate a separate remittance advice. Applications Desktop Integrator updates your invoice scheduled payment the same way regardless of which payment document you use to pay an invoice. Applications Desktop Integrator also allows you to instruct your bank to pay in a currency different from your functional currency, if you enable the multiple currency system option and define a multi-currency payment format.

**payment format**
A definition that determines your payment creation and remittance advice programs for a given payment document. When you define a payment format, you do so for a particular payment method. An Oracle Receivables feature that allows you to make invoice payments using a variety of methods. You can disburse funds using checks, electronic funds transfers, and wire transfers. Receivables updates your scheduled payments the same way, regardless of which payment method you use. You can assign a payment method to suppliers, supplier sites, invoice scheduled payment lines, and payment formats. You can then assign one or more payment formats to a bank account. You can have multiple payment formats for each payment method. Receivables associates receipt class, remittance bank, and receipt account information with your receipt entries. You can define payment methods for both manual and automatic receipts.

**payment method**
A feature that allows you to make invoice payments using a variety of methods. You can disburse funds using checks, electronic funds transfers, and wire transfers. Applications Desktop Integrator updates your payment schedules the same way regardless of which payment method you use. You can assign a payment method to suppliers, supplier sites, invoice payment schedule lines, and payment formats. You can then assign one or more payment formats to a bank account. You can have
multiple payment formats for each payment method. An attribute that associates receipt class, remittance bank and receipt account information with your receipt entries. You can define payment methods for both manual and automatic receipts. In Payables, you can assign a payment method to suppliers, supplier sites, invoice payment schedule lines, and payment formats. You can then assign one or more payment formats to a bank account. You can have multiple payment formats for each payment method. Receivables payment methods let you associate receipt class, remittance bank and receipt account information with your receipt entries. You can define payment methods for both manual and automatic receipts. In Payroll, there are three standard payment types for paying employees: check, cash and direct deposit. You can also define your own payment methods corresponding to these types.

**payment priority**
A value, ranging from 1 (high) to 99 (low), assigned to an invoice that determines how Payables selects invoices for payment in a payment batch.

You can assign default payment priorities to suppliers, supplier sites, and invoice scheduled payments in Applications Desktop Integrator.

**payment program**
A program you use to build and format your payment. Applications Desktop Integrator provides several payment programs. You can define as many additional programs as you need. Applications Desktop Integrator recognizes three payment program types: Build, Format, and Remittance Advice.

**payment schedules**
The due date and discount date for payment of an invoice. For example, the payment term ‘2% 10, Net 30’ lets a customer take a two percent discount if payment is received within 10 days with the full invoice amount due within 30 days of the invoice date. See also scheduled payment, payment terms.

**payment terms**
The due date and discount date for payment of a transaction. For example, the payment term ‘2% 10, Net 30’ lets a customer take a two percent discount if payment is received within 10 days; after 10 days, the entire balance is due within 30 days of the invoice date with no applicable discount. See also discount, scheduled payment.
payroll
A group of employees that Oracle Payroll processes together with the same processing frequency, for example, weekly, monthly or bimonthly. Within a Business Group, you can set up as many payrolls as you need. See also payroll run.

payroll run
The process that performs all of the payroll calculations. You can set payrolls to run at any interval you want. See also payroll.

precedence numbers
Numbers used to determine how Receivables will compound taxes. The tax line with the highest precedence number will calculate tax on all tax lines with a lower precedence number.

period type
You use the general ledger accounting period types to define your general ledger calendar. You use accounting period types to define your accounting calendar.

period-average exchange rate
See average exchange rate.

period average-to-date
The average of the end-of-day balances for a related range of days within a period.

period-end exchange rate
The daily exchange rate on the last day of an accounting period. Applications Desktop Integrator automatically translates asset and liability account balances using period-end rates, in accordance with FASB 52 (U.S.). When you run revaluation for a period, Applications Desktop Integrator automatically uses the inverse of your period-end rate to revalue your foreign currency denominated assets and liabilities in accordance with FASB 52 (U.S.). For companies in highly inflationary economies, Applications Desktop Integrator uses period-end rates to remeasure the balances of asset and liability accounts according to FASB 8 (U.S.).

personal library
If an Oracle Financial Analyzer database object belongs to a personal library, it means that the object was created by the workstation user and can be modified.
periodic alert
An alert that periodically checks for the occurrence of your alert condition, according to a schedule you define. For example, you can define a periodic alert to send a message to the Accounts Payable Supervisor once a week to report on the number of held invoices.

periodic key indicator alert
A message Oracle Alert sends after scanning your database to notify you of current productivity levels. The number of invoices you have entered during a period is an example of a periodic key indicator alert.

periodic troubleshooting alert
A message Oracle Alert sends after scanning your database to notify you of discrepancies from goals or standards you have set. Invoices on hold is an example of a periodic troubleshooting alert.

phantom assembly
An assembly that Oracle Work in Process explodes through when it creates the bill of material for a job or schedule. A particular assembly can be a phantom assembly on one bill and a subassembly on another.

Pick Release
An order cycle action to notify warehouse personnel that orders are ready for picking.

pick release batch
See picking batch.

pick release rule (Order Entry)
A user-defined set of criteria to define what order lines should be selected during pick release.

pick slip
A pick slip is a internal shipping document that pickers use to locate items to ship for an order. If you use standard pick slips, each order will have its own pick slip within each picking batch. If you use the consolidated pick slip, the pick slip contains all orders released in that picking batch.
**pick-to-order (PTO)**
A configure-to-order environment where the options and included items in a model appear on pick slips and order pickers gather the options when they ship the order. Alternative to manufacturing the parent item on a work order and then shipping it.

**pick-to-order (PTO) item**
A predefined configuration that order pickers gather as separately finished included items just before they ship the order. See also *kit*.

**pick-to-order (PTO) model**
An item with an associated bill of material with optional and included items. At order entry, the configurator is used to choose the optional items to include for the order. The order picker gets a detailed list of the chosen options and included items to gather as separately finished items just before the order is shipped.

**picking**
The process of withdrawing items from inventory to be shipped to a customer.

**picking batch**
A user-defined group of pick slips for orders that you release for picking all at once. You create picking batches when you release your orders for shipping. For example, a batch can contain all shipments for a specific warehouse, or all priority shipments regardless of warehouse.

**picking line**
A picking line is an instruction to pick a specific quantity of a specific item for a specific order. Each pick slip contains one or more picking lines, depending on the number of distinct items released on the pick slip.

**picking rule**
A user-defined set of criteria to define the priorities Oracle Order Entry uses when picking items out of finished goods inventory to ship to a customer. Picking rules are defined in Oracle Inventory.

**planned purchase order**
A type of purchase order you issue before you order delivery of goods and services for specific dates and locations. You usually enter a planned purchase order to specify items you want to order and when you want the items delivered. You later enter a shipment release against the planned purchase order to order the items.
Positive Pay Program

Third party or custom software that formats the output file of the Payables Positive Pay Report into the format required by your bank, and transmits it electronically to your bank. This prevents check fraud by informing the bank which checks are negotiable or non-negotiable and for what amount.

planning item

A type of item representing a product family or demand channel whose bill of material contains a list of items and planning percentages.

planning percent

A component usage percentage that facilitates planning for optional components on model and option class bills, and all components on planning bills.

PO

See purchase order.

pop-up window

An additional window that appears on an Oracle Applications form when your cursor enters a particular field.

posting date

The date a journal transaction is actually posted to the general ledger.

poplist

A poplist lets you choose a single value from a predefined list. To choose a value, press your left mouse button while on the poplist icon to display the list of choices, then drag your mouse through the list to the desired value. Release your mouse button to choose the value you highlight and display it in the poplist field. A poplist is also sometimes known as a list.

Post QuickCash

Receipts entered through the QuickCash window or using AutoLockbox are stored in interim tables; this lets you review them to ensure that all receipt and application information is correct. After verifying that all information is correct, you can run Post QuickCash to update your customer’s account balances. See also QuickCash.

posting

The process of updating account balances in your general ledger from journal entries. Applications Desktop Integrator uses the term posting to describe the
process of transferring posting information to your general ledger. When you initiate posting in Applications Desktop Integrator, Applications Desktop Integrator transfers your invoice and payment transactions and sets the status of the payments and invoices to posted. You must use your general ledger to create journal entries and post the journal entries to update your account balances. The process of updating account balances in your general ledger from journal entries. You can initiate posting in Oracle Payables and Oracle Receivables. You must use your general ledger to create journal entries and post the journal entries to update your account balances. Note that Oracle Applications sometimes use the term posting to describe the process of transferring posting information to your general ledger. See also Journal Import.

posting hold
A hold that prevents you from posting an invoice. You also cannot pay an invoice that has a posting hold, because all holds prevent payment.

pre-commitment
See commitment.

pre-encumbrance
See commitment.

pre-lien
See commitment.

predefined serial number
An alphanumeric prefix and a beginning number for your serial numbers before you assign them to items. Predefined serial numbers are validated during receiving and shipping transactions.

premium cost
See overtime cost.

prepayment
A payment you make to a supplier in anticipation of his provision of goods or services. A prepayment may also be an advance you pay to an employee for anticipated expenses.

In Oracle Payables, a prepayment is a type of invoice that you can apply to an outstanding invoice or employee expense report to reduce the amount of the
invoice or expense report. You must approve the prepayment and fully pay the
prepayment before you can apply the prepayment.

**prerequisite**
A combination of a specific order cycle action and an associated result that must
occur before an order progresses to its next action in an order cycle. See also *cycle
action, order cycle, passing result.*

**price adjustment**
The difference between the list price of an item and its actual selling price. Price
adjustments can have a positive or negative impact on the list price. Price
adjustments that lower the list price are also commonly known as discounts. Price
adjustments can be for an order line or the entire order.

**price correction**
An invoice you receive from a supplier that is an adjustment to the unit price of an
invoice you previously matched to a purchase order shipment. You can match the
price correction to specific purchase order distribution lines or you can have
Applications Desktop Integrator prorate the price correction across all previously
matched purchase order distributions. If you receive a price correction that
represents a price reduction, you enter the price correction as a Credit invoice. If
you receive a price correction that represents a price increase, you enter the price
correction as a Standard invoice.

**price list**
A register of all the products you offer and the selling price for each.

**pricing components**
Combinations of pricing parameters you use when defining pricing rules. Pricing
components can be made up of one or multiple pricing parameters.

**pricing parameters**
A parameter you use to create components to be used in a pricing rule. Valid
pricing parameters include segments of your item flexfield or Pricing Attribute
Descriptive Flexfield.

**pricing rule**
A mathematical formula used to define item pricing. You create a pricing rule by
combining pricing components and assigning a value to the components. Oracle
Order Entry automatically creates list prices based on formulas you define. See also *pricing components*.

**primary accounting method**
The accounting method you choose for your primary set of books. You can choose either the cash or accrual method. You must choose a primary accounting method before you can choose a secondary accounting method and before you submit journal entries for posting to the general ledger.

**primary agent**
The default agent that receives 100% of the revenue credits when you first enter an invoice or commitment.

**primary customer information**
Address and contact information for your customer’s headquarters or principal place of business. Primary addresses and contacts can provide defaults during order entry.

**primary role**
Your customer contact’s principle business function according to your company’s terminology. For example, people in your company may refer to accounting responsibilities such as Controller or Receivables Supervisor.

**primary salesperson**
The salesperson that receives 100% of the sales credits when you first enter an invoice or commitment.

**primary set of books**
The set of books you use to manage your business. You can choose accrual or cash basis as the accounting method for your primary set of books.

**print lead days**
The number of days you subtract from the payment due date to determine the invoice date for each installment. You can only specify Print Lead Days when you are defining split payment terms.

**prior period addition**
An addition is a prior period addition if you enter it in an accounting period that is after the period in which you placed the asset in service. Also known as *retroactive addition*. 
**prior period reinstatement**
A reinstatement is a prior period reinstatement if you enter it in an accounting period that is after the period in which the retirement took place. Also known as **retroactive reinstatement**.

**prior period retirement**
A retirement is a prior period retirement if you enter it in an accounting period that is after the period in which you entered the retirement. Also known as **retroactive retirement**.

**prior period transfer**
A transfer is a prior period transfer if you enter it in an accounting period that is after the period in which the transfer took place. Also known as **retroactive transfer**.

**process**
A set of Oracle Workflow activities that need to be performed to accomplish a business goal. See also *Account Generator, process activity, process definition*.

**process activity**
An Oracle Workflow process modelled as an activity so that it can be referenced by other processes; also known as a subprocess. See also *process*.

**process cycle**
The planned schedule for batch processing of costs, revenue, and invoices, according to your company’s scheduling requirements. See *streamline request*.

**process definition**
An Oracle Workflow process as defined in the Oracle Workflow Builder. See also *process*.

**process responsibility type**
An implementation-defined name to which a group of reports and processes are assigned. This group of reports and processes is then assigned to an Oracle Projects responsibility. A process responsibility type gives a user access to Oracle Projects reports and programs appropriate to that user’s job. For example, the process responsibility type Data Entry could be a set of reports used by data entry clerks. See *responsibility*.
product
See item.

product configuration
See configuration.

production depreciation method
See units of production depreciation method.

production interface table
The table in which Applications Desktop Integrator stores the information you need to use the Production Interface. Information in the Production Interface table is stored in columns.

production upload
The process by which Oracle Assets loads production information from the Production Interface table into Oracle Assets. You can use the Production Information Upload process to transfer production information from a feeder system, such as a spreadsheet, to Oracle Assets.

profile option
A set of changeable options that affect the way your applications run. In general, profile options can be set at one or more of the following levels: site, application, responsibility, and user. Refer to the Applications Desktop Integrator Profile Option appendix for more information. Refer to the Profile Option appendix in the Oracle General Ledger User’s Guide for more information.

program
An organized set of objectives directed towards a common purpose or goal, undertaken or proposed by an agency to carry out its responsibilities. Program can also mean an agency’s mission, programs, functions, activities, services, projects, and processes. You can define a segment of your Accounting Flexfield to capture program information when you implement Oracle Public Sector Financials.

project
A unit of work that can be broken down into one or more tasks. A project is the unit of work for which you specify revenue and billing methods, invoice formats, a managing organization and project manager, and bill rate schedules. You can charge costs to a project, and you can generate and maintain revenue, invoice, unbilled receivable, and unearned revenue information for a project.
**Project Accounting Period**

An implementation-defined period against which project performance may be measured. Also referred to as *PA Periods*. You define project accounting periods to track project accounting data on a periodic basis by assigning a start date, end date, and closing status to each period. Typically, you define project accounting periods on a weekly basis, and your general ledger periods on a monthly basis.

**Project Burdening Organization Hierarchy**

The organization hierarchy version that Oracle Projects uses to compile burden schedules. Each business group must designate one and only one version of an organization hierarchy as its Project Burdening Organization Hierarchy. (Note: In Oracle Projects Implementation Options, each operating unit is associated with an organization hierarchy and version for project setup, invoice level processing, and project reporting. The Project Burdening Organization Hierarchy selected for the business group does not have to match the hierarchy version in the Implementation Options.).

**project chargeable employees**

In a multiple organization installation, employees included as labor resource pool to a project. This includes all employees, as defined in Oracle Human Resources, who belong to the business group associated with the project operating unit.

**project funding**

An allocation of revenue from an agreement to a project or task.

**project operating unit**

The operating unit within which the project is created.

**project/task organization**

The Organization that owns the project or task. This can be any organization in the LOV (list of values) for the project setup. The Project/Task Organization LOV contains organizations of the Project/Task Organization Type in the Organization Hierarchy and Version below the Start Organization. You specify your Start Organization and Version in the Implementation Options window.

**project role**

The responsibility or position assigned to an employee on a project.
**project role type**
An implementation-defined classification of the role or responsibility that an employee can have on a project. When you define project role types, you can determine whether an employee assigned to a particular project role type can query labor costs.

**project segment**
To set up your account, you define the individual segments of your general ledger account code. You can define a project segment to enter your project identifier. You define all key attributes of the segment, including field length, position of the segment within your account, prompt, type of characters (numeric or alphanumeric), and default value (optional).

**project segment value**
The identifier (project name, number, or code) you use to designate each project. After you define a project segment in your account, you set up a project in Applications Desktop Integrator by simply defining a project segment value. For example, you could define a project name (ALPHA), a project number (583), or a project code (D890).

**project status**
An implementation-defined classification of the status of a project. Typical project statuses are Active and Closed.

**project type**
An implementation-defined template that consists of essential project attributes such as whether a project is direct or indirect, a project’s default revenue distribution rule and bill rate schedules, and whether a project burdens costs. For example, you can define a project type with a name such as *Time and Materials* for all projects that are based on time and materials contracts.

**project type class**
An additional classification for project types that indicates how to collect and track costs, quantities, and, in some cases, revenue and billing. Oracle Projects predefines three project type classes: *Indirect*, *Contract*, or *Capital*. For example, you use an Indirect project type to collect and track project costs for overhead activities, such as administrative and overhead work, marketing, and bid and proposal preparation.
**Project/customer relationship**
An implementation-defined classification of the relationship between a project and a customer. Project/Customer Relationships help you manage projects that involve multiple clients by specifying the various relationships your customers can have with a project. Typical relationships include Primary or Non-Paying.

**Project/Task Alias**
A user-defined short name for a project or project/task combination used to facilitate online timecard and expense report entry.

**Project/Task Organization**
The Organization that owns the project or task.

**promise date**
The date on which a customer promises to pay for products or services. The date on which you agree you can ship the products to your customer, or that your customer will receive the products.

**prompt payment act**
A law applying to U.S. Federal government agencies requiring them to pay interest on overdue invoices. Oracle Public Sector Payables supports recalculation of scheduled payments and payment of interest on overdue invoices in accordance with the U.S. Federal Prompt Payment Act. Many states have enacted their own prompt payment laws. Have your Oracle consultant review this function for applicability to your state.

**prompt payment act due date**
The date by which you must pay an invoice to comply with Prompt Payment Act regulations. Applications Desktop Integrator automatically revises your scheduled payment in accordance with Prompt Payment Act requirements when you approve an invoice.

**proprietary account**
An account segment value (such as 3500) assigned one of the five proprietary account types. The five types include Asset, Liability, Owner’s Equity, Revenue, and Expense.

**Proprietary account**
An account that contains a proprietary account.
proprietary account type
Any of the five account types: Asset, Liability, Owner’s Equity, Revenue, and Expense.

proprietary funds
A fund type that uses accounting and reporting techniques similar to commercial enterprises. Examples of proprietary funds include internal service funds, such as a central motor pool or central public works facility, and enterprise funds.

prorate calendar
The prorate calendar determines the number of prorate periods in your fiscal year. It also determines, with the prorate or retirement convention, which depreciation rate to select from the rate table for your table-based depreciation methods. You must specify a prorate calendar for each book.

prorate convention
Oracle Assets uses the prorate convention to determine how much depreciation to take in the first and last year of an asset’s life based on when you place the asset in service. If you retire an asset before it is fully reserved, Oracle Assets uses the retirement convention to determine how much depreciation to take in the last year of life based on the retirement date. Your tax department determines your prorate and retirement conventions.

prorate date
Oracle Assets uses the prorate date to calculate depreciation expense for the first and last year of an asset’s life.

protection level
In Oracle Workflow, a numeric value ranging from 0 to 1000 that represents who the data is protected from for modification. When workflow data is defined, it can either be set to customizable (1000), meaning anyone can modify it, or it can be assigned a protection level that is equal to the access level of the user defining the data. In the latter case, only users operating at an access level equal to or lower than the data’s protection level can modify the data. See also Account Generator.

provisional schedule
A burden schedule of estimated burden multipliers that are later audited to determine the actual rates. You apply actual rates to provisional schedules by replacing the provisional multipliers with actual multipliers. Oracle Projects
processes adjustments that account for the difference between the provisional and actual calculations.

**proxima payment terms**
A payment term you define for invoices due on the same day each period, such as your credit card or telephone bills. When you define a proxima payment term, you specify a cutoff day and the day of month due. This type of payment term is also used with consolidated billing invoices. See also *cutoff day, consolidated billing invoice*.

**PTO item**
*See pick-to-order item.*

**PTO model**
*See pick-to-order model.*

**purchase order (PO)**
A document used to buy and request delivery of goods or services from a supplier. The order on which the purchasing department approved a purchase.

**purchase order distribution**
Each purchase order shipment consists of one or more purchase order distributions. A purchase order distribution consists of the Accounting Flexfield information Oracle Payables uses to create invoice distributions.

**purchase order encumbrance**
A transaction representing a legally binding purchase. Oracle Government Purchasing subtracts purchase order encumbrances from funds available when you approve a purchase order. When you cancel a purchase order, Oracle Government Purchasing creates appropriate reversing entries in your general ledger. Also known as *obligation, encumbrance or lien*. A transaction representing a legally binding purchase. Oracle Purchasing subtracts purchase order encumbrances from funds available when you approve a purchase order. If you cancel a purchase order, Oracle Purchasing creates appropriate reversing encumbrances entries in your general ledger. Also known as *obligation, encumbrance or lien*.

**purchase order line**
An order for a specific quantity of a particular item at a negotiated price. Each purchase order in Purchasing can consist of one or more purchase order lines.
**purchase order requisition line**
Each purchase order line is created from one or more purchase order requisition lines. Oracle Payables creates purchase order requisition lines from individual requisitions.

**purchase order shipment**
A scheduled delivery of goods or services from a purchase order line to a specified location. Each purchase order line can have one or more purchase order shipments.

Applications Desktop Integrator defines a purchase order shipment by a purchase order line location you enter in Oracle Payables. When you perform matching during invoice entry, you can match an invoice to one or more shipments.

**purchase requisition**
An internal request for goods or services. A requisition can originate from an employee or from another process, such as inventory or manufacturing. Each requisition can include many lines, generally with a distinct item on each requisition line. Each requisition line includes at least a description of the item, the unit of measure, the quantity needed, the price per item, and the Accounting Flexfield you are charging for the item. Also known as *internal requisition*. See also *internal sales order*.

**purchasing site**
A supplier site from which you order goods or services. You must enter at least one purchasing site before Purchasing will allow you to enter a purchase order.

**purge**
To purge a fiscal year is to remove the depreciation expense and adjustment transaction records for that year from Oracle Assets. You must archive and purge all earlier fiscal years and archive this fiscal year before you can purge it. A Applications Desktop Integrator process where you identify a group of records for Applications Desktop Integrator to delete from the database. Applications Desktop Integrator purges each record and its related records. Applications Desktop Integrator maintains summary data for each record it purges.

**purgeable flag**
A flag in Applications Desktop Integrator you use to determine whether you can purge an imported invoice from the database.

Applications Desktop Integrator automatically enters Yes for the purgeable flag on
all expense reports you enter in the Payables Expense Report window, allowing you to purge all expense reports, after importing, without updating the purgeable flag. Oracle Projects enters No for the purgeable flag on all expense reports you enter in Oracle Projects. You must update the purgeable flag to Yes in Oracle Projects before you can purge the expense report in Applications Desktop Integrator. Applications Desktop Integrator does not display the purgeable flag for any invoices.

**quarter average-to-date**
The average of the end-of-day balances for a related range of days within a quarter.

**quantity on hand**
Current quantity of an item in inventory.

**query**
A search for applications information that you initiate using an Oracle Applications window.

**Quick Check**
See *Quick payment*.

**Quick payment**
A feature you use to create an automatic payment on demand. With Quick payment, you choose the invoices you want to pay, and Payables creates the check on a printer you choose. You can also void and reissue a Quick payment if your printer spoils it while printing.

**Quick Release**
A feature you can use to release all user-assigned and many system-assigned invoice holds. You can define and apply unlimited approval criteria to an invoice, and you can then use QuickRelease to release all holds for a particular invoice, batch, or supplier with a single keystroke.

**QuickCash**
A feature that lets you enter receipts quickly by providing only minimal information. After using QuickCash to enter your receipts, you can post your payment batches to your customer accounts by running Post QuickCash. See also *Post QuickCash*.  

See also: *Post QuickCash*.
QuickCodes

Codes that you define for the activities and terminology you use in your business. For example, you can define QuickCodes for personal titles, such as ‘Sales Manager’, so you can refer to people using these titles. For example, you can define QuickCodes for sales channels so that you can specify the various sales channels used for different kinds of orders. An Oracle Assets feature that allows you to enter standard descriptions for your business. You can enter QuickCode values for your Property Types, Retirement Types, Asset Descriptions, Journal Entries, and Mass Additions Queue Names. A feature you use to create reference information you use in your business. This reference information appears in lists of values for many of the fields in Payables windows. There are three basic kinds of QuickCodes: supplier, payables, and employee. With QuickCodes you can create Pay Groups, supplier types, and other references used in Payables

quota sales credits

See revenue sales credit, non-revenue sales credit.

R

draw costs

Costs that are directly attributable to work performed. Examples of raw costs are salaries and travel expenses.

realized gain

For foreign currency entries, a realized gain is the difference in your functional currency between the invoiced amount and the payment amount, if the payment in functional currency is less than the invoiced amount.

realized gain or loss

The actual gain or loss in value that results from holding an asset or liability over time. Realized gains and losses are shown separately on the Income Statement. See also unrealized gain or loss, foreign currency exchange gain or loss.

realized loss

For foreign currency entries, a realized loss is the difference in your functional currency between the invoiced amount and the payment amount, if the invoiced amount in functional currency is less than the amount of the payment.
**reasons**
Standard definitions that you can customize to clarify your adjustment entries, debit memos, customer responses, invoices, credit memos, payment reversals and on account credits. Use reasons to improve the quality of your reporting.

**receipt acceptance period**
The number of days you allow for acceptance or rejection of goods. Applications Desktop Integrator uses this to recalculate invoice scheduled payments. You specify receipt acceptance days when you define your Financials options.

**receipt batch source**
A name that you use to refer to how your agency accounts for payments. Receipt batch sources relate your receipt batches to both the bank and the accounting information required for recording and posting your receipts. A name that you use to refer to how your company accounts for receipts. Receipt batch sources relate your receipt batches to both the bank and the accounting information required for recording and posting your receipts.

**receipt class**
Automatic receipt processing steps that you relate to your payment methods. You can choose whether to confirm, remit, and clear automatic receipts.

**receipt grace days**
A specific number of days that you assign to your customers and sites to effectively extend the due dates for their outstanding debit items.

**receipt source**
Your name for a source from which your agency receives cash. Your receipt sources determine the accounting for payments that are associated with them. Receipts that you deposit in different banks belong in different payment sources. Your name for a source from which your company receives cash. Your receipt sources determine the accounting for payments that are associated with them. Receipts that you deposit in different banks belong in different payment sources.

**receipts**
Payment received in exchange for goods or services. These include applied and unapplied receipts entered within the GL date range that you specified. If the receipt is applied within the GL date range that you specified, it will appear in the Applied Receipts register; otherwise it will appear in the Unapplied Receipt Register. See also cross site and cross customer receipts, cross currency receipt.
receivable activities
Predefined Oracle Receivables activities used to define the general ledger accounts with which you associate your receivables activities.

receivables activity name
A name that you use to refer to a receivables activity. You use receivables activities during the setup process to create accounting distributions for cash and miscellaneous receipt payments, receivables adjustments, discounts, receivables accounts, and finance charges.

received quantity
The quantity of an inventory item returned by a customer for which you are not issuing a credit. Sometimes this is temporary, while you evaluate the condition of the item, other times you return the items to the customer, or keep them but do not allow a credit. See also accepted quantity.

receiving and inspection  A condition of a returned inventory item signifying it has been received but is being inspected for damage. If in acceptable condition, the items are transferred to stock and a credit can be issued. If unacceptable, the items can be returned to the customer or scrapped.

recipient
A person to whom Oracle Alert sends a message. The recipient may receive a message through electronic mail or via a printer.

reciprocal customer relationship
An equal relationship shared between two customers. Both customers can enter invoices against each others commitments as well as pay each others debit items. An equal relationship shared between two customers. Both customers can share agreements, enter invoices against each others commitments, as well as pay each others debit items.

reconciliation
An analysis that explains the difference between two balances. If you are using Cash Management to reconcile receipts, payments are reconciled when they are matched to a bank statement line. The process of matching and clearing your bank account statement lines with payments and receipts entered in Payables and Receivables. A reconciled document has been matched to a bank statement line in Cash Management. Applications Desktop Integrator inserts a cleared date and amount for all payments that your bank reports as cleared.
reconciliation
The process of matching bank statement lines to appropriate batches and detail transactions and creating all necessary accounting entries. See also reconciliation tolerance, AutoReconciliation.

Reconciliation Open Interface
This interface lets you reconcile with payments and receipts from external systems.

reconciliation tolerance
A variance amount used by Cash Management’s AutoReconciliation program to match bank statement lines with receivables and payables transactions. If a transaction amount falls within the range of amounts defined by a bank statement line amount, plus/minus the reconciliation tolerance, a match is made. See also AutoReconciliation.

record
A record is one occurrence of data stored in all the fields of a block. A record is also referred to as a row or a transaction, since one record corresponds to one row of data in a database table or one database transaction.

record identifier
A record identifier consists of either one or two characters which Applications Desktop Integrator uses to identify each record type. For example, Applications Desktop Integrator can identify a payment record in BAI bank files because this record always starts with the character 0 in the first position of the record.

record type
A bank file is made up of many different rows or records. Each record must have a type. For example, a record may store information about a payment record or a batch record. Record types help Applications Desktop Integrator determine where different types of data are stored in your bank file.

recoverable cost
The lesser of the cost ceiling or the current asset cost less the salvage value and ITC basis reduction amount. Recoverable cost is the total amount of depreciation you are allowed to take on an asset throughout its life.

recurring formula
See recurring journal entry.
recurring invoice
A feature that lets you create invoices for an expense that occurs regularly and is not usually invoiced. Monthly rents and lease payments are examples of typical recurring payments. You define recurring invoice templates and Applications Desktop Integrator lets you define recurring invoices using these templates. See also recurring rule.

recurring journal entry
A journal entry you define once; then, at your request, General Ledger repeats the journal entry for you each accounting period. You use recurring journal entries to define automatic consolidating and eliminating entries. Also known as recurring formula.

recurring rule
A rule that is applied to the model invoice to determine the invoice dates of the recurring invoices. You can choose Annually, Bi-Monthly, Days, Monthly, Quarterly, Semi-Annually, Single Copy, and Weekly.

recurring schedule
A schedule used to determine the number of recurring invoices created. You specify the recurring rule and number of recurring invoices you want to create.

reference designator
An optional identifier you can assign to a component on a bill. For example, when the bill requires four of a component, you can assign four reference designators to that component, one for each usage.

reference document type
The kind of source used to provide default information on a return, such as a sales order, purchase order entered on a sales order, or an invoice. See also reference source.

reference field
A field from which you can obtain the default context field value for your context prompt. The reference field you use for a particular descriptive flexfield is always located in the zone or form that contains the descriptive flexfield.

reference source
Provides default information on a return by allowing the user to enter a unique combination of reference document type, document number and line number, that
identifies the original sales order for the returning item. See also reference document type.

**region**
A collection of logically-related fields set apart from other fields by a dashed line that spans a block. Regions help to organize a block so that it is easier to understand.

**reimbursement**
A transaction you reflect once for the government as a whole, such as expenditures you make from a fund that are properly applicable to another fund. For example, if you charge an expenditure to the special revenue fund that is properly chargeable to the general fund, you reimburse the special revenue fund by recording the expenditure in the general fund and reducing the expenditure in the special revenue fund to be reimbursed.

**related transaction**
Additional transactions that are created for labor transactions using the Labor Transaction Extension. All related transactions are associated with a source transaction and are attached to the expenditure item ID of the source transaction. You can identify and process the related transactions by referring to the expenditure item ID of the source transaction. Using labor transaction extensions, you can create, identify, and process the related transactions along with the source transaction.

**relationship**
An association you can create between two or more customers in Receivables to make payment applications easier. See also reciprocal customer relationship.

**relative amount**
The amount that represents the numerator for the ratio used to determine the amount due. You specify your relative amount when you define your payment terms.

\[
\text{Amount Due} = \frac{\text{Relative Amount}}{\text{Base Amount}} \times \text{Invoice Amount}
\]

**release**
An actual order of goods or services you issue against a blanket purchase order. The blanket purchase order determines the characteristics and prices of the items. The release specifies the actual quantities and dates ordered for the items.

identify a release by the combination of blanket purchase order number and release number. See Pick Release.

release code
The release name Applications Desktop Integrator or you assign when releasing a hold from an invoice.

release reason
Justification for removing a hold on an order or order line. (Order Entry QuickCode)

released date
The date on which an invoice and its associated revenue is released.

remit to addresses
The address to which your customers remit their payments.

remittance advice
A document that lists the invoices being paid with a particular payment document. You can create and define remittance advices which you can use with any payment format or you can use a standard remittance advice that Applications Desktop Integrator provides.

remittance bank
The bank in which you deposit your receipts.

reorder point planning
An inventory planning method used to determine when and how much to order based on customer service level, safety stock, carrying cost, order setup cost, lead time and average demand.

replacement order
A sales order created to replace goods being returned by a customer.

replenish-to-order
See assemble-to-order (ATO).

report
An organized display of Oracle Applications information. A report can be viewed online or sent to a printer. The content of information in a report can range from a
summary to a complete listing of values. A combination of at least a row set and column set, and optionally a content set, display group, row order, and runtime options, such as currency and override segment name, that you can define and name. When you request financial statements, you can enter this name, and Applications Desktop Integrator automatically enters the report components and runtime options for you. You simply specify the accounting period. Applications Desktop Integrator automatically enters the rest.

**resource**
A user-defined group of employees, organizations, jobs, suppliers, expenditure categories, revenue categories, expenditure types, or event types for purposes of defining budgets or summarizing actuals.

**report component**
An element of a Financial Statement Generator report that defines the format and content of your report. Report components include row sets, column sets, content sets, row orders, and display sets. You can group report components together in different ways to create custom reports.

**report headings**
A descriptive section found at the top of each report giving general information about the contents of the report. Report headings provide you with general information about the contents of the report. Report headings provide you with the name of the Set of Books selected for all Applications Desktop Integrator transactions and reports. Applications Desktop Integrator prints the name of your Set of Books in the heading of most reports.

**report option**
See report parameter.

**report parameter**
Options that let you sort, format, select, and summarize the information in your reports. A variable you use to restrict information in a report, or determine the format of the report. For example, you may want to limit your report to the current month, or display information by supplier number instead of supplier name. Most standard reports in Applications Desktop Integrator that you can submit manually have a set of report parameters.
**report security group**
A feature that helps your system administrator control your access to reports and programs. Your system administrator defines a report security group which consists of a group of reports and/or programs and assigns a report security group to each responsibility that has access to run reports using Standard Report Submission. When you submit reports using Standard Report Submission, you can only choose from those reports and programs in the report security group assigned to your responsibility.

**report set**
A group of reports that you submit at the same time to run as one transaction. A report set allows you to submit the same set of reports regularly without having to specify each report individually. For example, you can define a report set that prints all of your regular month-end management reports.

**reporting currency**
The currency you use for financial reporting. If your reporting currency is not the same as your functional currency, you can use foreign currency translation to restate your account balances in your reporting currency.

**reporting entity**
The oversight unit and all related component units that combine to form a governmental reporting entity.

**reporting hierarchies**
Summary relationships within an account segment that let you group detailed values of that segment to prepare summary reports. You define summary (parent) values that reference the detailed (children) values of that segment.

**request date**
The date the customer requests the products be either shipped or received.

**request for quotation (RFQ)**
A document you use to solicit supplier quotations for goods or services you need. You usually send a request for quotation to many suppliers to ensure that you get the best price and terms possible. Depending on the way you do business, you can use two general types of RFQs: specific and generic.
requirement date
The date when the requirement needed by the discrete job or repetitive schedule is to be consumed. Requirement dates are defaulted to the start date of the operation where a requirement is consumed.

requisition
See purchase requisition.

requisition encumbrance
A transaction representing an intent to purchase goods and services as indicated by the completion and approval of a requisition. Oracle Purchasing subtracts requisition encumbrances from funds available when you reserve funds for a requisition. If you cancel a requisition, Oracle Purchasing creates appropriate reversing entries in your general ledger. Also known as commitment, pre-encumbrance or pre-lien.

reservation
A guaranteed allotment of product to a specific sales order. A hold is placed on specific items that assures that a certain quantity of an item is available on a certain date when transacted against a particular charge entity. Once reserved, the product cannot be allocated to another sales order or transferred in Inventory. Oracle Order Entry checks ATR (Available to Reserve) to verify an attempted reservation. Also known as hard reservation. See also Available to Reserve.

Reserve for Encumbrance
A portion of fund balance you use to record anticipated expenditures. In Oracle Financials, you define your Reserve for Encumbrance account when you define your set of books. Oracle Financials uses your Reserve for Encumbrance account to create offsets for unbalanced encumbrance entries you create in Oracle Purchasing, Oracle Payables, and General Ledger.

Reserve for Encumbrance account
The account you use to record your encumbrance liability. You define a Reserve for Encumbrance account when you define your set of books. When you create encumbrances automatically in Oracle Purchasing or Applications Desktop Integrator, General Ledger automatically creates a balancing entry to your Reserve for Encumbrance account as you post your encumbrance journal entries. General Ledger overwrites the balancing segment for your Reserve for Encumbrance account, so you automatically create the reserve for encumbrance journal entry to the correct company.
Reserve for Encumbrance account
The account you use to record your encumbrance liability. You define a Reserve for Encumbrance account when you define your set of books. When you create encumbrances automatically in Oracle Purchasing or Applications Desktop Integrator, General Ledger automatically creates a balancing entry to your Reserve for Encumbrance account as you post your encumbrance journal entries. General Ledger overwrites the balancing segment for your Reserve for Encumbrance account, so you automatically create the reserve for encumbrance journal entry to the correct fund.

responsibility
A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications windows, menus, reports, and data to fulfill your role in an organization. Several users can share the same responsibility, and a single user can have multiple responsibilities. A level of authority within Applications Desktop Integrator. Each responsibility provides a user with access to a menu and a set of books. You can assign one or more responsibilities to each user. Responsibilities let you control security in Applications Desktop Integrator.

responsibility report
A financial statement containing information organized by management responsibility. For example, a responsibility report for a cost center contains information for that specific cost center, a responsibility report for a division manager contains information for all organizational units within that division, and so on. A manager typically receives reports for the organizational unit(s) (such as cost center, department, division, group, and so on) for which he or she is responsible. A financial statement containing information organized by management responsibility. For example, a responsibility report for an organization contains information for that organization, a responsibility report for a division manager contains information for all organizational units within that division, and so on. A manager typically receives reports for the organizational units (such as division, department, group, and so on) for which he or she is responsible.

responsibility type
See process responsibility type.

restore
To restore a fiscal year is to reload the depreciation expense and adjustment transaction records for that fiscal year into Oracle Assets from a storage device. You can only restore the most recently purged fiscal year.
result
See action result.

result code
In Oracle Workflow, the internal name of a result value, as defined by the result type. See also result type, result value.

result type
In Oracle Workflow, the name of the lookup type that contains an activity’s possible result values. See also result code, result value.

result value
In Oracle Workflow, the value returned by a completed activity, such as Approved. See also result code, result type.

retroactive addition
See prior period addition.

retroactive reinstatement
See prior period reinstatement.

retroactive retirement
See prior period retirement.

retroactive transfer
See prior period transfer.

return
The opposite of a sales order, it involves receipt of goods previously sold to a customer, credit to a customer, and possibly replacement with an identical or similar product. ‘Return’ is often used synonymously with ‘RMA’. See also Return Material Authorization (RMA).

Return (of) Material Goods
(RMG) See Return Material Authorization.

Return Material Authorization
(RMA) Permission for a customer to return items. Applications Desktop Integrator allows you to authorize the return of your sales orders as well as sales made by
other dealers or suppliers, as long as the items are part of your item master and price list. 'RMA' is often used synonymously with 'Return'. See also return.

**return reason**
Justification for a return of product. Many companies have standard reasons that are assigned to returns to be used to analyze the quantity and types of returns. See also credit memo reasons.

**revaluation**
See foreign currency revaluation. An Fixed Assets feature that allows you to adjust the cost of your assets by a revaluation rate. The cost adjustment is necessary due to inflation or deflation. You can define revaluation rules for accumulated depreciation, for amortization of revaluation reserve, and for revaluation ceilings. Restatement of assets of liabilities denominated in a foreign currency using exchange rates that you enter. Fluctuations in exchange rates between the transaction and revaluation dates result in revaluation gains or losses.

**revaluation gain/loss account**
An income statement account you specify in which Applications Desktop Integrator records net revaluation gains and losses, in accordance with FASB 52 (U.S.). You specify the account you want to use for unrealized revaluation gains and losses in the Run Revaluation window. You can change your revaluation gain/loss account as often as you want. When you run revaluation, Applications Desktop Integrator creates a batch of revaluation journal entries that adjust your revaluation gain/loss account. Applications Desktop Integrator also marks the journal entries for reversal in the next accounting period.

**revaluation journal entry**
A journal entry that is automatically created when you run revaluation for a range of accounts denominated in a foreign currency. Applications Desktop Integrator creates a batch of revaluation journal entries when the exchange rate used for conversion on your transaction date differs from the exchange rate on your balance sheet date. Applications Desktop Integrator creates a journal entry to adjust an income statement gain and loss account for exchange rate fluctuations, in accordance with FASB 52 (U.S.).

**revaluation status report**
A report that summarizes the results of your revaluation. Applications Desktop Integrator automatically generates this report whenever you revalue foreign asset and liability account balances for an accounting period in your calendar. You can
review this report to identify accounts that were revalued in Applications Desktop Integrator and journal batches and entries that were created because of the revaluation.

**revenue**
In Oracle Projects, the amounts recognized as income or expected billing to be received for work on a project.

**revenue accrual**
The function of calculating and distributing revenue.

**revenue authorization rule**
A configurable criterion that, if enabled, must be met before a project can accrue revenue. For example, an active mandatory revenue authorization rule states that a project manager must exist on a project before that project can accrue revenue. Revenue authorization rules are associated with revenue distribution rules. See also revenue distribution rule.

**revenue budget**
The estimated revenue amounts at completion of a project. Revenue budget amounts can be summary or detail.

**revenue burden schedule**
A burden schedule used for revenue accrual to derive the revenue amount for an expenditure item. This schedule may be different from your invoice burden schedule, if you want to accrue revenue at a different rate than you want to invoice.

**revenue category**
An implementation-defined grouping of expenditure types by type of revenue. For example, a revenue category with a name such as Labor refers to labor revenue.

**revenue credit**
Credit that an employee receives for project revenue. See revenue sales credit. Revenue credit you assign to your agents that is from your invoice lines. The total amount of all revenue credit must be equal to your invoice lines amount.

**revenue distribution rule**
A specific combination of revenue accrual and invoicing methods that determine how Oracle Projects generates revenue and invoice amounts for a project. See revenue authorization rule.
**revenue item**
A single line of a project’s revenue, containing event or expenditure item revenue summarized by top task and revenue category or event.

**revenue recognition**
The point at which revenue is recorded. The concept of revenue recognition is central to accrual-basis accounting. Revenue recognition schedules detail the points at which percent amounts of a sale are recognized as revenue.

**revenue sales credit**
Sales credit you assign to your salespeople that is based on your invoice lines. The total percentage of all revenue sales credit must be equal to 100% of your invoice lines amount. Also known as *quota sales credits*. See also *non-revenue sales credit, sales credit*.

**revenue write-off**
An event type classification that reduces revenue by the amount of the write-off. You cannot write-off an amount that exceeds the current unbilled receivables balance on a project. See also *invoice write-off*.

**reversing journal entry**
A journal entry General Ledger creates by reversing an existing journal entry. You can reverse any journal entry and post it to any open accounting period.

**RFQ**
See *request for quotation*.

**RFQ Only Site**
A supplier site from which you receive quotations.

**revision**
A particular version of an item, bill of material, or routing.

**revision control**
An inventory control option that tracks inventory by item by revision and forces you to specify a revision for each material transaction.

**RMA**
See *Return Material Authorization*.
RMG

rollforward
The process of taking the beginning balance of a period and then accounting for the transactions within that period by attempting to equate the beginning balance with the ending balance for the period.

rollup group
A collection of parent segment values for a given segment. You use rollup groups to define summary accounts based on parents in the group. You can use letters as well as numbers to name your rollup groups.

root node
A parent segment value in Oracle General Ledger that is the topmost node of a hierarchy. When you define a hierarchy using the Hierarchy window, you specify a root node for each segment. Oracle Financial Analyzer creates a hierarchy by starting at the root node and drilling down through all of the parent and child segment values. See also parent segment value.

root window
The root window displays the main menu bar and tool bar for every session of Oracle Applications. In Microsoft Windows, the root window is titled “Oracle Applications” and contains all the Oracle Applications windows you run. In the Motif environment, the root window is titled “Toolbar” because it displays just the toolbar and main menu bar.

routing
A sequence of manufacturing operations that you perform to manufacture an assembly. A routing consists of an item, a series of operations, an operation sequence, and operation effective dates.

row
One occurrence of the information displayed in the fields of a block. A block may show only one row of information at a time, or it may display several rows of information at once, depending on its layout. The term “row” is synonymous with the term “record”.

Glossary-138
**row order**
A report component that you use to modify the order of detail rows and account segments in your report. You can rank your rows in ascending or descending order based on the amounts in a particular column and/or by sorting your account segments either by segment value or segment value description. You also specify display options, depending on the row ranking method you choose. For example, if you want to review Total Sales in descending order by product, you can rank your rows in descending order by the Total Sales column and rearrange your segments so that product appears first on your report. A report component you use to modify the current order of rows and Accounting Flexfield segments in your report. You can rank rows in ascending or descending order based on a selected column and rearrange the sequence of segments in your Accounting Flexfield. For example, to review Total Expenditures in descending order by project, you can rank rows in descending order by the Total Expenditures column and rearrange your segments so the project row appears first on the report.

**row set**
A Financial Statement Generator report component that you build within Applications Desktop Integrator by defining all of the lines in your report. For each row, you control the format and content, including line descriptions, indentations, spacing, page breaks, calculations, units of measure, precision and so on. A typical row set includes row labels, accounts and calculation rows for totals. For example, you might define a standard income statement row set or a standard balance sheet row set. A report component you build within Applications Desktop Integrator by defining all of the rows in your report. For each row, you control the format and content, including line descriptions, indentations, spacing, page breaks, calculations, units of measure, precision, and so on.

**rule numbers**
A sequential step in a calculation. You use rule numbers to specify the order in which you want Applications Desktop Integrator to process the factors you use in your budget and actual formulas.

**segments**
The building blocks of your chart of accounts in Oracle General Ledger. Each account is comprised of multiple segments. Users choose which segments will make up their accounts; commonly-used segments include company, cost center, and product.
segment values
The possible values for each segment of the account. For example, the Cost Center segment could have the values 100, which might represent Finance, and 200, which might represent Marketing.

selection tools
A set of tools in Oracle Financial Analyzer that provide shortcut methods for selecting the values that you want to work with in a report, graph, or worksheet.

sale or payment
This report column represents either the invoiced amount of the transaction or the payment amount of the customer’s remittance where the transaction was entered with a GL Date that is between the beginning and ending GL Dates. If the transaction is an invoice, a debit memo, a credit memo, a deposit, a guarantee or a chargeback, you should find the same amount on the Transaction Register in the Functional Currency column. If the transaction is a payment, you should find the same amount on the Payments Register in the Amount column. If the payment has been reversed, you should find the same amount on the Reversed Receipts Report in the Amount column.

sales channel
A term that indicates the method used to generate a sales order, such as Telemarketing or Direct Marketing. You can use this attribute of an order to classify orders for reporting purposes. (Order Entry QuickCode)

sales credit
Credits that you assign to your salespeople when you enter orders, invoices, and commitments. Credits can be either quota or non-quota and can be used in determining commissions. See also non-revenue sales credit, revenue sales credit.

sales tax
A tax collected by a tax authority on purchases of goods and services. The supplier of the good or service collects sales taxes from its customers (tax is usually included in the invoice amount) and remits them to a tax authority. Tax is usually charged as a percentage of the price of the good or service. The percentage rate usually varies by authority and sometimes by category of product. Sales taxes are expenses to the buyer of goods and services.
**sales tax structure**
The collection of taxing bodies that you will use to determine your tax authority. ‘State.County.City’ is an example of a Sales Tax Structure. Applications Desktop Integrator adds together the tax rates for all of these components to determine a customer’s total tax liability for an order/transaction.

**salesperson**
A person who is responsible for the sale of products or services. Salespeople are associated with orders, returns, invoices, commitments, and customers. You can also assign sales credits to your salespeople.

**schedule date**
The date the order line should be ready to ship. This date is communicated from Oracle Order Entry to Oracle Inventory as the request date anytime you reserve or place demand for an order line.

**schedule fixed date**
The date used to freeze bill rate or burden schedules for a project or task. You enter a fixed date to specify that you want to use particular rates or multipliers as of that date. You do not use schedule fixed dates if you want to use the current effective rates or multipliers for a particular schedule.

**scheduled payment** A schedule used to determine the amount and date of payment due. You use payment terms to determine your scheduled payment as well as any discounts offered. See also payment terms.

**scheduling**
Order scheduling includes assigning demand or reservations, warehouses, shipment dates, and lots or subinventories to an order line. Scheduling can be done on unbooked orders in the Schedule Details zone of the Enter Orders form or on booked orders in the same zone on the Schedule Orders window.

**scrollable region**
A region whose contents are not entirely visible in a window. A scrollable region contains a horizontal or vertical scroll bar so that you can scroll horizontally or vertically to view additional fields hidden in the region.

**secondary accounting method**
The accounting method you choose for your secondary set of books. You can choose either the cash basis or accrual basis accounting methods. Your secondary
accounting method cannot be the same as your primary accounting method. You do not need a secondary accounting method if you do not use a secondary set of books.

**secondary set of books**
The set of books you maintain for reporting purposes. You can run your business using accrual accounting and report on a cash basis, or run your business on a cash basis and report on an accrual basis.

**security rules**
(Order Entry) The control over the steps in the order process where you no longer allow users to add, delete or cancel order or return lines or change order or return information.

**segment**
A single sub-field within a flexfield. You define the structure and meaning of individual segments when customizing a flexfield.

**selection options**
For each report, Applications Desktop Integrator provides you with parameters you can choose to make your report as brief as possible. For example, on the Aging - 4 Buckets report, you can specify that you want to review the report for a range of customers or only the aging information for one customer. This feature saves time and lets you retrieve data in different ways.

**senior tax authority**
The first tax location in your sales tax structure. This segment does not have a parent location. For example, in the sales tax structure 'State.County.City', State is the senior tax authority.

**sequence type**
Receivables provides two types of sequences: Automatic and Manual. Automatic numbering sequentially assigns a unique number to each transaction as it is created. Manual numbering requires that you manually assign a unique number to each transaction when you create it. You can skip or omit numbers if desired.

**sequencing**
A parameter you can set when defining your dunning letter sets to ensure that your customers and sites receive proper notification of past due debit items. Sequencing
ensures that a customer receives each of the dunning letters in their dunning letter set in the proper order. See also document sequence.

**serial number**
A number assigned to each unit of an item and used to track the item.

**serial number control**
A system technique for enforcing use of serial numbers during a material transaction, such as receipt or shipment.

**service type**
An implementation-defined classification of the type of work performed on a task.

**set of books**
A financial reporting entity that uses a particular chart of accounts, functional currency and accounting calendar. You must define at least one set of books for each business location.

**set of books**
An organization or group of organizations within Applications Desktop Integrator that shares a common account structure, calendar, and functional currency. An organization or group of organizations within Oracle Applications that shares a common Accounting Flexfield structure, calendar, and functional currency. You must define at least one set of books for each business location.

**soft limit**
The default option for an agreement that generates a warning when you accrue revenue or generate invoices beyond the amount allocated to a project or task by the agreement, but does not prevent you from running these processes. See also hard limit.

**SFAS 52 (U.S.)**
Statement of Financial Accounting Standards number 52, issued by the Financial Accounting Standards Board (FASB), which dictates accounting and reporting standards for translating foreign currency transactions in the United States. Applications Desktop Integrator translates and reevaluates such transactions according to SFAS 52 (U.S.) standards. Usually, SFAS 52 (U.S.) mandates the use of a period-end exchange rate to translate asset and liability accounts, and an average exchange rate to translate revenue and expense accounts. Foreign currency denominated assets and liabilities are revalued using a period-end rate on each
balance sheet date, to reflect the period-end exchange rate in accordance with SFAS 52 (U.S.). You specify the account used for revaluation gains and losses in the Run Revaluation window. You maintain the rates used for translation and revaluation in the Define Period Rates and Define Historical Rates forms. SFAS 52 (U.S.) also mandates that you post any out-of-balance amounts arising from translation to a Cumulative Translation Adjustment account included in stockholders equity. You define the Cumulative Translation Adjustment account in the Set of Books window.

**SFAS 8 (U.S.)**

Statement of Financial Accounting Standards number 8, issued by the Financial Accounting Standards Board (FASB), which mandates that you use a historical exchange rate for all accounts based on past purchase exchanges, and that you use a current exchange rate for all accounts based on current purchase, current sale, and future exchanges. Applications Desktop Integrator remeasures specific account balances using historical rates you specify for companies in highly inflationary economies according to the standards of SFAS 8 (U.S.). SFAS 8 (U.S.) also mandates that you record any out-of-balance amounts arising from translation to an income/expense account included in your income statement.

**shortdecimal data type**

Oracle Financial Analyzer variables with a shortdecimal data type contain decimal numbers with up to 7 significant digits.

**shortinteger data type**

Oracle Financial Analyzer variables with a shortinteger data type contain whole numbers with values between -32768 and +32768.

**Settlement Date**

The date before which you cannot apply a prepayment to an invoice. Applications Desktop Integrator prevents you from applying a temporary prepayment to an invoice until on or after the Settlement Date of the prepayment.

**Shared use assets**

When your accounting entities in the same corporate book share the use of an asset, you can apportion depreciation expense to each by percentage or units used.

**Ship Confirm**

A feature that allows shipping personnel to verify that they have shipped or backordered the items of an order line.
ship date
The date upon which a shippable item is shipped.

Ship Partial
An order attribute indicating whether you allow partial shipments of an order. If you enter Yes for the Ship Partial field on an order, individual order lines can be shipped as they are available and you can assign different ship to locations and other order line details to different shipments in an order line. See also Ship Together.

ship set
A ship set is a group of order lines, linked by a common number, that you want the full quantity to ship all together. A ship set may include as many items on an order as you want, and one order may contain more than one ship set. Assigning order lines to a ship set allows you to force the full quantity of those order lines to ship simultaneously.

Ship To Address
The address of the customer who is to receive products or services listed on the invoice or order.

Ship Together
An order attribute indicating that you do not allow partial shipments of the order. You can also specify a configuration as Ship Together by setting the Ship Model Complete item attribute for the model item to Yes. See also Ship Partial, ship together model.

Ship Together model
A model item with the Ship Model Complete item attribute set to Yes. This indicates that the entire configuration must be delivered in the same shipment. If the item attribute is set to No, components can ship separately. ATO items and configurations are inherently Ship Together models. See also ship set.

ship via
See freight carrier.

shipment
A shipment is an individual package sent to a customer. Thus, a shipment might contain an entire order, if all items in that order are pick released and packed together. A shipment might contain just part of an order that is pick released and
packed. A shipment might also contain only part of a released order line, where some of the items on the picking slip are not in stock.

**shipment priority**
A term that indicates the urgency with which an order should be shipped to the customer. *(Order Entry QuickCode)*

**shipment schedule**
An itemized list of when, how, where and in what quantities to ship an order line.

**shippable item**
An item with the Shippable inventory item attribute set to Yes, indicating that this item will appear on pick slips and pack slips. See also *intangible item*.

**shipping batch**
See *picking batch*.

**shipping documents**
Shipping related reports, such as the Bill of Lading, Commercial Invoice, Mailing Label, and Pack Slip.

**shipping instructions**
Notes that print on the pick slip. These instructions are intended for internal use.

**shorthand alias**
A user-defined code or character string that represents a complete or partial flexfield value. You can define as many aliases as you need for each key flexfield.

**shorthand flexfield entry**
A quick way to enter key flexfield data using shorthand aliases (names) that represent valid flexfield combinations or patterns of valid segment values. Your organization can specify flexfields that will use shorthand flexfield entry and define shorthand aliases for these flexfields that represent complete or partial sets of key flexfield segment values.

**shorthand window**
A single-segment customizable field that appears in a pop-up window when you enter a key flexfield. The shorthand flexfield pop-up window only appears if you enable shorthand entry for that particular key flexfield.
**SIC code**
(Standard Industry Classification Code) A standard classification created by the government that is used to categorize your customers by industry.

**sign-on**
An Oracle Applications username and password that allows you to gain access to Oracle Applications. Each sign-on is assigned one or more responsibilities.

**site use**
See *business purpose*.

**skeleton entry**
A recurring journal entry the amounts of which change each accounting period. You simply define a recurring journal entry without amounts, then enter the appropriate amounts each accounting period. For example, you might define a skeleton entry to record depreciation in the same accounts every month, but with different amounts due to additions and retirements.

**source**
The origin of imported invoices. When you enter and import an expense report in Applications Desktop Integrator or Web Employees, the source is Payables Expense Reports. When you import an expense report from Oracle Projects, the source is Oracle Projects. You can define other sources in Applications Desktop Integrator for invoices you import from other accounting systems.

**source transaction**
For related transactions, the identifying source transaction from which the related items are created.

**sourcing**
The action of identifying a purchasing source or supplier for goods or services. To identify the best sources for your purchases, you can create RFQs that you send to your suppliers, enter quotations from your supplier, and evaluate these quotations for each item you purchase.

**split amount**
A dollar amount that determines the number of invoices over and under this amount, as well as the total amounts remaining. For example, your company generates invoices that are either $300 or $500. You choose $400 as your split amount so that you can review how much of your open receivables are comprised...
of your $300 business and how much corresponds to your $500 business. The split amount appears in the Collection Effectiveness Indicators Report.

**split payment terms**
A feature used to automatically schedule multiple payments for an invoice. You can split payments using either a flat amount or a percentage of the total amount due.

**spot exchange rate**
A daily exchange rate you use to perform foreign currency conversions. The spot exchange rate is usually a quoted market rate that applies to the immediate delivery of one currency for another.

**spreadsheet interface**
A program that uploads your actual or budget data from a spreadsheet into Applications Desktop Integrator.

**staged dunning**
A dunning method in which letters are based on the dunning levels of past due debit items. This method lets you send dunning letters based on the number of days since the last letter was sent, rather than the number of days items are past due. For each dunning letter, you specify the minimum number of days that must pass before Receivables can increment an item’s dunning level and include this item in the next letter that you send.

**standard balance**
The usual and customary period-to-date, quarter-to-date, or year-to-date balance for an account. The standard balance is the sum of an account’s opening balance, plus all activity for a specified period, quarter, or year. Unlike an average balance, no additional computations are needed to arrive at the standard balance.

**standard actions**
Oracle Order Entry provides you with a selection of predefined actions, called standard actions. Use these actions, along with those you define yourself, to create your customized order cycles. See also cycle action, order cycle.

**standard bill of material**
A bill of material for a standard item, such as a manufactured product or assembly. Standard bills contain no optional components. See also bill of material.
standard component
A mandatory component that is used to assemble an ATO (assemble-to-order) item or configuration.

standard entry
A recurring journal entry whose amount is the same each accounting period. For example, you might define a standard entry for fixed accruals, such as rent, interest, and audit fees.

standard item
Any item that can have a bill or be a component on a bill except planning items, option classes, or models. Standard items include purchased items, subassemblies, and finished products.

standard memo lines
A type of line that you assign to an invoice when the item is not an inventory item (for example, ‘Consulting Services’). You define standard memo lines to speed data entry when creating your transactions.

standard note
A routine message you can redefine and automatically or manually attach to orders, returns, order lines and return lines to convey important information. See also one-time note, automatic note.

Standard Request Submission
A standard interface in Oracle Applications in which you run and monitor your application’s reports and other processes.

STAT
The statistical currency Oracle General Ledger uses for maintaining statistical balances. If you enter a statistical transaction using the STAT currency, Oracle General Ledger will not convert your transaction amounts.

standard reversal
A payment reversal where Applications Desktop Integrator automatically updates your general ledger and re-opens the debit items you closed by reversing the original payment.
**standard value source**
The attribute or value Applications Desktop Integrator can use to provide a standard value or default for an order attribute.

**start organization**
An organization that defines a set which includes itself and all subordinate organizations in the organization hierarchy. When you choose a start organization as a report parameter, all organizations below the start organization are included in the report.

**statements**
Printed documents you send to your customers to communicate their invoice, debit memo, chargeback, deposit, payment, on-account credit, credit memo, and adjustment activity.

**statistical journal entry**
A journal entry in which you enter nonfinancial information such as headcount, production units, and sales units.

**statistical quantity**
Statistical information relating to the unit of measure for an invoice distribution line. For example, when you enter invoices for office rent, you can enter Square Feet (or whatever Unit of Measure you define in General Ledger) in the Unit field for an invoice distribution, and the number of square feet in the Statistical Quantity field for an invoice distribution. Applications Desktop Integrator includes the statistical quantity in the journal entries it creates for General Ledger during posting. You must use General Ledger in order to define a unit of measure and to be able to enter statistical quantities.

**statistics**
Accounting information (other than currency amounts) you use to manage your business operations. With Applications Desktop Integrator, you can maintain budget and actual statistics and use these statistics with budget rules and formulas.

**status**
See *customer status*.

**status line**
A status line appearing below the message line of a root window that displays status information about the current window or field. A status line can contain the
following: ^ or v symbols indicate previous records before or additional records following the current record in the current block; Enter Query indicates that the current block is in Enter Query mode, so you can specify search criteria for a query; Count indicates how many records were retrieved or displayed by a query (this number increases with each new record you access but does not decrease when you return to a prior record); the <Insert> indicator or lamp informs you that the current window is in insert character mode; and the <List> lamp appears when a list of values is available for the current field.

**step-down allocation**

An allocation upon which you run another allocation. For example, you might allocate parent company overhead to operating companies based on revenues. You can then use a step-down allocation to allocate overhead to cost centers within the operating companies based on headcount. An allocation upon which you run another allocation. For example, you might allocate parent fund overhead to operating funds based on revenues. You can then use a step-down allocation to allocate overhead to organizations within the operating funds based on headcount.

**straight time cost**

The monetary amount that an employee is paid for straight time (regular) hours worked.

**streamline process**

See streamline request.

**streamline request**

A process that runs multiple Oracle Projects processes in sequence. When using streamline processing, you can reschedule your streamline requests by setting rescheduling parameters. Rescheduling parameters allow you to configure your processes to run automatically, according to a defined schedule. When you reschedule a process, the concurrent manager submits another concurrent request with a status of Pending, and with a start date according to the parameters you define.

**structure**

A structure is a specific combination of segments for a key flexfield. If you add or remove segments, or rearrange the order of segments in a key flexfield, you get a different structure.
subinventory
A subdivision of an organization or warehouse, representing either a physical area or a logical grouping of items, such as a storeroom or receiving dock.

substitute item
An item that can be used in place of a component. Oracle Master Scheduling/MRP suggests substitutes items on some reports.

subtask
A hierarchical unit of work. Subtasks are any tasks that you create under a parent task. Child subtasks constitute the lowest level of your work breakdown structure; where Oracle Projects looks when processing task charges and for determining task revenue accrual amounts. See task.

summarization
Processing a project’s cost, revenue, commitment, and budget information to be displayed in the Project, Task, and Resource Project Status windows. You must distribute costs for any expenditure items, accrue and release any revenue, create any commitments, and baseline a budget for your project before you can view summary project amounts. Formerly known as accumulation.

summary account
An account whose balance represents the sum of other account balances. You can use summary accounts for faster reporting and inquiry as well as in formulas and allocations.

summary message
A summary message is a message representing one or more exceptions. The message includes an introductory paragraph followed by the exceptions listed in a columnar report format.

summary threshold
The number of exceptions after which you want Oracle Alert to send a message for a particular distribution. For example, if you define the threshold at five, and Oracle Alert locates between one and five exceptions, the recipients get one to five separate detail messages. But if Oracle Alert locates six or more exceptions, the recipients get one summary message that includes all the exceptions.
**supplier**
A business or individual that provides goods or services or both in return for payment.

**supplier codes**
A feature you use to define various kinds of supplier information, such as Pay Group and Supplier Type. You can create as many lookup codes for each item as you require. You can add or inactivate Supplier Codes to meet your changing business needs.

**SWIFT940**
A common format used by many banks to provide institutional customers with electronic bank statements. If your bank provides you with this type of statement, you can use Bank Statement Open Interface to load your bank statement information into Oracle Cash Management. See also Bank Statement Open Interface, bank statement.

**supplier invoice**
An external supplier’s invoice entered into Oracle Payables.

**system linkage**
An obsolete term. See expenditure type class.

**supplier number**
A number or combination of numbers and characters that uniquely identifies a supplier within your system.

**supplier site**
A facility maintained by a supplier for the purpose of conducting business. A supplier may have one or many supplier sites.

Payables maintains supplier information regarding each supplier site you define for a supplier. You may define a supplier site as a pay site only, a purchasing site only, both a pay site and a purchasing site, or as an RFQ only site, in which case it may not have purchase orders entered against it. See also pay site, purchasing site, RFQ only site.

**supply reserved**
A schedule status showing that Oracle Work in Process (WIP) has recognized the demand for an item or configuration and opened a work order to supply the
demand. Once the work order is complete and the finished product is received in inventory, WIP transfers a reservation for the finished product to the sales order. The schedule status for the order line or order line detail is then changed to be Reserved.

**System Items Flexfield**

A flexfield that allows you to define the structure of your item identifier according to your business requirements. You can choose the number and order of segments (such as product and product line), the length of each segment, and other characteristics. You can define up to twenty segments for your item. Also known as Item Flexfield.

**table-based depreciation method**

A depreciation method that uses the table-based method (rates) to calculate depreciation based on the asset life and the recoverable cost or net book value.

**tablespace**

The area in which an Oracle database is divided to hold tables.

**task**

A subdivision of project work. Each project can have a set of top level tasks and a hierarchy of subtasks below each top level task. See also Work Breakdown Structure, subtask.

**task organization**

The organization that is assigned to manage the work on a task.

**task service type**

See service type.

**tax authority**

A governmental entity that collects taxes on goods and services purchased by a customer from a supplier. In some countries, there are many authorities (e.g. state, local, and federal governments in the US), while in others there may be only one. Each authority may charge a different tax rate. You can define a unique tax name for each tax authority. If you have only one tax authority, you can define a unique tax name for each tax rate that it charges. A governmental entity that collects taxes on goods and services purchased by a customer from a supplier. In some countries,
there are many authorities (e.g. state, local and federal governments in the US), while in others there may be only one. Each authority may charge a different tax rate. Within Applications Desktop Integrator, tax authority consists of all components of your tax structure. For example: California.San Mateo.Redwood Shores for State.County.City. Applications Desktop Integrator adds together the tax rates for all of these locations to determine a customer’s total tax liability for an invoice.

**Tax book**
A depreciation book that you use to track financial information for your reporting authorities.

**tax codes**
Codes to which you assign sales tax or value-added tax rates. Oracle Receivables lets you choose state codes as the tax code when you define sales tax rates for the United States. (Receivables QuickCode)

**tax engine**
A collection of programs, user defined system parameters, and hierarchical flows used by Applications Desktop Integrator to calculate tax.

**tax exempt**
A customer, business purpose, or item to which tax charges do not apply. See also exemption certificate.

**Tax Identification Number**
In the United States, the number used to identify 1099 suppliers. If a 1099 supplier is an individual, the Tax Identification Number is the supplier’s social security number. If a 1099 supplier is a corporation, the Tax Identification Number is also known as the Federal Identification Number. In some countries this value is called a NIF.

**tax line type**
A distribution line used to record a sales or VAT tax charge on an invoice. See also invoice distribution line.

**tax location**
A specific tax location within your tax authority. For example ‘Redwood Shores’ is a tax location in the Tax Authority California.San Mateo.Redwood Shores.
tax tolerances
The acceptable degrees of variance you define for the differences between the calculated tax amount on an invoice and the actual tax amount on the invoice. The calculated tax amount is the amount of tax on the invoice as determined by the tax name for the invoice (which has a defined tax rate) and the amount of the invoice. The actual tax amount is the sum of all the tax distribution lines. If the variance between these two amounts exceeds the tolerances you specify, Approval places the invoice on hold.

tax type
A feature you use to indicate the type of tax charged by a tax authority when you define a tax name. Applications Desktop Integrator uses the tax type during invoice entry to determine the financial impact of the tax. When you enter a tax of type Sales, Applications Desktop Integrator creates a separate invoice distribution line for the tax amount. When you enter a tax of type Use, Applications Desktop Integrator does not create the invoice distribution line.

template
A pattern that Applications Desktop Integrator uses to create and maintain summary accounts. For each template you specify, Applications Desktop Integrator automatically creates the appropriate summary accounts.

Time dimension
An Oracle Financial Analyzer dimension whose values represent time periods. A time period can be a month, quarter, or year. The length of the Time dimension’s values is determined by the Width option on the Maintain Dimension window.

Terms Date Basis
The method that determines the date from which Applications Desktop Integrator calculates an invoice scheduled payment. The terms date basis can be Current, Goods Received, Invoice, or Invoice Received.

territory
A feature that lets you categorize your customers or salespeople. For example, you can categorize your customers by geographic region or industry type.

Territory Flexfield
A key flexfield you can use to categorize customers and salespersons.
**Time and Materials (T&M)**

A revenue accrual and billing method that calculates revenue and billings as the sum of the amounts from each individual expenditure item. The expenditure item amounts are calculated by applying a rate or markup to each item.

**timecard**

A weekly submission of labor expenditure items. You can enter timecards online, or as part of a pre-approved batch.

**TIN**

See *Tax Identification Number*.

**tolerance**

A feature you use to specify acceptable matching and tax variances. You can specify either percentage-based or amount-based tolerances or both for quantity and item price variances between matched invoices and purchase orders. You can also specify percentage-based or amount-based tolerances for your tax variances. Approval uses the tolerance levels you define to determine whether to hold or approve invoices for payment. See also *Matching Tolerances*, *Tax Tolerances*. See *reconciliation tolerance*.

**tolerance percentage**

The percentage amount by which customers are allowed to exceed their credit limit and still pass the credit check.

**toolbar**

The toolbar is a collection of iconic buttons that each perform a specific action when you choose it. Each toolbar button replicates a commonly-used menu item. Depending on the context of the current field or window, a toolbar button can be enabled or disabled. You can display a hint for an enabled toolbar button on the message line by holding your mouse steadily over the button. The toolbar generally appears below the main menu bar in the root window.

**transaction code**

A feature you use to describe bank transactions prior to initiating automatic reconciliation from a bank tape. You define transaction codes based on those your bank provides, and Applications Desktop Integrator uses them to load information from your bank tape. For example, your bank may use transaction codes T01, T02, and T03 to represent debit, credit, and stop payment. You define transaction codes that your bank uses to identify different types of transactions on its statements. For
example, your bank may use transaction codes T01, T02, and T03 to represent debit, credit, and stop payment.

**transaction type**

An invoice control feature that lets you specify default values for invoice printing, posting to the general ledger, and updating open receivable balances. The kind of action performed on an asset. Transaction types include Addition, Adjustment, Transfer, and Retirement. Transaction types determine how Cash Management matches and accounts for transactions. Cash Management transaction types include Miscellaneous Receipt, Miscellaneous Payment, Non-Sufficient Funds (NSF), Payment, Receipt, Rejected, and Stopped.

**transactions**

These include invoices, debit memos, credit memos, deposits, guarantees and chargebacks entered with a GL date that is between the beginning and ending GL dates. The transactions are displayed in the Transaction Register in the Functional Currency column. See also *batch source*.

**transaction batch sources**

See *batch source foreign currency translation*.

**transferred date**

The date on which you transfer costs, revenue, and invoices to other Oracle Applications.

**transition**

In Oracle Workflow, the relationship that defines the completion of one activity and the activation of another activity within a process. In a process diagram, the arrow drawn between two activities represents a transition. See also *activity, Workflow Engine*.

**translation**

See *revaluation, foreign currency translation*.

**transmission format**

A transmission format defines what data your bank is sending in the bank file, and how that data is organized. In Applications Desktop Integrator, you define a transmission format that identifies what types of records you want to import, what data is in each type of record, and the position in which that data is located on the record.
unapplied payment
The status of a payment for which you can identify the customer, but you have not applied or placed on account all or part of the payment. For example, you receive a check for $1200.00 and you apply it to an open debit item for $1000.00. The remaining $200.00 is unapplied until you either apply the payment to a debit item or place the amount On Account.

Unbilled Receivables
The amount of open receivables that have not yet been billed for a project. Oracle Projects calculates unbilled receivables using the following formula: \( \text{Unbilled Receivables} = \text{Revenue Accrued} - \text{Amount Invoice} \)

unearned discounts
Discounts your customers are allowed to take if they pay for their invoices after the discount date. (The discount date is determined by the payment terms.) You can specify at the system level whether you want to allow customers to take unearned discounts. See also payment terms.

Unearned Revenue
Revenue received and recorded as a liability or revenue before the revenue has been earned by providing goods or services to a customer. Oracle Projects calculates unearned revenue using the following formula: \( \text{Unearned Revenue} = \text{Amount Invoiced} - \text{Revenue Accrued} \)

unidentified payment
The status of a payment for which the customer is unknown. Applications Desktop Integrator retains unidentified payments for you to process further.

unit
See unit of measure.

unit class
A group of units of measure and their corresponding base unit of measure. The standard unit classes are: Length, Weight, Volume, Area, Time and Pack.
unit of measure
A label for the production quantities for a units of production asset. The unit used to measure production amounts. Each unit of measure belongs to a unit of measure class. A unit of measure records quantities or amounts of an expenditure item. For example, if you specify the unit Miles when you define an expenditure type for personal car use, Oracle Projects calculates the cost of using a personal car by mileage. The unit in which the quantity of an item is expressed, such as Each or Dozen. You can define a unit of measure in Oracle General Ledger and see the unit of measure information in Applications Desktop Integrator when matching an invoice to a purchase order. For example, you may want to define a unit of measure for Square Feet and then, when you enter invoices for office rent, you can track the square footage in addition to the dollar amount of the invoice. See also statistical quantity.

unit of measure classes
Groups of units of measure with similar characteristics. Typical units of measure classes are Volume and Length.

unit of measure conversions
Numerical factors that enable you to perform transactions in units other than the primary unit of the item being transacted.

units of production depreciation method
A depreciation method that calculates the depreciation for an asset based on the actual production or use for that period. This method uses the asset’s actual production for the period divided by the capacity of the asset to determine depreciation. Applications Desktop Integrator multiplies this fraction by the asset’s recoverable cost.

unrealized gain or loss
The measured change in value of an asset or liability over time. Oracle Payables provides a report (the Unrealized Gain and Loss Report) that you can submit from the standard report submission form at any time to review your unrealized gains and losses. See also realized gain or loss.

unscheduling
The removal of the schedule status for an order line or detail if a line or detail is either demanded or reserved; unscheduling will return the status to blank.
UOM
See unit of measure.

usage
See non-labor resource.

usage cost rate override
The cost rate assigned to a particular non-labor resource and non-labor organization which overrides the rate assigned to its expenditure type.

usage logs
Usage logs record the utilization of company assets on projects as the asset is used.

use tax
A tax that you pay directly to a tax authority instead of to the supplier. Suppliers do not include use tax on their invoices. You sometimes owe use tax for goods or services you purchased outside of, but consumed (used) within the territory of a tax authority. Use taxes are liabilities to the buyer of goods and services. You can define a tax name for use taxes. When you enter a use tax name on an invoice, Applications Desktop Integrator does not create an invoice distribution or general ledger journal entry for the tax.

user procedures
Applications Desktop Integrator provides you with a report set so that you can run through your concurrent manager to generate the reports from the rollforward process. You must specify the report parameters as you are prompted. You must also specify the same GL Date range for all of the reports in the set except for the Aging reports. The Aging reports require that you declare an As Of Date. The As Of Date represents the date that Applications Desktop Integrator uses to determine the balance of the transaction. Applications Desktop Integrator determines the balance by taking the current balance of an item, and then reversing any transactions against this item that occurred after the As Of Date. You must enter the beginning GL Date of your GL Date range to determine your beginning balance. You must enter the ending GL Date of your GL Date range to determine the ending balance. When the process completes, you should verify the amounts on the reports.

US Sales and Use tax
Levied on the end consumer, prior stages of supply are exempt by certificate awarded by the state of the recipient. Government and other organizations are
exempt by statute. Many taxes may apply to a single transaction, including state, County, City, Transit, and Muni tax. Monthly returns to each state are required only if the operating company is registered for business within that state. Monthly reporting of Sales and Use tax can be on an accrual or cash basis.

**user profile**
A set of changeable options that affect the way your applications run. You can change the value of a user profile option at any time. See *profile option*.

**value**
Data you enter in a parameter. A value can be a date, a name, or a code, depending on the parameter.

**value set**
A group of values and related attributes you assign to an account segment or to a descriptive flexfield segment. Values in each value set have the same maximum length, validation type, alphanumeric option, and so on.

**value added tax (VAT)**
A tax on the supply of goods and services paid for by the consumer, but collected at each stage of the production and distribution chain. The collection and payment of value added tax amounts is usually reported to tax authorities on a quarterly basis and is not included in the revenue or expense of a company. With Applications Desktop Integrator, you control the tax names on which you report and the reference information you want to record. You can also request period-to-date value added tax reports.

**variable**
An Oracle Financial Analyzer database object that holds raw data. Data can be numerical, such as sales or expense data, or textual, such as descriptive labels for products.

**variable text**
Variable text is used when dialog boxes or their components are unlabeled or have labels that change dynamically based on their current context. The wording of variable text does not exactly match what you see on your screen.
vendor
See supplier.

void check stock
A feature you use to void a range of blank check stock.

voucher number
A number used as a record of a business transaction. A voucher number may be used to review invoice information, in which case it serves as a unique reference to a single invoice.

warehouse
See organization.

warehouse
To store approved invoices for payment by a central Treasury or a central accounts payable department.

warrant
An order by authorized legislative or executive officials directing the treasurer to pay a specific sum to order or to the bearer. It may be payable upon demand, in which case it usually circulates the same as a bank check; or it may be payable only out of certain revenues, when and if received, in which case it does not circulate as freely.

warrant
An order drawn by a legislative body or an officer of the government upon its treasurer, directing the treasurer to pay a specified amount of money to the person named or to the bearer. A warrant may be payable upon demand, in which case it circulates the same as a bank check, or it may be payable only out of certain revenues when and if received, in which case it does not circulate as freely.

waybill
A document containing a list of goods and shipping instructions relative to a shipment.
waybill number
The number associated with a waybill that you record for the shipping batch at ship confirmation.

weighted-average exchange rate
An exchange rate that Applications Desktop Integrator automatically calculates by multiplying journal amounts for an account by the translation rate that applies to each journal amount. You choose whether the rate that applies to each journal amount is based on the inverse of the daily conversation rate or on an exception rate you enter manually. Applications Desktop Integrator uses the weighted-average rate, instead of the period-end, average, or historical rates, to translate balances for accounts assigned a weighted-average rate type.

weighted-average translation rate
The rate General Ledger uses to translate your functional currency into a foreign currency for your transactions. Applications Desktop Integrator provides transaction information based on daily rates you enter in the system and rate exceptions you define for individual transactions. This transaction information allows General Ledger to calculate an accurate weighted-average translation rate.

window
A box around a set of related information on your screen. Many windows can appear on your screen simultaneously and can overlap or appear adjacent to each other. Windows can also appear embedded in other windows. You can move a window to a different location on your screen.

window title
A window title at the top of each window indicates the name of the window, and occasionally, context information pertinent to the content of the window. The context information, contained in parenthesis, can include the organization, set of books, or business group that the window contents is associated with.

WIP
See work in process.

withholding
In some cases, the Internal Revenue Service requires companies to withhold a portion of payments to 1099 suppliers who meet specific criteria. These payments are for federal income tax. Before withholding any payments, you need to inform
the supplier in writing. You then send the accumulated withholding amount, with another window, to the Internal Revenue Service once per quarter.

**withholding tax group**
You can assign one or more Withholding Tax type tax names to a withholding tax group. Assign a withholding tax group to an invoice or distribution line and use Oracle Payables to automatically withhold tax for expense reports and supplier invoices.

**withholding tax rate**
The rate at which Payables withholds tax for an invoice distribution line that has a Withholding Tax type tax name assigned to it.

**Work Breakdown Structure (WBS)**
The breakdown of project work into tasks. These tasks can be broken down further into subtasks, or hierarchical units of work.

**work in process**
An item in various phases of production in a manufacturing plant. This includes raw material awaiting processing up to final assemblies ready to be received into inventory.

**work site**
The customer site where project or task work is performed.

**Workflow Engine**
The Oracle Workflow component that implements a workflow process definition. The Workflow Engine manages the state of all activities, automatically executes functions, maintains a history of completed activities, and detects error conditions and starts error processes. The Workflow Engine is implemented in server PL/SQL and activated when a call to an engine API is made. See also Account Generator, activity, function, item type.

**write-off**
See invoice write-off, revenue write-off.

**write-on**
An event type classification that causes revenue to accrue and generates an invoice for the amount of the write-on.
XpenseXpress
See expense report.

**year average-to-date**
The average of the end-of-day balances for a related range of days within a year.

**year-to-date depreciation**
The depreciation taken for an asset so far this fiscal year.

Zengin
The standard file format for bank transfers in Japan. The profile option AR: Alternate Name Search determines whether you can transfer this type of bank file into Receivables using AutoLockbox. The profile option AR: Zengin Character Set lets you choose the character set to use when importing bank files of this type.

**Zoom**
A forms feature that is obsolete in GUI versions of Oracle Applications.
Index

A

Account Hierarchy Editor
  adding or changing child values, 8-24
  adding or changing parent values, 8-21
  adding or changing rollup groups, 8-37
  changing account hierarchies, 8-17
  closing, 8-39
  displaying segment value details, 8-9
  duplicating hierarchies, 8-26
  expanding and collapsing hierarchy diagrams, 8-8
  finding segment values, 8-15
  Hierarchy Diagram window, 8-7
  Hierarchy status symbols, 8-5
  interface, 8-4
  merging ranges, 8-23
  modifying segment value descriptions, 8-34
  multiple hierarchy diagrams, 8-9
  parent levels concept, 8-2
  Replacement Order list, 8-33
  replacing parent segment values, 8-30
  Segment Values window, 8-5
  toolbar, 8-14
  using, 8-1

Account Hierarchy Editor menu, 8-10
  edit menu, 8-11
  file menu, 8-10
  window menu, 8-13

account segment values
  choosing, 3-38

accounts
  using Account Hierarchy Editor, 8-1
  adi frequently asked questions, 2-1

ADI toolbar, 3-3
Analysis tab, 3-28
Analysis Wizard, 7-1
  drilldown flows, 7-13
  drilling down to summary and detail accounts, 7-6
  features, 7-2
  pivoting and filtering drilldown data, 7-6
  setting options, 7-11
  toolbar, 7-10

applications database
  selecting, 3-12

Applications Desktop Integrator (ADI), 1-4
attribute sets, 12-21

B

budget accounts
  inserting new, 4-15

budget balances
  updating, 4-13

budget notes
  adding, 4-16

budget rules
  in ADI, 4-16

Budget tab, 3-24

budget upload options
  setting, 4-22

Budget Wizard, 4-1
  adding budget notes, 4-16
  budget criteria, 4-6
  budget rules, 4-16
  changing the worksheet view, 4-8
  creating budget worksheets, 4-2
graphing budgets, 4-18
inserting new budget accounts, 4-15
options when a budget worksheet is open, 4-5
setting budget upload options, 4-22
setting budget worksheet parameters, 4-6
updating budget balances, 4-13
uploading budgets, 4-19
view filters, 4-8
budget worksheets
creating in ADI, 4-2
budgets
adding budget notes in ADI, 4-16
ADI Budget Wizard, 4-1
entering with ADI, 4-1
graphing using ADI, 4-18
status, 4-7
updating balances from ADI, 4-13
uploading from ADI, 4-19

cancelling requests, 12-50
cell level formatting, 12-42
release 10.6 and 10.7, 12-45
Release 11, 12-44
closing Account Hierarchy Editor, 8-39
Colors tab, 3-19
content sets
generating, 6-28
hierarchy attributes, 6-31
hierarchy filtering options, 6-34
Create Assets feature
asset upload options, 9-11
layout templates, 9-3
overview, 9-1
setting asset worksheet parameters, 9-3
creating budget worksheets, 4-2
creating journal entries, 5-12
customizing journal worksheets, 5-6
drill options, 3-28
Duplicate Hierarchy window, 8-28
duplicating hierarchies

Account Hierarchy Editor, 8-26
enter journals
using ADI, 5-1
entering budgets
Budget Wizard, 4-1
expanded rows, 12-46
Financial Statement Generator (FSG)
using Report Wizard, 6-1
Find Segment window, 8-16
finding segment values
Account Hierarchy Editor, 8-15
format tokens, 12-38
formatting
attribute sets, 12-21
expanded rows, 12-46
frequently asked questions
ADI, 2-1
functional issues, 2-6
installation considerations, 2-1
technical issues, 2-14
General Ledger
Account Hierarchy Editor, 8-1
Budget Wizard, 4-1
import processes, 3-42
Journal Wizard, 5-1
Report Wizard, 6-1
General tab, 3-22
getting started, 3-1
graphing budgets
using ADI, 4-18
help system
setting the location, 3-33
hierarchy attributes for content sets, 6-31
hierarchy diagrams
  displaying multiple diagrams, 8-9
  expanding and collapsing, 8-8
hierarchy filtering options for content sets, 6-34
hot keys, 3-3

I
import processes
  General Ledger, 3-42
  Oracle Assets, 3-46
  submitting, 3-42
Import Text File feature
  mapping templates, 11-2
  overview, 11-1
  parameters, 11-2

J
journal entries
  creating with ADI, 5-12
  uploading from ADI, 5-17
Journal tab, 3-25
journal upload options, 5-21
Journal Wizard, 5-1
  creating journal entries, 5-12
  creating journal worksheets, 5-2
  customizing journal worksheets, 5-6
journal upload options, 5-21
journal worksheet options, 5-4
uploading journal entries, 5-17
journal worksheet options, 5-4
journal worksheets
  creating, 5-2
  customizing, 5-6
journals
  entering, 5-1

L
language options
  setting, 3-32
layout templates
  Create Assets feature, 9-3
  Record Physical Inventory feature, 10-4
  local printer settings, 12-31

M
macro
  report themes, 12-49
mapping templates
  Import Text File feature, 11-2
Modify Node Descriptions window, 8-35
modifying segment value descriptions
  Account Hierarchy Editor, 8-34

N
New Theme tab, 3-20

O
options
  Analysis tab, 3-28
  Budget tab, 3-24
  Colors tab, 3-19
  drill, 3-28
  General tab, 3-22
  Journal tab, 3-25
  language, 3-32
  New Theme tab, 3-20
  Report Definition tab, 3-26
  Request Center, 3-30, 12-5
  setting general, 3-16, 12-5
  wizard, 3-23
Oracle Assets
  Create Assets feature, 9-1
  import processes, 3-46
  Import Text File feature, 11-1
  Record Physical Inventory feature, 10-1

P
parameters
  Import Text File feature, 11-2
  parent levels concept, 8-2
  parent segment values
    replacing, 8-30
  publishing
setting publishing options, 12-18
web options, 12-23
publishing reports
spreadsheet options, 12-26

generating content sets, 6-28
interface, 6-4
menu options, 6-7
reports toolbar, 6-2
saving a report, 6-17
tools, 6-5

Report Wizard interface, 6-4
collapsible/expandable regions, 6-6
displayable windows, 6-8
graphical report layout, 6-4
menu options, 6-7
report indicators, 6-4
Report Navigator, 6-9
Report Object Properties window, 6-9
report worksheet buttons, 6-8
right mouse button options, 6-8
Row Properties window, 6-10

reports
ad hoc report components, 12-13
adding and deleting columns, 6-20
adding and deleting rows, 6-19
publishing options, 12-18
publishing text options, 12-29
saving, 6-17
setting report submission options, 12-30
submitting from Request Center, 12-8
submitting FSG or ad hoc, 12-11
submitting standard, 12-9
submitting standard variable format, 12-10
text publishing options, 12-29
web options, 12-23

Request Center
formatting report output, 12-33
local printer settings, 12-31
monitoring a request, 12-52
monitoring requests, 12-51
overview, 12-1
setting options, 12-5
specifying a sound file for request completion, 12-7
stop monitoring requests, 12-54
submitting reports, 12-8
toolbar, 12-2
using report output themes, 12-33
viewing reports and log files, 12-50

Record Physical Inventory feature
inventory upload options, 10-12
layout templates, 10-4
overview, 10-1
worksheet parameters, 10-3
release information
displaying, 3-36
Replacement Order list, 8-33
replacing parent segment values, 8-30
Report Definition tab, 3-26
report definitions
creating, 6-12
report formatting
formatting individual cells, 12-42
report indicators
Report Wizard, 6-4
report output themes, 12-33
applying to report output, 12-33
changing, 12-33
creating, 12-34
customizing, 12-47
customizing financial report themes, 12-35
report sets, 12-14
report themes
macro, 12-49
using cell level formatting, 12-42
using tokens, 12-38
Report Wizard, 6-1
adding and deleting column account assignments, 6-27
adding and deleting columns, 6-20
adding and deleting row account assignments, 6-23
adding and deleting rows, 6-19
changing column properties, 6-25
changing row properties, 6-21
Column Properties window, 6-11
creating report definitions, 6-12

Index-4
Index-5

Request Center options, 3-30
request sets, 12-14
requests
  cancelling, 12-50
  monitoring, 12-51
responsibility
  choosing a, 3-15
  rows
    expanded, 12-46
RXi Reports, 12-17

S
  security, 3-1
    validation and segment security, 3-3
segment value descriptions
  modifying, 8-34
setting budget worksheet parameters, 4-6
signing on, 3-10
signon information
  displaying, 3-34
submitting
  request sets, 12-14
  RXi Reports, 12-17

T
  tech19, 2-18
  toolbar, 3-3

U
  uploading asset data
    upload options, 9-11
  uploading budgets from ADI, 4-19
    setting budget upload options, 4-22
  uploading inventory data
    upload options, 10-12
  uploading journal entries
    from ADI, 5-17
    upload options, 5-21

V
  values
    choosing from lists, 3-37

W
  wizard options
    setting, 3-23
  worksheet parameters
    Create Assets, 9-3
    Record Physical Inventory feature, 10-3